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10 ATOMS Help

1 Introduction

The topics in this section give information about the capabilities of ATOMS, what
information is needed to draw a structure, general procedure for starting up, and a description of
the calculations.

See:

Types of Windows for more information about the windows which are used;

Menus and Dialogs for detailed help on input;

Reference for general topics;

Tutorials for some simple examples of input.

1.1 Capabilities of ATOMS

ATOMS s aprogram to display atomic structures of all types, including molecules,
polymers and crystals, and combinations of any of these.

If symmetry is used, the coordinates of only one atom of each equivalent set need to be
entered. The symmetry elementsfor all 230 space groups and 32 crystallographic point
groups are on file and can be called up by number or with their standard symbols. Non-
crystallographic symmetry - such as pentagonal or icosahedral - can also be used. An
auxiliary program SYMGRP is provided to derive complete symmetry matrices for any
point group. ATOMS also supports Shubnikov symmetry for illustration of magnetic or
other vectorial aspects of structures.

The boundaries for drawings of crystals and polymers can be specified in several ways.
First, the contents of any given number of unit cells can be shown by setting limitsto
trangational repetition. Second, any crystal faces, at any distance from the origin, may
form the boundaries. Third, thereis an option to show a dlice of the structure parallel to a
specified face with thickness equal to the d-spacing. Different boundary levels may be
specified for different atoms if necessary. Fourth, a sphere about any atom or arbitrary
point may be shown. Fifth, all molecules or other bonded units may be identified and
shown in their entirety.

Molecules, polymers or other bonded groups may be isolated (independently of the fifth
boundary option above). The generated atoms may be converted to input atoms, so that
individual atoms may be deleted, removed or otherwise modified without affecting
symmetry- or lattice-equivalent atoms.

Individual structure fragments may be combined to model twinning, epitaxy and
crystalline defects.
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There are severa ways of displaying atoms and bonds in the Standard Model mode: (1)
spherical atoms and stick or line bonds; (2) line bonds only; (3) interpenetrating
spherical atoms; (4) coordination polyhedra. Any of these types of representation may
be intermixed in asingle drawing. In addition, there is athermal ellipsoid mode which
draws atoms and bonds in the manner of ORTEP (by Carroll K. Johnson). The same
representations are available in both 2D (two-dimensional) and 3D (three-dimensional -
OpenGL) Drawing modes.

Shading, according to angle of illumination, can be automatically applied to atoms,
bonds and polyhedrain the 2D Drawing modes. The 3D Drawing modes, which use
OpenGL, provide additional options for lighting and material properties. The 3D modes
can display thermal ellipsoidsin avariety of ways.

The Cavities Model mode shows a surface enclosing the possible center locations of a
given-size spherical particle within the unit cell.

The drawing may be shown in strict projection, or in perspective at any given perspective
distance. Exact scales may be specified in terms of inches or centimeters per Angstrom
for the hard-copy output.

Separate stereopair images may be drawn and stereo output through quad-buffered
OpenGL (or Direct3D on Windows) is available for appropriate hardware (suitable
graphics cards, monitors, projectors and/or eyewear).

Atom labels and bond distances may be automatically added, drawn in proper location
for stereopair views.

Hard copy can be made with dot-matrix printers, laser printers, inkjet printers or pen
plotters. Also, you can write raster or bit-image filesin several formats as well as vector
files or metafiles, for usein other software. Files can also be written in 3D formats
(3DMF, VRML).

1.2 Information Needed to Draw a Structure

The first three categories of information listed below are intrinsic to a given structure,
and do not change in the course of a calculation. These categories require very specific
data from some source, if the structure is not theoretical or imaginary. Some sources of
structural information are listed at the end. Categories 4 and 5 are somewhat arbitrary,
but are generally fixed by chemical or geometric considerations. Categories 6 and 7
describe not so much intrinsic information about the structure, as attributes which are
assigned for display purposes.

1. Reference Axes/Coor dinate System/Unit-Cell Parameters.
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12 ATOMS Help

The natural coordinate system for crystalsisthe crystal axes, which give the length
and direction of the lattice trandations. These are specified by as many as three axis
lengths and three interaxial angles (afourth redundant axis which is frequently used in
hexagonal and trigonal crystalsisignored in ATOMYS). The axis typesfall into seven
different crystal systems, depending on the constraints of symmetry on the equality in
length of the axes and the interaxial angles. The coordinates of atoms and indices of
face (if present) in the crystal system are eventually converted to coordinatesin a
Cartesian system with a standard orientation (z= ¢, x = a*; see section IV-6), but
Space-group symmetry operations (reproduction of atoms within the unit cell) are
most easily carried out on the original crystal coordinates.

Coordinates of atomsin molecules are usually given in a Cartesian axial system. If the
molecule has one 3-fold or 6-fold axis of symmetry, i.e. hastrigonal or hexagonal
symmetry ATOMS can either use reference axes which also have this symmetry, that
istrigonal or hexagonal "crystal” axes (a1 and a2 axes at 120 degrees, ¢ axis at 90
degreesto aj and a2), or use unit Cartesian axes. The symmetry matrices for the
standard point groups are actually stored in the form appropriate to hexagonal axes,
and then converted to the Cartesian form during calculation if the structure axes are
unit Cartesian.

2. Atom Coordinates.

Any structure must be specified by the locations of the atoms. In the case of crystals,
thisisnormally donein terms of fractional coordinates on the structure axes. If
symmetry is used, only one atom of each equivalent set need be entered. Atoms may
be grouped by types (e.g. all Si atoms, all C atoms, etc.) to facilitate location of bonds
and polyhedra.

When drawing magnetic or other vector structures, the coordinates or indices of the
vector on each input atom is required.

3. Space- or Point-Group Symmetry.

This describes the way the atoms are repeated by the symmetry operators. The
combinations of symmetry operators fall into alimited number of groups called space
groups for crystals, and point groups for molecules. At aminimum, it is necessary to
know which of these groups the crystal or molecule belongsto. The standard
reference for space groups is the International Tables for X-ray Crystallography,
published by Kluwer (4th edition). All of the 230 space groups are listed by number
inVolume A, or Volume in older editions (all referencesto the Tables will assume
Volumel or A), and it isonly necessary to give this number, or the standard
Hermann-Maughin (International) or Hall symbol of the space group.

For molecules, ATOMS can also use the data from the Tables to provide the point-
group symmetry given the standard symbol for the group (either the International
symbol or the Schoenflies symbol), subject to some orientation restrictions, and to the
limitation that the point group is crystallographic, that isthat it belongs to one of the
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seven crystal systems.

If astructureis described in a crystallographic space- or point group in which the
orientation or choice of origin is non-standard, it is still possible to enter the
symmetry by essentially copying the information in the Tables or other source,
provided the symmetry is described in the standard format.

Point groups containing n-fold axes with n equal to 5 or larger than 6 are theoretically
possible for molecules or one-dimensional polymers but not crystals. For such cases,
the symmetry must be entered in the form of Cartesian matrices; these matrices, for
any point group, can be prepared with the auxilliary program SY MGRP.

4. Boundaries of the Structure.

For amolecule, it may be presumed that all atoms entered, and usually all those
generated by symmetry, are to be shown in the drawing, although selected individual
atoms can be hidden or "deleted” after generation of the structure (see

Deleting Atoms). Crystals and polymers, however, are idedlly infinite structures, in
which the unit cell isrepeated by translation in as many as three directions, and some
limitations must be placed on the extent of this repetition by trandation. In some
crystalsit may be desirable to isolate molecules or other units. There are several
different ways that such limitations can be imposed in ATOMS — see

Boundary Options.

5. Definitions of Bonds and Coordination Polyhedr a.

To specify bonds, you only need to give the types of the two atoms involved, and
minimum and maximum bond distances between the two atoms; all bonds with these
specifications are automatically located. These bond specifications can also be
derived automatically from a set of atomic radii. To specify polyhedra, you need to
give the type of the central atom, the coordination number, the types of the
coordinating atoms or ligands, and the maximum distance between central atom and
ligands. Normally, all polyhedrawill be identified except incomplete polyhedra, i.e.
those in which some of the atoms are not within the specified structure boundaries. If
the coordination number and/or bond distances are not known, they can be determined
with preliminary runs in which incomplete polyhedra are also accepted.

6. Sizes and Colors of Atoms, Bonds and Polyhedra.

In the Standard Model mode, atoms are shown as spheresif they are shown at all; the
radius (in Angstroms) must be specified. Bonds can be represented as single lines, or
as"sticks' or cylinders with agiven radius. If atomsinterpenetrate, thereis no size
parameter, but a bond between the two atoms must be identified (item 1-3.5 above) if
the junction is to be handled properly in 2D Drawing modes (thisis not necessary for
the 3D modes). If a color screen display is used, colors may be assigned to the atoms
and bonds according to several schemes. For the dot-matrix plot (including laser
printer) and black-and-white screen displays, different shades of gray, normally
represented by dot-patterns, may be specified for atom or bond colors. For pen plots,
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14 ATOMS Help

different pen numbers or colors may be specified for different atoms, bond, and
polyhedra.

For drawing in the thermal ellipsoid mode, temperature factors are required for each
atom, although default isotropic values are used if the temperature factors are not
available for a given atom.

7. Orientation, Projection, Scaling.

These things all have defaults, but can be changed after initial input, and it may
require some thought and experimentation to find the best settings. See

Coordinate Systems. The projection may be orthographic (straight down the x-axis)
or perspective. Perspective generally gives the most realistic appearance, while
orthographic retains strict geometric relations and scaling. The drawing may be on
some fixed scale (in inches or centimeters per Angstrom) or expanded automatically
to fill the plotting area.

Sour ces of Structure Information. Thetwo principal journalsfor crystal and
molecular structure information are Acta Crystallographica and Zeitschrift fur
Kristallographie, athough many other chemical, biological and mineralogical journals
publish structure determinations. Structure information is periodically summarized in
Structure Reports. Most of the important structures are described by R.G. Wyckoff, in
Crystal Srructures (7 Volumes).

There are many sources of structure datain the form of computer files. Seethe

Import Files option in the File menu for details on the formats supported by ATOMS.

1.3 Starting Up

When ATOMS is started, you see the Startup Window, which has buttons for the usual
waysto input data. The same choices arein the File menu. Thereisachoice of starting
anew file (New), opening an old file (Open), or importing afile (Import File). Also, a
list of filesrecently worked on is shown in the File menu - single-clicking on one of
these will open thefile.

When you double-click on an ATOMS datafile (.STR file) instead of the program icon
thefileisread in and you see a message box giving you the choice of calculating the
structure or cancelling (see below).

Thefirst time you run ATOMS you may want to check the dialogsin the Settings menu,
especially the Preferences dialog. If you intend to use a pen plotter [Windows only], you
should select the Pen Plotter Settings command, and verify or change the settings as
needed. Likewise, you many need to change or verify the PostScript Settings.

Opening a sample file or an old structurefile. You can read in one of the samplefiles (in

© 2011 Shape Software



Introduction 15

the SAMPLES sub-directory) or folder, using the Open command or the most-recently-
used list in the File menu. Alternatively, when ATOMS s not active, you can double
click on one of the ATOMS datafiles (.STR files).

Entering a new structure. You can enter anew structure with the New itemin the File
menu. Thiswill step automatically through all the categories of information necessary.
Between each of the main dialogs in this sequence there will come adialog titled "Enter
New Data Set". Thisdialog gives you a chance to back up to the last dialog completed,
or to abort the New data entry. Y ou can cause this dialog to be omitted with Preferences
in the Settings menu.

Thefirst part of the input is commandsin the I nput1 menu. Thefirst three categories,
Title/Axes, Symmetry, and Boundary, are all mandatory. The next three categories,
Crystal Forms, Atoms, Polyhedra and Bonds are optional, although all structure
drawings must have either atoms or acrystal shape (forms). If the dataentry is aborted
during thisfirst sequence, the entire file is abandoned.

At this point, you have the option of stepping through the remaining items, which are
from the I nput2 menu and mostly control the way the structure is displayed, or of
accepting default values. (Y ou can cause the current values and settingsin the I nput2
menu to be used as the defaults with the Save Defaults item in the Settings menu.) The
dataentry can be aborted at any point during this sequence and the new data set will be
preserved.

Importing afile. Thisrefersto filesfrom other software. New formats are frequently
added, so see on-line help for details.

After an old ATOMS data set or an import file has been read in or a new data set entered,
you are asked if you want to "..calculate now". If you reply Yes, the structureis
calculated and should appear in the Graphics window in ashort time. If you reply No, the
Graphics window is blank when it opens; you can then modify the data for the structure
or the display parameters using the menus and dialogs, as described in Chapter 111.

When corrections or additions have been made, use the Calculate command in the File
menu.

The Calculate command in the File menu and the Replot command in the Display
menu are two of the most important and frequently-used in ATOMS. Calculate
constructs crystal faces for boundaries (if used), reproduces atoms with symmetry and
|attice trandlations, identifies atomsin bonds and polyhedra, and then plots the structure
in the Graphics window. Y ou must use this command if you change anything which
determines the number and location of atoms, or the atoms involved in bonds and
polyhedra. Thisincludes many parametersin the dialogs of the I nput1 menu, although
there are are al'so some parameters, such as atom, polyhedron and bond colors and atom
and bond radii, whose changes do not require recalculation. Replot simply redraws the
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16 ATOMS Help

structure without changing the lists of atoms, polyhedra or bonds. Changesin any of the
parameters in the dialogs of the I nput2 menu can be put into effect with Replot.

The Calculate and Replot commands are also in the Dialog Bar - Left, whichis
controlled in the Display menu.

1.4 Description of the Calculations

It isimpossible to give a complete description of the calculation methods, but some
account of the procedures should be helpful to guide the use of the program.

L ocating Atoms, Bonds, Polyhedra and Vectors

If crystallographic symmetry is present, symmetry operationsin the form given in the
International Tables for X-ray Crystallography are converted to matrices. For non-
crystallographic symmetry (e.g. pentagonal, icosahedral) the matrices, generated by the
auxilliary program SY MGRP, are read in directly. The atom coordinates are multiplied
by these matrices, and trandations are added if there are screw axes or glide planesin the
space group, to find al the atomsin the unit cell or molecule. The coordinates of the
atoms are then converted to a Cartesian system if necessary.

If the structure is a molecule, then no further location of atomsis necessary, but for
polymers or crystals, the lattice trans ations must be applied, subject to one of several
types of boundary. In some cases, especially for polymers, it may be sufficient to take all
atomsin unit cells related to the initial one by specified numbers of |attice trandationsin
each of the three crystal or polymer axis directions— one or two of the trandlations may
be disabled, leading to two- or one-dimensional polymers, respectively.

For crystals amore general and powerful method of determining the structure boundaries
isby means of crystal faces. The crystal faces are specified by their standard Miller-
Bravaisindices (the reciprocals of the intercepts on the three crystal axes), and by a
central distance, which isthe perpendicular distance from the center of coordinates to the
face. If the crystal has symmetry, this can used in specifying faces; i.e. only one face of
each symmetry-equivalent set, or form, need be entered. Symmetry equivalents of the
faces are derived similar to that used for atoms. However, if desired the symmetry used
in the generation of faces can be lower than that used in the generation of atoms.

A special case of boundary facesisasdlice, which isasdlab of the structure bounded by a
given face and its negative, with a thickness determined by the crystallographic
interplanar or d-spacing — the limitsto the extent of the structure in the two dimensions
parallel to the given face are arbitrary and may be specified.

To identify the the corners and edges defined by the crystal faces, all possible
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intersections of triplets of faces are located; those which are further from the center than
any face arergjected as crystal corners. Edges are defined by pairs of corners which have
two faces in common.

Atoms within the specified face boundaries are ssimply those which are not at a positive
distance from any face. Starting with atoms in the central unit cell (fractional coordinates
0to 1), lattice translations are added or subtracted until all possible atoms have been
tested for inclusion. The algorithm which does thisis rather complex, as finding the
starting and ending unit-cell limits for the atoms search in the general case of face
boundariesis not trivial.

If coordination polyhedra are to be shown, the atoms involved must be located. ATOMS
will identify all polyhedra consisting of specified types of ligands within a given distance
of a central atom. The ligand atom locations (points) form the corners of opague
polyhedra. Edges and faces of each polyhedron must be identified, which requires some
rather complex calculations. Because of possible variation in coordination number, data
on corners, edges and faces of polyhedra must be packed into special arrays, and
unpacked each time they are used.

In the Thermal Ellipsoids Model mode, at the start of the calculation the temperature
factors for each input atom are converted to the principa axes of athermal ellipsoid.
During generation of the atoms within boundaries, the number of the symmetry matrix
used is saved, to be used later in plotting.

If atomic vectors are present, they are represented by pseudo-atoms (at the ends of the
vectors) and by pseudo-bonds. This simplifies the geometric relations for plotting in 2D
Drawing modes. These pseudo-atoms and pseudo-bonds are generated in a specia loop.

The atom locations, identity of bonds and data on polyhedraif present, constitute a
"permanent” set of parameters for each structure. The atom coordinates may be rotated in
any of several waysto obtain a suitable view.

Plotting - 2D Drawing modes

Whenever adrawing is made for the screen, dot-matrix plotter or pen plotter, the actual
elements which appear in the drawing, that is arcs of circles representing spherical atoms
and lines representing bonds and polyhedra, must be recalculated, since their
interrelations depend on the viewing angle. Each polyhedron must be examined to
classify edges as to whether they are front, back or boundary.

For screen or dot-matrix drawings, the procedure is somewhat simplified sinceit is
possible to blank out or draw over elements which lie underneath others. The atoms,
polyhedra and bonds are sorted according to their height, or distance from the viewer.
The elements are then plotted in sequence from the most distant to the nearest. Atoms
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are represented in the sorting process by their centers, bonds by their midpoints, and
polyhedra by the central atom. This sorting processis asimplification of the true
relationships, and conceivably could lead to error, but only if the bonds are unusually
long. In fact the drawing method relies on displaying only normal chemical bonds, not
arbitrary connections between atoms. If desired, atom labels are drawn during the
process of plotting atoms from back to front.

If crystal edges are also shown, the "back” edges, i.e. those that would beinvisiblein an
opague crystal, are plotted before the atoms, bonds, etc., and the "front" edges are plotted
after. Sorting the crystal edges is not practicable because of their length. Thereisno
attempt to solve for interpenetration relations of edges with atoms, bonds or polyhedra
and errors will usually result if the edges are not completely outside the structure.

For pen plots actual blanking or overlaying isimpossible, and it is necessary when
drawing a given element to consider every other element which lies higher (closer to the
observer), find al the possible intersections and remove the segments which are
obscured. Insofar as possible, intersections of structure elements (bonds and atoms,
polyhedra) are considered as intersections of two-dimensional figures (circles, lines,
ellipses), rather than computing the intersectionsin three dimensions and then finding
the projections. One approximation which is made here is to represent ellipses (which
only arise as junctions of atoms and stick bonds, and junctions of interpenetrating atoms,
and thus cannot overlie other elements) by means of line segments for purposes of
locating intersections; they are actually drawn as ellipses, but slight errorsin locations of
intersectionsinvolving ellipses may occasionally result.

For perspective drawings, the atom locations (and crystal cornersif present) are
projected from a given perspective distance onto a plane passing through the center of
the structure. Overlay relationships with other elements (for pen plots) are then
determined on the basis of circular projections for spherical atoms, again making
calculations in two dimensions as much as possible. Thisis not true perspective, but the
differenceisnot likely to be noticed unfavorably in the normal case. In fact, when true
perspective is used and the drawing is viewed at other than the (scaled) perspective
distance specified in making the projection, the distortion of the projected atom shapes
from circles can be very disturbing - this can be verified in 3D Drawing modes.

For shading of atoms, the given illumination vector and the number of shading zones are
used to set up outlines for each zone, consisting of circle and ellipse segments. The
angle with the illumination vector gives a shade for each zone. The zones need to be set
up only once for agiven illumination vector, since all atoms are identical except for
scaling by the radius. Zones can also be set up for stick bonds, but since the bonds make
various angles with the illumination vector, the shade can only be determined at plot
time. For polyhedra, the shade of each face is determined at plot time.

In the Thermal Ellipsoid Model mode, at plot time, atoms are sorted and plotted from
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back to front as for ball-and-stick, but as each atom is drawn the principal axes are
transformed using the appropriate symmetry matrix, and the ellipsoid is drawn. Bonds
are located in the same way as for standard ball-and-stick, but because the algorithm for
finding the intersection of stick bonds with ellipsoids is completely different from that
used for spheres, thermal ellipsoids and ball-and-stick cannot be intermixed.

Atomic vectors, which are represented as pseudo-bonds, arein fact drawn much like
normal bonds, except that cones (arrowheads) are substituted for the atom on the positive
end of the vector (if it istwo-ended) for all types of display and output aside from pen
plots.

Plotting - 3D Modes.

In this type of drawing, the surfaces of three dimensional objects such as spheres and
cylinders are converted to an assemblage of planar polygons. Then each polygon is
drawn essentially independently pixel by pixel. The critical difference with 2D Drawing
modes isthat a depth buffer isused in 3D imaging. Thisisan array of integers, one for
each pixel in the display or output (or that portion which is currently being drawn, when
banding is being used). Each element, representing a pixel, holds the relative x
coordinate (in the ATOMS observer coordinate system - this is more often the z-axis and
the buffer may be called the z-buffer) of the foremost object or polygon. The color for
this object is retained in the color buffer, which isasimilar array representing pixels; this
array isactually the image itself. Whenever a polygon is drawn, each pixel which it
contains is compared against the depth buffer; if the x coordinate of the pixel is greater,
or closer to the observer than what is in that element of the depth buffer, the color for
this pixel in the new polygon replaces the value in the color buffer. That is, the depth
buffer keeps track of the front surface of the drawing, and ensures that only this front
surface (not any hidden surfaces) are kept in the color buffer or image itself.

Typically, each corner of each polygon is assigned a vector normal, which is not the
same as the normal to the polygon itself. For example for a sphere the normals are
simply directed from the center outward through the corners of the polygons (triangles).
Color is assigned to each corner according to the light equation (see 3D Lighting in the
I nput2 Menu), and interpol ating between the corners at each pixel gives asmooth
curved appearance, rather than a collection of flat polyhedra.

When tranglucency isin effect, it is necessary to blend the color of a new object with
what is already in the color buffer. Itisnormally necessary to plot translucent objectsin
sequence from back to front, although opagque objects in the same drawing do not have to
be sorted. Translucency always requires increased plotting time.

The "double buffer" method is normally used, the "color buffer" being kept in an area of
memory and then copied to the screen memory when the drawing is completed. Thisis
usually faster than drawing directly to the screen.
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The 2D Drawing mode of ATOMS does not use a depth buffer: the atoms, bonds and
polyhedra are sorted from back to front and drawn in that order. When necessary, the
intersections of objects are solved analytically and only the required portions of each are
drawn.

Using a depth buffer has the advantages that it is not necessary to solve analytically for
intersections, nor to sort the objects with respect to depth. This may save considerable
time, especially for complex drawings, since the time for sorting tends to increase
exponentially with the number of objects. Since analytical solution of intersectionsis
not necessary, it is possible to place essentially any objects into the drawing. in any
location. This overcomes the problem in ATOMS 2D Drawing modes of sometimes-
incorrect drawing of crystal edges or unit-cell edges which intersect with atoms, bonds
and polyhedra. The 3D method allows more complex shading and lighting effects, such
as specular highlights and multiple light sources. It also allows translucent objects. For a
completely 3-dimensiona image, on a computer which has sufficient memory, the 3D
Drawing modes are superior to 2D Drawing modes.

However, there are disadvantages to the 3D method. The 3D method is not very suitable
for black-and-white drawings, which typically are simplified, showing mutual
intersections of atoms with bonds and polyhedra as lines or curves; such intersections
simply are not drawn in the 3D method. Because printers have much higher resolution
than the screen, this causes even higher memory requirements, and for reasonabl e sized
printed drawings it may be necessary to do the printing in bands or segments.

ATOMS itself uses"Immediate mode" to draw atoms, bonds, etc. - that is, it draws each
object and then discards the memory associated with that object. On the other hand,
many 3D applications, especially the standard viewersfor VRML and 3DMF files, use
"Retained mode". In this mode every vertex of every object isread into memory before
drawing. Thisallows simple drawings to be redrawn and rotated rapidly, but it may take
along timeto load large drawings initially and uses enormous amounts of memory
(typically 16 MB for 300 atoms in a ball-and-stick model).

3D files (VRML, and 3DMF for Macintosh) contain the locations and material properties
(especialy color) of such common objects as spheres, cylinders, disks and lines, and
their orientation where appropriate. Polyhedra are represented as assembl ages of
polygons. The viewers for these files then use methods similar to those used by ATOMS
to draw the objects.

2 Types of Windows used in ATOMS

ATOMS uses four types of windows besides dialogs and alerts: the Startup window; the
main Graphics window; secondary (Powder and Precession) Graphics windows; and
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Text windows. Each type of window hasits own menu bar. The Help system aso hasiits
own windows and menus.

Note that under the Windows operating system the ATOMS windows are not confined
to reside within aframework window, asin pre-V6.0 ATOMS.

All the current windows are listed in the Windows menu, and this menu can be used to
switch between windows if some are not visible.

When starting up ATOMS, the menus displayed in the Startup window include only a
File menu, a Settings menu and a Help menu. Use the commandsin the File menu to
start anew ATOMS data set, read an old one from afile, or import data from afile with
an external format.

After you have entered or read in the datafor an ATOMSfile, the main Graphics
window opens and the Startup window disappears; if you have elected not to Calculate,
the Graphics window may be blank, otherwise it will show the current ATOMS drawing.
Only one data set at atimeisalowed in ATOMS, and there is only one main Graphics
window. When thiswindow is active, thereis a File menu and various other specialized
menus such as |nputl for datainput and modification and graphics output.

The main Graphics window may be changed into Fullscreen mode, with a button in the
DialogBar - Left. Though some atom identification and rotation options are available in
this mode, most adjustment must be done in a normal window.

The secondary Graphics windows appear only when you have selected

Powder Diffraction (Graph Option) or Precession Pattern from the Display menu.
These windows have their own menu bars, with only a File menu, a Windows menu and
aHelp menu. When a secondary window is active, output, such as Print, Raster File, etc.
in the File menu, isfor the Diffraction results, not the atomic structure in the main
Graphics window.

The File menu of the main Graphics window has four commands, List Input, List
Generated Atoms, List Generated Faces and List Totals, each of which liststhe
relevant data to a separate Text window. When any of these Text windows is active, the
menu bar contains standard menus for saving, printing and editing the contents. Each
window actually displays the contents of afile, called respectively INPUT.ATD,
GENATOMS.ATD, FACESATD and TOTALS.ATD. Thesefiles are written over
again for each new ATOMS data set, so if they are to be preserved they should be saved
with the Save As command in the File menu, using a different name.

A Text window is also generated when Calculation Output is selected in the Input2
menu. The output iswritten to the fileinfile. ATD, whereinfile (.STR) is the name of the
ATOMS datafile. Similarly, the Coordination button in the Input Atoms dialog of the
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Inputl menu writes afile called BONDS.ATD, and the Powder Diffraction (List
option) dialog writes output to the file LIST.ATD. TheList Coords button in the
Cavity Parameters dialog lists the fractional coordinates of al grid points which can
accomodate the sphere of the specified Particleradius in the file CAVVAL.ATD.

Secondary Graphics windows and Text windows are "children” of the main Graphics
window, since their contents pertain only to the current structure, and they are destroyed
if the main Graphics window is closed.

An output Text window or adiffraction Graphic window may sometimes come up
behind the main Graphics window. If the new window isinvisible, use the Window
menu to bring it to the front.

2.1 Startup Window

Thiswindow appears when ATOMS isfirst started, or when a data set (Graphics
Window) is closed.

The structure image at the bottom of this window isfrom afile called default.png. You
may save a new version of thisfile (Raster option, File menu) - the image should be
about 300 pixels wide by 200 pixels high.

It has its own menu bar Startup Menu Bar, and the following buttons for getting a data
fileinto ATOMS.

New - Step-by-step input of anew ATOMS data set.
Open - Openanold ATOMS datafile.

Import File - Shows a pop-up menu with the file types currently supported. This
includes:

---- CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.
---- SHEL X.INS filesfrom the program system of Prof. G. Sheldrick.

---- CIE - Crystallographic Information Files.

---- DBWS/LHPM Rietveld input files.

---- ICSD Inorganic Crystal Structure Database files.

---- ORTEP Original or ORTEP Il atom information.

---- XTLVIEW Drawing program.

---- VIBRAT (.MOT) Graphic output filesfrom VIBRATZ.

---- PDB Protein Data Bank files.

---- RIETAN Rietveld program files.

---- GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system - may include
magnetic vectors.
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---- AM MINERAL. Datafilesfrom the American Mineralogist structure data base.

---- EULLPROE. All-purpose refinement program - may include magnetic vectors.

---- Free-form (Linp). Thisallowsinput of atomic coordinates and other information
from amost any source.

---- Ravel ATOMS. This program is not the same as ATOMS by Shape Software, but is
for EXAFS Analysis.

---- WIENZ2K. The program package WIENZ2k performs electronic structure calcul ations
of solids using density functional theory (DFT).

---- |ZA (zeolites). Filesfrom the International Zeolite Association database.

---- GAUSSIAN. Files from the molecular-orbital program (usually molecules)

Exit/Quit - Quit the ATOMS program.

2.2 Graphics Window

Thisisthe main window which shows the current structure drawing. When it is active,
most menus are available, allowing modification of the data and other operations.

Also, the controls or commands in the Dialog Bar - Left and Dialog Bar - Right are
active (if selected in the Display menu), and they operate on the drawing or on the main
ATOMS data set.

To switch to another window, such as atext window or the Powder or Precession
windows (see Types of Windows), click on that window if it is partially visible, or use
the Windows menu.

The Graphics window may be changed to Fullscreen mode with a button in the
DialogBar - Left or an option in the Display menu.

2.3 Powder Diffractogram Window

This graphics window (see Types of Windows) shows the results from the

Powder Diffraction dialog (Display menu). It hasits own menus, which essentially
alow only input of anew data set or saving of the current data set, and graphics output
of the Powder diffractogram to the printer or files (EPS, raster, metafiles).

Use the File menu for thiswindow for Print, Raster, PICT or Metafile output.

To access the menus which allow modification of the ATOMS data (and even

recal culation of the Precession Pattern), click on the main Graphics Window if itis
visible, or use the Window menu. The main Graphics Window has the title of the
current ATOMS datafile (.STR).
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2.4 Precession Pattern Window

This graphics window (see Types of Windows) shows the results from the

Precession Pattern dialog (Display menu). It hasits own menus, which essentially allow
only input of a new data set or saving of the current data set, and graphics output of the
Precession Pattern to the printer or files (EPS, raster, metafiles).

Use the File menu for thiswindow for Print, Raster, PICT or Metafile output.

To access the menus which allow modification of the ATOMS data (and even

recal culation of the Precession Pattern), click on the main Graphics Window if itis
visible, or use the Window menu. The main Graphics Window has the title of the
current ATOMS datafile (.STR).

2.5 Text Window

Text windows are generated by several commands (below). When atext window is
active, thereis a special menu bar which allows modification and saving of the particular
output file (LATD) which is being edited - the commands in these menus do not pertain
to the current ATOMS datafile. To return to the main Graphics Window for
modification, saving etc. of the ATOMS datafile, click on that window if it isvisible, or
use the Window menu.

The File menu of the Graphics window has four commands, List Input, List Gener ated
Atoms, List Generated Faces and List Totals, each of which lists the relevant datato a
separate Text window. When any of these Text windows is active, the menu bar
contains standard menus for saving, printing and editing the contents. Each window
actually displaysthe contents of afile, called respectively INPUT.ATD,
GENATOMS.ATD, FACES.ATD and TOTALS.ATD. Thesefilesare written over
again for each new ATOMS data set, so if they are to be preserved they should be saved
with the Save As command in the File menu, using a different name.

A Text window is also generated when Calculation Output is selected in the Input2
menu. The output iswritten to the fileinfile. ATD, whereinfile (.STR) is the name of the
ATOMS datafile. Similarly, the Coordination button in the Input Atoms dialog of the
Inputl menu writes afile called BONDS.ATD, and the Powder Diffraction (List
option) dialog writes output to the file LIST.ATD.

3 ATOMS Menus and Dialogs
ATOMSMenu Bars

Startup Menu Bar - This menu bar appears when starting ATOMS, or when all
windows (Graphics or Text) have been closed.
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Graphics Window Menu Bar - Thisisthe main menu bar for entry, alteration and
display of atomic structure data sets.

Text WindowMenu Bar - Thismenu bar is used for text windows produced by the
Listings group in the File menu of the Graphics window, and by the Cal culation Output
command in the Input2 Menu, or by the Powder Diffraction listing option. The Text
window is a more-or-less standard edit window.

3.1 Startup Menu Bar

Filemenu - Usethe commandsin this menu to start anew ATOMS data set, open a
filefor an old data set, or import a data set from a data base.

Settings menu - This contains settings for hardware, palettes and preferences for modes
of operation.

Help menu - On-line help

3.1.1 File Menu (Startup Window)

To start up ATOMS, you must select either New to enter an all-new data set; Open to
open apreviously-saved ATOMS datafile; or Import File to open adatafile written by
other software.

New - Step-by-step input of anew ATOMS data set.

Open - Openanold ATOMS datafile.

Recent FileList (Windows only) - Thelast four ATOMS data (.str) files can be opened
by selecting here.

Import File - Shows a pop-up menu with the file types currently supported. This
includes:

----CCDC FDAT filesfrom the Cambridge Crystallographic Data Centre.
----SHEL X.INS files from the program system of Prof. G. Sheldrick.
----CIF - Crystalographic Information Files.

----DBWS/LHPM Rietveld input files.

----1CSD Inorganic Crystal Structure Databasefiles.

----ORTEP Original or ORTEP Il atom information.
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-—--XTLVIEW Drawing program.

----VIBRAT (.MQOT) Graphic output filesfrom VIBRATZ.
----PDB Protein Data Bank files.

----RIETAN Rietveld program files.

----GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system - may include
magnetic vectors.

----AM MINERAL. Datafilesfrom the American Mineralogist structure data base.
----EULLPROE. All-purpose refinement program - may include magnetic vectors.

----Free Form (.inp). Thisallowsinput of atomic coordinates and other information
from amost any source.

---- Ravel ATOMS. This program is not the same as ATOMS by Shape Software, but is
for EXAFS Analysis.

---- WIENZ2K. The program package WIENZ2k performs electronic structure calcul ations
of solids using density functional theory (DFT).

Page Setup - Set the page size and select the printer.

Exit/Quit - Quit the ATOMS program.

--------- Windows and Linux Only

Note that you can aso
start ATOMS for Windows from the DOS or Linux command line, reading in an
ATOMS datafile or an import file.

3.1.1.1 New Command
New Command [ Filemenu (Startup) or File menu (Graphics)]

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.

When you use this command to start a new data set, ATOMS first steps through most of
the dialogsin the Inputl menu, which involve parameters which are considered to be
intrinsic to the structure in question. After you click OK in each dialog, adialog appears
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(Entering New Data) giving you the choice of continuing or aborting the dataentry. You
can eliminate this dialog with the Confirmatory alerts checkbox in the Preferences
dialog in the Settings Menu. At theend of the dialogsin the Inputl menu another
dialog appears (End of Mandatory Input) giving you three choices. 1) you can continue
with the non-mandatory part of the input, which consists of the dialogsin the
Input2menu, involving mostly display aspects of the structure; 2) you can stop here and
accept the display parameters currently in memory; or 3) you can read in the default
display parameters from adisk file (the current display parameters can be saved as the
defaults with the Save Defaults command in the Settings menu. If thereisno dataset in
memory, option 2) will give the default values.

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.

3.1.1.1.1 Entering New Data Set
Dialog Box - called from: [During New input]

This dialog comes up in between the main categories of data during input of a New data
file. Usually you can just click on Continue (or hit Enter), but you can Abort the input,
or Revise the category you have just finished.

The appearance or non-appearance of thisdialog is controlled by the Confirmatory
alert... checkbox in the Preferences dialog in the Settings menu.

3.1.1.1.2 End of Mandatory Input
Dialog Box - called from: [During New input]

The mandatory input for a New datafile consists of the commandsin the Inputl menu,
through the Bonds item, although you do not necessarily have to specify al of them.
The non-mandatory input consists of the display parameters, or most commandsin the

I nput2 menu (3D parameters are omitted). |f you elect not to continue with these
display items, the display parameters will be taken from a) a set of default parameters, if
you click on Default or if thisisthefirst file in your current ATOMS session; or b) from
the display parameters of the current file if you click on Quit. Y ou can save the current
display parameters (including mostly parametersin the dialogs of the I nput2 menu but
also some from the Display menu) as the default parameters with the Save Defaults
command in the Settings menu.

3.1.1.2 Import Files Submenu
Sub-Menu: Import File [File menu (Startup) or File menu (Graphics)]

This offers a selection of file typesto import, including CCDC FDAT, SHEL X-93, CIF,
DBWS/LHPM Rietveld, ICSD, ORTEP, XTLVIEW, VIBRAT, PDB, RIETAN, GSAS,
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AM MINERAL, FULLPROF, Free-Form, Ravel ATOMS, WIENZ2K, 1ZA(zeolites),
GAUSSIAN, and ADF.

The boundary option in most cases can either be Default Unit Cell, suboption as selected
with the Default radio button, or Locate Moleculesin Crystal.

Multiple occupancies are not permitted in ATOMS, and when more than one atom is
found to be in the same position (same fractional X, y and z coordinates) the second and
subsequent occurences will be deleted.

Thereisalimit of 500 input atomsin most cases.

Depending on the format, there may be many sources of error inimporting files. Open
the file with aword processor and check the symmetry and atom list in ATOMS against
the file contents.

3.1.1.2.1 Import File
Dialog Box - called from: File menu (Startup) or File menu (Graphics)

Thisdialog is used when importing most types of file format.

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.

If there is more than one data set or phase in the file, the Data Sets...in Import File dialog
will present you with alist. The name of the ATOMS datafile will be taken from the
name of the file, and the title (Title/Axes dialog in the Inputl Menu) will be taken from
the data set or phase. The extension.STR will be appended to the structure file.

If the Generate bonds box is checked, the Generate Bonds from Atomic Radii dialog
will come up as soon asthefileisread in.

Read default display parameters. If thisbox is checked, the display parameters last
saved (Settings menu) will be read for the new data set.

Read temperaturefactors. Thisoption may not be available for al types of import file.
In some file formats, such as ICSD RETRIEVE, the temperature factors are in a separate
list from the atomic coordinates. In order to assign the temperature factors to the atoms,
the atom labels in these two lists must match exactly. For thisreason, "OH" and "OH2"
inthe atom listsin RETRIEVE files are changed to "O", since the labelsin the
temperature factor listsuse only "O". If you get the message " Temperature factor atom
label not identified”, you may need to edit the atom labelsin the origina file so that the
two lists agree.
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File Extension. The three-letter extension (.xxx) which identifies the file type under
Windows (see below for Macintosh) may be specified here - only files of that type will
be shown in the Open File dialog. To show al files, enter ".* "

Atomic Radii. Y ou can choose standard ionic or covalent radii, which will be
multiplied by the factor in the edit box. For aball-and-stick drawing, afactor of 0.5 or
lessis appropriate. For interpenetrating atoms (space-filling), afactor of greater than 1.0
isusually necessary. All radii can later be multiplied by a given factor in the Atoms-
Globa command in the Inputl menu. The radii, aswell as default colors, are obtained
from the selected version of the ELEMENTS file (either ELEMENTS.ION or
ELEMENTS.COV) supplied with ATOMS (these files can be modified by the user).

Boundary Option. The boundary option can either be Default Unit Cell, using the
default suboption selected in that dialog, or Locate Moleculesin Crystal. If the

L ocate Moleculesin Crystal option is used, the Gener ate bonds box will be considered
to be checked, as bonds (or polymers) must be defined.

Sour ce of symmetry (some formats lack thisoption). If you select Use positions as
Xyz, in which symmetry operators are given in the form of positionsin the general
equipoint as in the International Tables, the symmetry option (Inputl Menu) will be
Custom Symmetry. After import, you may need to check the Symmetry option to be
sure the centric/acentric choice and the Bravais | attice type are correct (some formats
include a center of inversion and/or |attice centerings in the operators and some do not).
If you select Space group symbol, the Space Group symmetry option will be used. The
Hall symbol, the Hermann-Maughin symbol, and then the International Tables number
will be used in that order if present. If you select Use positions as xyz and the
information on operationsis not present, the symmetry option will default to Space
group symbol. The H-M space-group symbol, Hall symbol, and space-group number
arealwaysread if present.

If symmetry is present in the "xyz" or operation form, thisis usually the safest option
However, this option does not give information on systematic extinctions or true d-
spacings, which may be required for the Slice boundary option. Itisusually possible to
derive the correct space-group symbols from the operations using the Get Symbol option
in the Custom Symmetry dialog.

Atom types (some formats lack this option). ATOMS will try to assign an atomic
number to each input atom either from the first one or two characters of the atom label
itself, or from a separate atom type label if that is present. In diffraction refinement file
formats, this separate atom type label typically identifies the scattering factor, and it it is
your choice whether this or the atom label (if either) will identify the element.

Note that in the case of multiple occupanciesfor asite, ATOMS ignores all but the first
atom.
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For more information about the specific file types, see one of the following
CCDC FDAT

SHEL X-93

CIE

DBWS/LHPM Rietveld

1CSD

AM MINERAL
FULLPROF
Free-Form (.inp)
Ravel ATOMS
WIENZ2K

---- Macintosh only ----

Y ou can show all text files, or only those with the specified extension (.xxx) in the File
Open dialog - make this choice, which applies to most types of files, in the Preferences
dialog in the Settings menu.

3.1.1.2.2 Data Sets... in Import File

Dialog Box - called from: |mport File Command - File menu (Startup) or File menu
(Graphics)

When you open a CIF, DBWS/LHPM or other type of import file, ATOMS will search
through it to find all the data sets or phases within it, up to alimit. If there is more than
one, thisdialog will present you with alist. The name of the ATOMS datafile will be
taken from the name of thefile, and thetitle (Title/Axes dialog in the Input Menu) will
be taken from the data set, phase or crystal selected. The extension.STR will be
appended to the structurefile.

3.1.1.2.3 Free-Form (.inp) File
Import Free-Form (.inp) File [File menu (Startup) or Eile menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

Thisimportsfilesin the free-form format described elsewhere ( Atom Parameter Files).
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Note that this format has been expanded since earlier (pre-V4.1) version of ATOMS, so
that essentially all relevant datafor a crystal may be entered.

3.1.1.2.4 CCDC FDAT File
Import CCDC FDAT File [ Filemenu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

Most of the FDAT files have a"connection table" which specifies the bonds defining a
single molecule, while the unit-cell may contain several molecules. Thustheradio
buttons give you a choice of importing the file as a crystal or asamolecule.

When imported as a molecule, the structure will use the No Boundaries (Molecule)
boundary option, and no symmetry. The files normally contain a unique set of input
atoms, which are the same as those required for input of acrystal in ATOMS, plusin
many cases some extra symmetry-derived atoms necessary to complete the molecule; al
these atoms are used as input atoms when importing as amolecule. With the Atomic
radii radio buttons, you can choose to use either the radius values in the CCDC files, or
thoseinthe ELEMENTS file; in any case, the type number (atomic number), colors and
patterns will be obtained from the ELEMENTS file using the elemental symbol whichis
in thefirst one or two characters of the FDAT atom. Theradiusvauesinthe CCDC
filestypically are covalent radii, slightly smaller than those required for contact of
bonded atoms. For a space-filling or interpenetrating atoms model, they may need to be
increased, and for a ball-and-stick model they may need to be decreased. The radii of all
atoms can be changed by afactor with the Atoms - Global dialog in the Inputl menu.
All bonds between atoms will be the same; the radius, colors and patterns can be defined
with the Define Bonds for M olecule button; thiswill call up adialog which is similar to
that which comes up for individual bonds (Bond Data in the Inputl menu); however,
atom types and distance limits are not used and are omitted from thisdialog. After
calculation, the radius, colors and patterns can be changed with the Bonds command in
the Inputl menu. There will be only one bond type in thelist.

Note that importing a CCDC FDAT file as amolecule uses a different procedure from
the Locate Molecules in Crystal boundary option, which is used in most other cases
when importing a crystal structure as molecules. The Locate Moleculesin Crystal
boundary option uses the bond and polymer specifications entered in ATOM S to isolate
the molecules, whereas the FDAT files usually already contain the linkage information
which defines molecules. 1f you wish to use the Locate Moleculesin Crystal option, you
must import the FDAT file as a crystal, then change the boundary option.

When imported as a crystal, the structure will use only the unique set of atoms, omitting
the extraones. The boundary option will be Default Unit Cell, current default suboption.
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3.1.1.2.5 SHELX .INS File
Import SHEL X.INS-93 File [ File menu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

ATOMS is programmed only for SHEL X-93 files, although it may also be possible to
read SHEL X-76files.

Atom type numbersfrom. The Type labels radio button will use the SHELX SFAC
(scattering factor) number which is the number which follows the atomic label and
preceeds the atomic coordinatesin the SHEL X file. The numbers correlate with
elements through the SFA C instruction, which must be in the SHEL X file. These
elements will be used to determine the atomic radii and colors using the ELEMENTS
files supplied with ATOMS (which can be modified by the user). The SHELX atomic
radii are not used; if an element is not in the current ELEMENT Sfile, the correct radius
will not be supplied.

Symmetry. The Custom point or space group option will be used. Typically the true
symbol can be recovered from the titte. ATOMS will read the SYMM linesin the
SHELX fileonly if they arein standard International Tables format - the translational
part must precede the positional part (i.e. 1/2+x, not x+1/2). If the symmetry was copied
from the Tables, there should be no problem. Y ou can edit the symmetry operators after
they areread in with the Symmetry command in the I nput1 menu.

Multiple occupancy of sites. If thereisan EXY Z instruction, ATOMS will use only the
first atom - al others will be deleted.

FRAG instruction. Atoms listed between this instruction and the FEND instruction will
be ignored.

RESI instruction. Atoms listed after thisinstruction will be included, but not treated in
any special way.

Hydrogen atoms. SHEL X has severa sophisticated ways of locating hydrogen atoms
which are not duplicated by ATOMS. Frequently, the positions of the hydrogen atoms
are not in the.INSfile, and must be taken from the output. There are several waysto do
this. First, the output lines giving the hydrogen positions can be copied into the.INSfile.
If thisis done, atype or SFAC number must be inserted after the label and before the
coordinates. The hydrogen lines can also be put into a separate file and read in with the
SHELX +filename include-file instruction. Second, the hydrogen lines can be put into a
file of their own and read in with the input-file provision of the Input Atoms dialog in
the I nput1 menu, after the SHEL X.INSfile has been imported. Since the label and
coordinates are in the default order, no modification is necessary, and aFIELDSlineis
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not needed - only the lines with the labels and coordinates (any other fields following on
the same line will beignored). If you do this, do not check the Generate bonds box.

Y ou can generate bonds after the SHEL X and the hydrogen input files have been read in,
with the Bonds dialog in the Inputl menu.

Most of theinstructionsin a SHEL X filewill beignored. However, ATOMS may not
know all the current instructions. If it cannot identify an instruction, it tries to read the
line as an atom line (thisisthe way SHEL X works). If thisfails, you are asked if you
want to add the first four letters of the line to the list of instructionsto be ignored. These
instructions-to-be-ignored are at the end of the setup or Preferencesfile, separated by
spaces and preceeded by the number of instructions. Y ou can edit thislist if necessary.

Y ou should scan the atom list (Input Atoms dialog in the Input1 menu) to be sure
nothing has been included by mistake.

3.1.1.2.6 CIF File
Import CIF File [File menu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

ATOMS uses only asmall number of the possible dataitemsin a CIF file and recovers
only the most basic information.

Cell setting. If acell setting (crystal class) isnot present or is undecipherable, ATOMS
will try to recover the crystal class from the unit-cell parameters.

Extensionsto CIF filesand special versions. Some database operators have taken to
producing special versions of CIF files, with extensions which may or may not have been
approved and which may not readable without special knowledge or assumptions.
Despite these extensions and several types of errors with respect to the original
specifications (see below), ATOMS should be able to read most types of CIF file.

mmCIF files. These arefilesfor macromolecules, and despite being designated CIF (and
usually having the .cif filename extension) the atomic coordinates are Cartesian, and data
are given for a complete molecule or molecules, not the asymmetric unit of acrystal.

The Protein Data Bank (see PDB files) usually exports CIF files as mmCIF (molecular,
Cartesian).

Importing MmCIF filesas Crystals. ATOMS can use the information in the

_atoms _sites.fract_transf_matrix (Cartesian to crystal transformation matrix) linesto
recover the fractional coordinates and space-group symmetry for the original crystal. In
some cases thisinformation is not present - if it is present it will be used if you have
selected the Crystal boundary option in the Import File dialog. Note that the
transformation matrix given in the file (normally derived originally from a PDFfile) is

© 2011 Shape Software



34 ATOMS Help

sometimes not sufficiently precise (because of limitation to 6 places after the decimal
point) to recover the original unit-cell parameters precisely. The cell parameters used in
ATOMS are those derived from the transformation matrix. After importing, you should
check the cell parametersin the Title/Axes dialog and correct the crystal system -
because of this problem the cell parameters are aways imported astriclinic. If thistype
of fileisimported as a molecule, the PDB information on hetatoms, etc. is retained, and
the PDB quick bonds option (Bonds dialog in the Inputl Menu) can be used to locate
bonds, which cuts down drastically on the time required. It can also take a great deal of
time to isolate molecules with the Moleculesin Crystal boundary option, if you choose
to switch to that after importing - if you need the molecule(s) rather than crystal unit
cells, it is better to import as a molecule.

The Cambridge Crystallographic Data Centre generates CIF files (not mmCIF files)
which may contain all the atoms in an asymmetric unit, plus other atoms related by
symmetry to complete all moleculesin the structure. The choice of Boundary Option

in the Import File dialog determines how the structure is handled, asin the CCDC import
option. If Moleculesin Crystal is chosen, all the given atoms are accepted and no
symmetry isapplied. For thisoption, the crystal axes are used, not Cartesian axes. For
the Default Unit Cell option, the list of valid atomsis cut off when an atom label is
encountered with a non-numeric last character. If thisresultsin an incorrect atom list,
choose Moleculesin Crystal, delete any unwanted atoms and reset the Symmetry and
Boundary options.

If possible, CCDC and PDB files should be downloaded and imported in the "native"
formats, rather than as CIF - in these file types, information can only be lost in the
process of trandation to CIF. In other cases where there may be a choice of formats,
such as ICSD, a CIF file may be more successfully imported than the native version.

Errorsin CIF files. Many CIF files which are written by databases and other software
violate one or more of the CIF syntax rules (Acta Cryst. 1991, A47, 655) and may in
some cases be unreadable without modification. Some common errors:

1) Linelength greater than 80 characters.

2) Failureto enclose character fields in single quotes

3) Fields ("datanames") too long - for example "data " field longer than 32 characters.
The"data " line should be truncated to 36 characters.

Many of thelinesin atypical file are not used by ATOMS and may simply be deleted if
thefileisnot read correctly.
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3.1.1.2.7 DBWS/LHPM Rietveld File
Import DBWS/ILHPM Rietveld file [File menu]

See the Import File dialog for general aspects of importing atomic-structure datafiles.
The DBWS or LHPM formats are very similar.

In the Atom type number s from: box, the Type label option will select the NTYP field
which usually contains the elemental symbol for recovery of the scattering factor.

ATOMS can read three revisions of the DBWS format - 1990, 1994, and 1998 - but
there is no version number or other direct indication of therevision in the fileitself, so
sometrial and error may beinvolved. 1990 fileswill probably fail on the first attempt at
reading, and you are then given achanceto try again.

3.1.1.2.8 ICSD File
Import ICSD File[ File menu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.
Fivetypes of ICSD file are supported, classified according to source:

1) Filesfrom the CD-ROM database, accessed by the program RETRIEVE (see below
for the CD-ROM program FINDIT). The RETRIEVE files must be written from the
DATA window using the PRINT option, not as export files (if there is sufficient
demand, export files may be supported). That is, the file should be a copy of what i<
shown on the screen in the RETRIEVE program.

2) Filesfrom the CD-ROM database, accessed by the newer program FINDIT (see
above for the CD-ROM program RETRIEVE). Asfor RETRIEVE, the exported file
must be a copy of what isin the resultswindow. FINDIT can also write CIF files.

3) Filesfrom the Canadian Scientific Numeric Database System (CAN/SND ). This
service may no longer be available. Thefiles are referred to as CRY STIN, but are
different from original 4) CRY STIN files.

4) Original CRY STIN files, available from the Netherlands CAOS information system,
from ETH (Switzerland) and perhaps other sources.

5) Filesfrom the the ICSD World Wide Web site (barns.ill.fr/dif/icsd/). The"raw"
(ICSD) data format for this source is unreliable and is not shown in the menus. The data
should be exported in one of the formats which is supported by ATOMS. Unfortunately
again, these exported files may beincorrect - certainly the exported CIF files often
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violate many of the CIF rules and may be unreadable without modification (see
CIFfiles).

In CAN/SND files, ATOMS will usethe"NA:" linefor thetitle; in RETRIEVE and
original CRY STIN files, ATOMS will usethefirst "MINR" line if present, otherwise it
will usethe "NAME" line.

ATOMS actually distinguishes among the four different readable file types by reading
part of the main title or "Collection” line, which gives the ICSD index number:

1) RETRIEVE - " COL Collection Code" or " COL 1CSD Caollection Code"
2) FINDIT - "*datafor 1CSD #'

3) CANSND - "ID: "

4) ORIGINAL - " **x% COLLECTION CODE COL="

5) WWW - " COL ICSD Collection Code " with "DATE=" in the same line

In each case the index number follows the above excerpt. Notethat in al file types
except CANSND and FINDIT thereis aways ablank character in the first column.

The different ICSD entries in the various import options exist only to allow different file
extensions for the Open File dialog - when ATOMS opens and tries to read any ICSD
fileit will determine the file type itself according to the "Collection” line.

Please contact Shape Software if you have ICSD files which cannot be read by one of
these options. The best procedureisto send samples of the files by email or on afloppy
diskette.

3.1.1.2.9 ORTEP File
Import ORTEP File [File menu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

Thisimports the unit-cell parameters, symmetry, atomic positions and thermal data from
original or ORTEP 1 files. It does not read the boundary and plotting instructions - one
of thetwo ATOMS boundary options Default Unit Cell or Locate Moleculesin Crystal
is used.

Most of the ORTEP €llipsoid and bond plotting parameters are read from thefile, and
can be accessed in the Ellipsoid Parameters dialog in the [nput2 Menu. See Ellipsoid
Model mode for more details on display modes, etc.
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3.1.1.2.10 XTLVIEW File
Import XTLVIEW File [Eile menu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

ATOMS may need to shift the fractional coordinates to insure that the origin is placed on
acenter of inversion.

3.1.1.2.11 PDB File
Import Protein Data Bank (PDB) Files

See the Import File dialog for general aspects of importing atomic-structure datafiles.

These files can be imported and displayed in all the methods availablein ATOMS, i.e. as
ball-and-stick, interpenetrating (space-filling) and even polyhedra. ATOMS supports
one protein-specific Model mode, the Protein mode, which displays the bonds between
the backbone atoms of the amino acids as skeletal cylinders, omitting other atomsin the
amino acids (although individual amino acids or residues can be selected for complete
plotting in the Protein Display Attributes dialog in the Input2 menu).

Other specialized programs such as RASMOL can display protein structures faster and
with more protein-specific options. However, ATOMS may have an advantage over
some of these programs in the quality and flexibility of the printed output, for example in
using the full resolution of the printer, either directly or as EPS files, Metafiles or PICT
files.

Importing PDB files as Crystals. ATOMS can use the information in the SCALEN lines
(Cartesian to crystal transformation matrix) and the CRY ST1 line to recover the
fractional coordinates and space-group symmetry for the original crystal. 1n some cases
thisinformation is not present - if it is present you will be asked if you want to input the
data as acrystal instead of amolecule. Note that the transformation matrix givenin the
SCALER linesis sometimes not sufficiently precise (because of limitation to 6 places
after the decimal point) to recover the original unit-cell parameters (as given in the
CRYST1line) precisely. The cell parameters used in ATOMS are those derived from
the transformation matrix, not from the CRY ST1 line. After importing, you should
check the cell parametersin the Title/Axes dialog and correct the crystal system -
because of this problem the cell parameters are always imported as triclinic.

MODEL statements, greater than 99,999 atoms and temperature factors are not
supported.

In order to isolate the protein itself, thereis an option in the Protein Display Attributes
dialog in the Input2 menu which alows omission of al hetatoms, or just water hetatoms.
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This dialog also sets the parameters for the Protein Model Mode.

ATOMS is able to use the information on residues which is present in the file, aswell as
CONECT records, to greatly decrease the time required to locate bonds, compared to
standard ATOMS methods for crystals. However, if some bonds are missing from the
drawing it may be necessary to uncheck the PDB quick bonds box in the Bonds dialog
(Input1 menu), and generate a complete set of standard ATOMS bonds.

Connectivity tables. The PDB connectivity or bonding tables, as derived from the
CONECT recordsin the file, are somewhat problematic as there may be conflict with the
bond-locating algorithmsin ATOMS, and consequent duplication. Currently, on
importing a PBD file ATOMS will query if you want to ignore the connectivity tables -
unless there is a special reason for keeping the table(s), it isusually best to do so. If you
choose to keep the table(s), or in old ATOMS files which aways kept the table(s), the
properties of bondsin the connectivity table(s) are given as the first item(s) in the Bonds
dialog in the Inputl menu. Deleting one of these items del etes the connectivity table.

Doing the Generated to Input conversion (Transform menu), or adding hydrogens
(Atoms dialog in the Inputl menu) will automatically delete any connectivity tables.

3.1.1.2.12 GSAS (.EXP) File
Import GSAS ((EXP) File [ Filemenu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

The General Structure Analysis System can give magnetic moment vectors, and the
results for magnetic structures can be given in terms of Shubnikov black/white
symmetry. Unfortunately the information on magnetic reversals by symmetry is not
givenin an intelligible form in the.EXPfile, and if the magnetic space group differs from
the conventional space group it will be necessary to determine the Shubnikov space
group and enter it in the Space Group Symmetry option.

3.1.1.2.13 American Mineralogist File
Import American Mineralogist Structure Database File [FEile meny]

See the Import File dialog for general aspects of importing atomic-structure datafiles.
The American Mineralogist structure database is currently available on the Internet at

www.geo.arizona.edu/xtal-cgi.test. This may change, but the database should be
locatable by searching for American Mineralogist.
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3.1.1.2.14 FULLPROF File
Import FULLPROF file [ Eile menu (Startup) or File menu (Graphics)]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

The "User-supplied”" non-magnetic and magnetic options (JBT = +4 or +5) are not
directly supported - crystallographic and magnetic parametersin files using these options
will beread asif one of the standard options were used. Magnetic information is always
read as vectors in the crystallographic axes (not as polar or other coordinates), and

FUL LPROF-specific magnetic symmetry is not currently used. It may be necessary to
select the Shubnikov symmetry, if the magnetic symmetry is different from the
conventional symmetry. Non-commensurate magnetic models are not currently
supported (they may be supported if there isinterest).

3.1.1.2.15 VIBRATZ Files

Import.MOT or .VBR (VIBRATZ) Files [ File menu (Startup) or File menu
(Graphics)]

Both the.VBR main datafiles and the MOT vibrational displacement files from
VIBRATZ can beimported. The.VBR files simply contain standard crystallographic
information. The remainder of this topic pertainsto the .MOT files. See thetopic
Coordinating ATOMS and VIBRATZ in the Reference section for more information.

When importing either type of VIBRATZ file, ATOM S will read the type numbers modulo 100
- that is, atom types number 6, 106, 206 etc. will all be converted to 6 (carbon).

TheMOT vibrational displacement files are written by the VIBRAT program (Dowty,
Phys Chem Minerals, 1987, 14:67) or the Windows version VIBRATZ (available from
Shape Software). ATOMS converts the infomation in the MOT file into a standard.STR
ATOMS datafile, and also a special.MDT file which contains the atomic displacements
and other information for each vibrational mode. When the. MOT file isimported, the
first vibrational mode in thelist is selected and displayed (after calculation). When you
re-read the.STR file, it will contain the information for the vibrational mode in the list
which was selected when the file was saved. To see other modes, you must select the
Vibrational Modes option in the Inputl menu. Y ou must recalculate after changing the
mode, since new pseudo-atoms and bonds representing vectors need to be generated.

To see on the screen or output which vibrational mode is being displayed, select the
Print title on plot option in the Title/Axes dialog in the I nput1 menu.

The atoms will be given the default colors specified inthe ELEMENTS file, as for other
types of import file. However, you have the choice of using radii inthe ELEMENTS file
(or some fraction thereof - see the Preferences dialog in the Settings menu), or of using
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constant radii.

Bonds. When importing a.MOT file, bond specifications are taken directly from the VIBRATZ
data. If thereisastructurein memory, and if there are bonds (Bonds dialog in the Inputl menu),
the radius and colors of al the new bonds are taken from the first old bond - if there are no
bonds, radius and colors of the bonds derived from the .MOT file will be standard (radius 0.0,
black rim, whitefill), or from the values of the first bond the last time defaults were saved (Save
Defaults in Settings menu).

Crystal import mode. VIBRATZ.MOT datafor acrystal can be displayed in either of
two ways, showing the atomsin the primitive unit cell asamolecule; or using the normal
ATOMS boundary optionsfor crystals. If the choiceisa"molecule’, there will usualy
be both primary and secondary atoms (next paragraph). Lattice trandlation will be
disabled. If the choiceisto show asacrystal, there will be no secondary atoms, and
every trandationally equivalent atom will be the same - they will al have the same
motion vector. The boundary option will be Unit Cell, current default, but this can later
be changed. The atom list (Atoms in the Inputl menu) will include all atomsin the
Bravais (not primitive) unit cell. With either option, there will be no non-transational
symmetry, that isal atomsin the unit cell will bein the atom list.

Secondary atoms (applicable only to crystalsimported in molecule mode). VIBRAT
uses two types of atomsfor crystals or infinite polymers: primary atoms, which are just
those in the primitive unit cell; and secondary atoms, which are those required to
complete the bonds and angles of the complete set of internal coordinates (force
constants). Often there are more secondary than primary atoms. If you choose to show
the structure as amolecule (last paragraph), you have the option to show the secondary
atomsin just the same way as the primary atoms; to mark the secondary atoms with a
triangle; or to omit the secondary atoms altogether. 1f you omit the secondary atoms, the
bonds to them will also be omitted. Molecules do not require secondary atoms.

The Vector button calls up the Atomic Vectors dialog (I nput1 menu), for specification
of the details of the vectors which represent the atomic displacements, including the
scale factor.

3.1.1.2.16 Ravel ATOMS File
Import Ravel ATOMS [File menu]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

This program is not the same as ATOMS by Shape Software, but isfor EXAFS
Analysis.
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3.1.1.2.17 Wien2k File
Import Wien2K File [FEile menu]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

The program package WIEN2k performs electronic structure cal culations of solids using
density functional theory (DFT).

ATOMS will read the .struct input files, but will only recognize file extensions with
three characters, so it may be necessary to rename the files, search manually inthe File
Open diaog (enter *.struct) or usethe "al files' option.

Some files may have the space-group number and symbol, but the orientation may be
ambiguous and Use positions as xyz should normally be selected in the Import File
diaog.

3.1.1.2.18 IZA File
Import | ZA (International Zeolite Association) File [File meny]

See the Import File dialog for general aspects of importing atomic-structure datafiles.

The IZA has an extensive database of natural and synthetic zeolites available on the
WWWeb, but does not seem to have an option for export of the data - it will be
necessary to cut-and-paste the information into atext file.

Go to the Web page for the Database:

http://www.iza-structure.org/databases/

and select "Collection of Simulated XRD Powder Patternsfor Zeolites". Thisshould
show amatrix of structure types by three-letter code - select one of these. Y ou can also
access structures in other ways, but you need to end up on a page showing options for X-
ray powder diffraction together with the structure data. There should be linesfor
"Material name" ..."Composition:" ... "Crystal Data:" and others, with the fractional
coordinates for the atomsin atable.

Mark the top right part of the page with your mouse, starting with the three-letter code
centered at the top, and going below the atomic-coordinates table. Do not include the
"Reset" and "Submit" buttons and material below thisline. Do not include the column
of options on the left of the page. Copy the marked information into the clipboard in the
standard way.

Now, in aword processor, open a new text (ascii) file. Paste the clipboard contents into
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thefile. Savethefile, givingita".iza" extension if possible. Hereisasample (or look
inthe ZEOLITES subfolder for sample .izafiles):

LAU

Material name: Launontite

Conposition: | Ca4(H20) 18| [Si 16A 8I48]

Refined conposition: |Ca4(H20) 18| [Si 16A 80(48]
Crystal data: Space group: Cl2/nl (# 12)
a= 14.8538 A b = 13.1695 A ¢ = 7.5421 A
al pha = 90° beta 110.323° gamma = 90°

X-ray Rietveld refinenment, Rwp=0.115, Rp=0.090, RF2=0.046
Coment: unique axis b, cell choice 1
Reference: Artioli, G and Stahl, K
Zeolites, 17, 249-255, (1993)

At omi ¢ coordi nates Atom na
CA Ca 0.2601 0.5 0.737 1.0
SI1 Si 0.2368 0.3838 0.156

nme Formfactor x y z PP B(iso)
3
1
SI2 Si 0.0763 0.3834 0.325 1
1
.7
.0
.0

ocoooh~T

.8
.1
.6

P Wwo

AL1 Al 0.1315 0.3080 0.737
260 0.5 0.219 1.0 0
2084 0.3744 0.919 1.0 1.
1384 0.3838 0.552 1.0 O.
146 0.3454 0.203 1.0 2.9
3205 0.3185 0.248 1.0 O.
043 0.5 0.267 1.0 0.71
013 0.3083 0.743 1.0
-(H20 0.029 0.171 0
0
5

1
2
2
9
66
55
2
7

9

3
. 45
.92

-(H20 0.401 0.5 0.02

H20) 0.5 0.467 0. 6

2
.0
6
-( 0
-(H20O 0.1426 0.129 0.332 1.0 4.03

.5
.0
3.

SEoBA8RRBER

888Roco000000
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3.1.1.2.19 GAUSSIAN File
Import GAUSSIAN File [File menu]

Thiswill import the atomic coordinates and other structural information from alog file,
aswell asthe vibrational frequencies and atomic motionsif they have been calculated.
The section headed " Standard orientation” is required, and for atomic motionsin the
vibrational modes the section headed by several lines starting with "Harmonic
frequencies’ and ending with "and normal coordinates:" is required.

3.1.1.2.20 ADF File
Import ADF File [File menu]

Amsterdam Density Functional softwarefile.

Thiswill import the atomic coordinates and other structural information from a.adf file,
aswell asthe vibrational frequencies and atomic motionsif they have been calculated.
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3.1.1.3 Page Setup
Dialog Box - called from: File Menu

This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins (except Macintosh). Marginswill only be used in
Text Windows.

---Macintosh only ------

Use the Page Marqgins dialog to set margins.

3.1.2 Settings Menu (Startup Window)
Preferences - Sets parameters for modes of operation.

PostScript Settings - Hardware settings for direct PostScript output.

Pen Plotter Settings - Hardware settings for the pen plotter.

Paette - Modify, save or read the RGB values for the main 16-color palette.

Read Defaults - Thisreads structure display parameters, mostly those in the I nput2
menu, from a setup file. These will replace those currently in memory.

Save Defaults - This saves structure display parameters, mostly those in the I nput2
menu, for use when inputting a new structure with the New command in the File menu,
or when a standard set of parametersis desired.

Starting with ATOMS V6.3, the Read and Save Defaults options read/write a user-
specific filein a platform-standard location, rather than the DEFAULTSHile.

Read/Save archive SCRPTR and DEFAULTS - this reads/saves the defaults display
parameters, as well as the more general parameters, from/to the DEFAULTS and
SCRPTR filesin the folder or directory containing the ATOMS program or executable
file. See Settings, Preferences or Configuration Files.

3.1.2.1 Preferences, Operation Tab
Dialog Box Tab - called from: Settings Menu

See also Preferences - Constants Tab.

Sounds. Thisturnson or off the sounds emitted by ATOMS, for example at the
beginning and end of calculation and/or plotting (some system sounds are unaffected).
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Draw into buffer. If thisbox is checked, the image is drawn into an off-screen memory
buffer, and then copied to the screen. If not, the drawing is made directly to the screen,
and then copied afterwardsinto the buffer. Drawing into abuffer is usually faster, but
the difference may be small. No memory is saved by not checking the box, since the
buffer is always used anyway for refreshing the window after another window is draw
over it.

Confirmatory alertsin New input. If thisbox is checked, during input of a New
structure file (File menu), after every input dialog thereis an alert or dialog box
(Entering New Data Set) giving the choice of proceeding to the next dialog, aborting
datainput, or revising the last dialog. Without these dialogs, there is no escape from the
sequence of Inputl dialogs, and no escape from the sequence of I nput2 dialogs.

Calculate query on file open. If thisbox is checked, you are asked if you want to
calculate the structure - if not, the structure is calculated as soon asit isread in.

Scalelettering to screen. |If thisbox is checked, in printed output or output to afile,
the labelsin that output will be scaled to approximately the same relation to the drawing
itself as on the screen. Thisisavery approximate process, and trial-and-error adjustment
will still be necessary to get the desired label sizesin output. This option should be
thought of as adjusting the labels on the screen to look similar to those in the output,
rather than the other way around.

Screen start-up. This sets the color/black-and-white state of the screen at start of
ATOMS. It can be changed with the Color command in the Display menu.

Mark selected atoms. Thisrefersto selecting atomsin the screen plot with the mouse.
If Show last is selected, the last atom selected is outlined in a contrasting color, but this
marking disappears when another atom is selected, or an empty areaisclicked. If Show
all isselected, all markings remain until a Replot.

Skeletal mode during interactive rotation. When rotating using the mouse cursor,
ATOMS can switch to a skeletal mode so as not to slow down the motion. Thisis not
usually necessary when the number of atomsis small asthe redraw is usually fast
enough, so the best choice may be"If more atomsthan”. The number of atoms may be
several hundred or so, but thiswill depend on the speed of your system.

Color for linebonds. When in the skeletal drawing modes (Bond color s option above),
and when bond radii are 0.0 in the Standard drawing mode, the colors for lines
representing bonds may be either the rim or fill colors given in the Bond Data dialog.

Coordinate system for Input=Generated mode. This controls the display of structure
coordinates in the Generated Atom Data dialog. Original crystal will give the
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coordinates of the current point in terms of the original crystal (or other ) structure axes.
Structure Cartesian gives the coordinates in terms of the original Cartesian axes - only
this setting will correlate directly with the coordinates listed in the Input Atoms dialog in
the Inputl menu. This setting also affects the axes used in the Align on Face or Vector
and Current Orientation dialogs in the Rotate menu.

3.1.2.2 PostScript Settings
Dialog Box - called from: Direct Postscript Output Dialog, Settings Menu

The page size, page margins and dots per inch/centimeter should be determined by the
actual printer used for final output; if these are not correct, the drawing may not be
scaled and/or placed on the page correctly.

The Transfer Function is analogous to the PostScript function of the same name. The
linear option is standard; modify the function to get lighter or darker shadingin
PostScript print-out.

Preview Color. If you select a screen preview (TIFF bitmap or PICT sub-file) in the
Direct PostScript Output dialog, and if color output is selected, you can specify either a
color or black-and-white bitmap. The Screen option uses the color depth of the the
current screen display. Black-and-white PostScript output always uses a 1-bit or black-
and-white screen preview.

Background color. If thisoption ison, the color selected in the Background Color
dialog of the Input2 Menu will be applied in color output only. Background in b/w
output is always white.

Atom algorithm. ATOMS shows shading for atoms by computing concentric zones
around the point of emergence of the illumination vector. This can be done in two ways:
1) For non-PostScript display and output, points are calculated on lines radiating outward
from the point of emergence. This means that the curves defining atoms and atom shade
zones are defined by alarge number of short line segments - thisis called the "lengthy"
algorithm. 2) The default algorithm for Postscript, called the "compact” algorithm,
simply sends the parameters for the circle and ellipse segments which make up these
curves (this cannot be done for normal drawing because the system drawing routines do
not deal with general ellipses). The lengthy algorithm typically requires twice the disk
space as the compact algorithm for shaded atoms. The compact algorithm is also more
preciseinitsdrawing of curves, and it alowsall illumination vectors (for the lengthy
algorithm, the point of emergence of the illumination vector must be within the atom
outline, which may be truncated by interpenetrating atoms or large stick bonds). The
only case in which the lengthy algorithm might be necessary is when three or more atoms
interpenetrate, so that the segments removed from the outline of an atom overlap. This
condition in principle could also arise if two stick bonds to an atom overlap.
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---- Windows only ----

If you are using direct output to a printer you must select the Port; thiswill be either
"LPTn" or "COMN". Also, if you are using a serial port for the printer, you must set or
verify the data transmission parameters, such as baud, parity, etc., even if the port
currently shown isthe correct one. Thisisdonein the Ports item of the Windows
Control Panel (notin ATOMYS).

3.1.2.3 Preferences, Constants Tab
Dialog Box Tab - called from: Settings Menu

See also Preferences - Operation Tab.

Increment for drawing circles (degrees). Arcsof circles are drawn with line segments
at specified angular increments (full circles are drawn with system routines). Ellipses are
also drawn with proportionate line segments, although the increments are variable. The
default circleincrement of 12.0 degrees has been found to give satisfactory results for
laser and pen-plotting, provided atoms are not too large. Making the increment smaller
may improve the appearance, at a penalty in plotting time, especially if your computer
has no math coprocessor or you are using lines of finite width.

On-screen rotation increment (degrees). Thisisthe amount by which theimageis
rotated in the Dialog Bar - Left. Thisisthe value which exists when ATOMS is started;
this value and not the latest value in the dialog bar itself is saved on quitting ATOMS.

On-screen displacement increment (Angstroms). Thisis the default amount by which
astructure fragment is trandlated in the Dialog Bar - Fragments (Display menu). Thisis
the value which isin the dialog when it isfirst called; this value and not the latest value
inthe dialog itself is saved on quitting ATOMS.

On-screen rescaling factor (%). Thisisthe default amount by which the drawing is
rescaled with the Scale button in the Dialog Bar - Right (Display menu). Thisisthe
value which isin the dialog when it isfirst called; this value and not the latest valuein
the dialog itself is saved on quitting ATOMS.

Default radiusfor atom location (Angstroms). When identifying atoms with the
cursor, the given atomic radius is used for deciding when the mouse is clicked "on" an
atom. However, if theinput radiusis zero or negative (denoting either polyhedral atoms
or wire-frame atoms), this default radius is used instead.

Factor for scalingto screen or frame. In either the Maximize or Universal scaling
modes (Scaling dialog, Input2 menu), theimage is scaled to ailmost fill the screen or

frame. Thisfactor specifies how close the image comesto the edges. Thisscalingis
not precise when Perspective projection is used, so arelatively smaller factor may be
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necessary if the perspective distance is small.

Dash length and dash ratio. The dashes are used for back edges of crystals

(Crystal Edges and Faces) and in display of Crystal Axes and Unit Cell. Length or
repeat distance isin inches/centimeters, and the length factor is the actual length of the
solid part divided by the repeat distance. Note that when using Frames in output the
dash length remains the same - it may be desirable to decrease the length for very small
plots.

Atomicradii. Oneor the other of the two files, ELEMENTS.ION,ionic radii, or
ELEMENTS.COV, covalent radii, is used during input of Import files and input of
atomic parameters through the Input Atoms dialog (see ELEMENTSfiles). The Factor
multiplies the full radius values during thisinput. Values of around 0.5 are appropriate
for ball-and-stick display, while values well over 1.0 may be required for
interpenetration (space-filling).

Scaling units. This sets either inches or centimeters as the unitsfor overal usein
ATOMS. Thischoice may belocally overridden for printing or other output by the
Units setting in some of the dialogs involved.

3.1.2.4 PostScript Transfer Function
Dialog Box - called from: Postscript Settings dialog

The Transfer Function is analogous to the PostScript function of the same name. It
changes the nominal gray values (0.0-1.0 for black-white) calculated by ATOMS astrue
illumination to values actually output. (Note that the PostScript gray scale, 0.0-1.0 for
black to white, isin the opposite direction to the ATOMS gray scale, 0-15 for white-
black; the transfer function applies to the Postscript gray scale.) If your printer gives gray
shadingsthat are too dark (thisis common, especialy for lighter shades), you can
increase the output values. Values in between the listed values are linearly interpol ated.
The actual gray values output to the printer or EPS file are changed; the transfer function
itself is not part of the EPS file. Note that the gray-scale conversion also appliesto lines
of greater than single-dot width (single-dot lines are aways black).

3.1.2.5 Pen Plotter Settings
Dialog Box - called from: Pen Plot dialog, Settings Menu

Current plotter radio buttons. There are several pre-programmed plotters; clicking on
the Get Data button reads the pen-plotter datafile (PPLOT) and obtains the commands
and parameters. Even if your plotter is not listed here, you may be able to input the
commands through the Other option. In this case, click on the Commands button to set
or revise the commands and parameters.
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Pen-change mode radio buttons. If you have a multiple-pen plotter, you can elect to run
in the Use single pen mode with the pen number entered in the edit field, and conversely
if you have a single-pen plotter you can draw with multiple colors, but you will haveto
change the pens manually. If you choose the Change pens manually mode, the plotter
returns to the zero position after drawing all lines of each color, and a message box
appears, prompting you to change pens.

Blank border. A blank border can be added to atoms, bonds and polyhedrain the pen
plot in order to increase the illusion of depth. Lines which are part of atoms, etc.,
"behind" the atom in question are cut off when they get within the specified distance of
the atom, etc. which isin "front". This option may add considerably to the plotting time,
since it involves much recalculation. If the width of the border is set to 0.0, thereisno
recal culation.

Speed number. Thisisthe parameter (see Commands ) which controls velocity of the
pen - for example for the Comrex, speed number 1 isslowest and 15 is fastest. Although
some plotters, like the HP7475A, allow decimal speeds, you must use an integer here.

---- Windows only ----

Port. This should be either a serial or parallel port: "COMN" or "LPTn". Even if this box
shows the correct port, if it isaserial port you should verify the baud, parity, stop bits
and data bitsin the Ports item in the Windows Contr ol Panel. These parameters should
be set to match the settings on your pen plotter (which are usually controlled by DIP
switches).

3.1.2.6 Pen-Plotter Commands and Parameters
Dialog Box - called from: Pen Plotter Settings dialog

This allows you to enter or revise the pen-plotter commands and parameters, for non-
standard pen-plotter types.

It is assumed that the plotter accepts ASCII commands that follow a simple syntax of
"command, parameters, terminator”. For example, the Hewlett-Packard command for
moving the pen, raised, to the coordinates x,y is "PUX,y;". "PU" is the command, which
should be entered (without parentheses) in the text box M ove - pen up: x and y are the
parameters, which are always supplied internally by ATOMS; and the semicolon isthe
terminator required in the Terminator text box. Commas between parameters are also
supplied by ATOMS. Move - pen up means move to the new coordinates with the pen
up (not marking).

Y ou must enter or edit the commands in the text boxes on the | eft of the dialog. If more
than one command is required to perform the operation requested, give all the commands
with any intermediate parameters and terminators required, but omit the last terminator.
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If your plotter does not use acommand, just leave that field blank.

Following are comments on the plotter inputs. The type of variable required, and the
maximum number of charactersin case of acharacter variable, are given in parentheses.
View samples by clicking on the selectionsin the Current Plotter group in the

Pen Plotter Settings dialog.

Commands

Move - pen up. (6 chrs) Move to the new coordinates with the pen up.

Move - pen down. (6 chrs) Move to the new coordinates with the pen down.
Raise pen. (6 chrs) Raise the pen without movement.

Pen speed. (6 chrs) Thisisthe command which causes pen speed to be set or changed;
the parameter is entered as a separate item in the Pen Plotter dialog menu.

Change pen. (6 chrs) Thisisrequired only for multi-pen plotters.
Start plot. (12 chrs) Initialize the plotter. May require no commands, or several.
End plot. (12 chrs) Terminate plotting. Like (12).

Terminator. (2 chrs) The character which signals the end of a command. In most cases
the semicolon.

Parameter s

Maximum x/y. (Decimal) Maximum x and y coordinates. These values establish the
centering of the plot. Increments on the x and y axes are assumed to be equal.

xly at finish. (Decimal) The "base" coordinates, in plotter units, to which the paper or
pen will be returned at the end of the plot, or when pens are to be changed manually.

Units/inch(or centimeter). (Decimal) This establishes the resolution of the plotter and is
used in scaling. If your plotter instructions do not give this number, divide the maximum
x or y coordinate (item 1 above) by itslength in inches.

3.1.2.7 Palette
Dialog Box - called from: Settings Menu

The Palette is used to set up a 256-color palette for 8-bit screen display or raster output,
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and also to set the primary choices for color in all cases (you can always select other
colorsusing different RGB values). See Colors, Palettes and Dot Patterns for more
detail. The default Main palette has the same RGB values as the "alternate” pal ette used
in DOS versions of ATOMS, but rearranged to a more logical order.

Y ou can read and write valuesto palette (.PAL) files. Two palettes are provided on file:
STANDARD.PAL and ALTERNATE.PAL, which are respectively the standard IBM
palette and the default alternate palette used in DOS versions of ATOMS. Itiseasy to
write or modify the.PAL filesdirectly; they simply contain the RGB values, from O to
255, separated by spaces (or commas).

The Default button will reset the palette to the current default values.

3.1.2.8 Read/Save Defaults
Read and Save Defaults Commands [ Settings Menu]

When inputting data for adrawing with the New command in the File menu (Startup) or
File menu (Graphics), you can elect to use default values for display parameters, rather
than set these in the dialogs of the Input2menu . If no data set isin memory, the default
display parameters are always read from disk; and if thereis a data set in memory, you
can use the current values or read the defaults from disk.

Also, when importing afile (File menu (Startup) or File menu (Graphics)), you have the
choice of reading in the saved parameters or using the current ones.

Also, if you desire to convert the current parameters, which may have been read in from
a.STR datafile, to the standard set, you can use the Read Defaults command at any
time.

The Save Defaults option saves the current display parameters, i.e. most valuesin the
dialogs of the Input2 Menu and some in the Display Menu.

Starting with ATOMS V6.3, these values are saved in a user-specific filein a platform-
standard location, rather than the DEFAULTSfilein the ATOMS folder or directory.
See Settings, Preferences or Configuration Files.

3.1.2.9 Read/Save archive SCRPTR and DEFAULTS

These commands will read or save the current general settings and data-set settings
from/to the SCRPTR and DEFAULTS "archive" fileswhich are in the same folder or
directory asthe ATOMS executable or program file. The preceding items (Read/Save
Defaults) read/write these values to a user-specific file in a platform-standard location.
See Settings, Preferences or Configuration Files.
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3.2 Graphics Window Menu Bar

Filemenu - Inaddition to the usual New, Open, Print etc., this menu has commands
for listing input and generated data, and for for PostScript, pen plotter, raster or bit-map
and Metafile or PICT output.

Modesmenu - Thisallows setting the Display mode, and the Cursor mode.

Inputl menu - This contains dialogs involving mostly the basic data for the structure,
such as axes (unit cell), atom coordinates, etc.

Input2 menu - This contains dialogs setting display parameters specific to each
structure.

Display menu - Thiscontains commands and dialogs which set the overall display
attributes of ATOMS, and modeless dialogs for rapid rotation and displacement of the
structure.

Rotation menu - This contains several options for rotating and aligning the structure.

Transform menu - This contains specialized options for converting generated to input
atoms, locating groups and dealing with multiple structure fragments.

Settings menu - This contains settings for hardware, palettes and preferences for modes
of operation.

Window menu - This contains commands relating to the display or activation of the
different kinds of windows - the main Graphics window, diffraction Graphics windows
and Text windows.

Help menu - On-line help.

3.2.1 File Menu (Graphics Window)
New - Step-by-step input of anew ATOMS data set.

Open - Openanold ATOMS datafile.

Close - Close the current graphics window. Startup Menu Bar

Save - Savean ATOMS datafile.

Saveas - Savean ATOMS datafile with a new name
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Open Recent File Select from most-recently-used files.

Import File - Shows a pop-up menu with the file types currently supported. This
includes:

---- CCDC EDAT filesfrom the Cambridge Crystallographic Data Centre.

---- SHELX.INS filesfrom the program system of Prof. G. Sheldrick.

---- CIE - Crystallographic Information Files.

---- DBWS/LHPM Rietveld input files.

---- ICSD Inorganic Crystal Structure Database files.

---- ORTEP Oiriginal or ORTEP Il atom information.

---- XTLVIEW Drawing program.

---- VIBRAT (.MOT) Graphic output filesfrom VIBRATZ.

---- PDB Protein Data Bank files.

---- RIETAN Rietveld program files.

---- GSAS Datafiles (.EXP) filesfrom the Los Alamos Lab system - may include
magnetic vectors.

---- AM MINERAL. Datafilesfrom the American Mineralogist structure data base.
---- EULLPROE. All-purpose refinement program - may include magnetic vectors.
---- Free-form (.inp). Thisallowsinput of atomic coordinates etc. from almost any
source.

---- Ravel ATOMS. This program is not the same as ATOMS by Shape Software, but is
for EXAFS Analysis.

---- WIENZ2K. This package performs electronic structure calculations of solids using
density functional theory (DFT).

Export File - Thiswill write afilein one of several molecular formats, containing
labels and Cartesian coordinates of the generated (not input) atoms. Some files may
also have bond tables and other information

Calculate - Reproduce atoms within specified boundaries and locate bonds and
polyhedra.

Print - Print out the graphicsimage; see List... commands below for listing data and
calculation results, and Calculation Output in the Input2 menu for listing results of the
calculation.

Page Setup - Set the page size and select the printer.

Listings group - the following four commands are in a secondary pop-up menu

List Input - List all input data parametersto the file INPUT.ATD and to a Text window.
List Generated Atoms - List all generated atomsto the file GENATOMS.ATD and to
a Text window.

List Faces - List all generated facesto the file FACES.ATD and to a Text window.
List Totals - List varioustotals, such as generated atoms, bonds, etc., to the file
TOTALSATD and to a Text window.

Output group

PostScript - Direct output to a PostScript printer (Windows/Linux only) or to an EPS
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file.

Pen Plot - Output to a pen plotter or HPGL file.

Raster Files - Writesraster or bit-map filesin.BMP,.PCX,.TIF or.PNG (Windows)
or.PNG (Macintosh) format.

Metafiles (Windows) or PICT (Macintosh ) - Writes metafiles or PICTsto the
clipboard or disk files.

Save Graphics Window - Dumps the exacts contents of the Graphics window to the
clipboard or afile (BMP format for Windows or PICT for Mac).

VRML Files - Writes output in the Virtual Reality Modeling Language 3D format.
POV -Ray Files - Writes output for the ray-tracing program POV -Ray.

Exit - Quit ATOMS.

3.2.1.1 New command

The New command in the File Menu of the Graphics Window is identical to the New command in
the File menu of the Startup Menu.

3.2.1.2 Open command (Graphics)
Open command ( File menu (Startup) or Eile menu (Graphics))

If there is adata set in memory which has been modified, you are asked if you want to
save the changes - see the Close command.

Use this command to open an existing ATOMS datafile. After thefile hasbeenreadin,
you are asked if you want to calculate immediately (this query can be eliminated with a
checkbox in the Preferences dialog, Settings menu). If you reply OK, the structure will
be plotted in the Graphics window. If you decline to calculate immediately, you can
modify the structure or display parameters. When finished, use the Calculaie command
in the File menu.

Y ou can create anew ATOMS data set with the New command, or import various kinds
of filesfrom

other software with the Import command.

3.2.1.3 Save command (Graphics)
Save command ( File menu, Graphics window)

When called from the Graphics window, this saves the active data set to its current name
and directory. If you have changed the orientation from that specified in the

Initial Orientation dialog in the Input2 menu, you are asked if you want to save the
current orientation. 1f you choose to do this, the current orientation will be converted to
initial orientations on the observer x, y and z axes

When you save a data set for the first time, ATOMS displays the Save As dialog box so
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you can name your data set. If you want to change the name and directory of an existing
data set before you save it, choose the Save As command.

3.2.1.4 Save As command (Graphics)
Save As command ( File menu, Graphics window)

When called from the Graphics window, this saves the active data set. ATOMS displays
the Save As dialog box so you can nhame your data Set.

If you have changed the orientation from that specified in the Initial Orientation dialog
in the File2 menu, you are asked if you want to save the current orientation. If you
choose to do this, the current orientation will be converted to initia orientations on the
observer X, y and z axes

To save adata set with its existing name and directory, use the Save command.

3.2.1.5 Close Command (Graphics)
Close Command [ File menu (Startup) or File menu (Graphics)]

When exiting ATOMS, closing the graphics window, reading another file or starting a
new file, ATOM S triesto determine if you have made any changesin the structure
currently in memory; if so, you are asked if you want to save thefile.

First, it checks whether the orientation has changed from the [nitial Orientation
established during calculation. If so, you can save the current orientation as initial
rotations. It also checks whether any dialog in the Inputl and I nput2 menus have been
opened, or whether there has been any change in the status of atoms marked for non-
plotting (see Deleting Atoms ).

3.2.1.6 Import Files Submenu

The Import Files submenu in the File Menu of the Graphics Window isidentical to the
Import Files submenu in the Startup Menu.

3.2.1.7 Export Atom Data File

Dialog Box - called from: File menu

This exports the current generated atom data, with Cartesian coordinates, to a choice of
molecular file formats.

ATOMS does not necessarily write acomplete file for any particular format since it may
not have al the information required - manual editing may be necessary. If an el emental
symbol iswritten it assumes that the type number (modulo 100) is the atomic number.
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Export: Asdrawn/All generated atoms. If you choose As drawn, the atomsin thefile
will be just those shown on the screen, excluding atoms in incomplete polyhedra, atoms
marked for non-plotting, etc. All generated atoms will export all atoms within the
current boundary.

Strip non-alphabetic charactersfrom label. Thiswill end the label string at the first
non-al phabetic character. Some programs are not able to identify the element from
labelslike"C1", "O12", which are common in crystallographic files.

Convert polyhedrato bonds. Thiswill export bonds between the central atom and the
ligands of any polyhedra. Not all export formats have bond specifications.

PDB files. The space-group symbol inthe CRY ST1 record is not necessarily in the
form required by PDB and may need to be edited. The standard crystal-Cartesian
orientation in PDB filesisa=x and c* =z, whereasin ATOMS itisa* =xandc=2z. If
the crystallographic orientation isimportant it may be wise to reorient the crystal in
ATOMS to the standard PDB orientation. This can be donein the Align Face or Vector
option in the Rotation menu. Orient on vector [100], with alignment face (001).

ATOMS does not directly export crystallographic file formats. However, the shareware
program CRY SCON

(Shape Software - www.shapesoftware.com) can convert among several crystallographic
formats, and write files such as CIF from ATOMS data.

3.2.1.8 Calculate Command
Calculate Command [ File menu]

This may need to be used whenever an "intrinsic” or "input”" parameter of the structure,
including most itemsin the Input1 menu, is changed. For parameters which affect
display only, such as atom, polyhedron or bond colors and items in the I nput2 menu, use
the Replot command in the Display menu or the Replot button in the Dialog Bar - L eft.
Changing atomic radii does not require recalculation as long as stick bonds are not
changed to interpenetration or vice-versa.

With Version 6.1, there is a change in orientation behavior on the use of this command.
In previous versions, Cal culate aways completely reoriented the structure, returning to
the Initial orientation. Now, the current orientation isretained. If you wish to return to
the Original or Initial orientation, use the buttonsin the Dialog Bar-Right, or the
command Save-Recover Orientation in the Rotation menu.

3.2.1.9 Print Graphics Image
Dialog Box - called from: File menu
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There are basically two different methods of printing. For 2D Drawing modes, drawing
commands can be sent to the printer and the printer makes up theimage in its own
memory. These commands may be in the native graphics language of the operating
system, which is different for Macintosh and Windows or in PostScript, which is
universal but supported directly only in high-end printers. PostScript is the native
graphics language for Linux.

For 3D Drawing modes, the image is made up in the computer's memory and then sent in
its entirety, byte by byte, to the printer. This bitmap or raster mode is also optional for
2D Drawing modesin ATOMS

PostScript printing is standard in Linux, so for 2D output, including diffraction
diagrams, printing is handled by the Direct PostScript option, not by the dialog below.
However, for 3D output (including Cavity and Protein modes) printing is controlled by
this dialog.

This command isfor normal printer output through the printer driver (see below). If you
have a PostScript printer, you should probably use the PostScript command in the File
menu rather than this one for 2D images; that command sends PostScript language
commands directly to the printer, bypassing the printer driver. The PostScript language
has afew capabilities which are missing from the system routines. Using

Direct PostScript output may give somewhat different, and usually more correct colors,
than using the Print option (although color inaccuracies may possibly be fixed by
changing the settings of the printer driver in the Page Setup command).

In the case of 3D images (that is printing whilein the 3D Display mode), ATOMS does
not send drawing commands to the printer - rather the entire drawing (or sections
thereof) must be imaged in memory, and this raster or bitmap image is sent to the printer.

Three different Print M odes may be used, depending on the settingsin thisdialog and
the ATOMS Drawing mode - 1) Standard or QuickDraw, 2) Direct PostScript or 3)
Bitmap.

Option 1) sends standard QuickDraw graphics commands (the same as those used for the
screen) to a printer driver, which may be supplied by Apple or the printer manufacturer.
The printer then makes the image in its own memory. Y ou select the printer or printer
driver in the Chooser option in the Apple menu (OS 8/9) or in the Print Center (OS X).
This option sometimes results in poor quality output, with too-thick or irregular lines,
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patterns at ascale of 72 dpi instead of the true printer resolution, or incorrect colors. |If
this happens try one of the other options.

If you have a PostScript printer, for 2D Drawing modes output you should probably
select the Direct PostScript option - this causes ATOMS to send PostScript language
commands to the printer instead of the QuickDraw drawing commands, although these
commands are transmitted through the currently-selected printer driver. Some printer
drivers, especially the standard LaserWriter drivers, may not print at the maximum
resolution of the printer without this option. Note that direct PostScript printer output is
only supported through this option, not through the PostScript item in the File menu.
The Pattern Series selection isignored - patterns are determined by the Printer.

Option 3) forms the image in memory, then sends it as a bitmap to the printer. This
option isaways used for 3D Drawing modes. This method may be very slow, but often
gives higher quality than option 1).

If the Standard printer dialog on OK box is checked, the Print dialog supplied by the
operating system or the printer driver comes up after you click OK. Usethat dialog to
set the number of copies or in some cases the resolution. The orientation (portrait or
landscape) can also be set in the Page Setup dialog in the File menu.

If you have a color printer, you may need to make a choice between color and black-and-
white printing in one of the printer dialogs as well as with the Color printing checkbox
inthisdialog. Thischoice may be an option in the standard printer dialog above, or you
may need to set it in the Page Setup option in the File menu. Background applies only to
color printing; for black-and-white printing the background is always white (although
you could print on black paper).

See Frames for details of the frame and frame units.

In this print option, for 2D images, ATOMS sends standard graphics commands to the
operating system, which passes them on to the printer driver, apiece of software which
isnormally written by the printer manufacturer (but sometimes by Microsoft in the case
of Windows). For color printing, it is standard to send RGB values to specify colors for
lines and files, and for black-and-white printing, it is standard to send gray-scale values
(actualy, RGB values with all three components equal). The printer driver interprets
these values in terms solid areas and/or dot patterns of ink on the paper. No color printer
can print all colors as solid areas; traditional printing uses as few as three or four colors,
most commonly cyan, magenta, yellow and black, intermixed or dithered in dot-patterns
to produce afull range of colors. Microcomputer printers may use more colors, but the
principle isthe same, and dot density istypically lower than in traditional printing, so it
may be important to select colors which are as simple as possible in terms of red, green
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and blue or cyan, magenta and yellow (see Colors, Palettes and DotPeatterns ).

Use ATOM S b/w patterns - Pattern Series. Black-and-white printer drivers must
interpret the gray valuesfor fills as dot patterns of varying density. The patterns supplied
by the printer driver may or may not be satisfactory for the ATOMS user. Rather than
send gray-scale values for fills, ATOMS can aso send its own dot patterns, which have
been carefully designed for its purposes. The Fine seriesis appropriate for small
drawings which will not be reproduced photographically. The Coar se series simulates
halftone screening and is appropriate for photographic reproduction. To be precise, at a
printer resolution of 300 dots per inch, most of the patterns have a screen density of 53
lines per inch, at 45 degrees; thisis about half the density of typical standard printing, so
areduction of about afactor of two is generallly satisfactory. Of course, different printer
resolution would dictate different reduction factors. Note that this coarse/fine setting is
the same as that in the Raster and Metefile or PICT files dialogsin the File menu.

ATOMS patterns are always used for b/w printing, but they may be rescaled or otherwise
changed by the printer driver.

Actualy, different printer drivers may interpret the standard gray-scale commands in
terms of patterns which are similar either to the fine or coarse series supplied by
ATOMS. Some may convert the ATOMS patterns to their own patterns, and some may
not accept the ATOMS patterns at all. Some may offer their own choice of pattern types
or densities (typically in the printer dialog above or the Page Setup dialog in the File
menu). Thus some experimentation may be necessary to find the best choice for patterns
(i.e. printer-driver patterns, fine ATOMS patterns; or coarse ATOMS patterns). Gray
lines of greater than one-dot width are aways drawn by filling an outline with one of the
ATOMS patterns - gray-scale values are not used because many printers will not print
gray lines. Thus the coarse/fine setting is always used for wide b/w lines.

Maximum memory. Thisisused only when printing in bitmap mode, which is always
used for the 3D Drawing modes. Operating system support for printing in 3D modeis
incomplete, and ATOMS itself must therefore draw raster or bitmap images and send
these to the printer, rather than relying on the printer driver. Memory considerations
similar to those involved in Raster Files therefore come into play.

Full-page output with 32-bit color requires about 30 megabyes at 300 dots per inch, and
about 500 megabytes at 1200 dpi. Asof 2010, most computers have enough memory -
severa gigabytes - to support the entireimage at once. It should therefore not be
necessary to have the maximum memory set to other than zero. However, it may be
necessary to close other programsto make all the memory available. The following
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applies mainly to older systems.

Both Macintosh and Windows operating systems use virtual memory, which means that
they pretend that a hard disk can be used in place of actual hardware memory chips. For
some purposes thisis useful, but when writing raster filesit usually resultsin "disk
thrashing", or constant reading and writing of data to the hard disk.

ATOMS is capable of imaging and writing raster filesin segments or bands to avoid this
problem. This requires repeating the entire drawing process for each band, but this
usually is much faster than the reading/writing to disk involved in using virtual memory.
To do this requires knowing how much actual chip memory isavailable. Unfortunately,
at present the operating systems do not provide this information in a useful way. Thus
the user may need to determine this by trial and error using the M aximum memory
parameter. Thisisthe same parameter which is set in the Raster Files dialog.

When the Maximum memory parameter is set to zero, ATOMS will ssimply ask the
system for a block of memory large enough to image the entire drawing at once. If this
amount of memory is greater than the amount of chip memory which is made available
by the system (and this may be considerably less than the actual amount of chip memory
in the computer), the operating system will use virtual memory, which istypically
manifested by disk thrashing. If you change the M aximum memory to some amount
less than that require for the image (say half), ATOMS will only request this amount of
memory from the system, and virtual memory may not comeinto play. A Maximum
memory setting should be good for a given session, regardless of the size of the raster
file; larger fileswill use more bands. However, the amount of memory available may
depend on whether other applications are active.

The amount of virtual memory is determined by the available space on the hard disk. If
thisisinsufficient, ATOMS will automatically use bands, but since virtual memory is
being used, it may still be advantageous to use a M aximum memory value which will
increase the number of bands.

3.2.1.10 Page Setup

The Page Setup dialog box in the File Menu of the Graphics Window is identical to the
Page Setup dialog in the File Menu of the Startup Window

3.2.1.11 Listings Group

This submenu allows listing, in Text Windows, of Input Data (below), Generated Atoms,
Generated Faces and Totals with memory usage.

Dialog Box - called from: File menu

Thislists out the input data to a Text Window (see Types of Windows). The categories
selected by the check boxes correspond to the various dialogs in the Inputl and Input?2
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menus.

The Generated Atoms list gives a symmetry number (Symm.) which can be correlated
with the list of symmetry operations, or equivalent positions of the general equipoint, in
the Input/Symmetry listing. This number, in roman numerals, can be shown as a
superscript on the Atoms Label (Display menu).

3.2.1.12 Direct Postscript Output
Dialog Box - called from: File menu

PostScript printing is standard in Linux, so for 2D output, including diffraction
diagrams, printing is routed to this dialog, not the Print Graphics command in the
File menu. Output can be directly to the printer or to an EPSfile, asfor Windows
(below).

---- Windowsonly ----

This option can be used to write Encapsulated Postscript (EPS) files for transmission of

graphicsto other software, aswell asfor direct output to a Postscript printer. This direct
output is generally superior to, as well asfaster than, the output from the normal

Print Graphics command in the File menu if your printer is PostScript. The Destination
option sends output either directly to aprinter or to afile in standard EPS (Encapsul ated
Postscript V3.0) format.

Screen Preview.

Most word-processing and publishing software cannot display an EPS file on the screen

unlessthe file has a special bitmap attached, called the screen preview. Thisisactually a
sub-filein the TIFF format. The pixel depth of thisfile can be set in the

PostScript Settings dialog (Settings button). The pixel depth of the preview is set to that
of the screen, and the pattern seriesis set to fine (see Raster Files).

---- Macintosh only ----

This option can only be used to write Encapsulated Postscript (EPS) files for
transmission of graphicsto other software. For direct output to a Postscript printer, use
the Print option.

Screen Preview.

Most word-processing and publishing software cannot display an EPS file on the screen
unlessthe file has a special attachment, called the screen preview. Thisis actualy a
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PICT in the resource fork of thefile.
---- End Linux/Windows/Macintosh only ----

In 3D Display modes, ATOMS always writes data (or sendsit to the printer) in the
form of a bitmap (or "image" in PostScript terminology). Because of the facts that
PostScript files must be ASCII (text), and that efficient data-compression schemes (other
than the copyrighted LZW) are not supported in PostScript level 2, PostScript files for
3D drawings tend to be much larger than the best Raster formats, especially PNG. Thus
the PNG Raster format is generally preferable for all 3D Display mode drawings.

The Maximum memory setting limits the amount of memory used for bitmap buffers
when in the 3D modes - see the Raster section for further details. The number of pixels
on each raster line must be divisible by four - the image width will be increased if
necessary to achievethis.

Settings button (PostScript Settings dialog). On or before first using the Dir ect
PostScript Output command, you should set or verify the settingsin this dial og,
especially the port to which the printer is attached. Fonts in PostScript outpuit.
Depending on your system configuration (Windows or Macintosh, printer type and
driver), the PostScript fonts supported by a PostScript printer may or may not appear in
the dialog for selecting fonts which may be called from the Title/Axes, Atom Labels,
Bond Labels, Axes/Unit-Cell or Magnetic L abels dialogs. Furthermore, you may want to
write EPS files for a printer which is not even connected to your computer. These dialogs
thus have an option to specify a character string for the PostScript font. This string
specifies the typeface, and includes the weight (normal, bold) and other attributes (italic
or oblique), but does not include the size - the size is specified in the font dialog. There
are certain standard PostScript typefaces which are present on most PostScript printers.

See Frames for details of the frame and frame units.

3.2.1.13 Pen Plot
Dialog Box - called from: File menu

---- Windowsonly ----

This option can be used to send commands directly to a pen plotter, provided the plotter
is connected to one of the standard parallel or serial ports, or to write files such as
HPGL which may be read by other software.

---- Macintosh and Linux only ----

This option writes pen-plotter-language files such as HPGL which may be read by other
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software.
---- End Windows/M acintosh/Linux only ----

On first using this command, be sure to click on the Settings button to set or verify the
characteristics of the plotter.

Towrite HPGL files, click on the Settings button and make sure that the plotter selected
iIs"HPGL plotters".

See Frames for details of the frame and frame units.

3.2.1.14 Raster (Bitmap) Files
Dialog Box - called from: File menu

--Windowsand Linux Only ----------

This command can write filesin four different formats (File type): Windows device-
independent format (.BMP); PC-Paintbrush (.PCX); Tag-image-format (.TIF); and
Portable Network Graphics (.PNG) files.

--Macintoshonly---------

This command can write files in the Portable Network Graphics (.PNG) format. The
Clipboard/PICT option (File menu) can also write raster or bitmap files, in the PICT
format.

--End Windows/Macintosh/Linux only----
See Selection of File Format below for information on choosing the format.

The drawing may be either black and white or color. If black and white, the pixel size is
1-bit. For color filesthe pixel size may in some cases be selected. In Windows, 16-bit is
only available for.omp files. In Macintosh, 8-bit (256-color) isonly availableif the
screenis currently set at this color depth.

Using colors other than white, black or gray for background may result in increased size
of raster filesor PostScript filesin 3D Drawing Modes. In some cases asimple run-
length-encoding method is used for compression of these files (see below), and this fails
for 24-bit RGB (true color) files when the three components are not identical. That is,
for arow of white pixels the sequence of bytesis 255, 255, 255, 255... whereas for arow
of red pixelsitis 255, 0, 0, 255, 0, O...

The images will look much the same as a screen image, except that for black-and-white

© 2011 Shape Software



ATOMS Menus and Dialogs 63

files gray shades are always rendered as dot patterns, and there is a choice of coarse or
fine patterns, as for printing (see the Print dialog in the File menu). Fine patternsare
appropriate for small images which will not be reproduced photographically, or for
images which will be shown on the screen only; coarse patterns mimic halftone screens
used in printing, and generally reproduce better photographically, especialy when the
image is reduced in size. Note that this coarse/fine setting is the same as that in the Print
and Metefiles or PICT filesdialogsin the File menu.

If the Compress box is checked,. TIF files are compressed with run-length encoding,
which is one of the required formats under the TIFF 6.0 standard. However, some
applications may not support this type of compression, or may reject. TIF files for other
reasons. Also, if the Compress box is checked, 4- and 8-bit.BMP files are compressed.
1-bit and 24- bit.BMP files are never compressed. Owing to a Windows system bug,
compression of 4-bit.BMP files may not work when banding is used (see below). .PCX
files are dways compressed. with their own format. 24-bit.PCX files can compress well,
whereas 24-bit. TIF filesare only partially compressed (and then only if there are large
areas of black, white or grey), and 24-bit.BMP files are not compressed at all. PNG files
also are always compressed.

See Frames for details of the frame and frame units.

Maximum memory. Windows and Macintosh both use virtual memory, which means
that they pretends that a hard disk can be used in place of actual hardware memory chips.
For some applications thisis useful, but when writing raster filesit usually resultsaform
of lingering death involving "disk thrashing”, or constant reading and writing of datato
the hard disk.

Full-page output (8 by 11 inches) with 32-bit color requires about 30 megabyes at 300
dots per inch, and about 500 megabytes at 1200 dpi. Asof 2010, most computers have
enough memory - several gigabytes - to support the entireimage at once. It should
therefore not be necessary to have the maximum memory set to other than zero.
However, it may be necessary to close other programs to make all the memory available.
The following applies mainly to older systems.

ATOMS is capable of imaging and writing raster filesin segments or bands to avoid the
problem of using virtual memory. This requires repeating the entire drawing process for
each band, but this usually is much faster than the reading/writing to disk involved in
using virtual memory. To do this requires knowing how much actual chip memory is
available. The user may need to determine this by trial and error using the Maximum
memory parameter.

When the Maximum memory parameter is set to zero, ATOMS will simply ask the
system for ablock of memory large enough to image the entire drawing at once. This
amount of memory is printed out in the dialog which appears after starting the raster
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imaging: "nnnn bytes required, mmmm bytes available - will require 1 bands". If this
amount of memory is greater than the amount of chip memory available, Windows will
use virtual memory, which istypically manifested by constant running of the hard disk
for long periods (disk thrashing). If you change the M aximum memory to some
amount smaller than nnnn (say half), ATOMSwill only request this amount of memory
from the system, and virtual memory may not come into play. A Maximum memory
setting should be good for a given session, regardless of the size of the raster file; larger
fileswill use more bands. However, the amount of memory available may depend on
whether other applications are active.

The amount of virtual memory is determined by the available space on the hard disk. If
thisisinsufficient, ATOMS will automatically use bands, but since virtual memory is
being used, it may still be advantageous to use a M aximum memory value which will
increase the number of bands.

Selection of File Format. The choice of format depends first of al on what formats are
supported by the target software (paint program; publishing program; etc.). Beyond this
the first choice should be PNG, second choice PCX, and then PICT, TIF or BMF
depending of what is supported and how much memory or disk space is available.

Asof 1997, the preferred graphicsfile typesfor the internet were GIF and JPEG.
However, GIF usesthe LZW compression scheme copyrighted by Unisys Corp., which
in principle charges alicense fee for every application using it. JPEG files are compact
but involve losses and degradation of the image and are thus not suitable for ATOMS
files.

The PNG format is intended to be a replacement for GIF, and in fact is superior to most
other formats, being lossless and giving very good compression for the type of images
generated by ATOMS (although 3D images do not compress as well as standard-mode
images). Essentially all major software vendors have subscribed to the PNG convention
and releases from 1998 onward should support it.

Most TIF files also use LZW compression, but ATOMS does not use this type of
compression because of the copyright problem. The run-length-encoding which
ATOMS does use is supposed to be supported by all TIF readers, but in fact some do not
support it, and this algorithm does not work well for 24-bit (RGB) images.

PICT bitmap files on the Macintosh are compressed by the system software and the
algorithm may vary. PNG filesare usually smaller.

There are dozens of raster graphics formats and it will never be possible for ATOMSto
support al of them. ATOMS users who work with raster files should consider investing
in aconversion program - there are many such programs which are not expensive. The
PNG home page (www.cdrom.com/pub/pnp) has links to many shareware and
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conventional commercia conversion packages.

3.2.1.15 Clipboard/PICT (Mac)
Dialog Box - called from: File menu

Note that thistype of output may be referred to elsewhere as Metafile output. This
option can write images either to the Clipboard or to PICT files, in either of two formats:
(a) arescalable 2-dimensional Picture or metafile, or (b) araster image or bitmap. For
3D Drawing modes, this option writes a two-dimensional image and only bitmaps are
available, but seethe VRML Files and POV-Ray options for files which actually contain
three-dimensional data

Macintosh Pictures, as used here, are images containing lines or vectors and fills of
regions defined by lines, that can be rescaled without necessarily losing resolution. They
record the drawing commands that are used for the screen or standard printer output, but
the result may depend on the software or device in which they are used.

Bitmaps or raster images record every pixel, so they are not susceptible to undesirable
modification by other software. Although most "painting” software can resize bitmaps,
thisusually causes aloss of quality, so it is best to save a bitmap in exactly the desired
size. Note that you can also save bitmapsin the PNG file format (File menu), whichiis
superior is some respectsto PICT files.

If color output is selected, you can choose either 16- or 32-hit color depth - 8-bit (256-
color) files cannot be written.

Y ou can select the nominal dots per inch/centimeter, but note that programs which read
the file may ignore this and show the image at 72 dots per inch.

Background color. If thisoption, which applies only to PICT output, is on, the color
selected in the Background Color dialog of the Input2 menu will be applied in color
output only. Background in b/w output is always white.

In 3D drawing modes PICT (bitmap) output always has 32-bit pixel depth.

See Frames for details of the frame and frame units.

3.2.1.16 Metafiles (Windows)
Dialog Box - called from: File menu

--- WindowsOnly ----------
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Windows metafiles are basically vector images (but including fills) that can be rescaled
without necessarily losing resolution. They record the drawing commands that are used
for the screen or standard printer output, but the result may depend on the software or
device for which they are intended. A metafileimage may either be saved in the
Clipboard, to be Pasted into another application, or written to afile.

ATOMS can write three types of metafiles. The origina or Standar d metafile format
has proven inadequate for transmitting scaling information, and many applications do not
even accept Standard metafiles. Placeable metafiles, aformat which was originated by
Aldus Corporation, contain scaling information in an additional header. The standard
and placeable metafiles have the WMF extension. WMF or standard files are 16-bit
format, i.e. use 2-byte integers. Enhanced metafiles are 32-bit format files which also
contain scaling information. They are the preferred type of metafile for use in 32-hbit
Windows systems (Windows NT or Windows 95), but cannot be used in standard 16-bit
Windows 3.1or Win32s.

Original (16-bit or WMF) metafiles can be written with either of two Scaling Modes,

I sotropic or Anisotropic. Isotropic supposedly keeps the same proportions. Generally,
Isotropic isthe best asit alows rescaling while preserving proportions. However, some
applications only accept Anisotropic files, and some ignore the scaling mode completely.

The type of image written by thisoption is strictly two-dimensional. It isalso possible to
write files containing three-dimensional images with the VRML Files and POV-Ray
options.

When writing to afile, to prevent loss of resolution, ATOMS uses a standard scaling of
2540 dots or pixels per inch (1000/cm). However, some drawing applications may not
read the scaling correctly (assuming 72 dpi) and it may be necessary to rescale the
drawing after importation.

When writing to the clipboard, ATOMS uses the current screen resolution, which usually
isabout 92 dpi. Thisis because most drawing applications assume screen resolution or
72 dpi. The clipboard image can be either 16-bit (.wmf) or 32-bit (.emf) according to the
setting of the Type option.

See Frames for details of the frame and frame units.

Limitations of Metafiles. Asdesigned and implemented by Microsoft, the metafile
allowsrecording of all Windows drawing commands, so that a file image can be a copy
of what is shown on the screen but rescalable. Unfortunately non-Microsoft drawing
applications (e.g. Corel Draw, Adobe Illustrator) sometimes implement metafiles
incompletely or incorrectly so that there are some limitations in metafiles written by
ATOMS, in order to allow them to work in as many applications as possible. It many be
necessary to try many combinations of settings (Destination, Scaling mode, Type of file)
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to get satisfactory results in an importing program.

1) Resolution for the clipboard is now that of the screen, typically 72-96 dots-per-inch
(dpi) - earlier versions of ATOMS used 2540 dpi. The lower resolution should not cause
problems except for very complex drawings - if adrawing looks good on the screen, it
should look good in adocument. If the clipboard is unsatisfactory use afile.

2) ATOMS bhitmap patterns for black-and-white images cannot be used. Fillsare
transmitted as gray shades which are interpreted by the importing application and/or
printer.

3) A background is always present, to insure correct scaling. With some care, this
drawing element may be removed in importing applications.

4) Thereisno clipping of the image, although some importing applications may use the
drawing frame for clipping. For ATOMS structure drawings thiswill usually only cause
problemsif the fixed scaling mode is used, and parts of the drawing extend beyond the
frame. For Powder and Precession graphs, the title lettering may extend beyond the
frame. In someimporting applications (e.g. Corel Draw) it may be necessary to reset the
Size and/or proportions.

5) Transmission of theimage in Corel Draw with the Clipboard may require use of
Edit/Paste Special rather than a simple Paste.

6) Adobe Illustrator generally does not do well with labels - is may be necessary to use
an EPSfilefor Adobe Illustrator. Label backgrounds may not be transmitted in other
applications.

7) Some drawing applications may alter atom outlines and other curvesin ATOMS,
apparently attempting to "smooth" them. Thisis especialy likely if aclipboard imageis
expanded (made larger) - inthis case try afileinstead.

If ametafile is not satisfactory, araster file can be used. PNG raster files are often
smaller than metafiles, especially for complex drawings. Also, many drawing programs
now support import of EPS (Direct PostScript) files. EPSisusualy the preferred type of
filefor Adobe lllustrator.

3.2.1.17 Save Graphics Window

Dialog Box - called from: File menu

This command writes a bitmap giving exactly what is shown inside the current graphics
window.

This option is appropriate for applications which will use the image on the screen. For
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applications which will use a printed or other high-resolution image, either the
Raster Files or Metafiles (Windows) or PICT (Macintosh) options will usually give
better results.

---WindowsOnly ---------

Thiswill save a Device-Independent-Bitmap (DIB) either to the clipboard or to aBMP
file.

Y ou can also copy the current window to the clipboard with the Print Screen key (this
isastandard Windows function). However, thisincludes the window title bar and
border and parts of overlapping windows, whereas the Screen to Bitmap command
only copies the graphics part or the client area.

---Linux Only -------

Thiswill save aPNG file. The clipboard is not currently supported.

---Macintosh Only --------
Thiswill save a PICT file asraster, or put the image in the clipboard.

---End Windows/Macintosh Only --------

3.2.1.18 VRML Files
Dialog Box - called from: File menu

Virtual Reality Modeling Language files were intended for exchange of virtual reality
data on the Internet. However, they have become ade facto standard for interchange of
3D dataof all types.

ATOMS currently supports V1.0 ascii files.

VRML files can be viewed with Internet browsers for either Windows or Macintosh,
using plug-ins such Cosmoplayer (www.cosmosoftware.com). Sincethe files are text,
they can also be viewed on SGI and other UNIX systems. 3D Exploration
(www.righthemisphere.com) is a stand-alone viewer for Windows which is independent
of Internet browsers.

Most of the settings for 3D Drawing modes (3D Parameters dialogs, Input2 menu ) apply
to VRML files, athough thereislittle control of lighting (the viewer application or plug-
in usually controlsthis, although most viewers offer few choices). Thermal ellipsoids
may be drawn in VRML files, as selected in the 3D - General dialog or the
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Ellipsoid Parameters dialog, Input2 menu. Thermal ellipsoids are always solid, without
the cut-out octant which is possible in direct screen or print drawing, and bonds are
aways cylindrical, not tapered.

If the buttonsin this dialog are used to change 3D settings, these changes will also apply
3D Display mode on screen and in output.

For the latest information on crystallographic and molecul ar-modeling applications of
VRML see http://193.49.43/dif/3D_crystals.html or http://fluo.univ-
lemans.fr:8001/vrml/intvrml.html.

3.2.1.19 POV-Ray File Output
Dialog Box - called from: File menu

POV -Ray is a program which draws a 3D image pixel-by-pixel, calculating al possible
light-ray paths. It allows for much more elaborate lighting effects than the OpenGL or
Direct3D software used in the 3D Drawing Modes in ATOMS. Some obvious effects
are shadows and refraction but there are many possibilities. Backgrounds and other
objects may be added aswell. Thefilesaretext (ASCII) and may be edited.

Since the calculation is much more elaborate than that done by OpenGL, thisisnot a
method that can be used for real-time display on the screen - POV -Ray images may take
many minutes to complete.

The POV-Ray package, with instructions, samples, etc., may be obtained from
WWW.povray.org.

While adding shadows to ball-and-stick or space-filling structure drawings may make
them more "redlistic”, it also may tend to complicate things. Shadows are usually most
beneficial to Cavities mode drawings of crystals. The default output from ATOMS has
shadows, but this can be changed by adding the keyword "shadowless" after the color
definition in the "light_source" definition near the beginning of thefile.

Cavities- use spheres. Povray can show Cavities in its own way, using "constructive
solid geometry"”. For this, it only needs the unit cell and the atoms. This makesfor a
smaller file and usually gives a much smoother appearance than the standard method
used for cavitiesin ATOMS. If thisbox is not checked, the POV-ray rendering is
exactly the same as that shown on screen.

Currently only one unit cell is shown, and crystal axes cannot be shown.
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3.2.1.20 Exit/Quit command

Exit [Windows] or Quit [Macintosh] command [ File menu (Startup) or File menu
(Graphics) |

Use this command to end your ATOMS session.

If you have changed the orientation from that specified in the Initial Orientation dialog in
the File2 menu, you are asked if you want to save the current orientation. If you choose
to do this, the current orientation will be converted to initial orientations on the observer
X,y and z axes. If clinographic viewing isin effect at the time of saving, theinitial
clinographic viewing flag will be turned on. The initial rotations can be changed or
deleted in the Initial Orientation dialog in the Input2 menu. See also

Coordinate Systems.

ATOMS also checks whether any dialog in the [nputl and [nput2 menus have been
opened, or whether there has been any change in the status of atoms marked for non-
plotting (see Deleting Atoms).

3.2.2 Inputl Menu (Graphics Window)
Note: if the screen is narrow, this may be a submenu in the Input menu.

Title/Structure Axes - Titleand axia system (unit cell for crystals).

Symmetry - Symmetry of the structure.
Boundary - Boundariesfor limiting the reproduction of atoms by lattice vectors.

Display Faces - Theoptional crystal facesfor display surround the structure - they can
be the same as boundary faces, or different.

Atoms - The coordinates and other attributes of input atoms.
Polyhedra - Specificationsfor locating polyhedra, and display attributes.
Bonds - Specificationsfor locating bonds, and display attributes.

Atoms - Global - Thisallows changing the radius, colors etc., of al input atoms, or
specified subsets, at once.

Atomic Vectors - This specifies general attributes of vectors for magnetic spins or
vibrational displacements or other purposes.
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Vibrational Modes - For data sets originating from the VIBRAT program, this alows
selection of individual vibrational modes..

Cavity Parameters - This sets the parameters for showing "open spaces’ in the Cavities
Drawing mode.

3.2.2.1 Title/Axes
Dialog Box - called from: [nputl Menu

Thetitle may have up to 80 characters of identifying information. This may now use
non-ANSI character sets, selected with the Font button. The size of the text in the edit
box isfixed, and will not reflect the size sal ected with the Font button.

The axial system determines the type of coordinate axes for crystal faces (if present) as
well as atoms. If you are drawing a molecule you will probably want to choose Unit
Cartesian axes unless the symmetry istrigonal or hexagonal - see Coordinate Systems.

If you choose a crystal system you must supply the axis lengths and interaxial angles
appropriate to the crystal system you selected. Axis lengths should be in Angstroms, and
anglesin degrees and fractions (not minutes and seconds). If you are entering anew
structure, the unique angle for the monoclinic system is always called beta at this point.
However, in the Symmetry options the selection of space or point group may change
this, and if you return to the Title/Axes dialog the correct angle should be shown. If the
angles are still incorrect you can usetriclinic axes.

Although standard crystallographic nomenclature gives the same letter (usually a) to
symmetry-equivalent axes, after theinitial input ATOMS may call all axes, whatever the
system, "a, b, and ¢" and angles "Alpha’, "Beta' and "Gamma'.

If the Print title on plot box is checked, the title will be shown in the lower left on al
display and output (of the structure, not the Powder or Precession patterns). If the Scale
box is checked, the lettering on print and file output will be scaled to approximately the
same relative size compared to the drawing as it is on the screen.

Use PostScript font. Thisallows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified
in the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.
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3.2.2.2 Symmetry
Dialog Box - called from: [nputl Menu

The authority and source of information for crystal symmetry isnormally the
International Tables for X-ray Crystallography. However, any point- or space-group
symmetry may be used for the atoms. There are several options for selecting or entering
Ssymmetry information.

Space group from table - Choose a space group by symbol or number.

Point group from table - Choose a crystallographic point group.

Cartesian matrices - Use non-standard or non-crystallographic point symmetry.

Custom point or space group - Enter al theindividual operators.

Usenosymmetry - Usenosymmetry at all. Check Crystal to enable lattice
translations - the space group will be P1.

Except for the last option, Use no symmetry, each choice calls up a sub-dialog.

3.2.2.2.1 Space-Group Symmetry, Basic Tab
Dialog Box Tab - called from: Symmetry dialog

Starting with V4.0 of ATOMS, space-group symmetry is obtained using licensed
excerpts from the SGInfo program of Ralf Grosse-Kunstleve. This allows more complete
selection of alternate orientations and origins than in previous versions of ATOMS, and
also Shubnikov black-and-white symmetry.

Y ou can specify the space group in any of three ways: 1) the Hermann-Maughin (H-M)
or International symbol; 2) the Hall symbol (S.R. Hall: ActaCryst., A37, 517, 1981); or
3) the number of the group in the International Tables for X-ray Crystallography.

International TablesVolume. You have the option of using the older version of the
Tables (called the Second Edition: various revisions and reprints from 1952 to 1979) in
which the symmetry information wasin Volume I, or the newer version (1983 onwards)
inwhichitisinVolume A. The principal difference between the two versionsisthat in
the older one the unique axis of amonoclinic group is assumed to be the c-axis, whereas
in the newer oneit is assumed to be the b-axis. Thus entering the symbol P2/m gives two
different orientations depending on the volume selected. Y ou can always specify the
orientation by entering the long form of thesymbol,i.e. P2/m11,P12/mlorP11
2/m.
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The H-M symbol can be typed into the edit box in either short form or long form, with or
without spaces between positions. However, it isusually safer to select the symbol from
thelist box at the bottom, which gives the standard-form symbols for all the space-
groups. Clicking the Select button copies the relevant data to the edit boxes at the top; it
does not actually generate the symmetry. Symmetry generation is done after you click
OK - thismay take afew seconds. If the space group you select does not appear to be
consistent with your choice of axes, awarning box appears, but in most cases
consistency is not required. However, if you selected trigonal rhombohedral axesin the
Title/Axes diaog, only arhombohedral space group may be selected. Thisis done by
adding :R to the end of the symbol in the case of H-M symbols, or asterisk (*) in the case
of Hall symbols. Thisis achange from versions of ATOMS previousto V4.0, in which
the orientation of the space group was automatically determined from the Title/Axes
dialog. If you select the rhombohedral setting and then switch to the Custom symmetry
option, the lattice type will be P; it will be R if the axes are hexagonal.

Origin of coordinates. Inthe International Tables, 24 space groupsin the
orthorhombic, tetragonal and cubic systems are given with a choice of origin: 1) not on a
center of inversion or 2) on acenter of inversion. These two origins are selected by
adding :1 or :2 respectively to the end of the H-M symbol or the number. Although the
origin on the center is second in the Tables and in the list, if the number is omitted this
will be the default. Thisdifferencein originisexplicit in the Hall symbol, and other
choices of origin may be specified for any space group with the Hall symbol.

Shubnikov Symmetry. Y ou can use Shubnikov black-and-white symmetry to show
magnetic or other properties of crystals. If you choose this option you must enter at |east
some of the relevant parametersin the Shubnikov Tab. You enter the Shubnikov space-
group symmetry using modified versions of either the H-M or Hall symbols. After
entering the Shubnikov symmetry in the Basic Tab, you can check the Shubnikov lattice
type and basis operationsin the Shubnikov Tab after clicking OK or Apply. The H-M
symbol is modified in the standard way, by a) adding a subscript (actually a postscript) to
the lattice symbol; or b) adding a prime or apostrophe to the individua "positions’ or
basis operationsin the symbol. To enter a Shubnikov symbol you must separate the
lattice symbol and the individual positions by at least one space or underscore. The
entriesin the list box already have these separations, so it is advisable to select one of
these and then edit it. The Hall symbol is modified in asimilar way, but instead of using
aprime you must use the """ character. Aninitial minus sign on the Hall symbol
signifies acenter of inversion - if you want to assign Shubnikov inversion to this center,
add """ to the lattice symbol, not to the minus sign.

Standard H-M Shubnikov lattice symbols use both lower- and upper-case subscripts A,
B, Cfor "color" face centering, and a, b, ¢ for edge centering. In ATOMS a capital letter
will always indicate face centering, and either lower-casea, b, cor x,y, z (or X, Y, 2Z)
will indicate edge centering. Note that there is little checking for self-consistency, either
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for input through the symbol or explicit operatorsin the Shubnikov Tab. The user is
responsible for entering a valid Shubnikov space group.

Shubnikov inversion is considered to apply to the spin of a magnetic atom, rather than
directly to the vector which shows the magnetic direction. This means that improper
operations, including a center of inversion, planes of symmetry and improper (bar) axes,
result in inversion or reversal of the magnetic spin vector when the operation is not
primed or Shubnikov, and no inversion when the operation is primed or Shubnikov. Of
course, the resulting spin-vector orientation depends also on the orientation of the spin
with respect to the symmetry operator - when the vector is parallel to an axis or plane the
result is completely different from when it is perpendicular. ATOMS can apply
Shubnikov symmetry in thisway, or in certain other ways - see the Shubnikov Tab.

Magnetic or other Shubnikov symmetry normally involves entries in three different
places:

1) The Space Group from Table symmetry option (this dialog), including the
Shubnikov Tab;

2) The Atomic Vectors dialog (Inputl menu), to set the display parameters of the
vectors; and

3) the Revise Atom dialog, Vector Tab for individua input atoms, to set the orientation
of the vectors on the atoms.

Molecules. It may sometimes be desirable to use the Space Group symmetry option for
amolecule rather than the Point Group option because in some point groups you can
select different orientations of the symmetry operators with respect to the coordinate
axes by choosing the operations from different space groups. Space-group operations are
applicable to point groups, provided there are no translations - that is, you cannot use
space groups with screw axes, glide planes, or non-primitive lattices. For example, in
number 111, P42m - D2d1 the mirror planes are 45 degrees from the structure axes,
whereasin no. 115, PAm2 - D2d5, the mirror planes are parallel to the axes. If you
choose the Point Group symmetry option and enter the point group 4m2 - D2d, the first
of these orientations, asin number 111, will aways be used. These two space groups
actualy differ in other ways than the 45 degree rotation, but thisisirrelevant if the
operations are used without lattice trandations. The choice between the two space groups
depends on the relative orientation of coordinate axes and symmetry elements. In this
case, if an atom lieson a 2-fold axisit will belong to a set of four (rather than eight if it
does not lie on any symmetry elements). For no. 111, such atoms will have coordinates
like x,0,0, whereas for no. 115 they will be like x,x,0.

In the trigonal, hexagonal and tetragonal systems several space groups have alternate
orientations at 30 or 45 degrees from each other asin the case of D2d. If the symmetry
for amolecule is specified with the Point Group option, the "standard” orientation is
generated. One may access the alternate orientation by the Space Group option and
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giving the alternate space group as follows (a B before a number indicates a"bar" or
inversion axis:

Point Group Standard Orientation Alternate Orientation
42m - D2d PB42M (no. 111) PB4M2 (no. 115)
32-D3 P321 (no. 150) P312 (no. 149)

3m- C3v P3M1 (no. 156) P31M (no. 157)
32/m - D3d PB3M1 (no. 164) PB31M (no. 162)
6m2 - D3h PB6M2 (no. 187) PB62M (no. 189)

Y ou can also use this symmetry option to select a non-standard setting for monoclinic or
orthorhombic point groups as

discussed in the previous section. For example, you can cause the unigque axis of groups
2-C2, m-Csor 2/m- C2hto beeither a, b or ¢ (the standard setting for ATOMS is
unique axis b). You can also cause the 2-fold axis of mm2 - C2v to be parallel to any of
the three structure axes. If you do choose this option, using space-group operationsfor a
molecule, be sure that the space group has no screw axes or glide planes, and has a
primitive Bravais lattice.

3.2.2.2.2 Space-Group Symmetry, Shubnikov Tab
Dialog Box Tab - called from: Symmetry Dialog

ATOMS uses several tools for description and depiction of magnetic structures, loosely
gathered in the " Shubnikov" tab.

These tools include 1) constant vector orientation for all atomsin asite; 2) full
Shubnikov symmetry in that the vectors themselves obey the full specified symmetry; 3)
Shubnikov symmetry with vector orientations remaining constant except for inversion;
and 3) lattice inversion or magnetic supercells independent of Shubnikov symmetry.

Magnetic or other Shubnikov symmetry may involve entriesin three different places: 1)
The Space Group from Table symmetry option, including the Shubnikov Tab (this
dialog); 2) The Atomic Vectors dialog (Inputl menu), to set the display parameters of
the vectors; and 3) the Revise Atom dialog, VVector Tab for individual input atoms, to set
the orientation of the vectors on the atoms.

In the upper part of this dialog, the methods of Display and Application of the
Shubnikov symmetry are selected.

Display:
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1) Labels+/-. Inthismode, only thetwo "colors’, signified by the +/- symbols, are
shown. Select the size and other properties of the symbols with the dialog called up by
the L abels button. Caution : this option may not be suitable for showing Shubnikov
magnetic symmetry. Whether or not an atomic vector isreversed or inverted by the
combination of ordinary and Shubnikov symmetry depends on the orientation of that
vector with respect to the symmetry operator. Most published diagrams of magnetic
structure using black and white or + and - atoms are not actually showing the Shubnikov
inversions, they are showing symbolically the reversals of spin vectorswhich are
typically in special orientations. 1f you want to show arbitrary black/white inversion
which does not conform to Shubnikov symmetry, you can simple draw up anormal
structure, convert Generated to Input (Transform menu) and recolor individual atoms as
desired.

2) Vectors-reversal only. Inthismode, each input atom has a vector, but the
orientation is constant except that the direction may be reversed by the Shubnikov
operators. Thisisnot what most workers seem to understand by Shubnikov symmetry
applied to atomic spin vectors, but it can be useful in illustrating many magnetic
structures or in non-magnetic applications. Especialy, it can be used to aign all atoms
in aparticular site in the same direction, regardless of space-group symmetry. To do
this, you should also uncheck the Shubnikov box in the Space-

Group Symmetry: Basic Tab. Virtualy any commensurate magnetic structure can then
beillustrated by converting Generated to Input (Transform menu) and reversing or
otherwise reorienting the vectors manually. When in the Input=generated mode, clicking
on amagnetic atom brings up adialog which has a button for vector reversal or
inversion.

3) Vectors- full symmetry. Inthis mode, the orientation of the vector on each
generated atom is subject to all symmetry operations, both standard and Shubnikov
reversal.

Application :

1) Magnetic. Shubnikov inversion is considered to apply to the spin or electric current
loop of amagnetic atom, rather than directly to the vector which shows the magnetic
direction. This means that improper operations, including a center of inversion, planes
of symmetry and improper (bar) axes, result in inversion or reversal of the magnetic spin
vector when the operation is not primed or Shubnikov, and no inversion when the
operation is primed or Shubnikov. Of course, the resulting spin-vector orientation
depends also on the orientation of the spin with respect to the symmetry operator - when
the vector is parallel to an axis or plane the result is completely different from whenit is
perpendicular.

2) Dipole or Black/White. In this casethe inversions are applied directly to the vectors,
not to the spin or electric current loops. Thus improper operations result in no inversion
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or reversal of the vector when the operation is not primed, and inversion when the
operation isprimed. Thistype of symmetry could be applied to atomic dipoles, or to
displacements, for example.

See the table below for the various combinations of Display and Application.

Set the overall properties of atomic vectors with the Vectors dialog called up by the
Vector s button; set the orientation of the vector for each input atom in the

Revise Atom: Vector Tab. Whether each input atom has a Shubnikov reversal at all is
also set in the Revise Atom: Basic Tab. In general, not every input atom is Shubnikov or
even can be Shubnikov in display modes 1) and 3). The orientation of vectorsin special
positions may be restricted. Black-white reversal itself may be forbidden in some specia
positions. Such positions should be identified during the calculation and marked as non-
Shubnikov.

Shubnikov Operators. This section of the dialog summarizes the information obtained
from the Shubnikov symbol in the Basic Tab. The possibilities for the Shubnikov lattice
type or L attice centering are lower-case a, b, or ¢, indicating translation reversal in the
respective axis direction, or S, indicating reversal on all three directions; or upper-case
A, B, or Cindicating a Shubnikov centering of the respective faces, or |, indicating
Shubnikov body centering.

For non-trandational Shubnikov symmetry, the possibilities are Inversion, and either
Rotation parallel to, or Reflection perpendicular to any of the three axis directions. If
present, rotation and reflection are indicated by capital letters A, B and/or C. The face
diagonal [110] direction, indicated by AB, isalso possible in high-symmetry crystals.
The body diagonal [111] direction is not a possible Shubnikov operator orientation as it
can only have athree-fold axis.

Note that there is little checking for self-consistency of Shubnikov operators. The user is
responsible for entering a valid Shubnikov space group.

Table showing possibilities for Display and Application of Shubnikov symmetry

+/- Reversal Only Full Symmetry
Magnetic bc bc abc
Dipole bd bd abd

a) Operate on vector with ordinary space-group symmetry

b) Proper operators (lattice and non-bar axes) - reverse if primed, do not reverse if
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unprimed

C) Improper operators (inversion, reflection, bar axes) - reverse if unprimed, do not
reverseif primed

d) Improper operators (inversion, reflection, bar axes) - do not reverseif unprimed,
reverseif primed

Rever se means to change vector direction by 180 degrees, or to change + to - or vice-
versa. Theordinary space-group symmetry operations are always applied to the
positions of the atoms.

Lattice Inversionsor Magnetic Supercell. Thisoptionisnot actually part of
Shubnikov symmetry, but it offers a simple means of describing many magnetic
structures, either by itself or in combination with Shubnikov operators, often without
changing the unit cell and overall symmetry from what describes the non-magnetic
structure.

Checking one of the boxes causes al magnetic vectors to reverse with each tranglation
on that axis. Thisnormally resultsin a doubled magnetic axis or cell edge in that
direction. When more than one lattice inversion is selected, the operations are applied
successively. For exampleif thereisinversion on aand b axes, the 100 and 010 unit
cells have inversion, but the 110 unit cell does not.

If the unit cell is non-primitive you can use inversion on either the Bravais axes or the
primitive axes, but not both.

Note that the Default Unit Cell boundary option uses the non-magnetic Bravais axes, not
the doubled magnetic axes. To show the reversals adequately it may be necessary to
select the -1 to 1 inclusive option in the Default Unit Cell boundary option, or to use the
Trangation Limits boundary option.

This option is definitely not the same as using non-primitive Shubnikov lattices, and is
apparently equivalent to specifying a magnetic "wave vector”. Compare the samples
FCCMAG, FCCMAGR, and FCCFULL _II for different ways of showing Typell FCC
(MnO) magnetic structure - the most concise is FCCFULL _Il which usesinversionson
all three primitive (face-centering) lattice translations, with the full Fm3m X-ray
symmetry of MnO.

See also the CRCL2MAGD sample, which uses magnetic lattice inversions on two axes
in combination with a Shubnikov space group Pnnm' which is simply related to the non-
magnetic group Pnnm.

Irreducible Representations. ATOMS could in principle be programmed to use the
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method of description of magnetic structures by means of the irreducible representations
of space groups, as pioneered by Bertaut and others and described in the book by
|zyumov, Naish and Ozerov (Neutron Diffraction of Magnetic Materials). This has
obvious theoretical advantages over the ad hoc methods now used in ATOMS, but there
are practical difficultiesin that the representations are numbered in an arbitrary way and
and must refer to an essentially arbitrary order of symmetry operators. A description of
this type can be concise but it may convey little without reference to a standard
compilation such as that of Kovalev.

If thereis sufficient interest, using irreducible representations might be attempted in
ATOMS.

3.2.2.2.3 Magnetic Labels
Dialog Box - called from: Space-Group Symmetry Dialog

The only characters which will be shown are the symbols + and -. The choice between
showing these symbols and atomic vectors is made in the Space-Group Symmetry
dialog, Shubnikov tab.

If the Background is opague, each symbol will lie on asmall block of the designated
color; this usually makes the labels easier to read. Some other programs may not be able
to reproduce these opaque blocks in Metafiles or PICT file output.

Sequence. The labels may be plotted immediately after each atom, or all at once after all
atoms have been plotted. Thefirst usually looks better, but some labels will usually be
partly or completely obscured.

Use PostScript font. Thisallows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified
in the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.

The label positions are correct for stereopairs, and labels for central atoms of polyhedra
will appear suspended in the interior of the polyhedra.

Use the color options in this dialog, not the color optionsin the Font dialog to set the
color of the letters. Letters are always solid black in black-and-white display or output.
See |nput Colors/Patterns/Pens for general aspects of color input.

Labels are not supported for Pen Plot output.
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3.2.2.2.4 Point-Group Symmetry
Dialog Box - called from: Symmetry Dialog

Thisisthe simplest symmetry option for amolecule, provided the symmetry is
crystallographic and atomic coordinates conform to standard orientations. It is not
applicable if the symmetry isicosahedral, pentagonal or other non-crystallographic type;
choose the Cartesian matrices symmetry option in any of these cases. If the symmetry is
crystallographic, but the orientation is non-standard, it may be possible to use the

Space group option.

To use this option, click on the point group symbol; symmetry operations will then be
taken from a space group belonging to the given point group in the International Tables ;
the space group chosen will have a primitive lattice, no screw axes or glide planes, and
the standard orientation of axes. Usually, but not always, thisis the one with superscript
1 on the Schoenflies symbol. In the case of monoclinic groups (2 - C2, m- Csor 2/m -
C2h), the first setting (unique axis parallel to c) is standard: thisis different from the
standard for settings of monoclinic crystalsin the Title/Axes dialog in the Inputl menu,
but when you select the point group the unigue angle will be applied to the proper axes.
For group mm2 - C2v the 2-fold axisis parallel to c. For groups with 3-, 4- or 6-fold
axes, the unique axisis ¢, but there may be aternate orientations at 30 or 45 degrees
from one another: see the Space group option for the standards and how to access the
alternate orientations using space-group operations.

Coordinates of atomsin molecules are usually given in a Cartesian axial system. If the
molecule has one 3-fold or 6-fold axis of symmetry, i.e. hastrigona or hexagonal
symmetry ATOMS can either use reference axes which also have this symmetry, that is
trigonal or hexagonal "crystal" axes (a1 and a2 axes at 120 degrees, ¢ axis at 90 degrees
to a1 and a2), or use unit Cartesian axes. The symmetry matrices for the standard point
groups are actually stored in the form appropriate to hexagonal axes, and then converted
to the Cartesian form during calculation if the structure axes are unit Cartesian.

3.2.2.2.5 Cartesian Symmetry
Dialog Box - called from: Symmetry Dialog

This symmetry option, for point symmetry only, assumes that Cartesian axes arein use,
although it will work in any structure with axes at right angles. It is the only option
applicable to non-crystallographic symmetry, and it can be used if desired in any other
case. However, it isusually easier to use one of the other options for crystallographic
Symmetry.

This option requires afile containing the Cartesian symmetry matrices. The auxiliary
program SY MGRP writes files which are normally given the suffix.SY M. If you type the
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name into the edit box, give the full name of the symmetry file, including the.SYM
suffix. Some such files, namely those for pentagonal (C5, S10, D5, C5v, C5h, D5h and
D5d) and icosahedral (I and Ih) point groups, have already been provided. For other
point groups, it will be necessary to run the auxilliary program SY MGRP to generate the
file before running ATOMS.

The Get Symmetry button reads the file and fills out the symbol, number of matrices
and centric/non-centric state, which are printed out below the file name.

The file name as entered in the edit box is saved in the data file for the structure. If the
complete path is not given, the Cartesian symmetry file should be in the same directory
asthe datafile. If thefile cannot be found when the structure is calculated, you will get
an error message and a chance to locate the file with astandard file dialog. The
complete path name, as determined in this way or with the Browse button, will then be
saved in the datafile.

Obtaining SYMGRP. To get SY MGRP, download the demo for SHAPE from
www.shapesoftware.com - SYMGRP isin a sub-folder.

3.2.2.2.6 Symmetry - Custom
Dialog Box - called from: Symmetry Dialog

ATOMS can access al the standard orientations for space groupsin the International
Tables but there are still afew possibilities for alternate settings of symmetry elements
with respect to structure axes which are not listed in the Tables. In some cases
displacement, rotation or permutation of atomic coordinates may not be convenient, and
it may be easier to enter the symmetry operations for the non-standard setting. These are
sometimes given in reports on structures (e.g. Wyckoff, Crystal Structures). Note
however that often only the operations for special positions are given: ATOMS needs all
the operations for the general position.

The Symbol isfor your reference only - itisnot used by ATOMS, unlessyou click the
Get Symbol button (below).

Get Symbol. Thisbutton will attempt to identify the space group from the operations,
the lattice type and the centric/acentric setting. |f the operations contain an inversion
center or lattice centerings, they should be identified and can be removed at your option.

If you specify centric, rather than acentric, you must enter only half of the symmetry
operations, related to any others by the center. The two sets or halves of the operations
related by the center will have opposite signs on the x, y and z coordinates.

The Bravais lattice type isin most cases the capital |etter which begins the space-group
symbol. However, ATOMS uses a somewhat different convention from the standard for
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trigonal crystals: if you are using hexagonal axes for arhombohedral crystal (whose
standard space group symbol will aways begin with"R"), enter "R" - if you areusing
the primitive rhombohedral axes, enter "P". Enter "P" for amolecule.

If the group is monoclinic, you should specify which isthe Unique axis. Thisis
normally c for amolecule and b for acrystal. The angle specified in the Title/Axes
dialog will then be applied correctly, the other two interaxial angles being set to 90
degrees.

In the Oper ations group, you must enter all the "symmetry operations” for the most
genera position in the structure. Click on the Add Oper ation button to add an operator,
or Delete to remove an operator. The operation which is selected in the Operations list
box isavailable for editing in the box to the right. Note that earlier versions of ATOMS
allowed several operations per line; currently, there should be only one operation per
line. Semicolons at the end of each operation (line) are optional.

It isassumed in the following that you will be using data listed in the International
Tables, but thisisonly for purposes of illustration; if you find it necessary to enter the
operations through this dialog, you will very likely be using data from another source.
Reports on crystal structures, especially older ones, often list the relevant operationsin
the same format as the Tables.

In the Tables, the "Co-ordinates of equivalent positions' can be regarded as operations
(or at least the operations can be easily derived from them). These coordinates occupy
the middle of the page in each space-group entry in the Tables, and the general position
is the uppermost group. The general position has the point symmetry 1, and the list of
operations for this position aways beginswith "x,y,z;". The individual operations are
separated in the Tables by semicolons.

Copy these operations, including the commas (semicolons optional), one per line. They
are entered just as given in the Tables, except that a negative sign, indicated by a small
bar over the letter in the Tables, must be indicated with a minus sign in front of the letter.
Thefirst operation, "x,y,z;" is present in al symmetry groups and must always be
entered. Ignore the trandlations for non-primitive lattices (e.g. 0,0,0; 1/2,1/2,1/2) which
may be listed in the Tables above the operations; these are taken care of if you enter the
proper Bravais lattice symbol. Some older structure reports may include lattice-centering
in the equivalent positions.

Important: if you have specified a centric space group with origin on the center of
inversion, you should omit half the operations, which are related to the other half by the
center (opposite signsfor X, y and z coordinates). If you have difficulty making this
separation, you can specify non-centric and enter all the operations. The Get Symbol
button should detect a center of inversion on the origin, and remove it if desired.
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3.2.2.3 Boundary Option
Dialog Box - called from: Inputl Menu

For crystals and polymers, some limitations must be applied to the repetition of atoms by
means of the lattice trandations. Ten choices are available, as listed below. Note that the
first three are not usually applicable to molecules, while the fourth, No Boundaries, is
not applicable to crystals. Thereis an additional boundary option and operating mode,

I nput atoms = generated atoms, which isonly accessible by choosing

Generated to Input in the Transform menu.

Options applied to individual atoms :

Default Unit Cell - Offersfive sub-options to outline a volume with the same faces as
the unit cell.

Enter Forms - Use specified crystal faces for the boundaries.

Slice - Isolate adlab of the structure parallel to a given face, with thickness equal to the
d-spacing (or multiple thereof).

No Boundaries (molecule) - Useno boundariesat all. Thisoptionisprimarily for a
single molecule not in acrystal structure, not isolation of moleculesin acrystal structure
(see below).

Trangation Limits (polymer) - Useintegral numbers of unit cells.

Sphere - Include all atoms within a given distance of agiven point (or atom).

The Unit Cell and Slice options always use lattice tranglations in all three axis
directions, and the No Boundaries option never uses lattice trandations. The
Trandation Limits option, primarily intended for polymers, allows you to specify
which axis directions use lattice trandations. The Enter Forms option also allows
disabling of any of the lattice trandations.

Options applied to groups of atoms (molecules) in crystals.

In all these options, molecules or other bonded groups within the unit cell are located,
and the center point of each group isfound by taking a non-weighted average of the
atomic positions. Then the selected boundary method is applied to these molecular
centers.
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Atoms within molecules or groups must be connected by Bonds or Polyhedra, and there
must be no standard bonds or polyhedra connecting atoms of different molecules.
However, bonds can be specified as inter-molecular, so that they will not be used in the
molecule-locating algorithm but will be displayed.

Note that these options are not applicable to 1- and 2-dimensionally continuous groups
(polymers) - bonding must be discontinuousin all three lattice directions. In order to
isolate polymers, it is necessary to first use one of the six options above, then click on an
atom in the polymer and use the Find button in the Generated Atom Data dialog, or use
the Locate Groups option in the Transform menu. See

Dealing with Molecules, Groups and Fragments for more information about handling
groups of atoms.

Unit Cells - Molecules - Thiswill find any and al symmetry-unique bonded groups, and
can also show groups in additional unit cells. This option starts with a seed atom inside
the unit cell and finds all atoms bonded to it including those outside the central unit cell -
thus the bulk of a molecule may be outside the unit cell.

The other options below are actually identical to the options of the same name above,
except that they are applied to the centers of moleculesinstead of individual atoms. The
center, which isthe average of al atomsin the molecule, is always within the given
boundaries (thisis not guaranteed in the Unit Cells - Molecules option).

Enter Forms - Molecules - Use specified crystal faces for the boundaries.

Slice - Molecules - Isolate adlab of the structure parallel to a given face, with thickness
equal to the d-spacing (or multiple thereof).

Sphere - Molecules - Include all molecules within a given distance of agiven point (or
atom).

3.2.2.3.1 Boundary - Unit Cell
Dialog Box - called from: Boundary Dialog

This option (not intended for molecules) locates the faces of the unit cell, at various
choices of central distance.

Each of the sub-options may be chosen as the Default, which isthe boundary option
used when importing afile (Import File command in the File menu).

Y ou can choose either the primitive or Bravais cell if the lattice is non-primitive. If the
Bravaislattice is primitive, or if you elect not to use the primitive cell, the faces will be
(100), (010) and (001) and their negatives. If you choose to show the primitive unit cell
for non-primitive lattices, the faceswill be{110} and {001} for a C-cell, etc.
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The central distances for the faces depend on which Sub option is chosen. The central
distance is the perpendicular distance from the face to the center of the crystal.

If you choose the-0.5to 0.5 cell contents sub-option, the faces are at central distances of
0.5009 of the dimensions of the unit cell if the hindex is positive, or 0.499 if negative; if
hiszero, k isused; and if k is zero, | is used. Thus the volume enclosed is essentialy
that of the unit cell, with the origin at the center. Thisisthe only option which givesthe
correct number of atoms for one unit cell.

The 0.0 to 1.0 inclusive sub-option gives you faces at the full d-spacing for positive
indices, and zero for negative indices, plus asmall increment in both cases. Thusthe
"unit cell" in this case includes atoms with fractional coordinates 0.0 to 1.0 inclusive.

The 0.0 to 1.0 plus bonds sub-option adds to the central distances of the preceeding sub-
option the largest bond distance or coordination distance entered in bond and/or
polyhedron input. Thisallows for completion of the coordination of all atomsin the unit
cell. Note that atoms may be included which are not considered to be coordinated to the
atomsin the cell, and that the distances used are the limits entered in the bond and
polyhedron dialogs, not the actual bond distances.

The-1to 1 inclusive sub-option gives faces at the full d-spacing, plus asmall increment,
for both positive and negative indices. While all the previous options give one unit cell
or somewhat more, this option gives eight unit cells and somewhat more. Using this
option insures that at |east one complete molecule, or any other non-polymerized unit,
will be included.

The Central Distance sub-option sets all the faces of the unit cell at the given central
distance. Atoms"on" the faces are included.

The Get Faces button will calculate d-spacings and list the faces.

A single unit cell will not necessarily include a complete molecule or polymer; see the
L ocate Groups command in the Transform menu for information on isolating groups.

If you select this boundary option, you can later switch to the Enter Forms option; this
preserves the forms and the symmetry (i.e. no symmetry for the faces).

Note that the Trandation Limits option, with all limits set to zero, will include atoms
with fractional coordinates 0.0 to 0.99999, or in other words the same volume as sub-
option -0.5t0 0.5 cell contents, but displaced by half aunit cell on all axes.
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3.2.2.3.2 Boundary - Enter Forms
Dialog Box - called from: Boundary Dialog

This dialog may apply either to individual atoms, or to molecules (in which case the
dialog titlewill be Enter Forms- Molecules). Inthelatter case, bonded groupsin the
unit cell will beidentified and the center of each taken as the non-weighted average of
atomic positions. Then the boundaries will be determined with respect to the molecular
centers.

With this option, the most powerful of the boundary options, you can set the boundaries
of acrystal structure to be any rational faces consistent with the axial system defined in
the Title/Axes dialog. Y ou do not need to enter every individual face; you can enter any
one of the faces of aform (symmetry-equivalent set), and the remainder will be supplied
by symmetry. Y ou can use the full symmetry of the crystal class (point group), but you
may also elect to use alower symmetry (center of inversion only, or no symmetry at all)
to have more flexibility in the volume defined.

The Revise or Add Forms buttons call up the Add/Revise Form dialog for actual entry
of indices and central distance.

The Use individual atom distances option allows the boundary surfaces to be non-
planar with respect to the centers of the atoms. If you use this option, the actual central
distances for each boundary form are then entered (actually revised) during input for
each atom (Revise Atom: Central Distance Tab). However, the distance entered for each
forminthisdialogisstill necessary - it will be used: 1) Asthe default distance for the
boundary faces for each atom. Y ou will need to revise the actual boundary face distances
for each form during atom input. 2) Asthe default for display of the crystal edges. The
display forms can be given new distances or changed completely with the

Crystal Formsfor Display dialog in the Inputl menu. 3) For theinitial boundary search
limits while locating atoms. The distance entered here in the boundary option should
therefore not be too different from the distances for individual atoms to be entered in the
Revise Atom: Central Distance Tab in the Inputl dialog.

Individual atom distances are not used in the Enter Forms - Molecules option.

Thereisamaximum of six forms (not faces) if you choose individual atom boundary
distances.

Y ou can disable lattice translation on any of the structure axes, if you wish to use this
option to draw amolecule or polymer. Although it is generally simpler to use the
Trandation Limits option for polymers, you can use the Enter For ms option to show
more diverse shapes for atwo-dimensional polymer. For example with appropriate
choice of faces you can give the sheet a hexagonal shape, while the Translation Limits
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option will always give a parallelogram shape.

Y ou can use this option for molecules to isolate a section, slab, or any convex polyhedral
volume. To prevent the repetition of the structure by translation, you must disable all the
|attice trandlations. It is not necessary to specify enough faces to define a closed
polyhedron, although you will get warning messages during calculation if you do not.
For example, to effectively slice through the middle of a molecule and just view the back
half, give only the "face" (100) at central distance 0.0 (set the face symmetry to No
symmetry).

Hint : specifying a center of symmetry for boundary faces, and the smple forms (100),
(010) and (001) at central distances of about 10 Angstroms will usually give 500-700
atoms for typical inorganic crystal structures. Central distances of about 7 Angstroms
usually gives about 300 atoms. Numbers are usually smaller for organic crystals.

3.2.2.3.3 Add/Revise Form

Dialog Box - called from: Crystal Formsfor Display Dialog, Boundary -
Enter Forms Dialog

The central distance is the perpendicular distance, in Angstroms, from the center of the
structure to the faces of the form in question: the greater the distance, the greater the
number of atoms which will be included. Also, if there are many forms, the greater the
distance the less prominent the form (the smaller the area of the faces). Decimal values
may be used for the central distance, but not for the indices. Use the Next Form button
to add aform.

Keep in mind that there may be alterate orientations of symmetry elements with respect
to structure axes, and the indices of facesin a standard morphological setting may be
different from those in the setting of a particular space group. See section 1V-5 for
further details of variant orientations.

Y ou can use negative central distances to define aregion which does not include the
origin. For example, if you want to display the part of the structurefromy = 0.25toy =
0.75 in an orthorhombic crystal with b = 10.0, enter the face (010) at distance 7.5
Angstroms and the face (0-10) at distance -2.5 Angstroms. If the crystal axes are not
orthogonal, you should use fractions of the d-spacing for central distances, not axis
lengths. The Enter Forms and Default Unit Cell boundary options list d-spacings of the
forms, uncorrected for systematic absences; the Slice boundary option will give ad-
spacing corrected for systematic absences.

For hexagonal and trigonal crystals with hexagonal axes, four indices, (hkil), are
commmonly used, but one of the first threeisredundant. In ATOMS, you must omit the
third, or i index.
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3.2.2.3.4 Boundary - Slice
Dialog Box - called from: Boundary Dialog

This dialog may apply either to individual atoms, or to molecules (in which case the
dialog title will be Slice- Molecules). In thelatter case, bonded groupsin the unit cell
will beidentified and the center of each taken as the non-weighted average of atomic
positions. Then the boundaries will be determined with respect to the molecular centers.

This gives a section of acrystal structure parallel to a given face, with the thickness of
the X-ray d-spacing, or amultiple thereof. Such a"dlice" isintended primarily to
represent a growth layer, but is often useful for illustrating special structural features.

In addition to the indices of the face, you need to specify several other things. An
Alignment vector isaso necessary - when the calculation is complete, the slice will be
lying in the plane of the screen or paper and this vector will be vertical (paralel to z).
The vector must lie in the slice: avector [uvw] lying in aface (hkl) satisfies the
condition hu+ kv + lw = 0. If the default alignment vector is chosen, the alignment
vector will be taken as the intersection of the face (hkl) with the face (100), whose
indices are given by the vector cross product (hkl)x(100). If the dlice face (hkl) is (100),
the alignment vector will be taken asits intersection with (010), which is the vector
[001].

Y ou must also specify the Height and Width of the slice, parallel and perpendicular to
the alignment vector.

The location of the slice within the crystal structure must also be specified in terms of
the Offset from the origin. One can specify different offsets, or boundary locations, for
each atom (set of symmetry equivalent atoms) in case the slice is not considered to be
strictly planar (see below). The Thickness of the dliceisafraction of the d-spacing: in
most casesit should be 1.0.

Atoms lying exactly on the "upper" boundary - (the face to which the slice is defined to
be parallel) are excluded from the slice, whereas atoms lying exactly on the "lower"
boundary (the face with indices negative to the "upper” face) are included.

The Use individual atom offsets checkbox allows the boundary surface to be non-planar
with respect to the centers of the atoms. If you use this option, you should revise the
offsets for the forms during atom input - the overall offset entered in this section sets the
default values. It isalso used as the default for display of edges of the slice (the display
forms can be changed in the Crystal Formsfor Display dialog), and to determine
preliminary unit-cell search limits for atoms during the calculation; thus this overall
offset and the offsets for individual atoms should not differ too much.

Systematic absences can be used to take account of d-spacings which are a submultiple
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of those obtained solely from the cell parameters because of non-primitive lattices, screw
axes or glide planes. The subdivision of the central distance for each form is done when
the d-spacing is calculated, after OK is clicked; to see the d-spacing values you must re-
select the dialog. Y ou cannot manually edit or add absences asin pre-V4.0 ATOMS.
The Custom symmetry option does not contain information on systematic absences - if
you want to use systematic absences, you should switch to the Space Group symmetry
option.

Slice Dimensions

_ Farallel to (hkl), in Side
= plane aof screen ar _ ! -
2 - paper = | view | =
= =
T T Offset  — o—
gj Crigin
=

Width Thickness

3.2.2.3.5 Boundary - None
Dialog Box - called from: Boundary Dialog

No boundaries whatever are used if this option is chosen, nor are any tranglations
applied. That is, the atomsin the molecule are just those, and all of those, generated by
the point-group symmetry specified (or the input atoms only, if thereis no symmetry).

This boundary optionis primarily for the case in which you already have absolute
coordinates of asingle molecule. To draw a single molecule whichisin acrystal, using
fractional coordinates and other data for the crystal, use one of the Moleculesin Crystal
options in the Boundary dialog, or use the Default Unit Cell, Enter Forms or
Trandation Limits boundary option to generate a volume large enough to include the
molecule or other group, then use the Find button in the Generated Atom Data dialog
(which appears when you click on an atom) or the Locate Groups dialog in the File
menu to isolate the molecule or group. Also, you can use the Enter Forms boundary
option to use pseudo-crystal facesto isolate part of amolecule - see the last paragraph of
that section.
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3.2.2.3.6 Boundary - Translation Limits
Dialog Box - called from: Boundary Dialog

In this option, the contents of the central unit cell plus others within specified limits are
accepted. The central or "zero" unit cell contains atoms with fractional coordinates
0.00000 to 0.99999. The lower limit to unit-cell translations is normally zero or negative
and the upper limit is normally zero or positive. Disabling the translation entirely for an
axisis equivalent to setting the limits at zero. The trandlations belong to the Bravais
lattice, not the primitive lattice.

As an example of application to a crystal, putting the lower limit at -1 and the upper limit
at O for all axesresultsin abox with the shape of the Bravais unit cell, centered on the
origin and containing eight unit cells. Note that the "zero" unit cell, containing atoms
with fractional coordinates 0.0 to 0.99999, extends in the positive directions of the axes.

Thisisthe primary option for one-dimensional polymers. It is also the simplest option
for two-dimensional polymers, but the shape of the resulting sheet is limited to the shape
of the unit cell, always a parallelepiped. You can use the Enter Forms option to give a
different shape to sheets.

3.2.2.3.7 Boundary - Sphere
Dialog Box - called from: Boundary Dialog

This dialog may apply either to individual atoms, or to molecules (in which case the
dialog titlewill be Slice- Molecules ). Inthe latter case, bonded groupsin the unit cell
will be identified and the center of each taken as the non-weighted average of atomic
positions. Then the boundary will be determined with respect to the molecular centers.

This option is primarily designed to isolate a coordination sphere around a given atom,
although the center of the sphere can be at an arbitrary location in structure coordinates.

If you check the Specify structure coor dinates radio button, you must enter the
coordinatesin the x, y, z edit boxes below. If you check Input atom number, enter only
the input atom number in the edit box to theright. Then clicking the Get Coor ds. button
will fill out the coordinates (as will clicking OK).

If the structure is amolecule or polymer you should uncheck the appropriate lattice
tranlation(s), i.e. for amolecule uncheck al three.

3.2.2.3.8 Boundary - Locate Molecules in Crystal
Dialog Box - called from: Boundary Dialog

This option will locate all symmetry-unique bonded groups, or all bonded groups, within
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an integral number of unit cells. The central-ligand bonds in Polyhedra are used as well
asthe standard Bonds. Like the Locate Groups option (Transform menu), this boundary
option starts with a seed atom, in this case the first input atom, which is within the zero
or central unit cell (fractional coordinates 0.0 to 0.9999) and then finds all others
involved. If the first molecule found in thisway does not include al input atoms, the
excluded input atoms are in turn used as seed atoms, until all are located. An aert
informsyou if there is more than one molecule or group. While the seed atoms are
awaysin the central unit cell, any other atoms may be in adjacent unit cells.

If the number of atoms located exceeds the number in the unit cell the procedure is
aborted. In such acase there is presumably continuous bonding.

Y ou can locate all moleculesin the unit cell, or only symmetry-unique ones. Y ou can
also show the moleculesin multiple unit cells. In this option, the boundaries of unit cells
are alwaysthe planes at fractional coordinates 0.0, 1.0, etc. To have more control over
boundaries you can use the Enter Forms - Molecules boundary option. Note that that
option finds the center of each molecule (unweighted average of atom locations), and
then places molecules within boundary faces according to that center location, whereas
this option does not find the center of each molecule, and molecules may be placed
"inside" the unit cell even if only one atom (the seed atom) is actually inside the cell.

After initial isolation of the molecules, it may be desirable to use the Generated to Input
conversion (Transform menu). Thiswill smply make alist of the atoms located, which
issaved in the datafile, and will in the future avoid the molecul e-locating algorithm,
which can be time-consuming.

Do not use this option to isolate two- and three-dimensional polymer units. Instead, use
some other boundary option to generate a volume which you know includes a
sufficiently large number of polymer units. Then use the Locate Groups option in the
Transform menu - this option allows the specification of particular seed atoms. The

L ocate Groups option is also appropriate if there are isolated molecules aswell as a
continuously bonded framework, or polymers. See aso

Dealing with Molecules, Groups and Fragments.

Thisisapossible default boundary option for importing crystal-data files, with certain
exceptions (PDB, CCDC-FDAT, VIBRAT). If itisalowed, theinitial dialog for that
import file type will give a choice between Locate Moleculesin Crystal and

Default Unit Cell. Of course the boundary option can be changed after the import fileis
read in.

In the case of CCDC FDAT files, the "molecule" option does not use this boundary
option, rather it uses data on molecules which is already present in thefile.
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3.2.2.4 Crystal Forms for Display
Dialog Box - called from: [nputl Menu

With this option you can display an external crystal shape which is not the same as the
boundary faces for locating atoms. Y ou can even show acrystal shape for structuresin
which the boundary option is No Boundaries or Tranglation Limits.

This dialog controls the generation of the faces, corners and edges which make up the
display shape; the Crystal Edges dialog in the I nput2 menu controls colors and other
display aspects of the crystal edges - of courseit is only the edges which are actually
shown.

By default, the display shape is the same as the boundary shape for boundary options
Default Unit Cell, Enter Forms and Slice, and thereis no display shape for options
No Boundaries, Trandation Limits and Sphere. If you choose to change the display
shape, or to show one where no crystal forms are used as boundaries, the input and
revision thereof are similar to those for input of boundary crystal formsin the

Enter Forms boundary option, through the Add/Revise Form dialog

For the 2D Drawing modes of ATOMS, the edges demarking the external crystal shape
should be outside the atomic structure. Asdiscussed in Drawing Crystal and Unit-

cell Edges, an external crystal shape which liesinside or interpenetrates with the atomic
structure will in many cases be drawn incorrectly. Inthe 3D Drawing Modes,
interpenetration relations are drawn correctly.

Although this option is primarily intended for the Default Unit Cell and Enter Forms
boundary options, it can aso be used for molecules and polymers.

Note that you may have to change the Display radio buttons in the Crystal Edges dialog
in the Input2 menu, to allow the crystal shape to be displayed.

Using display faces with Cartesian symmetry input. The symmetry option

Cartesian matrices isintended primarily for molecules with non-crystallographic
symmetry. However, it can be used with "crystal" faces with certain restrictions. Y ou
must use Cartesian face coefficients or inverse intercepts, and if some of these "indices"
or the symmetry equivalents thereof areirrational they must be converted to large
integers. For example, the face (100) in atrigona or hexagonal crystal would also have
coefficients 1,0,0 in a Cartesian system with y=b (or a2), but some of the symmetry
equivalents of thisface, such as (-110) and (0-10) would have irrational coefficients. If
you enter 20000,0,0 asthe "indices' of the form, then when the indices are multiplied by
the Cartesian symmetry matrices the result will be large integral indices for the symmetry
equivaents. If you enter 1,0,0, the results would be fractions, which would be incorrectly
truncated or rounded off either to O or 1. As another example, an icosahedron may be
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drawn in either of the icosahedral groups| or Ih by giving the form indices 0,0,20000;
the indices 0,0,1 would not work because many of the 19 faces equivalent to this one
haveirrational indices.

Using integers with up to four or five digits (99,999) gives adequate precision for the
calculations involved in determining the external crystal shape.

3.2.2.5 Atoms (Input)
Dialog Box - called from: [nputl Menu

Y ou can choose to enter each atom interactively, or ATOMS can read some or all of the
atom parameters from atext file, supplying defaults for the atom types, radii and display
colorsif desired. You can typein the name of thisinput file, or browse to open thefile.
The file must contain certain lines specifying the which parameters are to be read in and
which set to default values (see Atom Parameter Files for specifications).

If you do not use afile, use the Revise or Add Atoms buttons to access the Revise Atom
dialog. You can aso double click on any line to revise that atom.

Thelist of input atomsin thisdialog may not show non-ANSI charactersin the atom
label correctly because this list must be written in a fixed-width font (Courier or
Monaco). Inthe Revise Atom dialog charactersfor non-ANSI typefaces should be
displayed correctly, but at afixed font size.

To calculate bond distances and angles, for use in the bond and polyhedrainput or just
for general information, use the Coordination button. It is not necessary to have
calculated the structure to use this option, or even to have selected the boundary option,
but you must have entered the correct structure axes or unit cell and symmetry.

The Vectors dialog called up by the Vector s button is for specification of general
properties of atomic vectors, for use in displaying magnetic symmetry or vibrational
modes. The vectorsfor the individual input atoms are specified in the Revise Atom
diaog.

The T. Factor s button is for adding temperature factors to all atoms, or deleting them
al. Toview or modify temperature factors for individual atoms, select that atom to call
up the Revise Atom dialog, and select the Temperature Factor tab in that dialog.

Z-Matrix. Thisallows construction of a molecule from a z-matrix or table of bond
lengths and angles instead of using Cartesian coordinates.

Hex->Cart and Cart-Hex buttons. These are for converting coordinates of atoms, and
vectorsif present, between the current hexagonal axes and unit Cartesian axes. Thusif
your current axes (Title/Axes dialog in the Inputl menu) are unit Cartesian, change them
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to the desired hexagonal/trigonal axes (a= b, apha = beta= 90, gamma = 120) before
converting. You will be warned if the current axes are not hexagonal. Only the lengths
of the axes are used in the conversion, so if your intention isto convert from unit
Cartesian to unit hexagonal you do not need to reset the axes before conversion. The
axes themselves are not automatically reset after the hexagonal to Cartesian
tranformation - do this manually in the Title/Axesdialog .

Note that starting with V6.2 of ATOMS, it is not necessary for crystals with trigonal or
hexagonal symmetry to use hexagonal axes - in the calculation, the type of axesis
detected and the symmetry matrices are converted to unit-Cartesian form. Types of axes
other than hexagonal/trigonal or Cartesian should not be used for hexagonal or trigonal
crystals.

Trandateall atoms. Thiswill add the given quantities to the coordinates of al atoms.
Thisistypically used for centering a molecule on a given atom (enter the negatives of the
coordinates of that atom). It isnot normally appropriate for crystals.

Solid Solutions. Thereis no provision in ATOMS for directly showing solid solutions as
fractional atoms. However, it is possible to use the Randomize option in the Atoms -
Global diaog inthe Inputl Menu to change the colors or other properties of selected
groups of atoms on arandom basis. Of coursg, it isalso possible to modify individual
generated atoms manually, after execising the Generated to Input option in the
Transform Menu.

3.2.2.5.1 Revise Atom, Temperature Factor Tab
Dialog Box - called from: [nput Atoms Dialog

See the Basic Tab for most normal aspect of individual input atoms, the
Central Distance and Slice Offset tabs for adjusting boundaries for individual atoms, and
the Vector Tab for atomic vectors for magnetic moments or vibrational displacements.

The temperature factor type, according to ORTEP, must be selected with the radio
buttons. The most common types are O for anisotropic beta; 6 for isotropic B; 7 for a
sphere of constant radius, 8 for anisotropic u, and 10 for isotropic U (not a standard
ORTEP type).

The instructions and help for some releases of pre-V5.0 ATOMS may be incorrect in
stating that type 7 indicates isotropic U. Actually, type 7 should be a sphere of arbitrary
radius. Importing files with isotropic U may in some cases have incorrectly assigned
type 7 to these atoms (although in most cases these should have been converted to
isotropic B). Thuswhen ATOMS reads apre-V5.0.STR file with type 7 temperature
factors, you will be asked if you want to change these to type 10.

| sotropic values are entered in the first box; if the second or b22/U22 valueis zero, the
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atom will be considered to be isotropic.

3.2.2.5.2 Revise Atom, Slice Offset Tab
Dialog Box - called from: [nput Atoms Dialog

See the Basic Tab for most normal aspect of individual input atoms, the

Temperature Factor Tab for modification or entry of temperature factors, the

Central Distance tab for adjusting boundaries for individual atomsin the Enter Forms
boundary option, and the Vector Tab for atomic vectors for magnetic moments or
vibrational displacements.

This applies only to the Slice boundary option.

The default value is the offset entered in the Slice boundary option.

3.2.2.5.3 Revise Atom, Vector Tab
Dialog Box - called from: |nput Atoms Dialog

See the Basic Tab for most normal aspect of individual input atoms, the
Temperature Factor Tab for modification or entry of temperature factors, and the
Central Distance and Slice Offset tabs for adjusting boundaries for individual atoms.

Atom vectors, for magnetic spin direction or atomic displacementsin vibrational modes,
are specified in the crystal or structure coordinate system. The length is specified
independently from the vector giving the orientation.

Vectors are drawn by adding pseudo-atoms to the list of generated atoms, and adding
pseudo-bonds between these pseudo-atoms and the real atom to which the vector is
attached. Thusif the length or orientation are changed the structure must be

recal culated, rather than just replotted. Also, since the length is computed as the visible
cylindrical part of the vector, if you change atomic radii the vector lengths will change
unless the structure is recal cul ated.

3.2.2.5.4 Revise Atom, Central Distances Tab
Dialog Box - called from: [nput Atoms Dialog

See the Basic Tab for most normal aspect of individual input atoms, the
Temperature Factor Tab for modification or entry of temperature factors, the

Slice Offset tab for adjusting boundaries for individual atomsin the Slice boundary
option, and the VVector Tab for atomic vectors for magnetic moments or vibrational
displacements.

This tab specifies central distances for an individual atom in the Enter Forms boundary
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option.

Only six forms are alowed. The default values are the central distances entered in the
option Enter Forms boundary option.

3.2.2.5.5 Revise Atom, Basic Tab
Dialog Box - called from: |nput Atoms Dialog

See the Temperature Factor Tab for modification or entry of temperature factors, the
Central Distance and Slice Offset tabs for adjusting boundaries for individual atoms, and
the Vector Tab for atomic vectors for magnetic moments or vibrational displacements.

Label. Each atom may be assigned alabel of up to 6 characters. Labelsin ATOMS may
not contain any embedded blanks. Any embedded blanks or leading blanks in labels will
be converted to underscores. Trailing blankswill be stripped. These labels may now
contain non-ANSI characters - see Character Sets. A superscript in roman numerals
giving the symmetry operation which generates each atom may optionally be appended
to the label on the drawing - thisis selected in the Atom L abels dialog (Display menu).

Fractional coordinates. For crystals, thex, y and z coordinates should be in fractions
of the unit cell. However, if you are drawing a molecule and have chosen unit Cartesian
reference axes, the coordinates should be in Angstroms.

Irrational coordinates. In some hexagonal and trigonal space groups there are specia
positions with coordinates like 2/3, 1/3, 1/6 etc. Such irrational coordinates should be
entered to at |east the fifth decimal place - for example 0.66667 instead of 0.67 or 0.667.
ATOMS must apply finite tolerance in the generation of all atomic positions, and the
second form is not precise enough - multiple atoms will be generated instead of one atom
on the special position.

Type. The atom type is used when locating bonds and polyhedra; it is usually expedient
to enter the same type for al atoms which are bonded similarly (e.g. all carbons, all
silicons, all six-coordinated cations, all oxygens, etc.) to save effort in defining bonds
and polyhedra. The atomic number can usually be used for the type, although there are
situationsin which different type numbers should be used for the same element (see
Polyhedra). For diffraction calculations (Powder, Precession) the type number must be
the atomic number, or a number which gives an entry to the scattering factor table,
modulo 100. That is, type numbers 6, 106, 206, 306 etc. will be read as atomic number 6
(carbon). Thusit is recommended that whenever possible type numbers be the atomic
number, with added 100's if necessary to differentiate bonds and polyhedra.

Radius. Each atom will be represented by a sphere of thisradius, unlessitisinvolvedin
apolyhedron defined in the polyhedrainput. If an atomis given radius 0.0, it will never
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be plotted as a sphere and will only appear (asacorner) if it isinvolved asligand in a
complete coordination polyhedron. Bonds to such atoms will not be plotted unless the
atoms are ligands in polyhedra. Thusif you want to show only polyhedra and never the
individual atoms, give radii of 0.0 to al the atoms which may be involved, either as
central atoms or asligands. Even if you use positive radii for the atoms, you can switch
off display of the atoms in incomplete polyhedra with a checkbox in the Polyhedra
dialog (Inputl menu). However, using aradius of 0.0 omits calculation of bonds to
atoms in incomplete polyhedra, which can improve computation time and conserve
memory.

If you do not want to show an atom at all, but want to show the bonds to the atom, that is
draw awire-frame model, enter a negative number for the radius. The absolute value of
the radius can still be used in the Generate Bonds from Atomic Radii option. If atoms
with negative radii areinvolved in polyhedra, they will be treated in the same way as
atoms with positive radii.

For ball-and-stick drawings of typical structures, radii of about half the ionic or covalent
radii usually work well. For space-filling or interpenetration the covalent radii can be
multiplied by a number larger than one. All radii can be changed simultaneously by a
given factor with the Atoms - Global dialog in the Input1 menu.

Colorsand patterns/shades. Each atom always hasarim and afill, the colors for
which are specified independently. Rims are turned on and off, and their widths are set,
in the Line Widths dialog in the Input2 menu. Shading applies only to fills. See

Input Colorg/Patterns/Pens for general aspects of input.

If you have checked the Use individual atom distances box in the boundary option
Enter Forms, or the Useindividual atom offsets box in the boundary option Slice, you
should use the Set Boundary For ms button (Central Distances for Individual Atom or
Slice Offsets for Individual Atom dialogs) to correct the central distance or offset for
each form, up to six forms for distances. These distances or offsets are the ones which
are actually used for the boundaries, but the central distances or offsets entered for each
form in the boundary option are used for display of crystal shape and to set up the initial
search intervals, so the individual distances or offsets should not be too different.

Shubnikov. This checkbox determines whether the equivalents of this particular input
atom show vectors or other Shubnikov indicators (+ or -). Set the orientation of atomic
vectorsin the Vector Tab, and set the overall properties of vectorsin the Vector dialog,
called from the Input1 menu or the [nput Atoms dialog.

Protein. Thisonly appliesto structure input from Protein Data Bank files. It callsup a
dialog (Protein) which gives protein specific information about the atom.

LineWidth. If the Use individual box for atomsin the Line Widths dialog (I nput2
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menu) is checked, the width specified here will be used, rather than the overall valuein
the Line Widths dialog.

Hachur e patter ns are macroscopic patterns of lines which may be drawn within the
outlines of atoms. These are useful for black-and-white output in situations where
shading patterns are not reproduced very well, or amore definite pattern differentiation
isdesirable. The patterns are smply drawn in 2 dimensions and do not vary with
attitude of the surface like the hachure patterns for Polyhedra.

Hachure patterns are not used in the 3D Drawing Modes, and this entire section is not
applicable to 3D display/output.

The Spacing is the distance between lines, in Angstroms. The colors/shades of the
patterns are same as those selected for the outlines or edges (above), and the widths are
also as selected (above) for each individual atom type, or as selected overall in the
Line Widths dialog (Input2 menu).

If the Use shade box is checked, the gray shade selected in this dialog will also be
applied asfill, in addition to the pattern, in black-and-white non-shaded output. This
choice overrides the Use initial patter ns box in the Shading dialog (Input2 menu).
Shading, as selected in the Shading dialog (Input2 menu) is applied independently of
hachure patterns, and it is possible to have both, either in color or black and white. In
color display and output, the fill color (above) is always used.

3.2.2.5.6 Coordination of Atoms
Dialog Box - called from: Atoms Dialog

This controls computation of the list of bond or interatomic distances and angles
centered on one or al of the input atoms. The radio buttons determine whether distances
and angles are computed for all input atoms or only the one currently selected in the

Input Atoms dialog.

Only 32 atoms in addition to the central atom are allowed in each coordination sphere, so
the distance limit for central-ligand should normally not be more than about 4
Angstroms. Anglesare only calculated for ligand pairs at less then the ligand-ligand
limit; if you want to determine angles for atoms on opposite sides of the central atom,

the ligand-ligand limit should be twice the central-ligand limit.

The results of the distance and angle calculations are written to afile called
BONDS.ATD, in the home directory (see File Types), and then shown in a Text window
(see Types of Windows). Inorder for this Text window to operate properly, ATOMS
exits from the |nput Atoms dialog from which the Coor dination dialog was originally
caled.
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From this Text window, return to the Graphics window and the ordinary operating mode
of ATOM S with the Window menu.

3.2.2.5.7 Construct Molecule from Z-Matrix
Dialog Box - called from: Atoms Dialog

With this dialog you can construct a molecule or structure fragment from a table of bond length
and angles. The table, called a z-matrix, is widely used in molecular science, and you can read
files in this form from other sources or write files for use in other software.

Action button section

The buttons at the top of the dialog indicate actions to be taken after the z-matrix at the bottom is
filled out

Add will add the new generated atoms to the atoms already in the Atoms (Input) list. If the
structure axes are not already Cartesian they are changed to Cartesian.

Replace will remove all the old atoms from the Atoms (Input) list and insert the new generated
atoms.

Add and Replace will change the structure axes to Cartesian, since all calculations with z-
matrices assume Cartesian coordinates, but most other settings, such as symmetry, boundary
option and others in the Inputl menu, will not be changed

Read will read a file containing a z-matrix and insert the contents into this dialog. There should
be no title or other extraneous lines, and each line, one line per atom, should contain the fields
Label, Bond Connect, Bond Distance, Angle Connect, Bond Angle, Dihedral Connect and
Dihedral Angle. Note that atom Type is not in this sequence, but the atom type or atomic number
may be on the end of the line. The fields should be separated by spaces, commas, colons or
semicolons.

Write will write a file as described in the previous paragraph, with one line for each atom, and
with the type number at the end of the line. The Orientation (below) will be added after the
atoms.

Show will do a conversion from z-matrix to Cartesian coordinates and display the z-matrix and
the results in a Text window.

You can cut-and-paste blocks of atom lines in the z-matrix by using the Read, Write and Show
buttons - for example you can save a file from the Text window (Show) after suitable editing,
then Read it back.

Orientation section

The Orientation section allows the molecule or fragment to be located and oriented in any
desirable way. It always refers to the first three atoms in the z-matrix list. Coordinates are
always Cartesian.

The Position gives the x, y and z coordinates of the first atom. By default they are 0,0,0.

The Atoms 1-2 vector gives the vector from the first to the second atom. By default it is 1,0,0,
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which puts the second atom on the x-axis at the given bond distance from the first atom.

The Atoms 1-2-3 plane gives the normal to the plane containing the first three atoms. The
vector from atom 2 to atom 1, the vector from atom 2 to atom 3, and this normal form a right-
handed system. By default this normal is 0,0,-1 which puts the third atom in the x-y plane with a
positive angle giving a positive y-coordinate for atom 3 (assuming standard placement and
orientation for atoms 1 and 2).

The vectors need not be normalized; they will be normalized during the transformation.
Z-Matrix section

Each line in the matrix below refers to an atom. You can select each atom by clicking on the
number to the left, and the entries are acted upon by the Move Up, Move Down (move the line
within the list), Insert and Delete buttons. The up and down arrows to the right scroll the entire
list up or down if there are more atoms than the list can hold at once.

The atoms are positioned with respect to other atoms in the list. The first three atoms are
oriented and positioned as described above in Orientation, and all other atoms are placed with
respect to these three.

Each line describes the positioning of a new atom (1) with respect to up to 3 atoms already in the
list (2, 3, and 4).

The Label and Type give the ATOMS label and type; the type is normally the atomic number. If
the type is 0, ATOMS will attempt to determine the atomic number (or other type number) from
the first two characters of the label.

Bond Connect: the number in this list of the atom (2) to which the new atom (1) is directly
bonded.

Bond Distance: distance in Angstroms from 1 to 2.

Angle Connect: the number in this list of an atom forming an ordinary angle 1-2-3.

Bond Angle: the value of the angle 1-2-3 in degrees.

Dihedral Connect: the number in this list of an atom forming a dihedral angle 1-2-3-4. The
dihedral angle is the angle between the normals to the plane 1-2-3 and the plane 2-3-4. This
angle (sometimes referred to as tau) is conventionally given values from 0 to 180 and 0 to -180
degrees, and the sign is positive if, viewing the angle along the bond 2-3, with 2 nearer the
observer than 3, the angle from the projection of 2-1 to the projection of 3-4 is traced in the
clockwise sense (definition from Wilson, Decius and Cross, Molecular Vibrations, 1955, p 60).
Dihedral Angle: the value of the angle between the normals to the plane 1-2-3 and the plane 2-
3-4 in degrees.

3.2.2.5.8 Add Hydrogens
Dialog Box - called from: Atoms Dialog

This option currently will attempt to identify carbon, nitrogen and oxygen atoms which

© 2011 Shape Software



ATOMS Menus and Dialogs 101

should have hydrogen attached. These atoms must have atom types 6, 7 and 8
respectively.

The first option will actually add hydrogen atoms to the list of input atoms - the new H
atomswill immediately follow the atom to which they are added.

The second option, "Change types..." will not actually add atoms, it will simply change
the atom type of the H-deficient atom to indicate the deficiency. The type number of
carbon atoms will be changed from 6 to 106, 206 or 306 respectively if the atom lacks 1,
2 or 3 hydrogens and similarly for N and O. Thisoption isintended specificaly for files
which will be imported into the program VIBRATZ, and for vibrational modelsin which
the weights of the C, N or O atoms are "corrected” for the attached hydrogens, rather
than dealing with the H atoms explicitly.

Orientation. When adding two hydrogens to a double-bonded carbon or to a nitrogen the
orientation is quasi-random with respect to rotation about the other bond vector, and
likewise when adding three hydrogens to a singly-bonded carbon atom. When adding
one H to an oxygen atom the orientation of the plane of the X-O-H angleis also quasi-
random. "Quasi-random" means that the hydrogens are added in afixed orientation with
the C-X vector (if the atom in question is a carbon) rotated to [001], then the groupisin
effect rotated back to its actual orientation in the structure. H20 groups (water) are fully
random in that two random rotations are applied.

Symmetry. The generated hydrogen atoms may not be consistent with symmetry, which
will be indicated by an excess number of H atomsin the complete structure.

At thistime the algorithms for locating hydrogens are very ssmple, based only on the
number of atoms and bond lengths in the first coordination sphere. The procedure was
developed specifically for protein structures where there are only alimited number of
configurations of nitrogen in particular. The algorithms may be corrected and expanded
asnecessary. If the hydrogen location in a structure isincorrect or ambiguous, please
send the structure file (.str file) to support@shapesoftware.com, with alist of the input
atoms, by number if necessary, which are believed to be incorrect.

3.2.2.6 Polyhedra
Dialog Box - called from: [nputl Menu

This lists the current polyhedra. Click on individual itemsin the list, then on the buttons
to add, modify or delete polyhedra. The Revise and Add Polyhedra buttons call up the
Polyhedron Data dialog.

To calculate bond distances and angles, for use in bond and polyhedrainput, use the
Coordination button in the Input Atoms dialog.
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If the Show back edges dashed box is checked, the invisible back edges of polyhedra
will be drawn as dashed lines - the dash parameters are set in the Crystal Edges dialog.
Polyhedra are still opague. This applies to unshaded polyhedra only.

The possibilities for showing polyhedra are diverse, depending on the Drawing mode. It
may be necessary to select settingsin the 3D Polyhedra dialog and also the

Ellipsoid Parameters dialog aswell asthisdialog. These two other dialogs are
accessible directly from this one with buttons.

The 3D parameter s button callsup adiaog (3D Polyhedra) for specification of
polyhedron properties unique to the 3D Drawing modes. Thisincludes optionsto draw
the polyhedron faces as transparent and to show the central atom and interior bonds. In
the 3D Polyhedra dialog, and also the Ellipsoid Parameters dialog, there is an option to
show corners and/or central atoms of polyhedra as thermal ellipsoidsin the

3D Drawing mode.

The Ellipsoid Parameter < button calls up the Ellipsoid Parameters dialog. In the
Ellipsoid Model mode (which mimics ORTEP) polyhedra are never shown with actual
flat faces, but thereis an option in the Ellipsoid Parameters dialog to draw the ligand-
ligand "bonds" or polyhedron edges, and a so the central-ligand "bonds" as standard
ORTEP bonds.

The Show ligands as spher es group has three options. If the None button is checked,
only the polyhedron faces are shown and ligands are represented as points at the corners.
If one of the other boxesis checked, ligands are drawn as spheres. Inthe

2D Drawing mode, this option is an approximation in that junctions between the atoms
and the polyhedra are straight lines. In the 3D Drawing mode, junctions are always
correct. For spherical atoms (not thermal ellipsoids) you can use the Atom radii entered
for each input atom, or you can use a Single radius for al ligands, entered in the edit
box to the right of thisoption. The Single radius option is not applicable to elipsoids in
the 3D Drawing mode; if either the Atom radii or Single radius option is selected,
ellipsoids will be shown at polyhedron corners. If atoms are not shown at polyhedra
corners (None option), the bonds to such corners are always cylindrical, not tapered as
they could beif they were to ellipsoids. This option does not function as well when
Hachure patterns (Polyhedron Data dialog) are used - the junctions of the polyhedron
corners with the spheres are not correctly drawn.

The Test for incomplete polyhedra group determines how atoms in incomplete
polyhedraare handled. Asdetailed in Generated Atom Data, when ATOMS locates
polyhedra, it assigns a certain plot code (5) to atoms which are parts of polyhedrawhich
have fewer than the specified number of ligands. Thiswill always be done, even if the
option selected is No test, and the atoms thus flagged can either be omitted or plotted as
spheres, depending on the setting discussed in the previous paragraph. However, some
further screening of possible polyhedral atoms can be made, to eliminate display of
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potential ligands which are not found to bond to any of the specified central atoms within
the given boundaries. While locating polyhedra, ATOMS can make alist of either the

I nput atom number s or the Atom types involved (as ligands) in polyhedra. Then after
al polyhedra are located, the generated atom list is searched to find those atoms with the
specified numbers, and these atoms are then marked with plot code 5, i.e. as belonging to
incomplete polyhedra.  The normal option for crystalsis I nput atom numbers.
However, this option is of no use when the structure is of type Input=Generated, or for a
molecule with no symmetry, since every input atom corresponds to a single generated
atom. Thusthe default for Input = Generated isNotest. The Atom types option
works well when each input atom type (normally the atomic number) plays only one
structural role, i.e. is either always a polyhedron ligand or not. However when an atom
type can be a polyhedral ligand in some cases, and anon-ligand in others (for example
when oxygen atoms are ligands in phosphate radicals or other groups and also are
present in water molecules or hydroxyls), the atoms which are non-ligands will be
incorrectly omitted. When using the Atom types option, it may thus be necessary to
assign special types to atoms with different structural roles, for example 8 for oxygens
which are in phophate (or other) groups; 108 for hydroxyls; and 208 for waters.

3.2.2.6.1 Polyhedron Data
Dialog Box - called from: Polyhedra Dialog

Polyhedra are defined by specifying the Coor dination number, and the Types of the
central atom and the coordinating atoms or ligands. Note that atom types are used, not
individual atom numbers, so that chemically similar atoms may be grouped. It isusually
convenient to use atomic numbers for the types. Y ou must further specify the Maximum
distance for the bonds from the central atom to the ligands.

If the coordination number is given as 3 or larger, only complete polyhedra are identified
and displayed; that is, both the central atom and all the ligands must be within the
structure boundaries defined in the Boundary option. Atoms belonging to incomplete
polyhedra can be displayed as spheres with the radii assigned in the Revise Atom dialog,
unlesstheir atomic radii are zero - then they will be marked as permanently non-plotting.
The display of these atomsis controlled by a checkbox in the Polyhedra dialog. If more
coordinating atoms are found than specified within the given distance, an error message
is shown and the polyhedron is skipped.

If you do not know the coordination number or the bond distances, you may wish to
make one or more runs with the coordination number set to zero. In this case, al
polyhedrawith three or more ligands within the bond-distance limit will be accepted, and
you can examine the Calculation Output to see what the proper coordination number or
distance limits should be.
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If you want to show polyhedrawhich do not have central atoms, it will be necessary to
enter dummy central atoms. The best way to do thisisto take the average of each
coordinate for all the atomsin one polyhedron.

In 2D Drawing modes, polyhedra are always opaque; if you wish to show only the
skeletons, you can define bonds among the ligands (next section). Once the ligands are
located, central atoms are never shown in 2D Drawing modes.

If anominally planar coordination is not strictly planar, within tolerances, it will be
shown as a polyhedron. In 2D Drawing modes, strictly planar polyhedrawill vanish
when seen edge-on if display of rimsor edgesis not turned on with the Rims dialog in
the I nput2 menu.

In 3D Drawing modes, planar polyhedra have finite thickness. There are also several
options for showing polyhedra as opaque, translucent or skeletal (see 3D Polyhedra).

Colorsand patterns/shades. Each polyhedron may have arim and afill, the colorsfor
which are specified independently. Rims are turned on and off, and their widths are set,
in the Line Widths dialog in the File2 menu. Shading applies only to fills. See

Input Colorsg/Patterns/Pens for general aspects of input.

LineWidth. If the Use individual box for polyhedrain the Line Widths dialog (Input2
menu) is checked, the width specified here will be used, rather than the overall value in
the Line Widths dialog.

Hachur e patter ns are patterns of lines based on a square grid which may be applied to
polyhedra. The patterns are drawn on the surface of each polyhedron facein 3
dimensions (not simply applied in 2 dimensions to the projection of the face), so that
they give someillusion of depth or shading. Thus they enhance the 3-dimensional
appearance of the drawing while at the same time allowing differentiation of the
different types of polyhedra. Differentiation of polyhedratypesisamost impossible
using gray shades (above) alone.

Hachure patterns are not used in 3D _Drawing modes, and this entire section is not
applicable to 3D display/output.

The Spacing is the distance between lines, in Angstroms. The colors/shades of the
patterns are same as those selected for the outlines or edges (above), and the widths are
also as selected (above) for each individual polyhedratype, or as selected overall in the
Line Widths dialog (Input2 menu).

If the Use shade box is checked, the gray shade selected in this dialog will also be
applied asfill, in addition to the pattern, in black-and-white non-shaded output. This
choiceisoverridden if the Useinitial patter ns box is checked in the Shading dialog
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(Input2 menu) - in that case, gray shades or dot patternswill always be applied.

In color display and output, thefill color (above) isawaysused. Shading, as selected in
the Shading dialog (Input2 menu) is applied independently of hachure patterns, and it is
possible to have both either in color or black and white. If hachure patterns are used in
conjunction with shading for atoms and bonds, the illumination vector (Shading dialog)
should probably be 1,0,0, asthisisthe effective illumination direction for hachures.

Differentiating polyhedra. The size and shape of different polyhedra are not generally
sufficient to allow identification of the polyhedron typein adrawing. There are severa
different display attributes of polyhedra which may be varied alone or in combinations to
alow differentiation.

1) Color. Thisiscertainly the best option when it is available, especially when using
shading, except that a significant fraction of people are at least partially color-blind.

2) Hachure patterns. Both the pattern itself and the scale can be varied.

3) Gray shade of fill (black-and-white). This does not usually work well in combination
with shading.

4) Width of edges.

5) Gray shade of edges. Lines of one dot width (width 0.0 in this dialog) are always
black.

3.2.2.7 Bonds

Dialog Box - called from: [nputl Menu

Thislists the current bonds. Click on individual itemsin the list, then on the buttons to
revise, delete or add bonds. The Revise and Add Bonds buttons call up the Bond Data
diaog.

To calculate bond distances and angles, for use in bond and polyhedrainput, use the
Coordination button in the Input Atoms dialog.

Y ou can aso click the Generate from Radii button, to derive bonds automatically.

PDB quick bonds check box. In the case of Protein Data Bank (PDB) structures,
ATOMS is able to use the information on residues which is present in the file, aswell as
CONNECT records, to greatly decrease the time required to locate bonds, compared to
standard ATOMS methods for crystals. However, if some bonds are missing or
duplicated it may be necessary to uncheck this box.
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Color mode. For stick bonds you can use either the color specified in the Bond Data
dialog for the entire bond, or the atom colorsin a haf-and-haf arrangement.

3.2.2.7.1 Bond Data
Dialog Box - called from: BondsDiaog

Bonds are specified by giving the Types of the two atoms involved - in some cases, such
as carbon-carbon bonds, these may be the same. The Minimum, aswell as Maximum
distance must be specified; this allows differentiating bonds to the same atom. A stick
bond has the shape of acylinder, but if the Radius of thiscylinder is entered as zero,
then the bond is drawn as asingle line. The width of this single line, or the width of the
lines defining the outline of a stick bond, is normally one dot in screen display or dot-
matrix plots, but this can be changed - for al bondsin the Line Widths dialog in the
Input2 Menu, or if desired for each input bond (see below).

If the Radius of the bond is greater than the radius of either of the two atoms involved,
the result will depend on the Model Mode. In Standard mode, the bond will be shown
with both ends terminated by a straight line. In Ellipsoid mode, the bond may normally
be absent entirely. In 3D Drawing Modes, the bond will be shown as a half-cylinder.

Bonds to atoms in polyhedra can only be drawn to ligands defined in the Polyhedra
input, not to central atoms.

If you wish to show only bonds, not atoms (wire-frame model), you should enter
negative radii for the atoms.

If the I nter-molecule box is checked, this bond specification will not be used in locating
molecules or groupsin either the Moleculesin Crystal boundary options, or the Find
button in the Generated Atom Data dialog or Locate Groups dialog. Intermolecule
bonds are drawn normally by default, but they can be dimmed, highlighted or hidden
(Atom/Bond Plot States dialog in the Input2 Menu, or Dialog Bar - Right)

In 2D Drawing modes, the interpenetration relationships of cylindrical bonds with each
other, and with the polyhedra to which they are attached, are not drawn accurately. This
affects wire-frame atoms (atomic radius negative), and bonds from polyhedral ligandsto
other atoms. The affect of thislimitation is mimimized if the bond radii are kept
relatively small. In 2D Drawing modes, if atoms are interpenetrating (interatomic
distance less than the sum of the radii), no sticks or lines will be shown, but it is still
necessary to specify abond between the atom types so that the junctions will be handled
properly (if no bond is specified, the atom in front will simply be drawn over the other
one). Theradius and colors of the bond are immaterial for interpenetrating atoms. In
3D Drawing modes, interpenetration relations are always drawn correctly and if atoms
are known to interpenetrate it is not necessary to specify bonds between them.
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Colors and patterns/shades. Each bond may have arim and afill, the colors for which
are specified independently. The color for asingle-line bond is the same as the rim color
for acylindrical bond. Rims are turned on and off, and their widths are set, in the

Line Widths dialog in the Input2 menu. Shading applies only to fills. See

Input Colorsg/Patterns/Pens for general aspects of input.

LineWidth. If the Use individual box for bondsin the Line Widths dialog (I nput2
menu) is checked, the width specified here will be used, rather than the overall valuein
the Line Widths dialog.

Individual input bonds may be dashed if they are single-line (radius 0.0). The length of
the dashes is specified in the Crystal Edges dialog.

3.2.2.7.2 Generate Bonds
Dialog Box - called from: |mport File, Bond Data dialog

Thiswill derive a set of bond specifications for the atoms currently in memory, which
may have just been read in from an import file.

Sour ce of atomic radii. Starting with V4.0, ATOMS can use a constant set of radii in
an internal table (read in from the RADII file), rather than the given input atom radii
(whichisstill an option). If you choose to use the table, the element can be identified
either using the first two characters of the label, or using the type number which is
assumed to be the atomic number. If you choose to use the input atom radii, the atom
list is scanned and the radius is taken from the first occurrence of each atom type. That
is, if input atom number one istype 1 with acertain radius, and input atom number seven
(for example) isalso type 1 but with adifferent radius, only the radius of input atom
number one will be used.

The Maximum distance as fraction of radii sum field specifies the upper distance limit
for each type of bond. Thiswill be the sum of the radii of the two atom types, multiplied
by the number entered in thisfield. The minimum distance will be 0.2 Angstroms. If
you choose to use the current input atom radii, the factor must take account of any
reductions in the atomic radii from values which cause the atoms to almost touch.

If the Delete old bonds box is not checked, the new bond list will smply be added to the
old list.

The All pairsg/Cation-anion only radio buttons allows skipping many superfluous
combinations, i.e. atoms which never bond with each other. Inthe RADII file, each
atom is assigned a code indicating whether it isacation (1), an anion (-1), non-metal (0)
orinert (3). A "non-meta” is considered to be able to bond with all other types except
inert atoms (rare gases). At the time of generating bonds, the codes for the two input
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atoms in question are added together, and any resulting values with absolute value
greater than 1 arergjected. The codesin the RADII file are by default set up primarily
for inorganic structures, and if you want to use this option for organic structures, they
may need to be modified.

Whether or not this option is used, superfluous bonds can still be removed in the Bonds
dialog in the I nput1 menu.

In the Bond radii group of radio buttons, you can choose to make the bond radius a
fraction of the radius of the smaller atom of the two in the bond; or to enter a constant
radiusfor al bonds. A constant radius value of 0.0 will result in single-line bonds.

The Default Color s button will call up adialog similar to that for individual input bonds
(Bond Data ), but the atoms types, distance limits and radius will be missing.

If the Hydrogen bonds box is checked, alist of Specifications will be used to set up
bonds for atoms involved in hydrogen bonding. Thiswill result in two input bonds for
each pair (H-other) which may beinvolved in hydrogen bonding. If the Hydrogen
bonds box is not checked, any bonds involving hydrogen should be of the normal
covalent type.

3.2.2.7.3 Hydrogen Bond Specifications
Dialog Box - called from: Generate Bonds Dialog

The current hydrogen bond specifications are given in the list box - edit the variables for
the selected specification in the edit boxes on the right.

If the Hydrogen bonds box in the Generate Bonds dialog is checked these specification
will be used to set up bonds for atoms involved in hydrogen bonding. ASATOMS
considers each possible pair of atomsin theinput list, it will test the type numbers
against thosein thislist

If one member of the pair has type number 1 (hydrogen), 99 (deuterium) or 98 (tritium),
and the other member of the pair has one of the type numbersin thislist, hydrogen bonds
will be set up. If both members of the pair have type numbers indicating hydrogen, no
bonds at all will be set up. Note that atomic numbersin thislist (non-hydrogen) do not
need to be atomic numbers, but hydrogen itself (and deuterium and tritium) must have
the default atomic numbers.

Two separate input bonds will be set up for each hydrogen-other pair: ashort or strong
bond in which the other (the atom in thislist) is the hydrogen donor in a hydrogen bond;
and along bond or hydrogen bond itself in which the other atom is the acceptor. For
normal, strong (non hydrogen) bonds between H and the other atom, the minimum
distanceis 0.2 Angstroms and the maximum bond distance is the minimum distance
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(Min) in thistable. For hydrogen bonds between H and the other atom, the minimum
bond distance is the minimum distance in this table and the maximum bond distance is
the maximum distance (M ax) in thistable. That is, the Min value is the boundary
between donor bonds and acceptor bonds, and the M ax distance is the longest possible
acceptor bond.

The Intermol (Intermolecular) flag determines whether bonds will be considered to be
intermolecular (see Bond Data dialog) for purposes of locating molecules.

Any input bond specifications set up with this option can always be edited through the
Input Bonds dialog.

3.2.2.8 Atoms/Bonds - Global, Which Atoms/Bonds Tab
Dialog Box Tab - called from: |nputl Menu

This tab specifies which atoms will be changed: it applies to input atoms, not generated
atoms. Y ou can change parametersfor all atoms, for al atoms of agiven type, for a
sequence of atoms, or for all atomsin agiven fragment (if there is more than one
fragment - see Multiple Structures ) in the Transform menu. Y ou can also change
parameters for al bonds.

Randomize. Thisallowsyou to modify only acertain fraction of the input atoms
chosen, on arandom basis. Thisisintended primarily for representing solid solutions -
you can modify the colors and/or sizes of individual input atoms. Before doing this, it
will normally be necessary to do the Generated to Input option in the Transform Menu,
so that all atoms become input atoms. If only atoms on a certain site are to be modified,
it may be necessary to change the atom type of this site before transforming

Generated to |nput.

A solid solution with only two types of atom is straightforward, but more than two
occupants will require some pre-calculation and repeated use of thisdialog. Since all
atoms present are affected, the fraction which is entered in this dialog must be with
respect to the new occupant and those occupants aready present, not the final fraction.
For example, suppose you want to show four occupants, each with occupancy factor
0.25. Thefirst occupant is already present. When adding the second occupant, for
example changing the color, the fraction should be 0.5, because this gives the correct
ratio of occupant 1 and 2. To add the third component, this dialog must be repeated and
the fraction is 0.3333, and for the fourth and last occupant the fraction is 0.25.

Select the variables or attributes to be changed in the Variables Tab.
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3.2.2.9 Atoms/Bonds - Global, Atom Variables Tab
Dialog Box Tab - called from: Inputl Menu

This appliesto input atoms, not generated atoms. Select the atoms to be modified in the
Which Tab.

3.2.2.10 Atoms/Bonds - Global, Bond VariablesTab
Dialog Box Tab - called from: |nputl Menu

This changes the selected attributes of all bonds in the Bonds specification list.

3.2.2.11 Atomic Vectors
Dialog Box - called from: [nputl Menu, Input Atomsdialog

The vectors can be cylinders or single lines; if cylinders, al will have the same radius.

The Scale factor should be in whatever units are necessary to convert the given lengths
of the vectors (specified in the Vector Tab of the Revise Atom dialog) to suitable
lengthsin Angstroms. The length of the vector is measured from the surface of the atom
to the end of the line or the cylindrical portion, except for double ended vectors (see
below) in pen plots, in which the length is measured from the surface of the atom to the
center of the sphere on the positive end..

Y ou can choose to use the colors of each individual atom, or the color specified in this
diaog.

If the Single-end, no arrow radio box is not checked, the vectors will be single lines or
cylinders extending in one direction from the atom. The terminationisadisk in
Standard Drawing mode or a hemisphere in 3D Drawing mode. If the Single-end, arrow
radio box is checked, the end will be marked with a cone (arrowhead) except in pen-plot
output, in which the positive ends will be marked with a sphere. If the Double-ended
box is checked, the vectors will extend in both directions from the atom, and the positive
end will be marked with a cone (arrowhead).

The Radiusincrement for arrow gives the absolute increment in Angstroms of the
radius of the base of the cone over the radius of the vector. The length of the arrow is
determined by the L ength/radius value. Likewise, the Radiusincrement for sphere
(pen-plot only) gives the absolute increment in Angstroms of the radius of the sphere
over the radius of the vector.

Vectors are drawn by adding pseudo-atoms to the list of generated atoms, and adding
pseudo-bonds between these pseudo-atoms and the real atom to which the vector is
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attached. Thusif the length, orientation (Revise Atom dialog, Vector tab) or
single/double-ended statusis changed the structure must be recalculated, rather than
just replotted. Also, since the length is computed as the visible cylindrical part of the
vector, if you change atomic radii the vector lengths will change unless the structureis
recalculated. Inthisdialog (Atomic Vectors), changing the scale factor will require
recalculation, as will changing the vector radius, since this affects the length of the
visible part of the vector (although this effect is slight).

3.2.2.12 Vibrational Modes
Dialog Box - called from: [nputl Menu

See the Import File dialog for general aspects of importing atomic-structure datafiles.

Thisdialog controls.MOT vibrational displacement files (see

Import VIBRAT (.MOT) files and Coordinating ATOMS and VIBRATZ) written by the
VIBRATZ program (or the original VIBRAT - Dowty, Phys Chem Minerals (1987)
14:67). When these files are read in the infomation is converted into a standard ATOMS
datafile, and also a specia.MDT modes file which contains the atomic displacements
and other information for each vibrational mode. When you re-read the.STR file,
the.MDT fileisread in also; if thisfails, you can read it in using one of the optionsin the
Modesfile groupinthisdialog. Thetitle of thee MDS file should already be present in
the edit box so you can edit it and click the Read Named File button, or use the Browse
button to find it.

The Read.MOT file for motions only button will read the atomic motions, but will
ignore other information in the MOT file. Thisallowsyou to set up the drawing oncein
terms of atom sizes, colors, etc., and retain all thisif you decide to recalcul ate the
vibrational modesin VIBRAT.

The mode which isin the.STR file and which is displayed when you first read and
calculate the file is the one which was selected when the.STR file was | ast saved.

After selecting anew mode, you will need to recal culate the structure (Cal culate
command in the File menu, or the Dialog Bar), not simply replot, since new vectors
involve generating new pseudo-atoms and pseudo-bonds.

To see on the screen or output which vibrational mode is being displayed, select the
Print title on plot option in the Title/Axes dialog in the Inputl menu.

MOT filesfrom versions of VIBRAT previous to 1997 do not transmit the lattice-type
information which is necessary for display of the unit cell. Insert the correct Bravais-
lattice symbol if necessary with the Lattice combo box. This does not affect the atoms,
bonds and displacements.
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VIBRATZ datafor acrystal can be imported in either of two ways; showing the atomsin
the primitive unit cell asamolecule; or using the normal ATOM S boundary options for
crystals(see Import VIBRAT ((MOT) files).

VIBRATZ usestwo types of atomsfor crystals or infinite polymers: primary atoms,
which are just those in the primitive unit cell; and secondary atoms, which are those
required to complete the bonds and angles of the compl ete set of internal coordinates
(i.e. force constants). Molecules do not require secondary atoms. For acrystal, the
atoms of the primitive (not Bravais) unit cell are listed in the MOT file, but the
coordinates are given in the standard Bravais cell..

If you have imported the. MOT file as amolecule, not acrystal, thisdistincion is
preserved. The structureistreated as amolecule, that isthere is no symmetry and no
|attice trandlations. Sometimes there may be more secondary than primary atoms. You
have the option to show the secondary atomsin just the same way as the primary atoms;
to mark the secondary atoms with atriangle; or to omit the secondary atoms altogether.
If you omit the secondary atoms, the bonds to them will also be omitted.

If you have imported the. MOT file asacrystal, there are no secondary atoms. If the unit
cell isnon-primitive the Bravais cell isfilled out (i.e. you do not see only the atomsin
the primitive cell), and all atomswhich are trandationally equivalent are displayed in the
sameway.

To specify the details of the vectors which represent the atomic displacements, including
the scale factor, go to the Atomic Vectors dialog in the Inputl menu.

Animate Motions. This section controls animated display of the vibrational motions.

The Screen button will produce an animated display in the current Graphics window.
Clicking the mouse or hitting any key will terminate the animation. In Windows, the
Full-Screen mode can also be animated with CTRL-A.

Frames/cycle applies to screen display only - it controls the speed, larger values giving
slower speed.

The Movie button will bring up the Movie dialog and allow writing of "video" files,
AVI for Windows or .MQV for Macintosh and .SWF (Flash) for all.

3.2.2.13 Thermal Motion
Dialog Box - called from: [nputl Menu

This will give an animated view of thermal motion on the screen or in a movie file.

The information on vibrational modes must be obtained by importing a .MOT file written by the
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program VIBRATZ.

If you click the Movie button (after setting the parameters), you will be presented with the same
dialog as in the Rotation or Vibration Movie dialog in the Rotation menu, to set image size, frame
rate, etc.

A range of temperatures will be shown, as given by the Low limit, High limit and Increment -
the amount of time spent at each temperature is determined indirectly by the Frames per cycle
and Number of cycles each temperature parameters below.

A Scale for motion factor of 1 gives exactly the amplitude of motion determined by the quantum-
mechanical formula for population of the modes (Planck distribution). The Scale for drawing
factor multiplies the scaling of the entire drawing set in the Scaling and Centering dialog - often
the drawing needs to be scaled down to accomodate the motion and the temperature lettering.
The Minimum frequency can be set to exclude questionable or zero-frequency calculated
modes.

The calculation is repeated and the image reshown at a time interval with respect to the vibration
set by the Frames per cycle parameter, which is applied to the highest frequency. If you set this
at 15 frames, and the frame rate in the Rotation or Vibration Movie dialog is also set to 15, then
the highest frequency vibration will go through one cycle in a second - lower frequency vibrations
will cycle more slowly. This number of frames is sampling an entire sine-wave cycle, so it should
not be too small (if it is two, for example, no motion will be shown at all for the highest-frequency
vibration). Then if the Number of cycles each temperature is set to 10, each temperature will
be shown for 10 seconds.

When the animation is shown directly on screen there is no set real-time speed or time scaling -
it is just shown as fast as it can be calculated. If this is too fast, increase the Frames per cycle.

If the Show temperature box is checked, the temperature in K will be shown in the lower left,
using the selected font, magnified by the Font Factor.

3.2.2.14 Cavity Parameters
Dialog Box - called from: [nputl Menu

This dialog controls the Cavities Model mode which uses the 3D system capabilities - if
your system does not support 3D display the Cavities Model mode is not available. Itis
applicableto crystals only (not molecules or polymers). The Model Mode is selected in
the Display Menu or the Dialog Bar - Left.

Grid spacing. Thisisthe approximate spacing in Angstroms between sample points -
the actual spacing may be slightly reduced from this value to give an integral number of
points across the unit cell. This should be considerably smaller than the radius of the
smallest atom. Valuesof 0.1 to 0.4 arereasonable. Time of the calculation is
proportional to the cube of this number.

Particleradius. Thisistheradius of the sphere which is presumed to exist in the
cavities. The volume shown isthat enclosing possible centerpoint locations of this
sphere. If thisradiusis zero, the volume shown will simply be that not occupied by the

© 2011 Shape Software



114 ATOMS Help

atoms of the structure.

Show cell faces. If thisbox is checked, the surface where the cavity volume crosses the
unit-cell facesis shown in adifferent color (next paragraph). If not checked, it may be
possible to see completely through a channel, although this requires that the channel be
fairly straight. Theinner surfaceisthen given adifferent color (next paragraph).

List Coords [Coordinates]. Thiswill list the fractional coordinates of all grid points
which can accomodate the sphere of the specified Particle radius. Thelistingis madeto
atext file, CAVVAL.ATD, and thisfileisthen displayed in a Text window (see

Types of Windows).

Colors- Outer surface and Cell facesd/Inner. Thefirst color isfor the outer or exterior
surface of the cavities, inside the unit cell. If the Show cell faces box (above) is
checked, the second color isfor the surfaces where the cavities cross the unit-cell faces.
The cell-face surfaces may be especially important in judging the continuity of the
cavities. If the Show cell faces box (above) is not checked, the second color isfor the
inside or inner surface of the cavitiesthemselves. The material parameters used

(3D Parameters/Materials, Input2 menu) are those for polyhedra. Asfor polyhedra, the
specular component is usually best kept small.

In VRML files the viewer controls the color of inner surfaces - it isimpossible to specify
the color without redrawing the surface (i.e. there is only one color per surfacein a

VRML file). Some viewers may make the inner surfaces the same color as outer
surfaces (there may be a switch specifying that surfaces are "double sided"), some may
make them black and some may make them transparent. For VRML filesit is safest to
check the Show cell faces box above.

Offset (fraction of unit cell). Thisallows the boundaries of the crystal volume shown
to be offset by afraction of the unit cell (axislength). The offset isawaysin apositive
direction, and the lower and upper boundaries are offset by the same amount. The
Offsets shift the boundaries of the volume shown, not the unit cell itself or the unit-cell
Displacements in the Axes/Unit Cell option.

Number of unit cells. You may display multiple integral unit cellsin any of the axis
directions. The extraunit cells extend in the positive directions of the axes. Y ou cannot
display fractions of unit cells.

Porosity. Thisisthe fraction of the volume of the unit cell which can accomodate the
given size particle. The value shown isfor the the last plot (which could be printed or
file output, rather than screen display). To get true porosity, set the Particle radius to
zero.
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Changing the Grid spacing or Offset requires arecalculation of the grid, and thus you
must select Calculate in the Dialog Bar - Left or File menu. Changing other parameters
only requires Replot.

3.2.3 Input2 Menu (Graphics Window)
Note: if the screen is narrow, this may be a submenu in the I nput menu.

Crystal Edges - This controls the display attributes (color, etc.) of the edges defining
the exterior crystal shape, if present.

Perspective - Controls drawing in perspective versus straight projection.
Stereopairs - Controls automatic drawing of stereopairs.

Rims - Controls presence or absence of rims on atoms and bonds and edges on
polyhedra.

Linewidths - Controlswidths of lines used as edges, etc.
Shading - Controlsthree-dimensional shading.

Background Color - Controls background color (ignored for b/w display or output).

Crystal Axes - Controlsdisplay of crystal or structure axes.

Unit Cell - Controlsdisplay of the unit cell, which may be drawn as edges or solid
(translucent) faces.

Ellipsoid Parameters - Controls the drawing of ellipsoids and stick bondsin the
Thermal Ellipsoids and 3D Drawing modes.

3D Parameters - A pop-up submenu, controlling aspects of the 3D Display mode.
---- General - Some overall parameters.

---- Lighting - Number, direction and/or location of lights.

---- Material - Theway the atoms, bonds and polyhedrareflect or emit light.

---- Fog (Fading) - Aidstheillusion of depth.
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---- Polyhedra - Some aspects of polyhedra specific to the 3D drawing mode.

PDB (Protein) Display - A pop-up submenu (no dialogs), controlling which atoms are
plotting in Protein Data Bank structures.

----All Atoms
----Omit All Hetatoms
----Omit Water

Initial Orientation - Controls the orientation which can be imposed after calculation
and before first viewing.

Scaling - Controls scaling modes and factors.

Centering and Displacements - Controls displacements and automatic centering of the
image.

Calculation Output - Controlsthe listing of the analytical results of the calculations
such as atom locations, bonds, etc.

Atom/Bond Plot States - Allows changing the plotting or non-plotting status of
generated atoms and intermol ecular bonds.

3.2.3.1 Crystal Edges and Faces
Dialog Box - called from: [nput2 Menu

Thisdialog controls the appearance of the display crystal shape. The
Crystal Forms for Display dialog in the Input1 menu controls the actual generation of
the faces which make up this shape.

Display. Crystal means the edges which define the external boundary faces. Atoms
means the atomic structure including bonds and polyhedra. If you are drawing a
molecule or polymer, crystal edges are not normally shown, but you can neverthel ess
display acrystal shapeif desired.

Edges Only/Faces Only/Both. In 3D Drawing modes the actual planes of the crystal
faces can be shown, instead of or in addition to the edges between faces. Set the
Opacity and color of the facesin the group at the bottom of the dialog.

Dash length and dash ratio. The dashes are used for back edges of crystalsand in
display of Crystal Axes and Unit Cell. Length or repeat distanceisin
inches/centimeters, and the length factor is the actual length of the solid part divided by
the repeat distance. Note that when using Frames in output the dash length remains the
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same - it may be desirable to decrease the length for very small plots.

Back edges - those not visibleif the crystal isopaque - may be specified as none (not
shown at al), dashed or solid.

Lines/Cylinders. In 3D Drawing modes the edges may be shown aslines or cylinders
of the specified width.

Colors, Patterns, Pen numbers. Front edges are those which are visible; back edges
are not visible in an opaque crystal. Widths of lines are set in the Line Widths dialog in
the Input2 Menu). See Input Colors/Patterns/Pens for general aspects of input.

For alternate ways of drawing unit cells, and problems sometimes encountered with
crystal edges, see Drawing Crystal and Unit-Cell edges.

3.2.3.2 Perspective
Dialog Box - called from: [nput2 Menu

If perspectiveisnot in effect, or turned off, the drawing is simply a perpendicular or
orthographic projection down the observer x axis. If perspectiveison, the drawingis
projected from a point (xp+Xo, yo, z0), where xp is the perspective distance and xo, yo
and zo are the projection offsets (below), perpendicularly onto the plane (xo, y,z ), that is
a horizontal plane passing through the structure center. Scaling applies to the projection
plane, but obviously fixed scaling has limited intrinsic meaning. Generally the scaling
modes Univer sal Maximum or Each View Maximum (set in the Scaling dialog in the
Input2 menu) should be used when perspective isin effect. The perspective distanceis
the distance xp of the projection point from the projection plane, or in other words the
distance from which the structure is viewed (distance from the center of the structure to
the eye). Smaller distances will accentuate the "perspective”; larger distances will cause
the plot to appear more like a straight-on projection. The perspective distance should be
considerably larger than the distance of the furthest atom from the center (or the plane
X=X0) in the positive x direction. If atoms come within about 1 Angstrom of the x
coordinate of the eye they will be omitted, but many of such atoms would be off scale

(sideways) anyway.

Proj ection Offsets. During calculation the midpoint of the structure is determined - this
includes all atoms, but does not include crystal edges, unit cell or axes. When projecting
in Perspective viewing, the coordinates of this midpoint, xo, yo and zo are used as the
coordinates of the projection point (xp+xo, yo, zo), where xp is the perspective distance.
Thisinsures that the projection is never oblique to the projection plane. Thisis
equivalent to the Automatic Centering option in previous versions of ATOMS. Although
arbitrary specification of the offsetsis no longer allowed, you can attain almost any
attitude of the structure by suitable rotations. Note that the structure can be displaced in
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the plotting area with the Centering and Displacements dialog (I nput2 menu). In effect,
the projection direction moves along with the structure. 1f you also have structure axes
or aunit cell (Display of Axes and Unit Cell diaogs, Input2 menu) which are separated
from the structure, they will be projected obliquely, according to their distancein
Angstroms from the structure center; that is, if you are looking down, say, the a-axisin
the structure itself, structure axes placed to the side will not have that axis exactly
parallel to the view direction. Y ou can rotate to effect a compromise between the two
orientations.

3.2.3.3 Stereopair Angle
Dialog Box - called from: [nput2 Menu

When either 2D Stereopair, OpenGL Stereopair, OpenGL Quad Stereo or

Direct3D Stereo Drawing mode is selected, two images of the structure will be drawn.
The left or |eft-eye image will be rotated by the stereopair Rotation angle clockwise
from the normal orientation, and the right-eye image will be rotated the same amount
counter-clockwise. If shading is active the illumination vector will be rotated along with
the structure. The stereopair rotation angleistypically about 3 degrees, although the
proper angle may vary depending on the perspective distance, the actual viewing method,
etc.

If the hard copy of stereopairsisto be viewed directly or with asmall viewer, aframe
size in the dot-matrix or pen plot of 4 to 5 inches across will give a distance between the
two images about equal to the normal interocular distance.

Few people can directly view a stereo pair as shown on the full screen because the
images are considerably further apart than the eyes. However, if anegative rotation angle
is used, some people can view the image by crossing their eyes.

The two images are separated in the 2D Stereopair and OpenGL Stereopair but
superimposed by viewing hardwarein OpenGL Quad Stereo or Direct3D Stereo modes.

The rotation angle can also be set in the DialogBar - Right

3.2.3.4 Rims/Edges
Dialog Box - called from: [nput2 Menu

In the Standard and Thermal Ellipsoid Model modes, this controls the drawing of rims
and edges for al the atoms, polyhedra and bonds. Colors and shades for rims and edges
are entered in the input for atoms, polyhedra and bonds. Note that edges for polyhedra
include edges that appear in the front, as well as those forming the outline.

Generaly, rims should be turned on for al types of black-and-white images. They should
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usually be off for atoms and bonds with color shading with 8-bit or greater pixel depth,
although you may wish to show polyhedron edges. Color images with black dithering,
such as 4-bit raster files, usually look better with rims. Rimsin color images should
usually be black or adark color.

Rims are never used in the 3D Drawing mode.

3.2.3.5 Line Widths
Dialog Box - called from: [nput2 Menu

The widths arein inches or centimeters. If the valueis0.0, the lineswill be only one dot
wide. For black-and-white display and output, one-dot lines will always be solid black,
while wider lines can have gray shades or patterns.

If the Use individual box is checked for atoms, bonds or polyhedra, the individual line
widths entered for each in the dialogs of the Input1 menu will be used instead of the
overall valuesin this dialog.

When reading older files written with ATOMS for the Macintosh or for Windows V3.0,
in which the line widths are in dots, the conversion to floating-point is made using the
resolution values for the current printer.

Note that line widthsin 3D Drawing modes are always one pixel. Y ou can use cylinders
of any desired diameter instead of linesfor Crystal Edges, Crystal Axes or the Unit Cell
(also 3D Genera diaog in the Input2 menu).

3.2.3.6 Shading
Dialog Box - called from: [nput2 Menu

For 8-bit screen display and raster files, the number of shading zones determines the
nature of the 256-color palette generated by ATOMS and the number of colors available
for shaded atom, bond and polyhedron fills. 1f the number of zonesis 16 or fewer, you
can use all 16 colors from the 16-color palette, except black, and there are 16 gradations
of each color. If the number of zonesis greater than 16, you should use only the first 8
colorsin the palette numbered from 0 to 7, each of which has 32 gradations. See
Colors, Palettes and Dot Patterns for more details.

Darkness angle (degrees). For an isolated object in avacuum, the intensity of
illumination should vary from maximum to minimum as the angle varies from 0 to 90
degrees. However, thiswould be avery "hard" illumination, and ATOMS allows for a
"softening” or diffusing of the illumination in two alternative ways, by darkness angle or
by darkest shade. The darkness angle, or the angle at which the illumination becomes
zero or minimal, can vary from 90 to 180 degrees.
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Darkest shade (fraction). This option "softens” the shading by allowing the presumed
illumination of the darkest zone to be other than zero. Small values of this fraction, such
as0.1or 0.2, areusually appropriate. I1tis0.0 by default.

Useinitial pattern numbers. Each atom, bond or polyhedron typeis given afill pattern
number or gray shade for use in black-and-white screen displays and dot-matrix images,
and thisisused if shading is turned off. If shading is on, the shading normally starts from
pattern zero, white. However, if the initial-pattern-number option is on, this pattern is
used as theinitial pattern number, for maximum illumination, other zones then
increasing in darkness from this pattern number rather than from zero.

This option can be useful for spherical atoms, which all show the same shading zones,
but isless successful for stick bonds and polyhedra, which will show different shading
depending on their orientation.

Front-back fading. Theinitia or unshaded colors of atoms, bonds and polyhedra can
be made to darken with depth (decreasing x coordinate). The foremost atom (greatest x
coordinate) is considered to have full illumination, and illumination drops off to the rear
according to the fading factor. The unit of fading is fraction of full illumination per
Angstrom. If the structure has already been calculated, the factor for complete fading
(black at the rearmost atom) is shown.

3.2.3.7 Background Color
Dialog Box - called from: [nput2 Menu

The best color for background may be neither white nor black - sometimes gray brings
out shading and front-to-back fading better. The background for black-and-white display
and output is always white.

Using colors other than white, black or gray for background may result in increased size
of Raster or bitmap files and PostScript filesin 3D Drawing Modes. In some cases a
simple run-length-encoding method is used for compression of these files, and thisfails
for 24-bit RGB (true color) files when the three components are not identical. That is,
for arow of white pixels the sequence of bytesis 255, 255, 255, 255... whereas for arow
of red pixelsitis 255, 0, 0, 255, 0, O...

3.2.3.8 Display of Crystal Axes
Dialog Box - called from: [nput2 Menu

Either of two types of axes may be drawn, Movable and Corner axes. Movable axes
may be located anywhere in the drawing with the Displacement parameters - these
parameters are in structure coordinates (Angstroms). The arms of the axial cross are
two-ended, showing both position and negative ends. Corner axes are placed in afixed
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position (in screen or drawing coordinates, inches or centimeters) relative to one of the
corners of the drawing. They show only one arm of each axis, which is oriented asfar as
possible toward the interior of the drawing.

In the 3D display mode, the axes can be either lines or cylinders with the specified radius
(which can aso be set in the General sub-option of the 3D Parameter s command in the

I nput2 menu). The axes are not shown in Stereopairsin 2D Drawing modes since they
do not have a definite location in space, but they are shown in stereopairsin the

3D Drawing mode

The Scale factor refersto the distance from the center to either end (one end for corner
axes). Thusascalefactor of 0.5 giveslinesequal in total length to the axes. In 2D
Drawing modes, the axes are always shown in front of the atoms and faces.

The Labels, if selected, will be on the positive ends of the axes for movable axes.

Use PostScript font. Thisallows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and dlant (italic, oblique) of the font, but not the size, which is specified
inthe Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.

Movable axis settings.

If the Dashed box is checked, the c axisis shown solid, the b axis is dashed with the
dash length and interval set in the Preferences dialog in the Settings menu or the
Crystal Edges dialog in the Input2 menu, and the a axis is dashed with half these
intervals.

If the One-ended box is checked, only the positive ends of the axes will be shown,
otherwise both ends will be shown.

If the Include in scaling box is checked the axes will not go off-scale in either the
Universal or Maximize for each view scaling modes (Scaling dialog, Input2 menu).

The Displacements can be used to separate the structure and axes. Note that you can
also move the structure with the Centering and Displacements command in the Input?2
menu. The Scale Grid can assist in these displacements. In 3D display mode, the axes
may interpenetrate with the structure, and the x-coordinate or front-back displacement is
also relevant. Unlike the Unit Cell, the crystal axes are not fixed with respect to the
structure, rather their location is specified in observer coordinates (see

Coordinate Systems), with respect to the center of the structure.
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Clicking in the plot area after clicking on the L ocate with M ouse button will determine
they and z (across and up) coordinates, al that isrequired in 2D Drawing modes; in 3D
Drawing mode the x (front-back) coordinate will be unchanged and can be set
independently.

Proj ection - Orthographic/Per spective. If Perspective (Input2 menu) is off, the axes
are always projected by the orthographic method, in the same way asthe structure. 1f
Perspective is on, the projection point is aways on a perpendicular to the projection
plane (screen or paper) passing through the approximate center of the structure. If the
Per spective radio button in this group is chosen, the axes are projected from the same
point, as athree-dimensional object. This meansthat if the axes are displaced from the
center of the structure, they are viewed obliquely, and it may not be obvious that they are
in parallel orientation with the structure. This can be confusing to the observer who is
not aware of the complexities of perspective projection. If the Orthographic radio
button is selected, the axial crossis projected orthographically, which usually is more
satisfactory. If the axes are at or near the center of the structure, thereislittle or no
difference between the two methods.

Corner axis settings.

The axes may be located in any of the four corners, at the specified Displacement in
both directions from the corner. If thetitleis printed at the bottom, the displacement will
be from the title instead of the corner.

In Perspective projection, corner axes are always drawn as for the Orthographic
projection option for movable axes, above. This means essentially that they indicate the
orientation at the center of the drawing, not that of

their actual position.

3.2.3.9 Display of Unit Cell
Dialog Box - called from: [nput2 Menu

For alternate ways of drawing unit cells, and problems sometimes encountered with
crystal edges, see Drawing Crystal and Unit-Cell edges.

The unit cell isasimple box, with front and back edges having the colors specified. No
distinction is made between "front” and "back" edges. In 2D Drawing modes, the unit
cell isshown in front of the structure, like the structure axes, while in 3D Drawing mode
it has a definite location in space and may interpenetrate with the structure depending on
the Displacements.

In 2D Drawing modes, only the edges may be shown, whilein 3D Drawing M odes faces
may be shown as opaque or translucent planes.

© 2011 Shape Software



ATOMS Menus and Dialogs 123

Edges may be Dashed in 2D Drawing modes only. The dash length and interval are set
in the Preferences dialog in the Settings menu or the Crystal Edges dialog in the Input2
menu.

If the Include in scaling box is checked the unit cell will not go off-scale in either the
Universal or Maximize for each view scaling modes (Scaling dialog, Input2 menu).

For non-primitive lattices, you can choose either the Bravais or Primitive cell; the
primitive cell will have the same shape as that generated by the Default Unit Cell
boundary option (if a primitive cell is selected in that option also).

In 3D modes the edges may be shown as lines, which are always one pixel wide, or as
cylinders with the specified radius. 1n 2D Drawing modes edges are always drawn as
lines - the width is set in the Line Widths dialog (Input2 menu).

The unit cell isnot shown in Stereopairsin 2D Drawing modes since it does not have a
definite location in space, but it is shown in stereopairsin the 3D Drawing mode.

In 3D Drawing mode, and in perspective viewing in 2D Drawing modes, the unit cell
appliesto only one location in three-dimensional space. Change this location with the
Displacements button, which calls the Unit-Cell Displacements dialog.

See | nput Colors/Patterns/Pens for general aspects of color input.

3.2.3.10 Unit-Cell Displacements
Dialog Box - called from: Unit Cell dialog

The unit cell drawn with the Unit Cell dialog (1nput2 menu) hasits origin at particular
coordinates in the structure coordinate system. The displacements from 0,0,0 arein
fractions of the current cell vectors, which may be either primitive or Bravais vectors.
The current vectors, in terms of components in the axes used for atomic coordinates
(normally the Bravais cell edges), are listed; these are trivial unless you have chosen a
primitive cell for a non-primitive Bravais lattice. If you have chosen the -0.5t0 0.5
suboption of the Default Unit Cellboundary option, the boundary volume is centered on
the origin, so the displacements -0.5, -0.5, -0.5 will cause the unit-cell outline to coincide
with the edges of the boundary shape. For the 0 to 1 suboptions use the displacements 0,
0, 0.

3.2.3.11 Ellipsoid Parameters
Dialog Box - called from: [nput2 Menu

This dialog controls plotting parameters for the Thermal Ellipsoid Model mode, set in
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the Model Mode sub-menu in the Display menu or in the Dialog Bar - L eft

The following parameters are those which are in the various instruction series of
ORTEP.

NPLANE - drawing of ellipses
=0, no ellipsoid components
=1, boundary €llipse only
= 3, principal ellipses only
=4, boundary + principal ellipses

NDOT - back side of principal elipses
<0, solid line back side
=0, back side omitted

3, 4 dots on back side

4, 8 dots on back side

5, 16 dots on back side

6, 32 dots on back side

NLINE - forward principal axes and shading (cut-out octant)
=0, no forward axes or shading
=1, forward principal axesonly
= N, forward axes + (N-1) line shading

NDASH - dashed reverse principal axes
=0, no reverse axes
= N, dashed reverse axes with N dashes
NBOND - bond type for stick bonds
=0, no bonds
=1,2,3,4,5givelinesat 180, 90, 45, 22.5 or 11.25 degrees apart, bonds ending
at ellipsoids
=-1to -5, same, bonds ending at atom centers
TAPER - bond taper. The bond radiusis
R=R0+- TAPER * ABS( COS(THETA) )

where theta is the angle between the bond and the view direction. The bond radius RO is
set in the Bond Data dialog (Inputl menu).

SCAL?2 - ellipsoid probability scaling factor.

This controls the size of ellipsoids. A value of 0.76 gives 10% probability, 1.54 gives
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50% probability, 3.36 gives 99% probability, etc. See the table below for sample
values - for more complete values, consult the table in the original ORTEP instructions.

DI SP - retrace resolution.

When lines are retraced to emphasize certain ellipsoids or make the width a function of
depth, thisisthe separation.

A0 and A1 - depth function parameters.

Lines may be retraced to give wider lines for closer ellipsoids.

dR(x) =AO+Al1* x

where dR is the width of the line and x is the height in Angstroms.
Use b/w shades. If thisbox is checked, ellipsoidsin black-and-white display and
output will be filled with the b/w shade or color specified in the Input Atom Data dialog

(Inputl menu). If itisnot checked, they are filled with white before drawing ellipsoid
components.

Show iso as spheres. If thisbox is checked, isotropic atoms are shown as spheres (i.e.
circlesin 2D display) without the principal planes which can give afalse impression of
anisotropy.

Default radius. Thisisthe mu value which is given to atoms with no valid entered
temperature factors; it is 0.1 by default.

If DISPis0.0, lines are not retraced. For one-dot lines on typical screens, DISP should
be about 0.01 inch, but it can be much smaller for printed output. Note that x is
measured from the zero of coordinates, not the rear-most atom

Linewidths for atoms are set independently in the Line Widths dialog (Input2 menu),
and the value of DISP should take account of these settings if wide lines are used.

For color display and output, depth is probably best shown by front-back fading of color
(Shading dialog, Input2 menu) rather than line retracing.

3D Drawing Modes. If temperature factor data have been entered, atoms will be shown
asellipsoidsin the 3D Drawing Modes (including 3D Quad Stereo). If NLINE isgreater
than O, the "forward axes" or cutout octant is shown asin ORTEP (except in 3D files -
see below). If NPLANE isgreater than 1, the trace of the principal planeswill be shown
as stripes or three-dimensional bands just outside the ellipsoids. The Width of
principal- plane stripes gives the width of these bands. The Radius Factor for stripes
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gives the height or extent to which the curves for the principal planes are outside the
ellipsoid itself; this should always be larger than 1.0. By increasing this factor and
decreasing SCAL 2, the principal planes can be made to dominate the representation, as
elliptical disks.

For direct screen and print rendering, the bonds between ellipsoids are the same size as
shape asin ORTEP drawing, and the TAPER parameter is applicable. In 3D files
(VRML and POV-Ray), bonds are always strictly cylindrical. Also inthesefiles, the
ellipsoids are aways complete and do not have the cutout octant as possible in ORTEF
drawing. When Polyhedra are present, and ligand atoms are not shown at the corners,
bonds to these corners are always cylindrical, not tapered. Note that the option to show
corner atoms as spheres of constant size is not applicable to the 3D mode - such atoms
are either absent, or shown asthermal ellipsoids. Of course, the atoms could be
converted to isotropic temperature factors of appropriate size.

The SCAL2 parameter above determines the size of the ellipsoids as in the Ellipsoid
drawing mode. Apart from SCAL2, TAPER, NLINE and NPLANE the ORTEP
parameters above are not applicable to 3D drawings.

The 3D Material parameters used for both the cutout octant and the principal -plane
bands are those for polyhedra - thisisto avoid distracting specular reflections from large
flat surfaces (although polyhedra may be assigned large specular reflection components
aswell).

Polyhedra in Ellipsoid mode (2D) group. Inthe Ellipsoid Model mode, you can either
show polyhedrawith flat, opaque faces (last option), or you can show the ligand-ligand
"bonds" which are the edges of polyhedra, and also the central-ligand bonds. Both of
these types of "bonds' are as defined in the Polyhedra input in the Inputl menu, not the
Bonds input. The ligand-ligand "bonds" or edges will have the fill and edge colors
which are specified for the given polyhedron in the Polyhedron Data dialog, and the
central-ligand "bonds" will have the edge and fill colors of the central atom

(Input Atom Data dialog). Both these bond typeswill have a uniform radius, as
specified in the edit box.

The intersections of the solid polyhedra with the corner ellipsoids are not solved exactly,
but approximated assuming the corner atoms are spheres. The size of these spheresis
determined by the settings in the Polyhedra dialog (Inputl menu). This approximation
will be less acceptable as the ellipsoids deviate further from sphericity.

All the atoms involved in polyhedra, except for the central atom in the case of solid
polyhedra, will be shown as elllipsoids.

The central-ligand and ligand-ligand "bonds", if used, must be added to the bond list
during calculation, so changesin this option may require Recal culation, rather than just
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replot.

Partial Table of Probability and SCAL?2 values

Probability ~ SCAL2

0.1 0.7644
0.2 1.0026
0.3 1.1932
0.4 1.3672
0.5 1.5382
0.6 1.7164
0.7 1.9144
0.8 2.1544
0.9 2.5003
0.95 2.7955
0.99 3.3682
0.999 4.0331
0.9999 4.5943

3.2.3.12 3D Parameters

These parameters apply to VRML and POV-Ray filesaswell as 3D Drawing Modes
modes.

3.2.3.12.1 3D General
Dialog Box - called from:  Input2 Menu

In the 3D Drawing Modes, crystal edges (Crystal Edges and Faces dialog), structure axes
(Crystal Axes dialog) or unit-cell edges (Unit Cell dialog) may either be lines or
cylinders. If they are lines, the width is set in the Line Widths dialog (I nput2 menu).
Rims of atoms and bonds and edges of polyhedra are never shown, so the relevant values
are for edges (which include axes and unit cell) and bonds (which include skeletal bonds.
Width of linesin VRML files cannot be controlled. Wide linesin 3D generally do not
look good, so if width isto be more than one pixel, cylinders are better.

Spheres (atoms) and cylinders (bonds or vectors) are actually drawn as assemblages of
planar polygons, the number of which is determined by the Subdivisions... setting
(below).
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If the Thermal ellipsoids box is checked, and if temperature factor data have been
entered, atoms will be shown as ellipsoidsin 3D Drawing modes. Some of the
parameters in the Ellipsoid Parameters dialog may need to be adjusted - see that dialog
for further details.

Subdivisions per quadrant... Spheresor ellipsoids (atoms) and cylinders (bonds or
other lines) are drawn as assemblages of flat faces, and this parameter determines the
fineness of the subdivisions. The default value of 5 may need to be increased for very
large atoms. This parameter replaces the Slices and Stacks parametersin V4.0 of
ATOMS - in V4.0 files, values of Subdivisions will be obtained from the sphere Slices
number. The Slices for spheres and cylinders number is 4 times the Subdivisions, and
Stacks for spheresis 2 times the Subdivisions. Cylinders have only one stack.
Ellipsoids are distorted spheres (it could also be said that spheres are special ellipsoids)
and they use the same subdivision parameters.

Bonds between ellipsoids, which are drawn in ORTEP style, have either 4 or 8
Subdivisions per quadrant, according to whether the value entered is less than, or equal
to or greater than 6.

3.2.3.12.2 3D Light Sources

Dialog Box - called from:  Input2 Menu

There may be as many as 8 light sourcesin the 3D drawing mode, and each may have a
different color.

Each light may be either Directional, in which case all rays are parallel in agiven
direction; it may be Positional, in which case all rays emanate from a given point; or it
may be Ambient, in which case the rays bathe all objects uniformly - thereisno
directional quality. If thelightisDirectional, the x, y and z coordinatesin the
Position/Direction box give the direction vector. If thelight is Positional, the
coordinates give the location of the light source, in Angstroms in the Observer
coordinate system. Ambient light is neither directional or positional and these
coordinates are not used.

There may be only one ambient light.

Each light has only one color. For non-ambient lights, the diffuse and specular
components have the same color and intensity. The absolute values of the RGB
components determine the intensity of the light - for example, 0.2, 0.2, 0.2 gives awhite
light of oneffifth the maximum intensity.

Since the colors and Material propertiesfor each atom, etc. are specified individually,
the Ambient, Diffuse and Specular Colors should normally be white (1.0, 1.0, 1.0).
However, they can be changed for special effects or to correct color distortions in display
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or output devices.

The color of agiven object is the resultant of the colors of the various lights, the color
specified for the object itself in the dialogs of the Inputl and I nput2 menus, and the
Material coefficients. See Lighting Equation for details.

Attenuation. Theincident intensity from alight sourceisitself subject to attenuation
according to the equation

li = 1i(0)/ (Kc+Kl d+Kqad2)

Where d is the distance of the point in question from the (positional) light and Kc, K

and Kq are the constant, linear and quadr atic attenuation coefficents respectively.
Constant attenuation is essentially a brightness coefficient. Valueslarger than 1.0 simply
darken the scene. Values smaller than 1.0 may add a white component and/or increase
the specular contribution. Linear and quadr atic attenuation apply only to Positional
lights.

3.2.3.12.3 3D Material Properties
Dialog Box - called from:  Input2 Menu

In the 3D drawing mode the material properties of objects determine the way the objects
interact with the light sources.

The color observed at agiven point is aresultant of the light source(s) (3D Lighting) and
the material properties; that is, the RGB coefficients of the Ambient, Diffuse and
Specular components of the light source(s) are multiplied by the specified colors of the
objects, and by the material coefficientsin this dialog, then the results are limited to the
range 0.0-1.0. See Lighting Equation for details.

Ambient light has no direction or origin and is considered to bathe all objects uniformly.
Having a significant ambient component causes non-illuminated parts of objects to be
other than black. It thus "softens’ the illumination in a somewhat similar way to the
Darkest Shade and Dar kness Angle parameters (Shading dialog) in

2D Drawing modes. Note that there must be a separate ambient light to show this
component.

Diffuse color is usually the main component of the appearance of objects. The intensity
of the color is dependent on the angle between the light ray and the normal to the surface
in question.

Specular reflection only occurs when the normal to the surface in question is close to
bisecting the angle between the incident light and the vector from the point on the
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surface to the eye. It produces bright highlights on a curved surface. The larger the

Shininess coefficient, the smaller will be the bright specular highlight on a curved
surface. The shininess coefficient has a maximum of 128 because of computational
restrictions, but values on the order of 5-30 are usually redlistic.

In ATOMS, specular reflection is always white, that isit does not depend on the color of
the object, only the color of the light source(s). Specular reflection does not work well
for polyhedra because faces at the reflection angle will give an essentially solid white
appearance, rather than a bright spot. Thisis because the angleis calculated for the
corners of the face, and interpolated for each point in the interior of the face.

When thermal ellipsoids are shown in 3D Drawing modes (see Ellipsoid Parameters),
the material parameters used for both the cutout octant and the principal-plane bands are
those for polyhedra - thisis to avoid distracting specular reflections from large flat
surfaces.

Emission is similar to ambient, except that there is no dependence on the color of any
light source. A high value of emission makes an object look likeisis glowing.

3.2.3.12.4 3D Fog
Dialog Box - called from: [nput2 Menu

Fog in the 3D drawing mode is similar to fading (Shading dialog) in the Standard
drawing mode - it contributes to theillusion of depth by changing the color as a function
of distance from the eye. It blends the specified foreground color for the atom, bond or
other object with the given background or other specified color, on a pixel-by-pixel
basis.

This can be according to one of three equations, selected with the radio buttonsin the
upper left of the dialog.

Linear: f=(end- 2)/ (end - start)

Exp: f = exp[-density * Z]

Exp2: f = exp[(-density * z) ~2]

where z is the distance from the eye and f is the fraction of theinitial color, the
remainder being the fog color specified in the lower part of the dialog. Note that the
color in this caseis specified by RGB components varying from 0.0 to 1.0 (floating
point) rather than O to 255.

ATOMS sets the parameters start and end at the foremost and rearmost atoms, or
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calculates the density, using the specified Fraction of intensity at rear. That is, the
foremost atom will always have the pure (non-fogged) color (f = 1.0), and the rearmost
atom will have the specified fraction (f) of the pure color and the remainder the fog
color.

For example, if the rearmost atom is to blend into the background, i.e. disappear, set the
Fraction of intensity at rear at 0.0 and check the Use background radio button. If the
fog color is not the current background (Background Color dialog, Input2 Menu), it will
usually be black (0.0, 0.0, 0.0).

Fog or fading may also be referred to as depth-cueing.

3.2.3.12.5 3D Polyhedra
Dialog Box - called from: [nput2 Menu

This dialog specifies some special ways of displaying polyhedrain the

3D Drawing mode and 3D file ouput (VRML and POV-Ray) which are not available in
2D Drawing modes. Y ou can independently control the display of faces ("fills"), edges
("rims" or ligand-ligand "bonds") and central-ligand bonds.

Of course other properties of polyedrawhich apply to the Standard mode as well, such as
display of ligands as spheres, are specified in the Polyhedra dialog in the Inputl menu.

Faces. The Opacity (1.0-transmission) for the translucent modes may be specified, but
system software and file viewers may not support a complete range. Translucency may
increase computation time. VRML files do not support Back faces opaque. Viewers
for 3D files may not support translucency.

The polyhedron faces may al be translucent, in which case objects behind show through,
or you may check the Back faces opaque box, in which case the interior may be seen,
but nothing behind the polyhedron. Complete translucency may be confusing if there
are many polyhedra, i.e. polyhedrabehind polyhedra.

Edges. The choice of edge color uses either the rim (or edge) and fill (or face) color
from the Polyhedron Data dialog, Inputl menu.

Central-ligand bonds. The color of these bonds, as well as the central atom isthefill
color of the central atom (Revise Atom dialog, Inputl menu).

The line option for edges and bonds may not be supported in all output modes - using
cylinders may be safer.

Material for edgesand bonds. The materia properties are specified in the
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3D Materials dialog. Prior to V6.3, the default material for screen display was the line
material, but POV -Ray output used bond material.

Planar polyhedra are shown as plates with a finite thickness, with or without the central
atom.

Previous versions. Prior to V6.3, not all combinations of faces, edges and bonds were
available. Specifically, the optionswere: 1) Completely opaque; Skeletal, no bonds,
Skeletal, with bonds; 4) Translucent, no bonds or 5) Translucent, with bonds. The
skeletal modes show the ligand-ligand bonds or polyhedral edges, with the central atom
asasphere. If an old file with one of these optionsisread in, the optionsin thisdialog
will be set to preserve the old display appearance.

3.2.3.13 PDB (Protein) Display Parameters
Dialog Box - called from: [nput2 Menu

The first radiobox, Display hetatoms, appliesto all Model modes, not just the special
Protein Model mode. Y ou can omit al hetatoms, or water (HOH) only.

The remainder of the settingsin this dialog apply to the special Protein Model mode.

This mode, which isa 3D Drawing Mode only, only works on dataimported from PDB
files. It displays the bonds between protein backbone atoms as cylinders, with the radius
specified in thisdialog. By default, other atoms in the amino acids or residues are
omitted, but you can specify alimited number of individual residuesto draw in the ball-
and-stick modein thisdialog. Hetatoms (non-residues) are always drawn as ball-and-
stick.

The bonds drawn in this mode must be specified in the Bonds dialog in the Inputl menu.
At aminimum to show the backbone there must be carbon-carbon and carbon-nitrogen
bonds. Any other bonds among hetatoms and non-backbone atoms in the residues must
also be specified. Usually this can be done by selecting automatic bondsin the Bonds
dialog or during importing.

This mode relies on the atomic labels and residue information derived from PDB files
and cannot be used without importing datain that format.

The Radius of sticks givesthe size of the skeletal or stick bonds between backbone
atoms - it does not apply to bonds involving hetatoms or non-backbone atomsin the
residues.

Show completeresidues - by number. This allows showing non-backbone atoms and
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associated bonds in the specified residues. Atom and bond attributes are as specified
globally in the Atoms and Bonds dialogsin the Inputl menu. Note that even if aresidue
is selected for "full" display in this option, the backbone atoms in that residue are still
shown in the standard protein way (as skeletal sticks).

In the edit box, give the residue sequence number and chain letter together, separated by
Spaces, commas or semicolons. Y ou can get these numbers and |etters by clicking on the
atoms, or from the Atoms dialog in the Inputl menu. Thus

5A 12B

indicates that residue 5 of chain A and residue 12 of chain B are to be drawn fully. A
number without aletter will be read aschain A.

3.2.3.14 Initial Orientation
Dialog Box - called from: [nput2 Menu

Any initial Cartesian rotations specified here will be be applied to the x, y and z structure
Cartesian axes (see section IV-4) in that order after the atoms are located and boundaries
determined and before the structure isfirst displayed. If initial clinographic viewingisin
effect, the clinographic rotations are applied after these initial rotations.

If the Clinographic viewing box is checked, the clinographic rotation (see

Coordinate Systems) will be applied at the end of the calculation, after any initial
Cartesian rotations. It may be turned off with the Clinographic Viewing command in the
Rotation menu (or the ClinographicViewing command in the Display menu).

When exiting, ATOMS checks to seeif the orientation has changed from theinitial
orientation defined in thisdialog. If so, you have the option of saving the current
orientation. This orientation will be converted into initial rotations on x, y and z, plus
initial clinographic viewing if that isin effect.

Summary of orientation operations. ATOMSfirst setsthe ¢ structure axis parallel to the
2 viewer axis, and the a * structure axis (perpendicular tob and ¢ ) paralel tox. Thisis
theoriginal orientation. Next, if the Slice boundary option isin effect, the dliceis
oriented with the slice plane parallel to yz, and the orientation vector parallel to z. Then
theinitial Cartesian rotations, if any, are applied. Finally, the clinographic rotations, if
selected, are applied. Thisistheinitial orientation.

3.2.3.15 Scaling
Dialog Box - called from: [nput2 Menu

Scaling and displacement operations do not apply to the actual values of atom and corner
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coordinates and face coefficients, which are permanently set (in Angstroms) by axis
lengths and fractional coordinates and the central distances of the faces. Rescaling and
displacement apply only to the plotting coordinates in screen, dot-matrix or pen-plotter

displays.
Scalemode. There are three modes of scaling:

----Maximize sizefor each view. Inthismode, the structure is scaled in each
orientation so that it isjust smaller than the viewing area. The actual scale will therefore
change whenever the structure is rotated. Hard copy is scaled the same way and what you
seeisessentially what you get. Note that the Rescale factor (below) is now applied -
this has the effect of reducing or enlarging the size of the viewing area as used for
determining the scaling.

----Univer sal maximum. In thismode, the structure is scaled so that its maximum
dimension isjust smaller than the minimum dimension of the plotting areas; thus,
rotations can be made without changing the scale and without going out of bounds.
Again, hard copy is scaled the same way and what you see is essentially what you get.
Note that the Rescale factor (below) isnow applied - this has the effect of reducing or
enlarging the size of the viewing area as used for determining the scaling.

----Fixed scalefactors. This suboption allows you to set the scale to a fixed number of
inches or centimeters per Angstrom for the dot-matrix and/or pen plot, or ssimply to
reduce or enlarge the image from the automatic scaling modes.

Rescalefactor. Thisfactor isaways applied in the Maximize size for each view and
Univer sal maximum modes. When you "zoom" or rescale with the scaling buttonsin
the Dialog Bar - Right, this changes the rescal e factor (rather than changing to the Fixed
scale mode, asin pre-V4.2 ATOMS).

Scaling for the screen and normal printer output (Print command in the File menu)
depends on the resolutions (dots per inch or centimeter), which are obtained from the
software drivers for these devices. Resolution for the printer may often be reset in the
Page Setup dialog in the File menu. The resolution for the Pen Plotter is set in the
Pen Plotter Settings dialog, and that for a direct PostScript printer is set in the
Postscript Settings in the Settings menu.

The Dialog Bar - Right allows "zooming" or incremental adjustment of the scale factors
in the Fixed mode, or the Rescale factor in the other modes.

3.2.3.16 Calculation Output
Dialog Box - called from:  Input2 Menu
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This output gives information on the results of theinitial calculation, including locations
of all atoms, all faces generated, and atoms involved in bonds and polyhedra. Itis
regenerated every time you use the Calculate command in the File menu.

Output. Output, if selected, issent to afilewith titleinfile. ATD, where infile isthe
name of theinput file. The.ATD file will be in the same directory asthe.STR file (data
directory). You can elect to show thisfile on-screen in a Text window, whichisa
standard edit window - see Types of Windows.

Note that the output referred to here gives the original atom locations without any
rotations whatsoever, while the List Generated Atoms command in the File menu gives
current Cartesian atom locations.

The listings of generated atoms give a symmetry number (Symm.) which can be
correlated with the list of symmetry operations, or equivalent positions of the generad
equipoint, in the Listings/Input/Symmetry listing (File menu). This number, in roman
numerals, can be shown as a superscript on the Atoms L abel (Display menu).

Bond lengths and angles. Bond angles are part of the normal bond output, so in order to
get angles, you must aso check the Bonds box. Y ou have the option of calculating the
angles on all atoms, or only on one atom of each symmetry-equivalent set (input atom)
which occursin the final atom list. ATOMS will find the generated atom which is
closest to the zero point.

Note that angles will only be calculated for bonds which have been specified for display,
and angles will only be calculated for atoms within the boundaries specified in the
Boundary option. Angles within polyhedrawill not be calculated. If the boundaries of
the structure are not large enough, you may not get a complete set of bonds and angles on
any given atom. Specifying the Default Unit Cell boundary option will not guarantee that
you get a complete set, unless you select the third suboption in that dialog, which
completes the coordination of all atomsin the unit cell.

Bond lengths and angles about any input atom can can be obtained immediately with the
Coordination button in the [nput Atoms dialog (I nputl menu).

3.2.3.17 Centering/Displacement

Dialog Box - called from:  [nput2 Menu

Automatic centering will center the structure in the current viewing area. Thisis done for
each view, and any displacements entered under Constant Displacements are ignored.

In most cases, the easiest way to scale and position a drawing onto a printed or typed
page is to use the frame optionsin the Print command or other optionsin the File.
However, the displacementsin this section can be used to position the drawing within
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the frame defined in those suboptions.

The displacements are used only in plotting and are not actually part of the atomic
coordinates. Note that the center of rotation is not changed by these displacements - that
is, the structure is always rotated about its own zero of coordinates. Thus any desired
rotations should always be made before using displacements.

The Dialog Bar - Right allows centering of the viewing area on a particular projection
point in the structure. Displacements made in that dialog will affect the displacementsin
thisdialog (Centering/Displacement), and may be removed here.

The Set Center button in the Dialog Bar - Right also allows centering of the viewing
areaon a particular projection point in the structure.

The Scale Grid command in the Display menu is useful for showing the actual scaled
location of the structure and in estimating displacements.

For perspective viewing, the projection is made from a point related to the zero of the
observer coodinate system. If the displacementsin Centering/Displacement are large, it
may be desirable to enter offsetsin the Perspective dialog, or to select Automatic
Centering of the projection point in that dialog.

Note that the projection point for perspective viewing is independent of the
Centering/Displacement settings, although this point may also be centered automatically
(see the Perspective dialog).

3.2.3.18 Reset Scaling/Centering
Dialog Box - called from:  Input2 Menu

This dialog allows reversion to the Scaling and Centering/Displacement modes and settings in
effect before various interactive changes, or selection of the default settings (Universal Maximum
scaling and Automatic centering).

Current makes the current settings permanent - after this these settings will be the "Last"
settings.

Last returns to the values set in the last calculation, or the last reset with this dialog. Current
settings are erased.

Default selects Universal Maximum scaling and Automatic centering, so the structure should
remain the same size and completely in view at all times.

Cancel will exit the dialog without any change - the current and last settings will be preserved.

You can always adjust the settings in the Scaling and Centering/Displacement dialogs in the
Input2 menu.
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This dialog can be called from the DialogBar-Right with the Reset Scaling button.

3.2.3.19 Atom and Bond Plot States
Dialog Box - called from: [nput2 Menu

Thisis primarily intended for restoration of generated atoms that have been marked as
non-plotting with the Generated Atom Data dialog which comes up when an atom is
identified by clicking with the mouse pointer in the Graphics window. However, you
can also select arange of atoms by number to mark for non-plotting. If the end number
iszero, it will be made equal to the start number, i.e. only one atom will be affected.

The Inter molecule/fragment bonds combo box (only displayed if there are bonds
between molecules or fragments) gives several options for display of inter-molecule or
interfragment bonds. If Highlighted is selected, such bonds are shown in normal colors
while all other atoms, bonds, etc. are dimmed. Other possible highlighting of molecules
or fragmentsisignored.

Changesin plot states will only be shown after using the Replot command in the
Display menu.

See Deleting Atoms and Generated Atom Data.

3.2.4 Display Menu (Graphics Window)

Asof ATOMS V6.4, different ways the structure can be shown are differentiated
according to the Model mode and the Drawing mode, instead of having only one
Display Mode selection.

Model Mode - Submenu - Controls the way that structure elements are represented in
ATOMS. Standard mode includes ball-and-stick as well as polyhedra; Thermal
Ellipsoid is like ORTEP; Cavities shows open space; and Protein mode shows protein
backbones and residues in specia ways.

Drawing Mode - Submenu - Controls the way the the structure is drawn on the screen,
on paper or infiles. The drawing can bein 2D (two-dimensional) mode, for more
schematic drawings; or in 3D (OpenGL) mode for more realistic representation as 3D
objects. For actual stereoscopic viewing, either 2D or 3D can be shown as separated
stereopairs, the Quad Stereo mode can take advantage of hardware which supports quad-
buffered OpenGL or the Direct3D mode can show stereo in Windows with appropriate
hardware.

Replot - Replotsthe image (does not recalculate).

Color - Switches the screen between black-and-white and color.
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Atom Labels - Controls automatic labeling of atoms, using input labels.

Bond L abels - Controls automatic labeling of bond distances.

Angle Labels - Controls automatic labeling of interbond angles.

Scale Grid - Superimposes ascale grid for location of the structure or parts thereof.
Mark Atoms - Drawsasmall box at the location of specified types of atoms.

Clinographic Viewing - Switches clinographic viewing on and off.

DialogBar - Left - Thisisacontrol bar which isfixed on the left side of the Main
window.

DialogBar - Right - Thisisacontrol bar which isfixed on the right side of the Main
window. It contains some frequently-used controls.

DialogBar - Fragments - This controls placement and orientation of individual structure
fragments, if present.

Powder Diffraction - Produces a simulated powder diffractogram or alist of reflections.

Precession Pattern - Produces a simulated precession photograph of a given net.

3.2.4.1 Model Mode Sub-Menu
Sub-Menu - Model Mode [Display menu]

This sub-menu switches between the four types of representation supported by ATOMS.
The Standard and Ellipsoid modes can be drawn either in the 2D or 3D Drawing modes
(Drawing Mode Sub-Menu), but Cavities and Protein are 3D only

Standard. Thisisthe main Model mode in ATOMS, which supports ball-and-stick,
interpenetrating atoms, polyhedra and wire-frame representations, or combinations of all
of these, ranging from simple schematic drawings to fully-shaded three-dimensional
drawings. Generally, thismode is most suitable for drawings in published works.

Thermal Ellipsoids. This mode shows thermal ellipsoidsin the style of ORTEP, the
classic plotting program by Carroll K. Johnson. Note that ellipsoid may also be drawn in
the 3D Drawing modes.

Cavities. Thisshows the cavities or "open space” in asingle unit cell, using the current
atomic radii. This mode usesthe 3D OpenGL system capabilities.
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Protein. This mode, whichisa 3D Drawing Mode only, only works on data imported
from PDB files. It displays the bonds between protein backbone atoms as cylinders, with
the radius specified in the Protein Display Attributes dialog. By default, other atomsin
the amino acids or residues are omitted, but you can specify alimited number of specific
residues to draw in the ball-and-stick mode in the Protein Display Attributes dialog.
Hetatoms (non-residues) are always drawn as ball-and-stick.

The choicesin this submenu are also in the Dialog Bar - Left which is controlled from
the Display menu.

Switching from Standard or Ellipsoid modesto either the Cavities or Protein model
modes, which are 3D only, will automatically change the Drawing M ode option to 3D
Single.

3.2.4.1.1 Standard Model Mode

Thisis one of the modes which can be selected in the Model M odes submenu in the
Display menu, or in the Dialog Bar - Left.

This model mode supports ball-and-stick and coordination polyhedra, which may be
intermixed in various ways. It does not support drawing atoms as thermal ellipsoids.

The representation in this model mode can be shown with either the 2D or 3D Drawing
modes, and either as single objects or stereopairs.

This mode is actually very flexible, and supports representations ranging from very
schematic line drawingsto fully three-dimensional. The settingsin the Rims,
Linewidths, and Shading commands in the I nput2 menu have an especially great
influence on this mode.

3.2.4.1.2 Thermal Ellipsoid Model Mode

This mode shows atoms as thermal ellipsoids, if the data are present. In the 2D Drawing
modes, ATOMS shows thermal ellipsoidsin the style of ORTEP, the classic plotting
program by Carroll K. Johnson. Display parameters, controlling the way the atoms and
bonds are drawn, are the same asin ORTEP. However, the ORTEP plotting commands,
including atom generation, are not used. Atom generation is done by the usual Boundary
methods of ATOMS, and bonds are set up in the usual way (Bonds dialog in the Inputl
menu). Bond radii used are the same as those specified in the Bond Data dialog. The
ORTEP parameters which actually affect the configuration of the ellipsoids and bonds
are set in the Ellipsoid Parameters dialog in the Input2 Menu.

Atoms and bonds are drawn generally from back to front in the 2D Drawing modes, the
height of bonds being taken at the midpoint. From V5.1, ATOMS has an additional
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algorithm which should eliminate most inaccuraciesin overlap relations which resulted
from strict back-to-front drawing. The true relations will be always be shown in
3D Drawing modes.

Thermal ellipsoids are also shown in the 3D Drawing modes. In the 3D drawing modes,
ellipsoids may be intermingled with coordination polyhedra, but coordination polyedra
are not shown in the Ellipsoid Model Mode in the 2D Drawing Modes. Thermal
ellipsoidsin pen-plot or HGPL-file output are not supported at this time.

Switching between Standard, Thermal-ellipsoid, Cavities and Protein Drawing modesis
done with (@) the Model Mode sub-menu in the Display menu; or (b) a drop-down box
in the DialogBar - Left, which isturned on and off in the Display menu.

Temperature factor data may be entered and edited for individual atomsin the

Atom Data Dialog (I nput1 menu), or temperature factors may be read in with the
Import File formats (File menu), including the original ORTEP format, or with atom
parameters in free-form style through the Input Atoms dialog (Inputl menu). ATOMS
supports all of the temperature factor types used in ORTEP, although most data
published now are of type 0 or 8 for anisotropic temperature factors, or 6 for isotropic
factors (and also type 10 for isotropic U, which is not a standard original ORTEP type).
ATOMS will save temperature factor datain its datafilesonly if thereis at least one
atom with non-zero B11 or U11 coefficient.

When converting to the I nput=Gener ated mode (Generated to Input command in the
Transform menu), the temperature factors of all generated atoms are converted to
eigenvectors and eigenvalues in the Cartesian system and stored in that way instead of as
betaor U coefficients. Therefore, temperature factors cannot be modified once the
conversion has been made. (It would be possible to modify the valuesin the.STR file,
but it is not likely this would be worth the trouble). The Thermal Ellipsoid mode is not
supported for multiple structure fragments.

3.2.4.1.3 Cavities Model Mode
Parameters for this Model mode are set in the Cavity Parameters dialog, Inputl menu.

This Model mode shows the surface enclosing the centerpoint locations of a given-sized
particle (sphere) within the structure. By setting the particle size to zero, you can show
the actual reciprocal of the crystal structure.

There are two steps to the location of this surface. First (grid calculation), the unit cell is
sampled at the given Grid spacing and Offset, to get the distance to the surface of the
nearest atom. This calculation need not be repeated unless the unit cell, atom
coordinates or atom radii, or the Grid spacing or Offset are changed. Second (surface
evaluation), at plot time the surface which outlines the given Particleradius (i.e. athree
dimensional contour surface) isdrawn. Multiple unit cells are drawn by duplicating the
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surface segmentsin the central unit cell, which increases drawing or rendering time, but
not grid calculation or surface location time.

The grid calculation uses the current atom radii (Atoms dialog, Inputl menu).
Presumably these are full ionic, covalent or van der Waalsradii. Theradii can all be
changed by afactor with the Atoms-Global dialog (Input2 menu).

Since asingle unit cell is sampled from 0 to 1, and offsets and multiple cells extend in
the positive axis directions, automatic centering should normally be selected in the
Centering/Displacement dialog (Input2 menu).

The calculationsinvolved in this mode are essentially independent of those involved in
the other Model modes. If you want to switch between Cavities mode and other modes,
to compare the the actual structure with cavities, it may be helpful to set the

Boundary Option and other conditions to match.

When showing a single unit cell with no offsets, the Boundary should be set to Unit Cell,
O-1inclusive. Itisusualy helpful show the unit cell edges with the Axes/Unit Cell
option (Input2 menu). The unit-cell Displacements (button in the Axes/Unit Cell
dialog) should all be set to zero.

When displaying in Cavities mode with multiple unit cells and/or offset unit cells,
showing the actual structure with the same boundaries requires using the Enter Forms
boundary option. Symmetry for the faces should be None, and the bounding faces
should be those of the unit cell, at central distances which are suitable fractions (to take
account of Offsets) and/or multiples of the d-spacing. The d-spacing is printed out for
each form after it isentered. If the boundary isinitially set up for Unit Cell (previous
paragraph), and then switched to Enter Forms, the appropriate faces will be entered and
the central distances/d-spacings given. Note that Offsets will require negative central
distances. For example, if the Cavities volumeis offset by 0.25 on the a-axis, the
bounding faces cutting the a-axis should be (100) at central distance 1.25d and (-100) at -
0.25d (where d is d-spacing).

Note that atoms with small radii have little influence on the configuration of cavities,
and such atoms can usually be omitted. For example when doing silicates using ionic
radii, silicon atoms may be omitted. Even using covalent or van der Waals radii the
silicon atoms do not greatly influence the configuration of cavities. Of courseif the
Particleradius is set to zero, the locations of omitted small atoms may show up as
isolated cavities, but this may be minimized by setting the Grid spacing to avalue larger
than the small atoms. Thus omitting small atoms improves the speed of the calculations
in two ways,; directly by reducing the number of atoms considered in the grid calculation
step; and indirectly by allowing larger grid spacing.

Cavitiess-mode drawings may be saved as VRML Files. Rotation of asmall Cavities-
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mode drawing may be faster inaVRML viewer thanin ATOMS, primarily because the
viewer saves all theindividual polygons comprising the surface in memory, and does not
have to calculate them for each view. However, for large drawings storage of all this
information may cause the viewer to use virtual memory, which can bring the entire
process essentially to a halt.

There are two zeolite structures set up for Cavities mode in the/SAMPLES sub-folder,
LINDE_L.STR and ZSM5.STR. Open these files and switch to the Cavities Model
mode.

Using stereopairsis usually very helpful in Cavities mode.

The ray-tracing program POV -Ray can be used to make a very smooth-appearing
cavitiesdrawing. To do this, select POV-Ray in the File menu and be sure the Spheres
box is checked.

3.2.4.1.4 Protein Model Mode

This mode, which isa 3D Drawing mode only, only works on dataimported from

PDB files. It displaysthe bonds between (all) protein backbone atoms as cylinders, with
the radius specified in the Protein Display Attributes dialog. By default, other atomsin
the amino acids or residues are omitted, but you can specify alimited number of specific
residues to draw in the ball-and-stick mode in the Protein Display Attributes dialog.
Hetatoms (non-residues) are always drawn as ball-and-stick.

The bonds drawn in this mode must be specified in the Bonds dialog in the Inputl menu.
At aminimum to show the backbone there must be carbon-carbon and carbon-nitrogen
bonds. Any other bonds among hetatoms and non-backbone atoms in the residues must
also be specified. Usually this can be done by selecting automatic bonds.

This mode relies on the atomic labels and residue information derived from PDB files
and cannot be used without importing datain that format.

The amino acids or residues are shown in the shapely color scheme as used by RasMol
(www.openrasmol.org). This Model mode shows more detail (more atoms) than the
"backbone" mode of RasMol because a main objective is to be able to focus on some of
the groups of hetatoms and show their bonding to the amino acids when necessary.

3.2.4.2 Drawing Mode Sub-Menu
Sub-Menu - Drawing Mode [Display menu]

This sub-menu switches between 2D and 3D types of drawing, and also alows either
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separated left-right stereopairs or superimposed full-size stereoscopic viewing with
appropriate hardware such as shutter glasses.

Graphics can be either 2D, which uses the standard system software for drawing in two
dimensions; or they can be 3D, which uses system software (OpenGL, or Direct3D in
Windows) for drawing three-dimensional objects. The Standard and Ellipsoid Model
modes can be either 2D or 3D, while the Cavities and Protein Model modes are 3D only.

3D. Although afully shaded drawing donein the Standar d mode may have ahighly 3-
dimensional appearance, this option, which uses special system software, allows a
number of extraoptionsin terms of lighting and material properties and correctly draws
interpenetration of crystal edges, axes and unit cells with the structure. Switching into
this mode requires loading the system software, which may take afew seconds. Thermal
ellipsoids may be drawn in combination with polyhedra, which is not possible in either
the Thermal Ellipsoids or Standard modes. Using one of the 3D modes is required for
"true” full-color, full size stereoscopic viewing as with nVidia3D Vision.

The choices in this submenu are also in the Drawing Mode drop-down in the
Diaog Bar - Left which is controlled from the Display menu.

The OpenGL system software (abbreviated OGL in some situations) is available on all
platforms - Windows, Macintosh and Linux. It can always be used to get 3D images, but
may require a specia graphics card such as the nVidia Quadro series to show non-
separated "true” stereo.

OpenGL Quad Stereo. Thisisaspecia kind of OpenGL drawing mode, which uses
quad-buffered display hardware to draw left- and right-eye images, which are alternated
on screen or other viewing device at a high rate, or which may even be drawn on separate
displays. Most systems require wearing special glasses, either shutter glasses or some
type of polarizing glasses. Currently nVidia, in their Quadro line of display cards,
provides the most widely available type of quad-buffered systems, which must be used
with certain types of monitor. Quad-buffered OpenGL may aso be supported by other
hardware such as projectors and using software drivers other than nVidia, such as iZ3D
and TriDef.

Direct3D (Windowsonly). Thisis Microsoft's version of 3D software. The only reason
for using this mode instead of the OpenGL modesis to support stereoscopic viewing
with shutter glasses or polarizing monitors using those display cards which do not
support quad-buffered OpenGL. Thisincludes most of nVidias display cards except
Quadro cards.

Fullscreen Mode. Any of the display modes can be shown in fullscreen mode rather than
in the graphics window. Change to fullscreen with the Fullscreen option in the Display
menu or the Fullscreen button in the Dialog Bar-L eft
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3.2.4.2.1 2D Drawing Modes

These drawing modes can be selected in the Drawing Mode submenu in the Display
menu, or in the Dialog Bar - Left.

This modeis actually very flexible, and supports representations ranging from very
schematic line drawingsto fully three-dimensional. The settingsin the Rims,
Linewidths, and Shading commands in the | nput2 menu have an especially great
influence on this mode.

The alternatives to 2D modes are 3D Drawing modes, which give amore realistic
appearancein full color, but are not generally suitable for schematic drawings, as there
are no rims or boundary lines. See Description of the Calculations for details on the
difference between 2D and 3D Drawing modes.

Sereopairs. Selecting 2D Stereopair causes two separate drawings to be made, which
areidentical except for the Stereopair Rotation Angle. Many people cannot view a
stereopair directly because of the difficulty of getting the left and right eyesto focus on
separate points at a short distance. However, various devices are available for such
viewing, using lenses, mirrors or prisms.

Some people can view stereopairs by crossing their eyes, without artificial aids. For this,
the Stereopair Rotation Angle should be negative.

Stereo viewing works best when Perspective is selected.

3.2.4.2.2 OpenGL Drawing Modes

These drawing modes can be selected in the Drawing M ode submenu of the
Display menu, or the Dialog Bar - Left.

Although afully-shaded ATOMS drawing in the 2D Drawing modes has an excellent 3-
dimensional appearance, the term "3D drawing" is used to denote a method of drawing
which isdifferent in several respects. ATOMS uses the OpenGL software package for
Windows, Linux and Macintosh. 3D Drawing modes give a more realistic appearancein
full color, especially on screen, but are not generally suitable for schematic drawings, as
there are no rims or boundary lines. See below and in Description of the Calculations for
details on the difference between 2D and 3D Drawing modes.

Sereopairs. Selecting 3D Stereopair causes two separate drawings to be made, which
areidentical except for the Stereopair Rotation Angle. Many people cannot view a
stereopair directly because of the difficulty of getting the left and right eyesto focus on
separate points at a short distance. However, various devices are available for such
viewing, using lenses, mirrors or prisms.
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Some people can view stereopairs by crossing their eyes, without artificial aids. For this,
the Stereopair Rotation Angle should be negative.

Stereo viewing works best when Perspective is selected.

In order to show non-separated stereo views with OpenGL, you must have an appropriate
graphics card and viewing hardware, and you must select the
OpenGL Quad Stereo Drawing Mode

Older stereo drawing drivers from nVidia, which worked with shutter glasses but only on
Cathode-Ray-Tube monitors, not flat-screen LCD monitors, supported OpenGL without
quad-buffering. If you are using such a system, you do not need to select the ATOMS
OpenGL Quad Stereo Mode; stereo images can be viewed in the OpenGL Single
Drawing mode. However, stereo will be shown only in Fullscreen display, notina
window. The stereo effect is turned on with ahot key or other switch for the hardware.

Difference Between 2D and 3D Drawing Modes.

In 3D drawing, the surfaces of three dimensional objects such as spheres and cylinders
are converted to an assemblage of planar polygons. Then each polygon is drawn
essentially independently. The critical difference from 2D Drawing modesisthat a
depth buffer isusedin 3D imaging. Thisisan array of integers, one for each pixel in the
display or output (or that portion which is currently being drawn). Each element,
representing a pixel, holds therelative x coordinate (in the ATOMS observer coordinate
system) of the foremost object or polygon. The color for this object is retained in the
color buffer, whichisasimilar array representing pixels; this array is actually the image
itself. Whenever apolygon is drawn, each pixel which it contains is compared against
the depth buffer; if the x coordinate of the pixel is greater, or closer to the observer than
what isin that element of the depth buffer, the color for this pixel in the new polygon
replaces the value in the color buffer. That is, the depth buffer keeps track of the front
surface of the drawing, and ensuresthat only this front surface (not any hidden surfaces)
are kept in the color buffer or image itself. It is aso possible to have transparent or
translucent objects, through which hidden surfaces may show partially, by mixing the
color of the latest object with the color which is already in the buffer.

Actualy, the "double buffer" method is normally used, the color buffer being kept in an
area of memory and then copied to the screen memory when the drawing is compl eted.
Thisisusually faster than drawing directly to the screen.

The 2D Drawing modes of ATOMS do not use a depth buffer: the atoms, bonds and
polyhedra are sorted from back to front and drawn in that order. When necessary, the
intersections of objects are solved analytically and only the required portions of each are
drawn.
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Using a depth buffer has the advantages that it is not necessary to solve analytically for
intersections, nor to sort the objects with respect to depth (unless some objects are
transducent). This may save considerable time, especially for complex drawings, since
the time for sorting tends to increase exponentially with the number of objects. Since
analytical solution of intersectionsis not necessary, it is possible to place essentially any
objects into the drawing. in any location. This overcomes the problemin ATOMS 2D
Drawing modes of sometimes-incorrect drawing of crystal edges or unit-cell edges which
intersect with atoms, bonds and polyhedra. The 3D method allows more complex
shading and lighting effects, such as specular highlights and multiple light sources. For a
completely 3-dimensional image, on a computer which has sufficient memory, the 3D
Drawing mode is superior to the ATOMS 2D Drawing mode.

However, there are disadvantages to the 3D method. The depth buffer may result in
excessive memory requirements even for the screen (but some 3D accelerator cards may
have special memory for the depth buffer). The 3D method is not very suitable for
black-and-white drawings, which typically are ssmplified, showing mutual intersections
of atoms with bonds and polyhedra as lines or curves; such intersections simply are not
drawn in the 3D method. Because printers have much higher resolution than the screen,
this causes even higher memory requirements, and for reasonable sized printed drawings
itisusualy necessary to do the printing in bands or segments.

3.2.4.2.3 OpenGL Quad Stereo Drawing Mode

This drawing mode can be selected in the Drawing M ode submenu of the
Display menu, or the Dialog Bar - Left.

Thisisaspecial type of 3D Drawing mode which is available only for graphics hardware
supporting OpenGL quad-buffered stereo. In this mode, left- and right-eye images are
drawn and displayed by either of two methods:

1) Shutter glasses. The images are drawn independently and flashed alternately on the
screen at a high rate - 120 times per second in the latest computer implementations, for
exampl e those supported by the nVidia Quadro series of display cards. A special
monitor or projector isrequired, and it must be viewed with special shutter glasses which
blank out the left and right eyes alternately in synch with the images on the screen.

2) Polarized monitors or projections. The monitor or projector simultaneously or
aternately (very rapidly) generates two images which are polarized at 90 degrees to each
other, or with different circular polarizations. Some"3D" (stereoscopic) televisions have
different polarizations (and different images) for alternate lines on the screen and some
projectors and TV's use a checkerboard pattern. Theater 3D systems use this method. It
does not require expensive shutter glasses, only relatively cheap polarizing glasses for
each viewer.

See the Stereoscopic Display section in Reference for general requirements and
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procedures.
Two settings affect the perception of depth in stereo viewing:
1) The Stereopair Rotation Andle, set in adialog in the Input2 Men, or in the

DialogBar - Right. A value of about 1 to 3 degreesis usually appropriate (smaller when
starting out in stereo viewing).

2) The Perspective distance which isset in adiaog in the Input2 Menu, or in the
DialogBar - Right. A value of about 100 Angstroms is usually appropriate, but it may be
smaller for small structures.

In viewing real life objects setting the perspective distance would fix the stereopair
rotation angle because the human eyes are afixed distance apart. However in viewing
objects on an Angstrom scale the interocular distance is arbitrary, and thus it is possible
to set both parameters - in effect the stereopair rotation angle fixes the interocular
distance or the scale of the atomic structure relative to the viewer.

Not al stereo hardware supports OpenGL. The GeForce series of video cards from
nVidia supports stereo viewing with shutter glasses, but only through the Windows 3D
system software, Direct3D, for which a different drawing mode isavailablein ATOMS.
Direct3D is only available on Windows systems, not Macintosh or Linux. Although
hardware isindifferent to whether the program draws in 3D through OpenGL double-
buffered, OpenGL quad-buffered or Direct3D, the proper driver software must be
present. Polarizing monitors may or may not have drivers supporting OpenGL.

Older stereo drawing drivers from nVidia, which worked only on Cathode-Ray-Tube
monitors, not flat-screen LCD monitors, supported OpenGL without quad-buffering, as
well as Direct3D. This system worked with inexpensive shutter glasses, but if the
refresh rate of the monitor is lessthan 100 hz or so the flicker tends to be excessive. If
you are using such a system, you do not need to select the ATOMS 3D Quad Stereo
Mode; stereo images can be viewed in the OpenGL Single Drawing mode. However,
stereo will be shown only in Fullscreen display. The stereo effect is turned on with a hot
key or other switch for the hardware.

Stereo viewing works best when Perspective is selected.
Certain high-end nVidia Quadro cards support quad stereo on Linux, using special
"Professional” emitters and glasses. Thismode isthus availablein Linux, although it

will not produce stereo images without this special hardware. This mode has not been
tested on Linux.
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Setting up nVidia 3D Vision for quad-buffered OpenGL. Inthe nVidiacontrol panel,
select Manage 3D Settingsin 3D Settings. In the Global Settings tabe, the Global
presets option can be set to "3D OpenGL Stereo”. It may then be necessary to select the
particular setting Stereo - Display Mode and set it to " Generic active stereo (with
NVIDIA 3D Vision)".

If you have arecent VidiaQuadro card it may support 3D Vision stereo through
Direct3D aswell as OpenGL. There seemsto be no advantage to using Direct3D if
guad-buffered OpenGL isavailable, but if Direct3D is used, different settings may need
to be selected in the nVidia Control Panel. The Global preset option should probably be
"3D App - Default Global Settings'. All the nVidia settings may change and it may be
necessary to experiment to find the best combination.

3.2.4.2.4 Direct3D Drawing Mode

Thisisa 3D mode using the Microsoft Direct3D software, which is essentially
equivalent to OpenGL. Direct3D isa part of the DirectX drawing software. The main
reason for selecting this mode isto display stereoscopically using shutter glasses or a
polarizing monitor or projector, if you have adisplay card which supports stereo only
using Direct3D, not OpenGL guad-buffering. See the Stereoscopic Display sectionin
Reference for the requirements and procedures.

This mode also allows anaglyph (Red/Green or Red/Blue) stereoscopic viewing with
appropriate software drivers. This requires only cheap plastic colored glasses. The
nVidia GeForce graphics cards which support stereo viewing with shutter glasses also
support anaglyph viewing - in the nVidia Control Panel, enable Stereoscopic 3D and
select "3D Vision Discover” in the Stereoscopic 3D display type option.

Other software vendors such as iZ3D and TriDef supply drivers which may support
anaglyph or various other kinds of stereoscopic viewing on your system.

Sereo Viewing with nVidia shutter glasses. The nVidia GeForce display drivers prior to
V266 supported stereo viewing only in fullscreen mode, not in awindow. If you have an
old driver you will have to go into fullscreen mode (Fullscreen button in the Dialog Bar -
_Left) to see stereo, but you should download the updated driver from nVidia if possible.
For smoothest operation of windowed stereo, in the nVidia Control Panel, under
Stereoscopic 3D/Set up stereoscopic 3D, in the category " Select when the display isin
3D mode:" choose "Always'. If thisisset to "Only while 3D programs run”, the entire
screen may blank out while entering and exiting Direct3D mode and entering and exiting
from fullscreen mode. If it is set to "Only while full-screen 3D programsrun”, there will
only be stereo in fullscreen mode, not in the ATOM S graphics window.

In the Direct3D mode, fullscreen, there is no atom identification - the only action of the
mouse isto rotate the structure. The shortcut keys have their full effect.
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The nVidia settings depth and convergence are not available to the user in ATOMS,
because they are controlled by the two ATOM S settings Stereopair Rotation Angle and
Perspective Distance. Convergence affects the apparent overall distance of the object -
whether it appearsto bein front of or behind the screen. However, excessive
displacement in either direction can cause difficult in the ability of the eyesto merge the
two images (they may become excessively separated on the screen), and aso increased
prominence of "ghosts" or residual weak imagesin thewrong eye. Therefore ATOMS
always sets the convergence distance equal to the perspective distance so that the center
of the structure is essentially in the screen, not in front of or behind it. The stereopair
rotation angle then sets the nVidia depth (the term "depth" does not refer to the position
of the object front-back, but to the apparent distance between the nearest and the furthest
parts of the object).

The nVidiaKeyboard Shortcuts or hot keys for changing depth and convergence have no
effect in ATOMS, although using the depth keys will bring up a scale showing the
relative degree of stereo effect.

3.2.4.3 Fullscreen Display

The Fullscreen option in the the Display menu or the Fullscreen button in the
Dialog Bar - Left switchesto full-screen display. One reason to do thisisto take
advantage of full-screen, full-color stereoscopic viewing using shutter glasses - the
software and hardware for some of these systemswill only work in full-screen mode.
See below and the Stereoscopic Display section in Reference for the requirements and
procedures.

Except when in the Direct3D drawing mode, mouse buttons have the same effect as
when in the atom ID Cursor mode in awindow

L eft button down isfor identifying atoms, as in the normal windowed mode. If the |eft
mouse button is clicked when not on an atom, a dialog offering Quit or escape from the
Fullscreen mode, plus the control options of the shortcut keys, will appear.

Right button down and moving the mouse down causes rotation exactly asin the
normal windowed mode.

In the Direct3D mode, fullscreen, there is no atom identification - the only action of the
mouse isto rotate the structure. The shortcut keys have their full effect.

To exit from Fullscreen display, press the Escape key; or click with the mouse where
thereisno atom.

-- KEYBOARD CONTROLSFOR FULLSCREEN MODE
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With V6.4, the ATOMS shortcut keys have been revised and greatly expanded.

Rotation and vibrational animation can not currently be done at the same time - turn off
vibration in order to rotate the structure and vice-versa.

--IF THE KEYBOARD ISNOT FULLY ACTIVE IN FULLSCREEN MODE

On different platforms (Windows, Macintosh, Linux) or different releases or versions of
the same platform, some or all of the keys may be inactive in Fullscreen mode. Thus if
some or all of the above keyboard controls do not work, click with the mouse where
there is no atom, and you will be presented with a dialog giving the above options
explicitly, aswell as the option to Quit or exit full screen mode.

--Windows Only

Full-screen, full-color stereoscopic viewing with shutter glasses and CRT Monitors. The
following describes older technology for CRT monitors, not newer technology such as
nVidia3D Vision, which requires special shutter glasses and certain 120 Hz monitors.
That technology is supported with the 3D Quad Stereo Drawing mode (and can work in
awindow, not only in Fullscreen mode) or with the Direct3D mode.

Stereo viewing works best when Perspective is selected.

Shutter glasses, with driver software for Windows operating systems, were available
from some vendors. The most complete support isfor nVidia cards, the stereo drivers
for which are available for free online (www.nvidia.com). The requirements and general
procedure for shutter-glasses viewing are as follows.

1) You must have a cathode-ray-tube (CRT) monitor. Flat-screen monitors will not
work because the refreshing mechanism is different.

2) You must install the stereo software driver for your particular graphics card onto the
computer. Y ou may also need an up-to-date driver for the card itself. For nVidia cards,
it may be necessary to get older drivers which support the 3D stereo mode - try searching
on the internet for the name of your card plus"3D stereo driver”. For other cards you
will need athird-party stereo driver, which may be provided with the glasses. The driver
must support OpenGL.

3) Install the glasses (or the wireless station), typically by inserting a"dongle" where the
monitor cable plugsinto the computer (graphics card).

4) Turn on the Fullscreen mode in ATOMS, then turn on the stereo mode, usually by
using a"hot key". It may be best to turn stereo on after entering full-screen modein
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ATOMS, and turn it off before exiting.

Flickering in stereo mode is caused by a monitor refresh rate that istoo slow. This
usually may be reset in the Windows Display control panel and/or in the stereo driver
software. On switching into full-screen mode, ATOM Sfirst tries the current screen size,
bit-depth and refresh rate. If thisfails, then it tries successively smaller screen sizes. If
you get a message saying that the switch into full-screen mode has failed, you can try
changing the bit-depth (for example from 32- or 24-hit to 16-bit) or the refresh rate in the
Windows Display control panel or in the stereo driver software.

The Website www.stereo3d.com has some basic technical information about shutter-
glasses stereo, but the information on specific hardware and vendors may be out of date
because the technology and marketing are currently moving very rapidly.

Caution: use shutter glasses or other hardware and driver software at your own risk -
stereo drivers may have atendency to crash your system. SHAPE softwareis not
responsible for any damage to your hardware or software through use of these devices.

3.2.4.4 Cursor Mode Sub-Menu
Cursor Mode Submenu [ Display Menu]

In Atom I D (identification) mode, clicking on the left (or only) mouse button will
identify atoms and give bond lengths and angles - see Atoms at Cursor. The cursor in
thismodeisacross. Clicking and dragging with the right mouse button (\Windows) or
control+button (Macintosh) will switch temporarily (aslong as the button is down) to the
the Rotate mode, below.

In Rotation mode, clicking and dragging rotates the structure. In most of the window,
rotation will be around the y and z Cartesian axes, in the plane of the screen. Clicking
and dragging near the left or upper edges will rotate about the z axis, perpendicular to the
screen. The cursor is aquadruple arrow when rotating on x and y, and acircular arrow
when rotating on z.

The Cursor Mode can be selected either in the Display menu or the Dialog Bar - Right.

3.2.45 Replot Command
Replot Command [ Display menu]
This command redraws the image in the graphics window which is currently active

without recalculation. The active window may be the main graphics window
(containing the structure image), the Powder or Precession diffraction patterns.
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Changesin most itemsin the [nput2 Menu can be put into effect with this command
(although these dialogs all have an automatic replot check box). It can also be used after
some changesin the itemsin the Input1l menu, such as colors and bond radii. For
changes which affect atom locations and atoms involved in bonds and polyhedra, or
changesin thermal ellipsoids, use the Calculate command in the File menu. Changing
atomic radii does not require recalculation as long as stick bonds are not changed to
interpenetration or vice-versa.

When the Auto button in the Dialog Bar - Left is checked, replot is automatic whenever
you click one of the axis rotation buttons.

3.2.4.6 Color Command
Color Command [Display menu]

This switches between full-color and black-and-white screen display (all types of output
such as printing, metafiles, etc. have independent color switches). Screen displays with
more than 16 colors may show true gray-scale rather than the dithering which isused in
actual black-and-white output. Y ou can set the default or start-up status of this switch in
the Preferences dialog in the Settings menu.

3.2.4.7 Atom Labels
Dialog Box - called from: Display Menu

Y ou can show either labels or generated atom numbers. The labels will use the atomic
labels entered in the Revise Atom dialog, up to 6 characters. Y ou can specify fewer
characters with the M ax. letters item. The labelswill be stripped of trailing blanks and
centered on the projection of the atomic center, unless the Offsets are non-zero.

If the Scale box is checked, in printed output or output to afile, the labelsin that output
will be scaled to approximately the same relation to the drawing itself as on the screen.
Thisisavery approximate process, and trial-and-error adjustment may still be necessary
to get the desired label sizesin output. The option appliesto al types of lettering on the
plot, not just atom labels.

If the Background is opague, each letter will lie on asmall block of the designated
color; this usually makes the labels easier to read. Other programs which read ATOMS
output files may not be able to reproduce these opaque blocksin Metafile or PICT files
output. Labelsare not supported for Pen Plot output.

Sequence. The labels may be plotted immediately after each atom, or all at once after all
atoms have been plotted. The first usually looks better, but some labels will usually be
partly or completely obscured.
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Use PostScript font. Thisallows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and dlant (italic, oblique) of the font, but not the size, which is specified
in the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.

The label positions are correct for stereopairs, and labels for central atoms of polyhedra
will appear suspended in the interior of the polyhedra.

Show symmetry number (roman). If thisbox is checked, each atom label will have a
superscript, in roman numerals, giving the number of the symmetry operation which
generated the atom, or in the case of atomsin specia positions the first operation
generating that atom. Thisisthe method for designating symmetry operations (or
equivalent positions) mandated by Acta Crystallographica. The symmetry operations or
positionsin "xyz" form (as given in the International Tables) can be listed out with the
Listings/Input option in File menu. The symmetry numbersin roman and arabic
numerals for generated atoms can also be listed with the Listings/Generated Atoms
option in the File menu, and in the Calculation Output option in the Input2 menu. Note
that no superscript will be given to atoms generated by the first symmetry operation (X, y,
z or identity), and roman numeral "i" will be given to atoms generated by the second
operation, and so on.

The order of space-group symmetry operators may be changed to some extent, giving
different symmetry numbers and roman superscripts. To do this, switch to the Custom
symmetry option and rearrange the list of operations. The list of operations can also be
edited in the saved .str file with aword processor. Operationswill always be listed in
groups, related by a center of inversion, and by Bravais lattice centerings.

With Atomsto omit, you can elect to omit labels for certain classes of atoms, such as
non-plotting atoms (those in incomplete polyhedra, or deleted by the user) which are
deleted by default.

Individual generated atoms can be omitted or deleted, by clicking on the atom and
unchecking the L abels checkbox in the Generated Atom Data dialog. Thistype of
deletion islike deleting atoms themselves (see Deleting Atoms) - when you save afile, a
list is made of the generated atoms for which labels are deleted. Labelswhich have
been deleted in thisway can all be restored with the Restor e All button in this dialog.
Also, you can delete all labels with the Delete All button, then restore selected atoms
individually with the Generated Atom Data dialog. Starting with V4.0, the lists of
deleted atoms and label s use a code containing the unit-cell, the symmetry operator etc.,
rather than an arbitrary sequence number, so that changing the boundary conditions will
not usually make thelist invalid (although some deleted atoms or labels may no longer
be within the boundaries). However, changing the symmetry will make the list invalid.
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Labels on individual atoms can be moved onscreen with a special cursor mode controlled
by the M ove L abels button in the Dialog Bar - Right. The Zer o Displacements button
in this dialog will remove the displacements on all atom labels.

Use the color options in this dialog, not the color options in the Font dialog to set the
color of the letters. Letters are always solid black in black-and-white display or output.
See |nput Colors/Patterns/Pens for general aspects of color input.

Note that in 3D Drawing mode the labels have an absolute position in space, including
the x (front-back) coordinate. They are arbitrarily plotted a short distance in front of
each atom if the after each sequenceisselected. If the after all sequence is selected,
they aredrawn in asingle plane in front of all atoms.

3.2.4.8 Bond Labels
Dialog Box - called from: Display Menu

Y ou can specify the number of figuresto the right of the decimal with the Decimals
item. The labelswill be stripped of trailing blanks and centered on the projection of the
center of the bond (midpoint between atom centers), unless the Offsets are non-zero.

If the Background is opague, each letter will lie on asmall block of the designated
color; this usually makes the labels easier to read. Some other programs may not be able
to reproduce these opaque blocksin Metafiles or PICT files output. Labels are not
supported for Pen Plot output.

Sequence. The labels may be plotted immediately after each atom, or all at once after all
atoms have been plotted. Thefirst usually looks better, but some labels will usually be
partly or completely obscured. Some offset may be required.

Use PostScript font. Thisallows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and slant (italic, oblique) of the font, but not the size, which is specified
in the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.

If the Scale box is checked, the lettersin the labels in printed or file output will be
rescaled to keep the same approximate proportions with respect to atoms, bonds, etc. as
in the screen view.

Use the color options in this dialog, not the color optionsin the Font dialog, to set the
color of theletters. Letters are always solid black in black-and-white display or output.
See |nput Colorsg/Patterns/Pens for general aspects of color inpuit.
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Individual bond labels may be "deleted", or marked for non-plotting, by clicking on the
two atoms in succession and unchecking the Bond L abel box in the

Generated Atom Data dialog. The Show All button in this dialog will restore all bond
labelsto visibility, and the Delete All button will mark them all for non-plotting.

Labels on individual bonds can be moved onscreen with a special cursor mode controlled
by the M ove L abels button in the Dialog Bar - Right. The Zer o Displacements button
in this dialog will remove the displacements on all bond labels.

Note that in 3D Drawing mode the labels have an absolute position in space, including
the x (front-back) coordinate. They are arbitrarily plotted 0.5 Angstromsin front of the
center of the bonds, but they may still actually intersect or interpenetrate with the bond in
some cases.

3.2.4.9 Angle Labels
Dialog Box - called from: Display Menu

Angles are labeled with their valuesin degrees. A circular arc is drawn between the two
central-ligand bonds defining the angle, and the label is drawn over the midpoint of this
arc. Notethat thisarcis 3-dimensional, and its projection may not be circular. The
radial position of arc and label are defined with the Fraction of short bond edit box. If
thisvalueis 0.5, for example, the arc will be drawn half-way out from the central atom to
the atom at the end of the shorter bond.

Angles are located automatically, from the Specifications (below). Note that the
location is done in the calculation, not plotting, so changing the specifications will
require Recalculation (Dialog Bar - Left or File menu).

Drawings should be kept simple when this option is used, as only alimited number of
angle labelswill beintelligible. Typically this option would be used in conjunction with
the Sphere boundary option, to illustrate the coordination of asingle atom.

The Blank interval causes the bond to start and end short of the actual center line of the
bonds. Using thisinterval may improve the appearance, especially if stick bonds, instead
of line bonds, are used.

Y ou can specify the number of figuresto the right of the decimal with the Decimals
item. The labelswill be stripped of trailing blanks and centered on the projection of the
midpoint of the arc, unless the Offsets are non-zero.

If the Background is opague, each letter will lie on asmall block of the designated
color; this usually makes the labels easier to read. Some other programs may not be able
to reproduce these opaque blocksin Metafile or PICT file output.
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If the Scale box is checked, the lettersin the labelsin printed or file output will be
rescaled to keep the same approximate proportions with respect to atoms, bonds, etc. as
in the screen view.

The Linewidth givesthe width of the arc, which isaways aline evenin 3D Drawing
mode. Theline will have the same color as the letters; this color can be specified in this
dialog. [Macintosh only ] In the 3D Drawing mode on the Macintosh it is not possible
to set linewidths - all lines are one pixel wide.

Use PostScript font. Thisallows you to enter a character string for PostScript fonts
supported by a PostScript printer if such fonts do not appear in the standard system font
dialog called up by the Font button. This character string usually specifies the weight
(normal, bold) and dant (italic, oblique) of the font, but not the size, which is specified
in the Font dialog. Certain PostScript typefaces are standard, and should be present on
most PostScript printers.

Use the color options in this dialog, not the color optionsin the Font dialog to set the
color of the letters. Letters are always solid black in black-and-white display or output.
See |nput Colors/Patterns/Pens for general aspects of color inpuit.

Specifications. These are given in terms of coordination of asingle central atom.
Angles will be found around all atoms of the given Type. The Maximum Angle can be
used to exclude near-180-degree angles in octahedra, for example. The angles are
located at calculation, not plot time, so changing specifications will require
Recalculation (Dialog Bar - L eft or File menu).

"Deleting " angle labels. All angles around the atoms of the specified type(s) will be
located. However, individual angles can be "deleted”, or actually marked for non-
plotting. Thisisdone by clicking successively on the three atoms in the order outer-
central-outer. Inthe Generated Atom Data dialog, there then appears an Angle
checkbox. Unchecking will cause non-plotting of the angle. A list of the non-plotting
anglesis saved in the data (.str) file. The Show All button alows restoration of al non-
plotting angles, and the Delete All button marks all angles for non-plotting. Individual
non-plotting angles can be restored by clicking on the atoms and checking the Angle box
in the Generated Atom Data dialog.

Labels on individual angles can be moved onscreen with a special cursor mode
controlled by the M ove L abels button in the Dialog Bar - Right. TheZero
Displacements button in this dialog will remove the displacements on all angle labels.

Angle labels are not supported for Pen Plot output.

Note that in 3D Drawing mode the labels have an absolute position in space, including
the x (front-back) coordinate. They are arbitrarily plotted 0.5 Angstromsin front of the
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arc, but they may still actually intersect or interpenetrate with the arc in some cases.

3.2.4.10 Scale Grid
Dialog Box - called from: Display Menu

This option allows you to locate and size the structure, so that it can be rescaled or
displaced. It will draw a square grid at the given absolute intervals. The center of
coordinates is shown by a star at the center of the screen, and the current location of the
center of the structure by another star. These two center points differ only if you have
entered displacements or turned on automatic centering with the
Centering/Displacements dialog in the Input2 menu. The grid isremoved only by
replotting with the Grid plotting on box unchecked.

See |nput Colors/Patterns/Pens for general aspects of input

3.2.4.11 Mark Atoms

Dialog Box - called from: Display Menu

Thiswill draw abox of the given size around the center of of each of the selected type of
atom. Thisisespecially useful in locating atoms which you have previously marked as
non-plotting.

See |nput Colors/Patterns/Pens for general aspects of input.

3.2.4.12 Clinographic Viewing
Clinographic Viewing Command [ Display menu]

This turns clinographic viewing on and off, with automatic replot. See also
Clinographic Viewing in the Rotation menu, which does the same thing without
automatic replot. Set the inital state of clinographic viewing in the Initial Orientation
dialog in the Input2 menu.

See also Coordinate Systems.

3.2.4.13 General Planes
Dialog Box - called from: Display Menu

3D Drawing modes only.
This allowsinsertion of general planes.

The planes are defined in terms of corners (points) in fractional coordinates on the
structure (crystal) axis system. The points must define a convex planar polygonin
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correct order. The planes are two-sided, so the sequence 1-2-3-4 is equivalent to 4-3-2-
1.

Complete parallelogram. If thisbox is checked and there are only three points, afourth
point will be added such that side 3-4 will be parallel to 2-1 and 4-1 will be parall€l to 3-
2. If the box is not checked, three points will define atriangle.

3.2.4.14 General Lines or Cylinders

Dialog Box - called from: Display Menu

3D Drawing modes only.
Thisalows not only general lines or cylinders, but customized "bonds" to be drawn.

Thelines or cylinders are defined in terms of two pointsin fractional coordinates on the
structure (crystal) axis system.

If the Radiusis 0.0, lineswill be drawn (if allowed in the particul ar type of display or
output) - otherwise cylinders will be drawn.

If you have clicked with the mouse on two atoms (see | dentifying (Picking) Atoms), you
have the option, in the Generated Atom Data dialog, of defining a"bond" between the
current atom and the last one. Y ou will be referred to this dialog, and the "bond" will be
kept in thelist of lines/cylinders, not in the Bonds dialog in the Inputl menu.

3.2.4.15 Dialog Bar - Left
Dialog Bar - Left

Thisisactually a special type of Control Bar, which resides on the | eft side of the Main
window. It can be turned on or off with the Dialog Bar - L eft command in the Display
menu.

The upper part controlsrotation of the structure in simple ways (for more ways to rotate
or align the structure, see the commands in the Rotation menu). The current orientation
isshown at thetop. The a, b and c axis labels are attached to the positive ends of the
axes, and the part of the axes extending forward (positive x) are drawn with heavier
lines. The rotation buttons below this are for rotation on x, y and z, respectively;
positive angle (clockwise looking outward on the axis) is on the left, and negative
rotation on the right. The angle of rotation isin the box below the buttons. The initia
value of thisangle is set in the Preferences dialog in the Settings menu.

If the Auto box is checked, the drawing is replotted immediately after each click on a
rotation button. If it is not checked, the rotations are accumulated into a matrix, and the
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drawing is not replotted until you click on the Replot button lower in the dialog (or
select Replot from the Display menu).

The buttons and other controls beneath Auto duplicate some common commands,
mostly from the File menu and the Display menu. Y ou can use Open to start up
ATOMS by reading in afile.

Replot - Replotsthe image (does not recalculate).

Calculate - Reproduce atoms within specified boundaries and locate bonds and
polyhedra.

Open - Openanold ATOMS datafile.

Import - Open acrystallographic or molecular data file from other sources.
Import - Open acrystallographic or molecular data file from other sources.
Save - Savean ATOMSdatafile.

Saveas - Savean ATOMS datafile with anew name

Print - Print out the graphicsimage.

The Model Mode drop-down or box controls the Model Mode - this duplicates a
submenu in the Display menu. The options are Standard, Ellipsoid, Cavities and
Protein.

The Drawing Mode drop-down or box controls the Drawing Mode - this also duplicates
asubmenu in the Display menu.

The Fullscreen button switches from normal windows to display using the entire screen.
From ATOMS V6.4 this can be done with any combination of Model and Drawing
Modes and on Macintosh, Windows or Linux (although there are some different controls
for Linux)

The Animate button, present when you haveread ina .MOT file from VIBRATZ and
have atomic-motion data for vibrational modes, will start an animated (moving) display.
Exit the animated mode by clicking the mouse or hitting any key. Speed and other
parameters of thisdisplay are set in the Vibrational Modes dialog in the Inputl Menu.
That dialog also controls making movies or "video" files.

3.2.4.15.1 Import File
Dialog Box - called from: Dialog Bar - L eft

This offers a selection of file typesto import, including CCDC FDAT, SHEL X-93, CIF,
DBWS/LHPM Rietveld, ICSD, ORTEP, XTLVIEW, VIBRAT.PDB, RIETAN, GSAS,
AM MINERAL, FULLPROF, Free-Form, Ravel ATOMS and WIENZ2K.

The boundary option in most cases can either be Default Unit Cell, suboption as selected
with the Default radio button, or Locate Moleculesin Crystal.
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Multiple occupancies are not permitted in ATOMS, and when more than one atom is
found to be in the same position (same fractional X, y and z coordinates) the second and
subsequent occurences will be deleted.

Thereisalimit of 500 input atoms in most cases.
3.2.4.16 Dialog Bar - Right
Dialog Bar - Right

Thisisactually a special type of Control Bar, which resides on the right side of the Main
window. It can be turned on or off with the Dialog Bar - Right command in the

Display menu.

Cursor Mode. In Atom ID (identification) mode, clicking on the left (or only) mouse
button will identify atoms and give bond lengths and angles - see Atoms at Cursor.

The cursor in this mode is a cross. Clicking and dragging with the right mouse button
(Windows) or control+button Macintosh) will switch temporarily (aslong as the button
is down) to the the Rotate mode, below.

In Rotate mode, clicking and dragging rotates the structure. In most of the window,
rotation will be around the y and z Cartesian axes, in the plane of the screen. Clicking
and dragging near the left or upper edges will rotate about the z axis, perpendicular to the
screen. The cursor is aquadruple arrow when rotating on x and y, and acircular arrow
when rotating on z.

The Clino (clinographic) View checkbox will switch viewing with the Clinographic
rotations.

The Set Center button defines anew center point - use thisto "focus' or "zeroin" on a
specific area or point in the plot. After clicking on this button, an dialog informsyou
that the next mouse click in the graphics window will define anew center point. After
clicking on a point, the drawing will then be displaced so that that point will be at the
center of the viewing area. It may be more useful to think of the result as the viewing
area being centered on the point selected. Displacements set in thisway may be changed
in the Centering/Displacement dialog in the Input2 Menu.

With the Rescale buttons, you can "zoom™ in or out. The actual factor applied is 1/(1+x)
for down scaling, and (1+x) for up scaling, where x is the amount in the edit box
converted from percent to afraction. Inthe Maximize size for each view and Univer sal
maximum modes this changes the Rescal e factor, which may be reset manually in the
Scaling dialog in the Input2 menu. When in the Fixed scaling mode, the actual scale
factorsfor screen, print and pen plot are changed. This behavior isachange from pre-
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V5.0 ATOMS, in which rescaling always changed to the Fixed mode.

Orientation buttons. These buttons will actually remove accumulated rotations and
return to either the original orientation or the initial orientation. They perform the same
functions as the Remove Rotations option in the Rotation menu.

Theoriginal orientation means the orientation before any rotations, including the
alignment of adlice, and the rotations of the Initial Orientation dialog in the I nput2
menu, have been made. This gives the standard orientation of the crystal (thefirst onein
the case of multiple crystals) with respect to the reference Cartesian coordinate system.
Theinitial orientation isthat attained after the rotations just listed have been made, if
any of them were actually used. See also Coordinate Systems.

Delete Tool. Thisalows"deleting" (see Deleting Atoms and Atom L abels) groups of
atoms by creating a polygon with the mouse. All atoms within the projection of the
polygon can be marked for non-plotting.

The Show All button allows immediate restoration of al atoms marked as non-plotting.
See the Atom/Bond Plot States dialog (Input2 menu) for more options regarding non-
plotting atoms.

Move Labels. Individua atom, bond and angle labels on generated atoms can be
moved from their centered position. This button turns on and off a special cursor mode
(for the left button only) in which clicking and dragging labels will move them. This
should not be done until the very latest stages of preparing a drawing, since rotations are
liable to make the changed locations invalid. All label displacements can be removed for
each type of label in the dialogsin the Display menu.

The Inter. bonds (inter-molecule bonds) combo box (only displayed if there are bonds
between molecules or fragments) gives several options for display of inter-molecule or
interfragment bonds. If Highlighted is selected, such bonds are shown in normal colors
while al other atoms, bonds, etc. are dimmed. Other possible highlighting of molecules
or fragmentsisignored.

The Reset Scale button calls the Reset Scaling and Centering dialog. This alows
reversion to the last setttings, before interactive changes with the Set Center or Rescale
buttons (above), or in the Fullscreen 3D mode.

The Stereo Angle edit box sets the angle between left- and right-eye viewsin the 2D
Stereopair, 3D Stereopair and Quad Stereo Drawing modes. This angle should be
negative for cross-eyed viewing of stereopairs

The Per spective Distance edit box sets the perspective distance (not relevant in most
cases if perspective viewing is turned off in the Perspective dialog). This can affect the
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perception of depth in stereoscopic modes.

3.2.4.17 Dialog Bar - Fragments
Dialog Bar - Fragments

Thisisactually a special type of Control Bar, which resides on the right side of the main
Graphicswindow. It can be turned on or off with the Dialog Bar - Fragments
command in the Display menu.

Frag (Fragment) This selects the fragment to be operated on.

Rotate. Each of the six buttons will rotate the sel ected fragment about one of the
Cartesian observer axes (see Coordinate Systems) by the angle in degrees entered in the
edit box below. The arrowsin the lower four buttons indicate motion of the front of the
structure.

Trangate. Pressing the Translate button will move the selected structure by the
distance in Angstroms entered in the edit box, along one of the Cartesian observer axes
(Cart x, y or z) or one of the structure (crystal) axes (Struct a, b or c) of the main
structure as selected by the radio buttons.

Use a negative distance to move backward along one of the axes.
Thetrandationsin this dialog affect the actual x, y and z coordinates of the atoms and

are thus quite different from the plotting displacementsin the
Centering and Displacements dialog in the Input2 Menu.

Trandations can be removed in the Trand ate Structure Fragment dialog under
Multiple Structures in the Transform menu. Thisdialog also allow more complex
trangd ations.

Rotations made in this dialog can be removed with the Rotate Structure Fragment
dialog, Transform menu.

Note that the rotations and translations (on Cartesian axes) are applied in the current
orientation of the overall structure and fragments, but they operate on the original
coordinates as listed in the |nput Atoms dialog. These rotations and translations are
permanent, and will be saved with the Save or Save As options. Currently, the input
atom coordinates are not changed by rotations of the complete structure (e.g. with the
DialogBar-L eft), whereas in earlier versions of ATOMS rotations of the complete
structure acted directly on the input atoms.
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3.2.4.18 Powder Diffraction
Dialog Box - called from: Display Menu

To calculate diffraction, the type numbers for atoms (Atom Data dialog) must be valid
atomic numbers, or those numbers modulo 100, or must anyway correlate with the table
of scattering factorsin the SCATFAC.DAT file if you modify that file.

If you select aList, thelist will appear in a Text window (see Types of Windows).
Therewill bealinein thelisting for each crystal form, or symmetry-unique set of
reflections (with center of inversion assumed). If there is more than one wavelength, the
2-theta and relative intensity will be listed for each in that line.

If you select a Graph, you may show either Bar s or a Curve - the curve will use
Gaussian lines with the selected full width at half maximum (FWHM). For acurve, the
location of individual reflections will be shown as a short bar underneath the curve.

The Line width pertains to the width of all lines or "pen strokes" in the graph, not the
width of each spectral peak (FWHM).

If the Vertical scalefactor or magnification is 1.0, the strongest peak will just fill the
plot area. If you want to see more detail in the weaker reflections, this factor can be
increased and the stronger reflections will be truncated.

If the atom records include temperature factors, they will be used. If an atom has no
temperature factor, the B isotropic value in the Default temper atur e factor box will be
used. No absorption or extinction corrections are applied.

There are four options for wavelength; averaged K (alpha); separate K (alpha)l and

K (alpha)2; averaged K (alpha) and (separate) K (beta); and a single Specified
wavelength. For thefirst three options, the X-ray tube target element must be selected
in the Radiation combo box. When two wavel engths are cal culated, the barsindicating
the second (K (alpha)2 or K(beta)) are shown in red on the screen and in color output,
and as a dotted line in black-and-white output.

In the case of K (alpha) and K (beta) the relative intensity of K(beta) must be specified
(Betainten.). For unfiltered radiation thisisin the neighborhood of 0.2. Of courseit
will be smaller for filtered radiation.

This option gives only a semi-quantitative calculation of powder intensity, intended for
purposes of identification. For somewhat more elaborate options, including the ability to
show multiple species, try the program Powder Cell. For highly quantitative
reproduction of powder patterns, there are now many Rietveld programs available (see

Import files).
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The results of the Graph option are shown in a graphics windows (see
Types of Windows), and when thiswindow is active, the File menu allows graphics
Printing, Raster Files and Metafiles or PICT files.

For this option to work properly the space-group symbol entered either in the

Space Group from Table or Custom Symmetry option must be valid for a standard
setting. If itisnot, it should be possible to transform to avalid setting using the program
CRY SCON (Shape Software).

NOTE: Many of the sample files provided with ATOMS, especially the Basic Inorganic
structures, are idealized structure types. They may have a unit cell scaled to abond
length of 1.0, or use arbitrary numbers for typesinstead of atomic numbers as required
for diffraction. Therefore they will not always give correct diffraction results.

3.2.4.19 Precession Pattern
Dialog Box - called from: Display Menu

To calculate diffraction, the type numbers for atoms (Atom Data dialog), or those
numbers modulo 100, must be valid atomic numbers, or must anyway correlate with the
table of scattering factorsin the SCATFAC.DAT fileif you modify that file.

The Precession angle (mu) and Crystal-Film distance should match those of the real
film to which comparison isto be made. The Precession angle determines the extent of
the pattern in reciprocal space. If the Fixed Scale option (rather than Fit in Window) is
selected, the pattern will be in true scale. This can be altered with the Factor, which is
1.0 by default.

The part of the reciprocal lattice shown is determined by the Horizontal axis, the Other
axis and the Level. For example, for a Okl pattern with b* horizontal, the Horizontal
axisisb*, the Other axisisc*, and the Level isO.

Reflections are shown as squares whose area is proportional to the calculated relative
intensity. The intensities are normalized based on the number of electronsin the unit

cell (intensity of reflection 000) and the smallest reciprocal lattice spacing in this net.
The Intensity factor scalesthe edge length, not area, of the squares (thusit really applies
to the structure factor).

To reproduce actual X-ray precession photographs, the Do L orentz-polarization box
should be checked. Omitting the Lp corrections shows the structure factors (squared),
and it also allows display of the inner region in the upper levels, which is not recorded in
an actual X-ray pattern. The Lp factor becomes very large near the inner and outer edges
of the recorded pattern - if the value of this correction is greater than 10.0, an open
symbol is used rather than afilled one. Such intensities are not reliable.
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If an atom has no temperature factor, the B(iso) value in the Default temper atur e factor
edit box will be used. Extinction and absorption are not considered.

Scattering factors used by default are those for neutral atoms from Volume 4 of the
International Tables (1974 edition). Atom type numbers must be atomic numbers, or
must correlate with the order of the entriesin the SCATFAC.DAT file. Thisfile may be
edited to supply different scattering factors.

If the Show grid box is checked, the reciprocal lattice will be shown asagridinred on
the screen and color output, or as dotted lines in black-and-white output.

The results of this option are shown in a graphics windows (see Types of Windows), and
when thiswindow is active, the file menu alows graphics Printing, Raster Files and
Metafiles or PICT files.

For this option to work properly the space-group symbol entered either in the

Space Group from Table or Custom Symmetry option must be valid for a standard
setting. If itisnot, it should be possible to transform to a valid setting using the program
CRY SCON (Shape Software).

NOTE: Many of the sample files provided with ATOMS, especialy the Basic Inorganic
structures, are idealized structure types. They may have a unit cell scaled to abond
length of 1.0, or use arbitrary numbers for typesinstead of atomic numbers as required
for diffraction. Therefore they will not always give correct diffraction results.

3.2.5 Rotation Menu (Graphics Window)
Cartesian Axes - Rotate on the viewer or reference axes.

Structure Vector - Rotate on arational structure vector [uvw].

Clinographic Viewing - Thisturns clinographic viewing on and off, with optional
replot

Align Face or Vector - Align the structure with aface in the screen or a vector
perpendicular to it.

Stereopair Rotations - Used to draw separate left- and right-eye stereopair views when
Shading ison.

Remove Rotations - Remove all rotations made since the calculation or the
Initial Orientation.
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Current Orientation - Givesthe current orientation of the structure with respect to the
observer coordinate system.

Continuous Rotation - Sets up continuous timed rotation about any of the observer
axes.

Rotation Movie - Write avideo or moviefilein the AVI (Windows), . MOV
(Macintosh) or .SWF - Flash (all platforms) format.

3.2.5.1 Rotate on Cartesian Axes
Dialog Box - called from: Rotation menu

This rotates the structure on one of two sets of Cartesian axes. If clinographic viewing is
off, the structure is always rotated about one of the axes belonging to the observer
system: x coming straight out towards the observer, y in the plane of the screen or paper
pointing to the right and z upwards.

Each time you click the Rotate button, arotation is added to a master rotation matrix;
the number of such rotationsis listed at the bottom of the dialog box. When you have
finished rotating, click the Done button and the master rotation matrix is applied to the
structure. If you click Cancel, no rotations are applied.

3.2.5.2 Rotate on Structure Vector
Dialog Box - called from: Rotation Menu

Thiswill rotate about arational structure direction [uvw], regardless of the current
Model mode or orientation of the structure. If you are drawing a molecule and have used
Cartesian reference axes, the rotation direction is simply avector with the coefficients u,
v and w in the original molecule axis directions a, b and c. The indices or coefficients
refer to a coordinate system fixed with respect to the structure (always rotating with it).
The indices must be integers, but thisis not a bar in practice to rotation about irrational
vectors, since the indices may take very large values.

Each time you click the Rotate button, arotation is added to a master rotation matrix;
the number of such rotationsislisted at the bottom of the dialog box. When you have
finished rotating, click the Done button and the master rotation matrix is applied to the
structure. If you click Cancel, no rotations are applied.

3.2.5.3 Clinographic Viewing
Dialog Box - called from: Rotation Menu

Thiswill switch on and off the rotations of -18.4 degrees on z and 9.5 degreeson y,
applied in clinographic display mode. Thisin effect changes the viewpoint of the
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observer between the clinographic position, down the vector [621] referred to the
observer Cartesian axial system, and a straight-on position, down the x axis. This
command isincluded in the menu for convenience; the same operation is performed by
the Clinographic Viewing command in the Display menu, although choosing that
command always causes areplot.

See also Coordinate Systems.

3.2.5.4 Stereopair Rotation
Dialog Box - called from: Rotation Menu

If you want to show a steropair which can fit onto one page, it is usually easiest to draw
it automatically by turning on the stereopair mode with the Stereopairs dialog in the

I nput2 menu. However, you may want to set up and draw each half of the pair
manually, if for example each view isto take up an entire page of output. Thisoption
rotates the structure and the illumination vector for shading by the requested angle about
the z axis. If you are not using shading, ordinary rotation about z (viewer) will suffice.

The left-eye view should be rotated clockwise (positive angle): an angle of about +3
degreesisusually satisfactory, although this may depend on the perspective distance, the
type of viewing device, etc. After making a hard copy of this orientation, the rotation
should be negated with the Remove button. Then make aright-eye view by rotating the
negative of the left-eye value; after making the hard-copy, remove the rotation again.

3.2.5.5 Align Face or Vector
Dialog Box - called from: Rotation Menu

Thiswill rotate a specified face (hkl) to lieflat in the screen or paper (face-normal
parallel to x observer), or avector (uvw) to be perpendicular to the screen or paper. To
align aface, it is also necessary to specify avector lying in the face which will be vertical
in the screen or paper (z direction). Conversely, to align avector, it is necessary to
specify aface, containing the vector, whose normal will be vertical. If avector [uvw] lies
in aface (hkl), the indices satisfy the condition hu + kv + lw = 0. If clinographic viewing
isin effect, it isturned off when the face is aligned, to simplify any subsequent rotations.

Y ou can elect to use the default alignment vector or face, instead of specifying it. The
default vector will be the intersection of the face (hkl) with the face (100), whose indices
are given by the cross product (hkl)x(100). If the face (hkl) is (100), the default
alignment vector will be the vector [001]. For aligning a vector the algebraisjust the
same, with interchange of face and vector.

When dealing with amolecule or polymer, using a Cartesian axial system, thisrotation
option can be used to obtain aview down a given vector direction. Use the vector
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alignment option, although when the structure axes are Cartesian the two cases of
aligning aface or avector areidentical. After specifying theinitial vector or view
direction, if you do not accept the default you must then give another vector, in place of
the "faceindices’, which is perpendicular to the first vector, and which isto be vertical
(z direction). If the two vectors are at right angles, their coefficients or "indices"
multiplied together (the vector dot product) should equal zero asin the above condition
for avector lying in aface.

Coordinate system (Input=Generated). When in the specia Input=Generated
boundary mode, you can choose to align the structure (and the aggregate if more than
one structure fragment is present on either the original crystal axes (if the structure was
originally acrystal), or the Cartesian axes to which the atoms were transformed when the
last Generated to Input operation (Transform menu) was performed. Note that before
V6.3 the alignment was always done on the Cartesian axes of the structure - if you want
to continue with this behavior, select Cartesian axes.

3.2.5.6 Remove Rotations
Dialog Box - called from: Rotation Menu

Thiswill counteract all rotations made by the dialogs in the Rotation menu as well as
any made on-screen with dialogsin the Display menu, and take you back to one of two
settings. The original orientation means the orientation before any rotations, including
the alignment of a dlice, and the rotations of the |nitial Orientation dialog in the Input2
menu, have been made. Theinitial orientation isthat attained after the rotations just
listed have been made, if any of them were actually used. See also Coordinate Systems.

Summary of orientation operations. ATOMSfirst setsthe ¢ structure axis parallel to the
2 viewer axis, and the a * structure axis (perpendicular tob and ¢ ) paralel tox. Thisis
theoriginal orientation. Next, if the Slice boundary option isin effect, the dliceis
oriented with the slice plane parallel to yz, and the orientation vector parallel to z. Then
theinitial Cartesian rotations, if any, are applied. Finally, the clinographic rotations, if
selected, are applied. Thisistheinitial orientation.

3.2.5.7 Current Orientation
Dialog Box - called from: Rotation Menu

This gives the current orientation of the structure in terms of the structure vectorslying
in the x (reverse view direction) and z (vertical) axes of the Cartesian observer system
(see Coordinate Systems).

Coordinate system (Input=Generated). When in the specia Input=Generated
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boundary mode, the orientation can be given in terms of either the original crystal axes
(if the structure was originally a crystal), or the Cartesian axes to which the atoms were
transformed when the last Generated to Input operation (Transform menu) was
performed. Note that before V6.3 the orientation was always given in terms of the
Cartesian structure axes.

3.2.5.8 Continuous Rotation
Dialog Box - called from: Rotation Menu

This option will rotate the image about any of the three Cartesian observer axes (see
Coordinate Systems), by the given increment in degrees.

The Timedelay isthe delay after the image isfinished before redrawing is started again.
The time required to draw the image is not included in this value.

When this option isin effect, the image is drawn into an off-screen bitmap and then
copied onto the screen (see the Preferences dialog in the Settings menu), rather than
drawn directly onto the screen. When continuous rotation is halted, the previous mode
of drawing on- or off-screen isrestored. Sound istemporarily turned off.

Pressing any key or mouse button will halt the rotation.

3.2.5.9 Rotation or Vibration Movie

Dialog Box - called from: Rotation Menu, Vibrational Modes dialog,
Thermal Motion dialog.

Thiswill writeamovie or video filein .AVI (Windows), .MOV (Macintosh) or .SWF -
Flash (all platforms) format. These files consist of a series of bitmap (raster) images.

Rotation. The structure will be rotated from its current attitude about the selected Axis,
with the selected Rotation increment, until the sum of rotations exceeds the Maximum
rotation.

Vibration. One vibrational cycleiswritten - normally this should be displayed as aloop,
or in continuous mode. The Seconds per cycle determines the duration of the loop, and
therefore the total number of frames.

Thermal Motion. The complete range of temperatures will be recorded.

A normal motion picture uses 30 Frames per second, but typical computer videos use
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less than this. In fact, some computers may not be able to handle 30 frames/sec for large
images. 15 frames/sec may be adequate

For .SWF - Flash files (only) you can add a sound track from a.mp3 file.

Note that movie files may be very large (many megabytes) even if compressed. For
Macintosh, the compression mode is automatically selected by the System software, and
is supposedly optimal for the resolution (Pixel size) selected. In Windows, you are
presented with a dialog showing the available codecs (COmpression-DECompression
algorithms), and you must select one. Finding the optimal codec may be a matter of tria
and error - performance usually varies with the Pixel size and the actual number of
colorsused. Some codecs compress very effectively, but cause degradation of theimage
- ATOMS images should usually be compressed with alossless compression method.
Some codecs which have been found to be good for typical ATOMS images are the
CorePNG and Lagarath codecs. These and other codecs can be downloaded on the
WWWeb (Internet).

See Frames for details of the frame and frame units.

3.2.6 Transform Menu (Graphics Window)

Generated to Input - Converts to a special mode, necessary for dealing with multiple
structure fragments, and for modifying individual generated atoms.

L ocate Groups - Isolate molecules, polymers or other bonded groups.

Multiple Structures - Generate, read in, or manipulate separate structure fragments.

Remove Crystal Symmetry - Convertsto acrystal with no symmetry (space group P1).
Unit-cell contents will be converted to input atoms, retaining cell parameters (as
triclinic). Temperature factorswill be converted to isotropic B.

Expand Layers - Expands a crystal structure on certain planes, increasing the length of
the selected axis, creating space near the expansion planes, but leaving the actual
structure within layers unchanged.

3.2.6.1 Generated to Input

Dialog Box - called from: Transform menu

This converts the generated atoms (i.e., al those generated by the symmetry operations
and trandations within the given boundaries) to input atoms, removes all symmetry and
boundary conditions, and changes to a special operating mode, called "Input=generated”.
Thisislike converting the current generated volume to a molecule with no symmetry.
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This option is required before using the Multiple Structures optionsin the Transform
menu. Itisalsoagood ideato usethisoption if you want to delete more than afew
generated atoms (see Deleting Atoms).

Temperature factor data are carried over into the special mode as Cartesian eigenvalues
and vectors rather than U or beta coefficients, but they can no longer be modified.
However, if there is more than one structure fragment temperature factors are not
allowed (they will be deleted).

Orientation radio buttons. Y ou have the option of returning to the original or standard
orientation before converting, or taking the current orientation as the new "original"
orientation. This orientation will be saved, which was not the case in pre-V4.0 ATOMS.

Some of the following checkboxes may not be shown, depending on circumstances.

Convert moleculesto fragments. Thiswill convert molecules or groups located in
several different waysto individual fragments. If one of the Moleculesin Crystal
boundary options has been chosen, all atoms will be in molecules, and each molecule
will become afragment. "Molecules’ may be individual atoms, asin CaCO3 structures
(assuming Ca-O bonds are not defined or are marked asintermolecular). If another
boundary option is used, and molecules or groups are subsequently located with the Find
button in the Generated Atom Data dialog (which appears when you click on an atom),
or with the Locate Groups dialog in the Transform menu, there may be atomswhich are
not part of molecules or groups. All these "leftover" atomswill be put into asingle
fragment, in addition to those already |ocated.

Remove non-plotting atoms. Non-plotting atoms are those which have been explicitly
marked as non-plotting, either individually or in groups. Also classed as non-plotting
atomsin PDB (protein) structures are hetatoms and/or waters which have been omitted
from the plot by means of the setting in the PDB (Protein) Display Parameters dialog in
the Input2 menu. Atoms in incomplete polyhedra, which may or may not be shown in
the drawing (Polyhedra dialog, Inputl menu) are in a separate option below.

Keep thermal ellipsoids. Thermal ellipsoids are not allowed in Multiple Structures, so
there is no point in keeping them if additional fragments are to be added.

Omit atomsin incomplete polyhedra. Thisincludes all atomsin polyhedra which have
less than the specified number of ligands, i.e. are incomplete because of boundary
conditions.

Keep vectors. Atomic vectors are not likely to be useful in Multiple Structures.

In early versions of atoms in Input=generated mode there were no separate lists of input
and generated atoms, because of memory constraints. Rotations of the complete
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structure acted directly on the input atoms (not a separate list of generated atoms), and
thus when the structure was saved the rotations were permanent. Currently, rotations act
on aseparate list of generated atoms, and do not affect the input atoms. However, if you
rotate or translate individual fragments with optionsin the Multiple Structures Dialog or
the DialogBar-Fragments, these will permanently affect the input atoms.

3.2.6.2 Locate Groups
Dialog Box - called from: Transform Menu

This allows you to isolate individual molecules, polymers or other structural groupsin a
crystal. You must specify asingle "seed" atom, then all other atoms interconnected to
this one are located. The interconnection is by bonds specified in the Bonds input, or
polyhedra specified in the Polyhedra input in the Input1 menu. There must be no bonds
(except those marked inter-molecular) from atoms in a group to atoms outside the group,
nor can polyhedra connect atoms within and without the group.

If the structure consists of discrete molecules, not polymers, it is usually easier to use one
of the Moleculesin Crystal Boundary options. These will automatically identify any and
all molecules. See Dealing with Molecules, Groups and Fragments for more information
on strategy for dealing with groups. Note also that ATOMS V5.1 differs from previous
versionsin the way groups are identified - several groups can be identified and this
identification persists regardless of whether the atoms are marked for non-plotting or

not; and groups may be directly converted to fragments with the Generated to Input
option (Transform menu).

Creation of a structure file for displaying such groups involves three steps. Note that the
Find button in the Generated Atom Data dialog (which appears when you click on an
atom) is an aternative to step 2 (that is, to this dialog).

1) Setting the original boundary option. Before exercising the L ocate Groups option,
the molecules or other groups must be within the boundaries of a structure calculated in
the usual way. For example, you can use the Default Unit Cell option, suboption -1 to 1;
this gives one full unit cell on either side of the origin (for atotal of 8 unit cells).

2) Locating the group(s). To do the actual isolation of the group, call on thisdialog -

L ocate Groups or use the Find button in the Generated Atom Data dialog. Y ou must
specify aninitial or "seed" atom; this can either be a specific generated atom, or an input
atom. If you use agenerated atom, it will normally be necessary beforehand to use the
on-screen atom-location feature (see Generated Atom Data ) or a print-out from the
List Generated Atoms command in the File menu to find the number of a suitable
atom. Actualy, when using a generated atom the Find button in the Generated Atom
Data dialog is usually more convenient than using this dialog (L ocate Groups).
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However, thisdialog is the only way to use an input atom (see thelist in the Input Atoms
dialog in the Input1 menu, or the List Input dialog in the File menu). In this case,
ATOMS will test all the generated atoms in the equivalent set derived from that input
atom, and find the one which is closest to the origin.

When you click on OK, ATOMS makes atemporary list of al atomsin each group.

3) Saving the Sructure. After you are finished with step 2, you are presented with the
Groups Located dialog, which allows a) restoration of the non-plotting atoms, which
will not undo the process of group location (asin pre-V5.1 ATOMS); b) locating an
additional group; or c) converting the generated atoms to input atoms. If you leave the
dialog without doing any of these things, the molecule(s) can be highlighted or hidden in
variousways.

Y ou may wish to turn on centering with the Centering/Displacement dialog in the
I nput2 menu if the group(s) are not near the origin.

The"deletion” of atoms (see Deleting Atoms) or marking for non-plotting, does not
directly affect the location of groups. That is, if you mark an atom for non-plotting,
neither the atom nor bonds to it are shown in the drawing, but the atom and its bonds still
exist for the purpose of locating groups. In order to remove atoms and bonds
permanently before locating groups, you must convert Generated to Input (Transform
menu), selecting the option to remove non-plotting atoms. Or you can convert
Generated to Input and then delete the atoms. Then recal culate to reestablish bonds and
polyhedra, and proceed with location of groups.

3.2.6.3 Groups Located
Dialog Box - called from: Transform Menu

This dialog appears after you have located one or more groups with the Locate Groups
diaog.

If you click on the Done button, the last and other groups can be displayed in various
ways according to the radio buttons;

---Highlight the last group - really meansdim al atoms not in this group.

---Hide all except thelast group - atoms not in the last group selected will be marked
as non-plotting.

---Hide all except groups - atoms not in any group will be marked as non-plotting.

Highlighting and hiding can be reversed with buttons in the Generated Atoms Data
dialog which appears when you click on an atom.

The Show All button allows restoration of any non-plotting atoms. In pre-V5.1 ATOMS
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this would undo the process of group location, but now the atoms in groups are
individually marked with the group number.

The Add button allows locating an additional group (back to the Locate Groups dial og).
The Convert button converts generated to input atoms in exactly the same asin the

Generated to Input command in the Transform menu. Note that this option now can
convert molecules directly to independent structure fragments.

Seethe Locate Groups dialog for step-by-step instructions on locating groups, and
Dealing with Molecules, Groups and Fragments for general aspects of handling groups.

3.2.6.4 Multiple Structures
Dialog Box - called from: Transform Menu

Multiple structures fragments can be used to model twinning, epitaxy and certain types
of crystalline defects, aswell as interactions between molecules. Each structure can be
rotated and tranglated independently; however, there isonly one list of bonds and of
polyhedra, and both are located throughout the structure as awhole.

Thermal ellipsoids for multiple structures are not supported; temperature factor
information islost if you introduce multiple fragments.

Most operations on individual structures are carried out through thisdialog in the File
menu. However, individual structure fragments can be rotated and translated in some
simple ways using the Dialog Bar - Fragments (Display menu).

Before more than one structure can be dealt with, each of the structures concerned must
be transformed to the "Input=generated” mode with the Generated to Input command in
the Transfor m menu.

The Multiple Structures dialog gives alist of the current structure fragments. The first
fragment is always the main structure. There are two ways to add additional fragments;
the Duplicate button and the Read File button.

If you choose Duplicate, the new fragment will have the same orientation and center
point as the current fragment. Y ou have the option of inverting the current fragment,
that is, negating all the atomic coordinates. All the types of the atoms remain the same,
and the lists of bonds and polyhedra are not duplicated. Thetitleis copied to the new
fragment (thetitle for fragment number 1 isthat of the structure as awhole).

The Read File button calls up the Read Structure Fragment from File dialog. The
Revise button calls up the Revise Structure Fragment dialog.
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After duplicating a structure or reading in an additional structure fragment, you must
choose Calculate from the File menu in order to locate bonds and polyhedra. The
Calculation Output dialog in the Input2 menu allows you to get alisting of only those
bonds and bond angles which involve more than one fragment, i.e. inter-fragment bonds.
To get such alist you must have some sort of calculation output turned on, and the bond
distances and/or angles print-outs turned on a so.

Y ou can highlight, dim or omit interfragment bonds with a Combo box in either the
Dialog Bar - Right or the Atom/Bond Plot States dialog (Input2 menu). Individual
fragments can be rotated or moved with DialogBar - Fragments.

Note that clicking with the mouse on an atom in the drawing on-screen brings up the
Generated Atom Data dialog, which lists the bond distance to the last atom, and the bond
angle involving the last three atoms.

3.2.6.5 Read Structure Fragment from File
Dialog Box - called from: Multiple Structures dialog

The file specified must be an ATOMS datafile (.STR), and this structure must already
have been transformed to the "Input=generated” mode with the Generated to I nput
command in the Transform menu. Structure files from old versions of ATOMS may
not be readabl e through this option - in this case the old file may be read with the Open
command (File menu) and saved in the current format.

Y ou have the option of inversion, that is negating all the atomic coordinates. All other
orientation operations can be carried out with rotations after thefileisread in. Y ou have
the option of adding the bond and polyhedralists to the old ones.

ATOMS can use either standard bonds, defined by specifying atom typesin the

Bond Data dialog in the I nput1 menu, or it can use a connectivity table, which is
obtained only froma CCDC FDAT file or PDB file - it cannot use both. Thusif the
main (first) structure has normal bonds, and the structure read in has a connectivity table,
the connectivity table will be ignored; and if the main structure has a connectivity table,
normal bonds in the structure fragment being read in will be ignored. In general, normal
bonds are more flexible, and can be derived automatically (see

Generate Bonds from Atomic Radii).

3.2.6.6 Revise Structure Fragment
Dialog Box - called from: Multiple Structures dialog

This gives the start and end numbers of the atoms for the current fragment or individual
structure - the atoms are all kept in the same master list. The coordinates, colors, etc. of
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individual atoms are revised through the Input Atoms dialog in the Inputl menu. The
displacement of the current fragment is given in both Cartesian coordinates and
coordinates on the structure axes of the current fragment, and the fragment may be
moved on either set of axes with the Translate button. The center point, used for
rotations, is given in Cartesian coordinates with respect to the zero or center point of the

aggregate.

The structure which isin memory when you first add a second fragment provides the
overall zero point for tranglations of individual fragments, and for rotations of the
aggregate with the Rotation menu or the on-screen rotations in the Display menu.
However, it is possible to rotate theinitial fragment, translate it or reset its center point
with the subdialogs under Multiple Structures so that its center point and/or orientation
are not the same as that of the aggregate.

There are three main types of coordinate system involved in Multiple Structures dialog:

(1) Fixed or reference Cartesian coordinate systems. These apply to all structures and
have fixed orientations. The main observer or reference system has a simple relationship
to the screen or paper. When Clinographic Viewing isin effect, rotations can also be
done on the Clinographic axial system, which is another Cartesian system rotated by a
fixed amount relative to the reference system (see Coordinate Systems).

(2) The aggregate or overall structure axes coordinate system. Thisistaken originally
from the first or main structure, but if the first structure isindividually translated or
rotated through sub-dialogsin Multiple Structures dialog, it may not be the same.
Operationsin the Rotation menu apply to this coordinate system.

(3) A structure-axes coordinate system for each individual structure. Translations and
rotations done with sub-dialogs in Multiple Structures dialog may use these coordinate
systems.

Only one set of crystal facesis allowed, and it belongs to the overall structure axes
coordinate system. Thusit is possible to rotate the first structure out of proper
orientation with the faces. For this and other reasons, rotating structure fragment number
1individually isnot usualy advisable.

3.2.6.7 Rotate Structure Fragment
Dialog Box - called from: Revise Structure Fragment dialog

This allows much the same operations as for the overall rotations in the Rotation menu,
except of course that only the atoms in the current fragment are rotated, about its own
center. The Cartesian Axes, Structure Vector and Align Face/\ ector options call up
dialogs which are called up from the Rotation menu, but in this case only the current
fragment is affected. The StructureVector and Align Face/Vector options use the
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structure axes belonging to the current fragment. For orienting fragments, especially
crystal structures, the Align Face/Vector option is most useful.

If you click on the Set Default button, the current orientation of this fragment will be the
one which is returned to with the Remove Previous Rotations button.

3.2.6.8 Translate Structure Fragment
Dialog Box - called from: Revise Structure Fragment dialog

The locations listed at the top are the distances the structure has been moved from its
original position, or since the last time the Set Current L ocation as Zer o button has
been used.

Y ou can move the current structure on either its own structure axes or the overall
observer Cartesian axes. Note that the Distance in Angstroms applies only to
tranglation on Cartesian axes; if you use a structure vector, the vector itself must have the
proper length, which is expressed as fractions of the original structure axes.

If you click on the Set Zer o button, the current location of this fragment will be the one
which is returned to with the Remove Previous button.

3.2.6.9 Reset Rotation Center of Fragment
Dialog Box - called from: Revise Structure Fragment dialog

This allows you to change the observer Cartesian coordinates of the point about which
the fragment is rotated. Thisrotation center isinitially the same as the origin of the
coordinate system for this fragment. If it is changed, the new center will be moved along
with the fragment by any tranglations.

3.2.6.10 Remove Crystal Symmetry
Dialog Box - called from: Transform menu

Thiswill convert all generated atoms in the unit cell to input atoms, convert the space
group to P1, and the unit-cell parametersto triclinic.

3.2.6.11 Expand Layers
Dialog Box - called from: Transform Menu

This option will expand acrystal structure on certain planes, increasing the length of the
selected axis, creating space near the expansion planes, but leaving the actual structure
within layers unchanged.. It operates on input atoms, leaving the symmetry unchanged.

Any atoms which are exactly on the expansion planes (for example K atomsin amica
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structure) will remain on the expansion planes, and thus bonds from these atoms to other
parts of the structure will be lengthened. Bonds connecting structural layers (that is, any
bonds crossing the expansion planes) will also be lengthened.

The Expansion factor isthe amount by which the selected axisisincreased. For
example, if the c-axisis 10.0 Angstroms before conversion, an expansion factor of 1.5
will change it to 15.0 Angstroms.

Expand on axis. This selects the axisto be lengthened. Fractional coordinates of most
atoms on thisaxis will be changed. The other two axes, and fractional coordinates on
these axes, will be unchanged. Thus the structure will be expanded on the principal
plane or unit-cell face which cuts the chosen axis - this plane is not always perpendicular
to the axis. For exampleif the chosen axisis c, the expansion is on the (001) plane.

Number of planes. There are often several symmetrically identical planes cutting the
selected axis. For example, there may be identical mirror planesat 0.0 and 0.5. You
must determine this number from examination of the space-group symmetry.

Expand at zero. There may be achoice of location of the expansion planes. Normally
thiswill be a choice between the set of planes at fractional coordinate zero (on the
expanded axis) and another set at some rational fractions. For example, if the Number
of planesis 2, there may be aset at 0.0 and 0.5 and another at 0.25 and 0.75. If the
Expand at zero box is checked, the expansion will be at the first set.

At the moment an arbitrary location of the expansion planeis not supported, and for low-
symmetry crystals, or those which have a choice of more than two locations, it may be
necessary to adjust all coordinates so that the expansion planeis at zero. If thissituation
is common, support for arbitrary location will be added. Support for expansion planes
other than unit-cell faces could also be added if necessary.

Tolerance. Thisisused to decideif an atom is exactly on the expansion plane, in which
case its coordinate on the expansion axis will not be changed - that is, it will remain
exactly on this plane. Toleranceisin fractional coordinate units (not Angstroms). If
you want atoms which are exactly on the expansion plane to remain in continuity with
the remainder of the structure, their fractional coordinates on the expansion axis should
be changed by greater than the tolerance. Usually thiswill result in duplication of the
atoms.

3.2.7 Settings Menu (Graphics Window)
The Settings Menu (Graphics Window) is identical to the Settings Menu (Startup Window).
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3.2.8 Window menu

The Window menu lists all the possible windowsin ATOMS - those which do not
actually exist are greyed out. Select awindow to make it active, or bring it to the front.

When a Text window or either the Powder or Precession graphics window is active, the
first item in the menu is a Font selector. In the Text window, this acts on the entire text
in the window and the font appliesto al Text windows. The font for the powder and
precession windows applies to both windows and to all text, except that the index
lettering in the Powder window is 0.4 times the size of the lettering for legends.

3.3 Text Window Menu Bar

Text windows are used for the Listings group in the File menu of the Graphics window,
by the Coordination button in the Input Atoms dialog in the I nput2 menu, and by the
Calculation Output command in the Input2 menu - see Types of Windows. They are
standard text or edit windows. To switch to the ATOMS main graphics window, which
has the menus and commands for atering and displaying atomic structure data, use the
Window menu, or click on the Graphics window if itisvisible.

Filemenu - Thisisastandard File menu which pertainsonly to the special files with
extension.ADT named above.

Edit menu - This menu has the normal text editing commands, which again pertain
only to the special fileswith extension.ADT.

Window menu - Usethis menu to switch to the ATOMS graphic window for most
operations on ATOMS data sets, and to set the font for the Text windows.

Help menu - On-line help.

3.3.1 File menu (Text Window)

The commands in this menu apply only to Text windows, which are generated by the
List... commandsin the File menu of the Graphics window, by the Coordination button
in the Input Atoms dialog in the Inputl menu, or by Calculation Output - see

Types of Windows for further explanation.

Close - Closes the Text window, and the file associated with it.
Save - Savesthefile associated with the window.

Save As - Saves the contents of the window to a specified file name.
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Print - Printsthe contents of the Text window.
Page Setup - Set the page size and select the printer.

Exit - EXitsATOMS.

3.3.1.1 Save command (Text Window)
Save command ( File menu, Text windows)

When called from Text windows, this saves the (text) contents of the current window in
the filewhose nameisin thetitle bar. The standard ATOMSfilesINPUT.ATD,
GENATOMS.ATD, FACES.ATD and TOTALS.ATD arein asubdirectory or subfolder
(Output) to the directory containing the ATOMS program (.EXE) file. They are
overwritten each time you request alist of the corresponding type. Thusif you want to
save these files, you should probably use the Save As command instead of Save, give the
files new names and put them in the same directory as the structure data (.STR) file. See
Types of Windows.

3.3.1.2 Save As command (Text Windows)
Save Ascommand ( File menu, Text windows)

When called from Text windows, this saves the (text) contents of the current window in
the file whose nameisin thetitle bar. The standard ATOMSfilesINPUT.ATD,
GENATOMS.ATD, FACES.ATD and TOTALS.ATD arein asubdirectory or subfolder
(Output) to the directory containing the ATOMS program (.EXE) file. They are
overwritten each time you request alist of the corresponding type. Thusif you want to
save these files, you should probably use the Save As command instead of Save, give the
files new names and put them in the same directory as the structure data (.STR) file. See
Types of Windows.

To save atext file with its existing name and directory, use the Save command.

3.3.1.3 Close command (Text Windows)
Close command ( File menu, Text windows)

Use this command to close the currently active Text window. ATOMS inquiresif you
want to save changes to your datafile before you closeit. If you close a data set without
saving, you lose all changes made since the last time you saved it.

The standard ATOMSfilesINPUT.ATD, GENATOMS.ATD, FACESATD and
TOTALS.ATD arein asubdirectory or subfolder (Output) to the directory containing
the ATOMS program (.EXE) file. They are overwritten each time you request alist of
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the corresponding type. Thusif you want to save these files, you should probably use the
Save As command, give the files new names and put them in the same directory as the
structure data (.STR) file.

3.3.1.4 Print command (Text Windows)
Print command ( File menu, Text windows)

Use this command to print the contents of a Text window. This command presents a
Print dialog box, where you may specify the range of pagesto be printed, the number of
copies, the destination printer, and other printer setup options.

3.3.1.5 Page Setup

This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins (except Macintosh). Marginswill only be used in
Text Windows.

---Macintosh only ------

Use the Page Marqgins dialog to set margins.

3.3.1.6 Page Margins
————— Macintosh only----

This dialog sets the margins for Text Windows. Use the Page Setup dialog to choose page
size and orientation.

3.3.2 Edit menu (Text Window)

The Edit menu for Text windows offersthe usual commands.

Undo Reverse previous editing operation.

Cut Deletes data from the document and movesiit to the clipboard.

Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.

3.3.2.1 Cut command
Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on
the clipboard. Thiscommand isunavailableif there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.
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3.3.2.2 Paste command
Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This
command is unavailableif the clipboard is empty.

3.3.2.3 Copy command
Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is
unavailableif thereis no data currently selected.

Copying datato the clipboard replaces the contents previously stored there.

3.3.2.4 Undo command
Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible. The name of the
command changes, depending on what the last action was. The Undo command changes
to Can't Undo on the menu if you cannot reverse your last action.

3.3.3 Window Menu

The Window Menu in Text Windows is identical to the Window Menu in the Graphics Window. It
does have a command for changing the font of all text in the window.

3.4 Help Menu

The Help menu offers the following commands, which provide you assistance with this
application:

ATOMSHelp Topics. Thisbrings up the Help system. Use the Content, Index or Find
tabs to locate information on a particular topic.

About. Thisgivesthe version number of ATOMS. For Macintosh, the About dialog is
either in the Apple menu (OS 8/9) or the Application menu (OS X).

3.4.1 About command
About command (Help menu)

Use this command to display the copyright notice and version number of your copy of
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ATOMS.

3.5 Identifying (Picking) Atoms
I dentifying (Picking) Atoms

When adrawing isdisplayed in the ATOMS graphics window, you can identify
generated atoms by clicking with the mouse. Generated atoms can thus be marked for
non-plotting and later deletion (see Deleting Atoms). If molecules have been located or
fragment are present these are also identified.

A mouse click isjudged to be "on" agiven atom if it iswithin that atom's radius of its
center point. If the atom in question has zero or negative radius (see the Revise Atom
dialog in the Input1 menu for the significance of non-positive radii), then the default
radius, set in the Preferences dialog in the Settings menu, is used.

The click point may actually be "on™ more than one atom; all atoms which project onto
the plane (x = 0) within the specified distance of this point are identified, not just the one
which isvisible at this point. In this case, the Atoms at Cursor dialog comes up, giving a
list of the atoms, from foremost to rearmost. Select the desired atom, and click on the
View/Revise Atom button. This brings up the Generated Atom Data dialog for that
particular atom. If the click point is only on one atom, the Generated Atom Data dialog
comes up directly. If the click point is not on an atom, you get an alert to this effect.

The atom(s) which have been identified may be marked by outlining with a contrasting
color - see the Preferences dialog in the Settings menu.

3.5.1 Atoms at Cursor
Dialog Box - called from: click in graphics window

When adrawing isdisplayed in the ATOMS graphics window, you can identify
generated atoms by clicking with the mouse. Generated atoms can thus be marked for
non-plotting and later deletion (see Deleting Atoms). If molecules have been located or
fragment are present these are also identified.

A mouse click isjudged to be"on" agiven atom if it iswithin that atom's radius of its
center point. If the atom in question has zero or negative radius (see the Revise Atom
dialog in the Input1 menu for the significance of non-positive radii), then the default
radius, set in the Preferences dialog in the Settings menu, is used.

The click point may actually be "on™ more than one atom; all atoms which project onto
the plane (x = 0) within the specified distance of this point are identified, not just the one
whichisvisible at this point. In this case, the Atoms at Cursor dialog comes up, giving a
list of the atoms, from foremost to rearmost. Select the desired atom, and click on the
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View/Revise Atom button. This brings up the Generated Atom Data dialog for that
particular atom. If the click point is only on one atom, the Generated Atom Data dialog
comes up directly. If the click point is not on an atom, you get an aert to this effect.

The atom(s) which have been identified may be marked by outlining with a contrasting
color - see the Preferences dialog in the Settings menu.
3.5.2 Fullscreen Options

Since menus are not available in full screen mode, clicking off any atom will bring up a
dialog giving the options for changing scale, rotating, etc. These options are basically
the same as those for the shortcut keys.

However, in Direct3D Drawing Mode, fullscreen, there is no atom identification - the
only function of the mouse cursor is to rotate the structure, or to stop rotation or
vibration by aclick anywhere.

3.5.3 Generated Atom Data
Dialog Box - called from: click in graphics window, Atoms at Cursor dialog

When adrawing is displayed in the ATOMS graphics window, you can identify
generated atoms by clicking with the mouse. With this dialog, generated atoms can thus
be marked for non-plotting and later deletion (see Deleting Atoms).  If molecules have
been located or fragment are present these are also identified.

A mouse click isjudged to be"on" agiven atom if it iswithin that atom's radius of its
center point. If the atom in question has zero or negative radius (see below and the
Revise Atom dialog in the Input1 menu for the significance of non-positive radii), then
the default radius, set in the Preferences dialog in the Setting menu, is used.

The click point may actually be "on" more than one atom; all atoms which project onto
the plane (x = 0) within the specified distance of this point are identified, not just the one
whichisvisible. Inthiscase, thedialog Atoms at Cursor dialog comesup, giving alist
of the atoms, from foremost to rearmost. Select the desired atom, and click on the
View/Revise Atom button. This brings up the Generated Atom Data dialog for that
particular atom. If the click point is only on one atom, the Generated Atom Data dialog
comes up directly. If the click point is not on an atom, you get an message to this effect.

The atom(s) which have been identified may be marked by outlining with a contrasting
color - seethe Preferences dialog in the Settings menu.

The label, type and atomic radius listed towards the top of the Generated Atom Data
dialog pertain to the input atoms and cannot be changed here - they are set in the
Revise Atom dialog in the Input1 menu.
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The listed Cartesian atomic coor dinates are in Angstroms, in the observer Cartesian
system (see 1V-4). Y ou can change these coordinates if you wish, but if ATOMS isinits
normal operating mode this change in position will only be temporary; it appliesto a
generated atom, which is not saved in the structure file. If the structure is recal cul ated,
the changes arelost. However, you can make such changes permanent by using the
Generated to Input conversion in the Transform menu. This puts the Input=generated
operating mode into effect, and the changes in atomic coordinates are permanent (if the
fileissaved). When this modeisin effect, input atoms are equivalent to generated
atoms.

The fractional atomic coordinates are in the structure axis system. They cannot be
changed directly, but will be changed if the Cartesian coordinates are changed (previous
paragraph). In the Input=Generated mode, the fractional coordinates may be either in
terms of the original crystal (or other) structure axes, or in terms of the current structure
Cartesian axes (as listed in the [nput Atoms dialog) - the choice between these two is
made in the Preferences dialog. (This setting is also accessible in the

Align on Face or Vector and Current Orientation dialogs in the Rotate menu ).

If the structure has been converted to the Input=generated mode (Generated to Input in
the Transform menu), thereis an Edit Input button. This button brings up the

Revise Atom dialog for the current atom. With this dialog, you can change the color,
radius, type, etc. of the current atom. Some such changes may require recal culation,
rather than replotting. For example, you can change the color of individual polyhedra.
Set up an additional polyhedron type, identical to a current type except for color and the
type number of the central atom. Then, by clicking on a central atom, you can change
the color by changing the atom type number.

Use the Mark Atoms command in the Display menu to mark the locations of specified
types of atoms, or of atoms which may not currently be plotting.

The Atom plot type determines how the atom, and bonds to it, are displayed. The plot
type is determined by the absolute value of aplot code, which is set by certain input
values and results of the calculation. (this plot codeislisted with other data on the
generated atoms, with the List Generated Atoms command in the File menu). The
check box below the plot type may be labeled Plot atom, Plot bonds, Plot Atom and
Bonds or Plot Polyhedron, or it may be absent altogether. Checking or unchecking this
box changes the sign of the plot code; generally positive means plotting and negative
means non-plotting.

By unchecking the box, you can make the atom and/or and the bonds to it non-plotting.
This action marks the atom as non-plotting but does not remove it from the generated
atom list. A list of non-plotting generated atomsis saved in the structure file (see
Deleting Atoms). Y ou can cause the non-plotting atoms to be permanently deleted by
exercising the Generated to Input conversion in the Transform menu; this can be done
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repeatedly, just for the purpose of deleting atoms.

All atoms marked as non-plotting can be restored, and a specific range of generated
atoms can be either restored or marked non-plotting, with the Atom Plot Status dialog in
the I nput2 menu.

The effect of the check boxes depends on the atom plot type. The atomic radius of an
input atom (see the Revise Atom dialog in the Input1 menu) in part controls the plot
type; if the radiusis positive, the generated atoms derived from thisinput atom are
shown as spheres, if they are not part of polyhedra. Display (as spheres) of atoms which
belong to incompl ete polyhedrais controlled by a checkbox in the Polyhedra dialog
(Inputl menu). Display of polyhedron ligands as spheresisalso controlled by a
checkbox in the Polyhedra dialog. [f the input radiusis zero (polyhedron atom), the
atomisonly shownif itisacorner of acomplete polyhedron. If the radiusis negative
(wire-frame atom), the atom is never shown as a sphere, but its bonds may be shown.
The plot codes are derived as follows.

Non-plotting atom (plot code 0). These atoms never plot. Thiscodeis assigned to
atoms with input radius zero, and which should be either central atoms or ligands of
polyhedra, but which belong to incomplete polyhedra - that is polyhedra with an
insufficient number of ligands or no central atom.

Spherical atom (plot code 1). Thistypeisaways shown asasphere. The check box
below Atom plot type islabelled Plot Atomsand Bonds. Positive (+1) plot code (box
checked) means the atom and all bondsto it are plotted, negative (-1) means they are not
plotted.

Central atom of polyhedron (plot code 2). Thistypeis never actually shown itself; The
check box below Atom plot type islabelled Plot Polyhedron. Positive (+2) plot code
(box checked) means the entire polyhedron is plotted, negative (-2) meansit is not
plotted. Checking or unchecking not only changes the sign of the plot code for the
central atom, but also that of all the ligands (see next item). This meansthat all the
bonds from spherical or wire-frame atoms (codes 1 and 3) to the ligands become plotting
or non-plotting respectively.

Polyhedron ligand (plot code 3). If the atom input radiusis positive, thistype of atom
may be shown as a sphere, as controlled by the checkbox in the Polyhedra dialog (Inputl
menu). If theinput radiusis zero, these atoms may never be shown as spheres, only as
corners of polyhedra. The check box below Atom plot type thus can be labelled either
Plot Atom and Bonds or Plot Bonds. Whether the polyhedron as awhole is shown or
not is controlled by the central atom (see above). The Plot Atoms/Bonds box controls
al bonds from this ligand to spherical atoms (code 1), ligands of other polyhedra (code
3) or wire frame atoms (code 4).
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Ligand or wire frame (plot code 4). The check box below Atom plot type islabelled
Plot Bonds. Thistype of atom is never plotted itself. However, the Plot bonds check
box is active and controls whether the atom isvisible, since it controls all bonds to the
atom.

Atomsin incomplete polyhedra (plot code 5). If theinput radius of either the central
atom or ligands of polyhedrais positive, and an insufficient number of atomsisfound to
complete the polyhedron (because of boundary conditions), these atoms will be given
plot code 5. The display of such atoms as spheresis controlled by a check box in the
Polyhedra dialog (Inputl menu). Notethat if input radius of polyhedral atomsis zero,
atoms in incomplete polyhedrawill be given plot code zero, and will never be plotted.
This saves computation time because the bonds to these atoms are not |ocated.

For polyhedron ligands, the Plot Atoms/Bonds check box is generally best left alone,
except for the case of ligands shared between polyhedra. In this case, if the Plot
Polyhedron box for the central atom of one of the polyhedrais unchecked, this unchecks
the Plot Atoms/Bonds box for all of itsligands (i.e. changes the plot code from +3 to -
3). If there are non-polyhedron bonds, i.e. bonds from a spherical atom or awire-frame
atom, to aligand which is shared between the non-plotting polyhedron and a polyhedron
which isstill plotting, they will not be shown. Y ou can correct this condition, restoring
these bonds to plotting, by checking the Plot Atoms/Bonds box of the shared ligands.
Note that changing the status of the central atom will undo changes of the status of the
ligands.

Deletions or restorations of atoms and attached bonds with the check boxes does not take
effect immediately, only after replotting of the drawing. Replotting is automatic if the
Replot box is checked; otherwise select the Replot command in the Display menu.

Label. Thisbox ischecked by default, so that turning on atom labels with the

Atom L abels dialog in the Display menu will produce alabel for each atom. Deleting or
omitting labelsis similar to deleting atoms (see above); it only applies to generated
atoms. Deleted labels can be restored with the Restor e Deleted button in the

Atom Labels dialog in the Display menu.

The distance to the last atom selected with this dialog is printed out near the bottom, if a
different atom was selected. Therewill be aBond Label checkbox, and unchecking this
box will suppress plotting of the label. All labels can be restored with the Show All
button in the Bond Labels dialog. A list of non-plotting bond labels is kept in the data
(.str) file.

The Bond button can be used to make a custom "bond" between the current atom and the
last one. If you click on this button, you will be shown the General Lines or Cylinders
dialog, and the "bond" thus defined will be kept in that list, not in the Bonds dialog in
the Inputl menu.
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The bond angle involving the last three atoms selected is also printed out, if three
appropriate atoms have been selected. If thisangleis one of those which satisfy the
specificationsin the Angle Labels dialog, there will be an Angles checkbox.
Unchecking this box will supress plotting of the angle label. All labels can be restored
with the Show All button in the Angle Labels dialog. A list of non-plotting anglesis
kept in the data (.str) file.

The Align button will use the last three atoms selected (those which define the angle) to
realign the entire structure (generated atoms). These atomswill be aligned in they-z
plane (screen or paper). If the atoms are number 1, 2 and 3 in the order selected (last one
selected is 3), then the 2-1 vector will be vertical, paralel to z, and the 2-3 vector will be
in the y-z plane, clockwise from z (looking down x).

If Atomic Vectorsare present and if the structure is Input=generated, the direction may
be reversed with the Invert Vector button. The drawing must be recal culated, not just
replotted, to see the reversal.

For Protein Data Bank (PDB) structures, the Protein button will bring up alisting of the
protein-specific attributes of the selected atom.

If thermal ellipsoids are shown the Ellipsoid button will give information on the
orientation of the ellipsoid axes.

The three lines at the bottom of the dialog give the distance from the current atom to the last
atom selected, the angle defined by the current atom and the last two, and the dihedral angle
involving the last four atoms. See Construct Molecule from Z-Matrix for the definition of the
dihedral angle and the sign convention.

M olecule/Group options.

If molecules have been located or individual structure fragments are present (allowed
only in the Input=generated boundary/operating mode), you can control their display
with the buttons at the bottom of the dialog. Highlight means that the selected group
appearsin normal colorswhile all other atoms are dimmed. Hide means that atomsin
the group are marked as non-plotting (see above)

If molecules have not been located with one of the Moleculesin Crystal

boundary options, you can locate them with the Find button. Molecules or groups to be
located or isolated must have all their atoms connected by Bonds or Polyhedra, and the
must be no bonds (except those marked as intermolecular in the Bond Data dialog) or
polyhedrainterconnecting molecules. For more information on locating and
manipulating groups, see Dealing with Molecules, Groups and Fragments, and the

L ocate Groups dialog (Transform menu).
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3.5.4 Protein Attributes of Atom
Dialog Box - called from: Revise Atom: Basic Tab, Generated Atom Data

Thisdialog is used only when the atom data are obtained from a Protein Data Bank
(PDB) file. It gives the parameters which are specific to protein structures - none of these
parameters are set in ATOMS. See the PDB literature for explanation.

3.5.5 Ellipsoid Orientation
Dialog Box - called from: Generated Atom Data

This gives, for each axis of the thermal ellipsoid, the orientation in terms of the Cartesian
axes: the orientation in terms of the crystal axes; the angle with the bond to the last atom
clicked; and the angle to each of the three crystallographic axes.

3.6 Select Color

Dialog Box - called from: variousdialogs

This dialog allows color selection from the current 16-color palette, and also allows
selection of acustom color. The Custom button calls up a system standard col or-
picking dialog.

The red, green and blue values are given below each color box, to the right of the radio
button. These values are on a scale of 0-255, as used by Windows.

It isusually best to use one of the 16 colors in the palette, because 1) the 256-color or 8-
bit display palette is derived from these colors, and shaded atoms, bonds and polyhedra
will be forced to one of these colors anyway at plot time; and 2) display and output are
usually more satisfactory when simple colors, such as those in the default palette, are
used.

The default colors selectable in this dialog may be changed in the Palette dialog (Settings
menu).

4 Reference

Topics here are of general interest or may be referred to in several dialogs.
4.1 Atom Parameter Files

Atom Parameter Files (Free-Form or.inp)

Thistype of ASCII or text file may be used in either the Input Atoms dialog in the Inputl
menu, or the the Import option in the File menu (Import Free-Form), to read in atomic
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coordinates alone, or to supply complete structure information. ATOMS itself does not
write.inp files, but they are written by the program CRY SCON (Shape Software) which
can be used to perform various types of crystallographic conversions, such as
sub/supercell, change of origin, change of symmetry, etc. Listings of atomic coordinates
from amost any source can be used as the basis of afree-form file.

All or part of the parameters for each input atom, namely label, fractional coordinates,
type, radius and display colors and pattern numbers, can be read in. Y ou can also supply
default values for some parameters, so that the parameters neither need to be present on
every line of thefile, nor need to supplied through the dialog.

Except for the TITL line, keywords and actual values to be read in should be separated
by spaces or commas, and there should be no spaces within keywords or values. Thereis
no need for alignment by column.

The input file may contain two overall types of lines; General and crystallographic
information lines; and actual data or atomic parameter lines.

General and crystallographic information lines. These lines should all precede the
atomic parameter lines. Each line consists of akeyword followed by one or more values
or character constants. The keyword should start in the first column and be followed by
at least one space before the actual values. Where more than one value is called for,
they are separated by spaces. All of these lines are optional - when afree-formfileis
used for import (File menu), if any lines are absent, default values will be supplied.
When afree-form fileis read through the Input Atoms dialog in the Inputl menu, current
values are kept if the corresponding line is absent.

TITL line. Upto 76 characters (may contain spaces).

CELL line. The unit-cell lengthsin Angstroms and the interaxial anglesin degrees (6
floating-point values). If the atomic coordinates are Cartesian, the axes should be 1.0
and the angles 90.0.

SPGP line. The Hermann-Maughin or standard International symbol for the space
group. There should be no spacesin the symbol, although there may be underscores
(which areignored when the symbol is interpreted.

HALL line. TheHall symbol for the space group. There should be no spacesin the
symbol, although there may be underscores (which are ignored when the symbol i<
interpreted. If thisline comes after the SPGP line (or that line is absent), the Hall
symbol will be used in the Space Group Symmetry option.

SYMM lines. These give symmetry operatorsin "xyz" form, that isin the form in which
the coordinates of the general position are listed in the International Tables for X-Ray
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Crystallography. Fractions must be given asintegers separated by adash ("1/2", "2/3"),
rather than decimals ("0.5", "0.333"). Thex, y and z positions must be separated by
commas and there should be no spacesin the operator. There should be one line for each
operator. |If the space group is centrosymmetric, only half the operators need be given, if
the originison a center of inversion. If the originis not on a center, all operators must
be given and the space group should be denoted non-centricinthe LATT line. If these
lines come after the SPGP and HALL lines (if present), the Custom Symmetry option
will be used.

LATT line. Thisgivesthe Bravais|attice type (single capital character), followed by a
space and O if the space group is centrosymmetric or 1 if it is non-centric.

FORM lines. These lines contain the three indices and the central distance for each
form. When thefileisread in, you will have the option of using these formsin the
Enter Forms boundary option.

FACTOR line. A single (floating-point) factor which multiplies al the fractional or
atomic coordinates.

Atomic parameter lines:

The file should have all the information for each atom, except for temperature factors, on
asingle line with amaximum of 80 characters per line, and the values must bein fields,
which are set off or delineated with either spaces or commas. There can be no spaces or
commas within fields. The names of fields are given in the following in capitals, but in
the actual input they may be lower case; all |etters are converted to upper case when the
lineisreadin.

DEFAULT lines supply valuesto the parameters, such as colors, which are not read in
for each atom. If default values are not entered in this way, default values are obtained
from the separate ELEMENTSfile, using the chemical symbol of the atom which is
assumed to bein the first two characters of the atom label. See the further description of
DEFAULT linesand the ELEMENTS file below.

FIELDS lines. Theselines set up the ATOMS input parameters which are to be read
from the file, and the order in which they are to be read.. Thisisfollowed by the
keywords giving the order of the fields. The allowed keywords are as follows (INTEGER
fields may not contain a decimal point):

1) LAB - (6 characters maximum). Any label for the input atom may be used, but the
label normally begins with the chemical symbol for the element. The first two characters
may be used to determine default values for some of the parameters, as described below.
The characters may be upper or lower case, but they are all converted to upper case after
input. Thisisarequired field.
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2) COO - Thisactually denotes three floating-point fields giving the fractional atomic
coordinates for crystals, or the absolute coordinates for molecules. After input, the
coordinates are multiplied by the number in the FACTOR line, if thislineis present.
These arerequired fields.

3) TYP - Thisisthe type which isused in locating bonds and polyhedra. INTEGER

4) RAD - Thisisthe radius used when the atom is plotted as a sphere. FLOATING-
POINT

5) RMC - Thisisthe color for the atom rim or edge, in terms of three RGB components
0-255. 3INTEGERS

6) FLC - Thisisthe color for the atom fill, in terms of three RGB components 0-255. 3
INTEGERS

7) RMP - Thisisthe pattern number or gray shade used in black-and-white display or
output. This number is used only for wide lines (see Line Widths). INTEGER

8) FLP - Thisisthe b/w pattern number for fills. Thisisused only if shading is off or
the initial pattern number option (Shading) ison. INTEGER

9) PEN - Thisisthe pen number used for atom outlinesin pen plots. INTEGER

10) TFB - Temperature factorsin B or bij (beta) form, types O (anisotropic) or 6
(isotropic) in ORTEP. If thiskeyword is present, the temperature factor(s) are present on
asecond line for each atom, inup to six fields Theorder is11, 22, 33, 12, 13, 23. If the
second value is absent or zero, the temperature factor will be read asisotropic. Note that
ATOMS will save temperature factors only if at least one atom has non-zero for the first
value or b11.

11) TFU - Temperature factorsin U or uij form, for anisotropic type 8 in ORTEP.
Similar to TFB. Isotropic U values will be converted to B values (type 6 in ORTEP).

12) VEC - Atomic vectors, e.g. for magnetic spins or vibrational displacements. If this
keyword is present, the vector coefficients are present on a second line, in four fields.
The first three are the relative components in the structure axes, and the fourth is the
length. The length may be in any units, as a scale factor is aways applied (see the
Atomic Vectors dialog). Vectors and temperature factors may not both be present.

13) DUM - Thisdesignates afield (character, integer or floating-point) that exists in the
input data line, but should be ignored by ATOMS.

Note that the actual atom data lines do not contain any keywords. The keywordsin the
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FIELDS lines set up the sequence of parametersin each dataline.
An example FIELDS line:

FIELDSDUM LAB COOTYPRAD

Some corresponding data lines:

1C10.1234 0.23450.3456 6 1.2
2H20.4321 0.54320.65431 0.1

Herethefirst field, which is simply a sequence number, must be ignored by ATOMS,
and is designated with aDUM.

Hereis an example of some lines copied from an (old) ATOMS.STR file (spinel):
FIELDSDUM LAB TYP COO RAD

1 MG1 12 .12500 .12500 .12500 .000

2 AL2 13.50000 .50000 .50000 .000

3 O3 8.26200 .26200 .26200 .000

There should normally be aFIELDS line at the beginning of the atomic parameter lines,
but additional FIELDS lines can be inserted at any point to redefine the fields. If thereis
no FIELDS line, the fields are by default; LAB and COO.

In the actual datalines, fields denoted INTEGER above should not be more than 6
characters; the COO and RAD fields (floating-point) should not be more than 20
characters.

DEFAULT line. Thisisused to set particular default values for fields other than LAB
or COO. DEFAULT must be thefirst 7 characters. Then the default values are indicated
with the name of the field connected with an equals sign (with no intervening spaces) to
an appropriate value. Example default line:

DEFAULT TYP=1RAD=0.95 FLC=15

There are twelve possible input fields for each input atom, or each linein the file, plus
the placeholder DUM field. The LAB and COO fields are required for each atom and
must be read in from the file; the other fields are optional. If the latest FIELDS line does
not define afield for a particular parameter, then the value of the missing parameter i<
determined by reading the first two characters of the label (LAB field) and taking the
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correspoding value from the ELEMENTS file, as discussed in the next section.

However, values given in the latest DEFAULT line take precedence over any values read
in or derived from the ELEMENTS file. You can turn off defaults, thereby accepting the
values on the input atom line or the valuesin the ELEMENTSfile, with aline containing
the word DEFAULT and no other keywords.

ELEMENTS files. These files may contain aline for each possible type of input atom.
Either of two filesmay be used: ELEMENTS.COV, with covalent radii, and
ELEMENTS.ION, with ionic radii - the choice between the two is made in the
Preferences dialog in the Settings menu.

The ELEMENTS files may be modified to change the default parameters. Thefirst field
in each line is the atomic number or other designated type number. The second field, or
SYM field, consisting of two charactersin single quotes, is usually the normal elemental
symbol. The remaining fields give the default values for the RMC, FLC, RMP, FLP and
PEN parameters. If all fields for each input data line are either read in with one of the
fieldsin the FIELDSine, or given valueswith aDEFAULT line, the ELEMENTSfileis
not used. If one or more parameters are missing, then the first two characters of the LAB
are matched with the elemental symbol in the ELEMENTSfile. If the TY PE has not
been read in or specified with aDEFAULT line, it istaken to be the atomic number, and
other missing parameters are given values from the proper field in the ELEMENTSfile.

4.2 central distance

Central distance. The central distance for aface or form (set of symmetry-equivalent
faces) isthe perpendicular distance in Angstroms from the center of the structure
coordinates to the face in question. Generally, the larger the central distance the less
prominent (smaller) thefaceis.

4.3 Character Sets - sub- and superscripts

ATOMS uses only 1-byte characters (256 possible characters) for the various types of labels and
for file input and output. Most types of file containing structural information use only this type of
character encoding, not multi-byte characters such as unicode. As latin characters and arabic
numerals for chemical symbols are nearly standard worldwide, this should not cause too much
difficulty.

ATOMS previously was restricted to the standard ANSI character set, but this restriction has
been removed for the Title and atom labels. Thus it is possible to use fonts with non-latin-based
character sets (if simplified to 256 characters), and special fonts such as FEBTechnical to display
numeric sub- and superscripts and special characters. Such fonts may be selected through the
Font options in these dialog.

In the Title/Axes and Input Atom Data dialogs (Inputl menu) characters for non-ANSI typefaces
should be displayed correctly, but at a fixed font size. The list of input atoms in the Atoms dialog
(Inputl menu) may not show non-ANSI characters correctly because this list must be written in a
fixed-width font (Courier or Monaco).
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Note that superscript 1 (character number 185), 2 (178) and 3 (179) are included in the standard
ANSI character set and may be displayed in standard latin fonts such as Times, Courier,
Monaco, etc.

To insert special characters into the title or atom labels in ATOMS, it may be easiest to generate
these in special system-supplied applications or applets, such as the Character Map in Windows
or the Character Palette in Macintosh, and cut-and-paste into the text boxes in the ATOMS
dialogs. In some operating systems it may be possible to insert characters by number using
specific key combinations.

Special fonts with desired characters may be designed, or standard fonts modified, with
commercial font-editing tools. The Private Character Editor in recent releases of Windows does
not apply to 1-byte characters.

Atom labels may optionally include special roman-numeral superscripts indicating the symmetry-
operator number - this is done automatically and should not require any special font as long as
the font selected for atom labels contains the standard latin characters used in the roman
numerals.

4.4 Colors, Palettes and Dot Patterns

Color Models.

ATOMS isdesigned to give the best quality display and output for the most common
types of screen display, printers and plotters. However, because these devices vary
widely in their capabilities for displaying color, it may be necessary to understand
several different color models. The models are best discussed in terms of the number of
bits used to represent each pixel in araster or bit-mapped display or output.

1-bit or black-and-white. Thisis used for two-color or black-and-white printing and files
destined to be printed. Each pixel is either off (white) or on (black). For filled areas
dot-patterns with varying percentages of black dots simulate shades of gray. Every input
atom, bond or polyhedron has a black-and-white pattern number for rim and fill. For
raster files, ATOMS supplies the patternsin two series, coarse and fine (see below). For
printer output in Windows, you can select either the ATOMS patterns or the screen-
driver patterns; for Macintosh the ATOMS patterns are always used. Direct PostScript
output uses the patterns supplied by the output device.

The dot pattern is used for linesonly if wide lines (Line Widths dialog in the I nput2
Menu) are selected; if lines are one-dot width, they are black. If atoms, bonds or
polyhedra are not shaded, that is given variable coloring depending on presumed
illumination, then the pattern number can be used without modification as a means of
distinguishing different atoms, etc. Generally, if shading isused, it isbest to treat all
atoms, bonds and polyhedra alike, that is show awhite color (no dithering) at maximum
illumination. However, it is possible to assign an initial shade to each type of atom.
(Shading dialog in the I nput2 menu).

8-hit or 256 color. Thismay be used by older types of screen displays, and it is often
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advantageous for 2D drawingsin raster files. The 256 colorsin these displays (in
Windows minus 20 colors set aside for system use) may each be set to any admixture of
red, green and blue. ATOMS sets up a 256-color palette designed for displaying shaded
atoms, bonds and polyhedra. It isbased on 16 principal colors, which can be defined in
the Palette dialog in the Settings menu. See below (Palettes) for further information on
palettes.

15-, 16, 24- or 32-bit or RGB color. Thisisbecoming standard for screen displays, and
itisused for Postscript color output and for 16- and 24-hit raster files. One-third of the
available bits are used to represent each of the color components red, green and blue.
For 24- or 32-bit screen displays, there are virtually no restrictions on colors, and any
colors and shadings thereof can be rendered faithfully.

In 2D Drawing modes, for the most part RGB color does not greatly improve the quality
of ATOMS drawings over 8-bit color. However, it does remove restrictionsin two
areas. (1) Any number of separate colors are valid for shaded atoms, bonds and
polyhedra, rather than only 15 colorsfor 16 or fewer shading zones, or 7 colors for 32
zones (see under palettes below); (2) when front-back fading (Shading dialog in the

I nput2 menu) isin effect, the atoms etc. in the rear of the drawing are not restricted to a
few of the darker zones in a shading series, asin 8-bit color.

When generating raster files of color imagesin 2D Drawing modes, it may advantageous
to use use 8-hit (256-color) rather than RGB (15-bit through 32-bit) color because the
filestend to be much smaller. Thisis because of the smaller number of bitsin the pixels,
but also because the run-length encoding used in some file types does not compress RGB
fileswell.

The 3D Display Modes does not use the ATOMS 256-color palette on 8-bit displays, in
either Windows or Macintosh. Windows uses a special palette for this mode and the
Macintosh must use the system color table. This often resultsin dithering, so RGB color
should generally be used for 3D modes.

Printing. The choice between 4-bit (standard VGA), 8-bit (256-color) and 15-32-bit
display may may agreat difference in the appearance on screen, but hard-copy devices
such as printers actually use only avery limited number of colors (typically cyan,
magenta, yellow and black, although some inkjet printers may use more by mixing inks),
simulating more complex colors with dithering. Some degradation of color quality from
screen to printed image is to be expected. If color match of the printed output is very
poor, check the settings for the printer in the Print dialog.

Palettes.

Although Windows and Macintosh programs can specify colors made up of any
admixture of red, green and blue components, it is generally agood ideato use ssimple
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colors whenever possible, to increase the chances of faithful reproduction on avariety of
display and output devices.

16-Color Palettes. ATOMS uses aMain Palette composed of 16 colors for two reasons:
to aid in the consistent selection of simple colors; and to form a basis for the 256-color
palette used for 8-bit displays or other devices. Thefirst eight colorsin the default Main
palette are black, white, red, green and blue, and then the binary combinations of red,
green and blue which are cyan, magenta (violet) and yellow. The second eight colors are
two shades of gray, then the binary combinations of red, green, blue, cyan, magentaand
yellow (these six have no universally-recognized names). The colorsin this palette are
the same as those in the Alternate palette which is used in the DOS versions of ATOMS,
but in adifferent order.

The RGB values in both the 16-color palettes can be changed with dialogsin the
Settings menu. You can also save and re-read palette files.

256-Color Palettes. The palettes which are used in 256-color screen-display modes are
primarily designed for shading. There are two distinct palettes; the first has 15 principal
colors, each with 16 gradations from full intensity to amost black, and is used whenever
the number of atom shading zones (Shading dialog in the I nput2 menu) is 16 or fewer;
the second has only 7 principal colors, each with 32 gradations from full intensity to
amost black, and is used when the number of atom shading zonesis 32.

Thefirst or "16-zone" palette is made up asfollows. Thefirst 15 colors (0-14) start with
full-intensity color number 1 (white), and grade with decreasing intensity to near black;
the second 15 colors (15-29) start with full intensity color number 2, grading to near
black, and so on. When shading isin effect, ATOMS finds the nearest color in the 16-
color palette to the color selected in the input for the atoms, bond or polyhedron. Any
shading zone of an atom, bond or polyhedron receiving full illumination is given this
full-intensity color and shaded parts are given colorsin the series of 15 colors derived
from that principal color. The palette defined in thisway actually contains only 225
colors.

In the second or "32-zone" palette, the first 31 colors (0-30) grade from full-intensity
color 1 to near black, the next 31 from full-intensity color 2 to near black and so on,
through color number 7 and its derivatives. When shading isin effect, ATOMS again
"forces" the color to one of those in the 16-color palette, but the choices thistime are
only colors 0-7. Asthe colors are arranged in the default palette, this results in changing
colors 8-15 to 0-7 respectively. Actually, colors 0-7 can be regarded as"simplified" or
more basic versions of colors 8-15. The above shaded colors add up to only 217, so
colors 8-15 are also added to the palette to be usable for lines and unshaded fills.

Again, if shading isin effect and you are using more than 16 shading zones (Shading
dialog in the Input2 menu), any fill colors for atoms, stick bonds or polyhedrain the
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range 8-15 will be automatically "downgraded" to colors 0-7.

All these complexities and restrictions pertain only to 8-bit or 256-color display or raster
files. For standard VGA (4-bit) display in Windows, the RGB values are sent to the
display driver, which determinesin its own way what combination of pixelsto mix to
represent agiven color. Thisislikewise true for printer and PostScript output. The
RGB values are also sent directly to 16-, 24- and 32- bit screen displays, which can
presumably render any color without dithering.

Dot Patternsfor Black-and-White Display and Output.

The dot-patterns which are the "colors' for atom, bond and polyhedron fills and wide
lines in black-and-white printer output (if ATOMS patterns are selected in preference to
those supplied by the printer driver in Windows), and which are also used for shading in
black-and-white raster files, are shown in the diagram below. The patterns comprise two
series of dot-patterns of increasing density with shade numbers 0-15; the choice between
them is made in the Print or Raster File dialogs (File menu).

The fine series is recommended for 9-pin or other low resolution dot-matrix plotting, for
very small drawings done at high resolution, or for raster files which will be shown on a
low-resolution screen. The coarse series contains patterns more like the half-tone
screening used in printing. It is appropriate for gray tones and shading in high-resolution
dot-matrix plotting. Actually, for shading with 32 zones, there are 32 patternsin the
coarse series, only half of which are shown in Figure IV-1. Thefine serieshasonly 16
unigue patterns even if the number of shading zonesis 32, although this could be
changed in the setup or Preferences file (Direct Modification...).

ATOMS has the ability to use macrosopic hachure patterns on both polyhedra and atoms.
In many casesit may be more appropriate to use these patterns to differentiate atoms and
polyhedrathan to use grey shades.
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4.5 Colors/Patterns/Pens for Input

In color display or output, lines may be drawn with different colors, and atoms, stick
bonds and polyhedra may be filled with different colors (except in pen plots, in which
atoms, stick bonds and polyhedra are aways blank or white). In black-and-white display
or output, various dot-patterns, simulating shades of gray, are normally used for fills, and
for linesif they are wide enough.

This section discusses the common aspects of color/shade input for lines and fills, as
occursin many input dialogsin ATOMS. Depending on the type of display and output
involved, any of three different sets of colors or patterns/shades may be used.
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() For color screen displays, printer, Raster, Metafile or PICT output, actual colors are
used. The RGB components, which are numbers ranging from zero to 255 can be
directly entered in the edit boxes, but the color is most easily and reliably selected with
the Select...Color buttons. These bring up the Select Color dialog, presenting the colors
of the current main palette. If the color is being selected for afill, and if shading for the
object in question (atom, stick bond or polyhedron) is selected in the Shading dialog in
the I nput2 menu, the color chosen hereisthat at maximum (perpendicular) illumination.
If front-to-back fading has been selected in the Shading dialog in the I nput2 menu, the
chosen color isthat for the foremost atom.

For 16-, 24- or 32-bit color screen displays you have complete freedom to choose colors.
For 8- or 4-bit color thefill colors of shaded atoms, bonds and polyhedra may be forced
at plot time to one of alimited number of allowed colors. For 8-bit color the number of
colors allowed depends on the number of atom shading zones selected in the Shading
dialog in the Input2 menu. See the general section Colors, Palettes and DotPeatterns for
further information on palettes for the 8-bit color mode.

For best results on awide range of display and output devices, chose the simplest colors,
which arefirstly colors 0-7 in the default main palette, and secondly colors 8-15

(b) For black-and-white screen displays and printer, raster or metafile output, either true
grays or dot patterns of various densities are used. The codes for these shades or patterns
range from O for white to 15 for solid black.

The selected pattern is used for fillsif shading is not in effect. If shading isin effect,
selected in the Shading dialog in the I nput2 menu, the actual fill patterns shown may
either start at white for maximum illumination, or at the pattern number selected here
depending on the setting of the Useinitial patter ns checkbox in the Shading dialog.

The selected pattern is used for linesonly if the width of the lineis greater than one dot.
The width of various types of linesis set in the Line Widths dialog in the I nput2 menu.
Note that rendering of gray-scale for linesin black-and-white printed output i<
determined by the printer driver, not ATOMS. Many printer drivers do not support gray
lines and pattern numbers other than 15 may give either white or black lines.

(c) For pen-plotters the number requested refers to the pen number used in drawing the
lines. For atoms, stick bonds and polyhedra, this refers to the outlines; there are no fills
in pen plots (the interiors of atoms, stick bonds and polyhedra are always blank). These
numbers are not used if the single-pen mode is selected in the Pen Plotter Settings dialog
in the Settings menu.

When changing the red, green and blue values directly in the edit boxes which appear in
many dialogsin ATOMS, the rectangle showing the actual color does not change until
the focus shifts from the current edit field, that is until the mouse is clicked in another
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placein the dialog.

4.6 Coordinate Systems

Three types of coordinate system are used frequently in ATOMS: the observer Cartesian
system; the natural structure system; and a Clinographic system.

The observer system isfixed with respect to the display screen or paper of dot-matrix or
pen-plotter copy. The origin is at the center of the screen or paper, and the x axis points
directly toward the observer. They axis points to the observer'sright and the z axis
vertically, both in the plane of the screen or paper.

The atomic coordinates and the parameters of crystal faces if present are given in terms
of the natural structure axis system, although in the case of molecules this may itself be a
Cartesian system. Once all the atoms and faces have been generated, their coordinates
are converted to Cartesian coordinates. Except for crystals using rhombohedral axes, the
natural c axisisoriginally placed parallel to the observer z axis, and the natural b axisis
aligned in the y-z plane (or in crystallographic terminology the a* axisis parallel to x). If
rhombohedral crystal axes are chosen, the three-fold symmetry axisis paralel to z, and
the the vertical plane containing the first rhombohedral axisis aligned in the x-z plane.

This conversion defines the "original" orientation of the structure. After the location of
atoms and faces, and before theinitial display, the orientation may optionally be
modified by the rotations in the Initial Orientation dialog in the I nput2 menu, by the
alignment of a Slice of acrystal, and by clinographic rotation, defined in the next

paragraph.

Clinographic Viewing. One of the standard methods of drawing crystals (external
morphology) is clinographic projection, in which the crystal isin effect viewed from
above and dlightly to the right of the a axis, or to be more precise, in towards the center
along the vector [621] referred to cubic or Cartesian axes. If the option for clinographic
viewing is chosen, after the faces, atoms etc. are found, the structure and its associated
Cartesian system are rotated -18.4 degrees on the z axis, then 9.5 degrees on the y axis.

After the drawing appears, additional rotations may be made either on (1) specified
vectorsin the natural structure system; (2) the observer Cartesian axes; or (3) if
clinographic viewing is on, the rotated Cartesian axes, or clinographic system. The
clinographic system does not rotate with the crystal; it is always related to the observer
system by the two rotations given above.

If clinographic viewing is not on, the clinographic and observer systems have the same
orientation, and if the natural structure system is Cartesian or cubic all three systems
have the same orientation.
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Summary of axial systems:

1) Observer Cartesian system. Reference system, fixed with respect to the display
screen or paper.

2) Natural or structure system. Fixed with respect to the atomic structure. Atom
coordinates are initially given in this system. The axes are the unit-cell edgesin the case
of crystals. Axes may have unequal lengths and may be at angles of other than 90
degrees.

3) Clinographic system. Only applies when clinographic projection or viewing ison.
Axes are those of the observer Cartesian system, but rotated in a certain manner to avoid
astraight-on view of the structure.

If Perspective viewing is not selected, the drawing isadirect projection in the x axis
direction (observer system). If perspective viewing is selected, the atoms are projected
onto they-z plane from a point on the x- axis at the specified distance in the positive
direction (toward the observer).

INATOMS, a, band c (or A, B and C) refer to the natural structure axes. The three axes
may sometimes have these names although it is conventional in some systemsto use al,
a2 and a3 if the axes are equal by symmetry. The letters x, y and z usually refer to the
observer Cartesian axes. If it is necessary to refer to the clinographic system, thisis
mentioned explicitly. The fractional atomic coordinates are also referred to as x, y and z,
but these are usually identified explicitly.

Coordinate Systems for Rotations

T

Ed ¥

Ohzerver Clinographic
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4.7 Coordinating ATOMS and VIBRATZ

The vibrational-analysis program VIBRATZ and the structure-display program ATOMS are
designed to work together. The structure-display capabilities of ATOMS, which has 3-D
display and animation of vibrational motions, among many other things, are much greater than
those of VIBRATZ.

Communication between the two programs is through the modes (.MDS) binary files, which can
be written by either program. These files contain the detailed data for each mode, including
atomic motions. These files are designed for quick access to the datafor each individual mode,
so al the data for all modes does not have to be in memory at the same time.

ATOMS can import the .MOT ascii (text) fileswritten by VIBRATZ. These also contain
detailed data for each mode. AsATOMS importsa.MOT file, it writesa.MDS (binary) file -
this should be the same as the .MDS file written by VIBRATZ. Why bother with two different
types of file? Because the binary .MDS files are not portable between platforms (e.g. Intel vs.
Motorola processor).

ATOMS can also import the main VIBRATZ .VBR datafiles. Theinformation in thesefilesis
not the same asin the .MOT files - the .VBR datafiles, like ATOMS .STR files, contain
complete symmetry information and only the symmetry-unique input atoms, while MOT files
contain all atoms in the molecule or unit cell, without symmetry. The atomic motionsin .MDS
and .MOT files must refer to al atoms in the molecule or unit cell. Thus, **do not** import
VBR filesinto ATOMS if you want to display atomic motions.

When importing either type of VIBRATZ file, ATOMS will read the type numbers modulo 100
- for example, atom types number 6, 106, 206 etc. will all be converted to 6 (carbon).

Recommended procedure for using ATOMS to show vibrational motions.

1) If you import an ATOMS (.STR) fileinto VIBRATZ, itisagood ideato use two different
names, for example myfile_orig.STR for the original ATOM S files, and myfileVBR for the
VIBRATZ file. Thisis because you will use another .STR file, without symmetry, to display
the motions.

2) InVIBRATZ, check the .MOT file box in the Control window so that a.MOT fileiswritten
during calculation. Thiswill be myfile MOT.

3) INATOMS, import the myfileMOT file. Thiswill rewrite myfileMDS. The new ATOMS
file will be by default myfile STR. Set up the boundary (for crystals), display parameters,
vectors, etc. as desired. Most parameters dealing specifically with motion display arein the
Vectors and Vibrational Modes dialogs in the Inputl menu. The bonds are just those specified
inVIBRATZ.

4) If youreturnto VIBRATZ to recalculate with changed forces, it will rewrite myfile MDS,
which can be read by ATOMS, so ATOMS will remain up to date with the latest VIBRATZ
calculations. On the other hand, if you want to preserve the motions for a particular calculation,
you can rename the . MDSfile, e.g. myfile_1.MDS (you must do thisin the operating system).
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Y ou can switch between different .MDSfilesin the Vibrationa Maodes dialog in the Inputl
menu. You can also reread the .MOT file, for atomic motions only, in the Vibrational Modes
dialog.

5) Sarting a new problem. Once you have the parametersin ATOMS set up to your liking,
before importing anew .MOT file, just read an old ATOMS file with the appropriate settings.
When you import a.MQOT file, the new ATOMS .STR file will have the same name as the
.MOT file. Or, save the desired parameters by selecting Save Defaults in the Settings menu in
ATOMS. These parameters can be reread during import, or later through the Settings menu.

6) Transferring problems across platforms. The binary .MDS files may be incompatible
between platforms (Macintosh and Windows computers write the bytes of numbers in opposite
order). Thusyou should transfer the ascii (text) files myfile_orig.STR, myfileVBR and
myfileeMOT. When you open the myfile.STR filein ATOMS for display of atomic motions,
use the option in the Vibrational Modes dialog in the Inputl menu to read in the .MOT file for
atomic-motion parameters only. Thiswill cause writing of a new myfileMDS. Rerunning
VIBRATZ should also rewrite the . MDSfile.

Display parametersin ATOMS. The atomic radii are controlled during import with the choice
between covalent and ionic radii, and by the factor which may be applied - for displaying
motions the factor should normally be well under 0.5. Y ou can later change radii globally with
the Atoms-Global option in the Inputl menu. Y ou can change the default radii and atom colors
for import by editing the ELEMENTS.ION and ELEMENTS.COV files. (Thefile RADII
contains a universal table for automatic bond generation - this should not be modified unless
there are problems with automatic bond generation). Bond parameters may be set during
import, or reset with automatic bond generation (Bonds dialog in the Inputl menu).

When importing a.MOT file, bond specifications are taken directly from the VIBRATZ data. If
there isastructure in memory, and if there are bonds (Bonds dialog in the Input1l menu), the
radius and colors of all the new bonds are taken from the first old bond - if there are no bonds,
radius and colors of the bonds derived from the .MOT file will be standard (radius 0.0, black
rim, whitefill), or the values of the first bond when defaults were last saved.

4.8 Dealing with Molecules, Groups and Fragments in Crystals

Atoms has capabilities to deal with several types of atomic groups, which may be
roughly separated into three classes.

1) True Molecules

It is often useful to be able to identify true moleculesin crystals. A "true" molecule has
strong bonds linking all atoms within it, does not have strong bonds linking its atoms to
other molecules or groups, and is limited to a constant number of atoms, i.e. it isnot a
polymer.

True molecules which are not to be combined with other structures are most easily dealt
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with initially using one of the special Moleculesin Crystals Boundary Options. These
boundary optionswill identify all moleculesin the structure regardless of whether or not
they cross the formal unit-cell boundaries, and fill out a specified volume using ssmple
trandlation or crystal faces or a sphere as boundary surfaces, these boundaries being
applied to the centers of the molecules. Individual molecules can be identified with the
cursor and highlighted or hidden completely (i.e. marked as non-plotting).

Atoms within molecules can be connected to each other with bonds or with polyhedra.
Input bond specifications can be marked as inter-molecular, meaning that they will not
be used in the molecule search.

Molecules |ocated with these boundary options cannot be deleted, translated or rotated.
Colors, etc. cannot be changed for molecules as a whole as opposed to individual input
atoms. For these reasons, and because the molecule-locating algorithm is time
consuming, it is often advantageous to use the Generated to Input conversion (Transform
Menu). In thisconversion, the symmetry and lattice translations are essentially lost, but
the molecules can be optionally converted to fragments, which can then be duplicated,
trandated, rotated and deleted independently. Molecules which have been marked as
non-plotting may be optionally deleted during the conversion.

2) Polymer groups

Many crystal structures have polymer units which are continuously bonded in one, two
or even three directions (lattice directions). It is often useful to be able to isolate these
units, which requires a different approach from true molecules.

Polymer groupsin crystals cannot be identified in the Moleculesin Crystal Boundary
options because the bonding is continuous. To deal with such groups, it isfirst necessary
to define boundaries for the drawing using one of the boundary options which apply to
individual atoms, not molecules. Then bonded groups can be located individually in
either of two ways: with the Find button in the Generated Atom Data dialog which
comes up when you click on an atom in the display; or with the Locate Groups option in
the Transform menu. In either case the unitsidentified are limited to the current
generated atoms, i.e. those within the current boundaries, whereas the special boundary
optionsin 1) above locate complete molecules regardless of the boundaries. That isto
say, in 2) groups may be truncated (which is necessary in the case of polymers) whereas
in 1) molecules always maintain their integrity.

Groupsidentified in thisway are not permanent - the groupings disappear when the
structure is saved in afile, although if some groups have been hidden, the individual
atom numbers will be saved in the list of non-plotting atoms. Having made the desired
identification of groups, it may thus be advantageous to use the Generated to |nput
conversion (Transform Menu), converting groups to fragments which are then saved in
the data (.str) file.
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3) Structure fragments

ATOMS can combine portions of completely separate crystals and/or molecules (termed
fragments). Thisismost commonly used for epitaxy (crystal on crystal or molecule on
crystal), but can also be used for combining molecules, for example to depict chemical
reactions. These fragments can be duplicated, trandated, rotated and deleted
independently.

Fragments can exist only in the Input=Generated boundary/operating mode, which is
attained only by going through the Generated to Input transformation (Transform Menu).
As explained above, molecules or polymer groups can be converted to fragments, so
fragments can represent 1) molecules, as identified with one of the Moleculesin Crystal
boundary options; 2) polymer (or molecular) groups, asidentified with the Find button
in the Generated Atom Data dialog (after clicking on an atom) or with the

L ocate Groups option in the Transform menu; 3) completely distinct structures, obtained
by reading from files or by one of the other optionsin the Multiple Structures optionsin
the Transform menu.

It is not possible to identify groups or molecules when in the Input=Generated mode and
more than one fragment is present. However, al the atoms can be combined into one
fragment with the Consolidate option in the Locate Groups dialog (Transform Menu),
and you can then start over with identification of molecules or groups. Of course all
molecules or groups will have to be identified individually.

Molecules, groups and fragments do not have to contain more than one atom, nor do they
have to be electrically neutral. Furthermore, the atoms of fragments are not necessarily
connected by bonding. For example, in structures with cations and anion radicals, for
example CaCOg3, using the Moleculesin Crystal boundary options will result in each Ca
atom, as well as each CaCO3 group, being identified as amolecule. The

Generated to Input transformation would (optionally) convert each of these moleculesto
afragment. On the other hand, if you calculate a CaCO3 crystal using one of the
boundary options for individual atoms, then identify each CO3 group (but not Ca atoms)
and finally use the Generated to Input transformation, all the Ca atoms will be grouped
in one fragment.

4.9 Deleting Atoms and Atom Labels

In ATOMS normal operating mode, there are two types of atoms, input atoms and
generated atoms. The input atoms are usually entered and removed in the the
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Input Atoms dialog. The symmetry and lattice trandlations, if present, are used to derive
the generated atoms from the input atoms; it is the generated atoms which are actually
viewed in adrawing. There are basically two ways of removing specific generated atoms
from the drawing.

If only afew atoms are to be deleted, they can be marked as non-plotting. Clicking with
the mouse on or near the location of an atom brings up either the Generated Atom Data
dialog or the Atoms at Cursor dialog, in which selecting an atom brings up the first
dialog. Unchecking the Plot Atom box will mark the atom as non-plotting. Y ou must
replot to actually cause the atom to be removed from the drawing. When the structure
fileisclosed, alist is made of the non-plotting atoms, which will be saved and used the
next time the structure is calculated. Starting with V4.0, the lists of deleted atoms and
atom labels use a code containing the unit-cell, the symmetry operator etc., rather than an
arbitrary generated-atom sequence number, so that changing the boundary conditions
will not usually make the list invalid (although some deleted atoms or labels may no
longer be within the boundaries). However, changing the symmetry will make the list
invalid.

When molecules or fragments are present, the atoms in the entire group can be marked as
plotting or non-plotting.

All atoms marked as non-plotting can be restored, and a specific range of generated
atoms can be either restored or marked non-plotting, with the Atom/Bond Plot States
dialog in the I nput2 menu.

If many generated atoms are to be deleted, it may be better to change to the special
Input=generated operating mode. Thisis done with the Generated to Input command in
the Transform menu. In this operating mode, all symmetry and boundary conditions are
removed, and generated atoms are exactly equivalent to input atoms. The individual
atoms can be removed in the Input Atoms dialog. Y ou can click on atoms on the screen
and use the Generated Atom Data dialog to get the number, then delete them in the
Input Atoms dialog. Or, you can mark atoms for deletion by unchecking the Plot atom
box as above, then do the Generated to Input command. This command gives you an
opportunity to delete atoms which are marked as non-plotting. It can be repeated as
many times as necessary, just for the purpose of deleting atomsin thisway.

Deleting angle labels. Angle labels are automatically applied to all groups meeting the
specificationsin the Angle Labels dialog (Display menu). Individual angles can be
deleted (actually, marked as non-plotting) by clicking on the three atomsin succession
(outer-central-outer) and unchecking the Angle box which appearsin the

Generated Atom Data dialog.
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4.10 Direct Modification of Files

If you modify any data or setup file, be sure never to use tabs.

Data Files. The files written for each structure are of the standard ASCI|I type. Direct
modification of these filesis no longer recommended. However, occasion may arise for
repairing a damaged file, which can be done with any word- or text-processor or other
program which handles ASCII files.

SCRPTR Setup File. There are now only two types of datain the SCRPTR file which
should be modified; the dot-patterns and the SHEL X commands-to-be-ignored. The
contents of thisfile and the DEFAULTSfile are now in a user- and platform-specific
setup or Preferencesfile

There are two sets of 32 dot-patterns (fine and coarse), each consisting of 32 lines of 8
numbers each. Each number can range from O to 255, with abinary 1 bit representing a
black dot and O representing white (or color in the case of 4-bit raster files). Note that
earlier versions of ATOMS may have had either 14 (V1.0) or 16 patterns in each series.
Thefine series, which isfirst, contains duplicate lines so that there are only 16 patterns
for shading, even if the number of shading zonesis greater than 16. These patterns could
be modified to give 32 distinct shades, although it is doubtful if this would greatly
improve the quality of the image.

Patterns can also be modified to give striations, hachures or other patterns for
distinguishing unshaded atoms. For example, thesequence”1111111 1" will give
vertical striations, and the sequence "2550000 0 0 0" will give horizontal striations.
Such patterns should not be used when shading isin effect. ATOMS now has the ability
to show macrosopic hachure patterns on polyhedra and atoms, so pixel-scale patterns are
probably unnecessary.

The patterns in the SCRPTR file are only used for raster-file output, and for standard
printer output (when ATOMS patterns are selected in Windows); they are not used for
the screen.

At the end of the SCRPTR fileisalist SHEL X commands of four (or fewer) characters
each, which areto beignored by ATOMS when importing SHEL X files. Thelist hasten
commands per line, and is preceeded by the number of commands. If you add
commands, be sure to change the number.

Although the data for the two 16-color palettesis aso in the SCRPTR file, it iseasiest to
modify palettes with the M ain Palette and Conver sion Palette dialogs in the Settings
menu, or to prepare files to be read in with these dialogs.

ELEMENTSfiles. Thesefiles, ELEMENTS.ION and ELEMENTS.COV supply default
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types (atomic numbers by default), radii and colors for input atoms read in from an
ASCII file. Seethe next section for information on modification.

SCATFAC.DAT file. Thisfile contains scattering factor data for powder and precession
diffraction. The data are by default those for neutral atoms from the International Tables
for X-Ray Crystallography (1974, Vol. 4). The ATOMS type numbers of input atoms
are keyed to the entriesin this table in order of the entries (not by element name). Other
values using the same exponential form, for example different valence states, may be
substituted. The coefficients are separated by blank spaces and are not confined to
particular columns.

Thefirst nine coefficientsin each line are the X-ray scattering factor coefficients and the
last number is the neutron scattering factor or length.

By default, number 99 in thisfileis used for deuterium (symbol "D") and number 98 is
tritium (symbol "T"). These differ from hydrogen only in the neutron scattering factor.

The atomic type numbers, modulo 100, are used as indices to thistable. For example 6,
106, 206 etc will all reference the sixth entry (carbon). Thus entries beyond 100 will be
ignored. Any special or temporary entries should generally be placed in numbers 93 to
97.

If you modify any data or setup file, be sure never to use tabs.

4.11 Drawing Crystal and Unit-cell Edges
Drawing Crystal and Unit-cell Edges and Faces

2D Drawing Modes. Inthe Standard and Ellipsoid drawing modes of atoms, all objects
in the atomic structure itself, namely atoms, bond and polyhedra, are sorted with respect
to distance from the eye (perspective projection) or height in the x -coordinate
(orthogonal projection). Then the objects are drawn in order from back to front. Instead
of constructing three-dimensional objects and then projecting onto the plane of the
drawing, it is possible in many cases to use simplified two-dimensional objects (e.g.
circleinstead of sphere). When objects are actually in bonding relationship the
interpenetrations are solved analytically, but thisis done only for certain cases where the
geometry is very restricted; atom-atom, bond-atom where the bond connects that atom
with another; and atom-polyhedron in the case where the atom is aligand of the
polyhedron. For the atomic structure itself, there is no need to solve for interpenetration
of, for example, a bond with atoms which are not connected by that bond, or a
polyhedron with bonds other than those to its ligands, because such geometries do not
exist.

However, for the lines or cylinders which are used to represent the edges of the boundary
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polyhedron, or the edges of the unit cell, there are no such restrictions on interpenetration
geometry; such lines or cylinders may interpenetrate with atoms, bond and polyhedrain

any way.

For pen plots and pen-plot files, which use strictly vector methods of drawing, it is not
possible to superimpose objects while drawing from back to front, and it is necessary to
solve analytically for overlay relationships as well as the same limited interpenetration
relationships mentioned in the first paragraph. However, this process is made much
faster by the process of sorting and drawing from back to front.

For these reasons, the drawing of lines representing the boundary or other crystal shape
(Crystal Formsfor Display) in 2D Drawing modes assumes that there is no
interpenetration between these lines and atoms, bond or polyhedra. The lines
representing edges which would be hidden if the crystal shape were opaque ("back”
edges) are drawn before the structure; and the lines representing visible edges ("front"
edges) are all drawn after the structure.

Sinceit isnormally necessary to show avolume of acrystal greater than one unit cell,
similar assumptions cannot be made for the special drawing in the Unit-Cell optionin
the Input2 menu. The unit-cell edges in thisoption are thus all drawn after the
structure. They are intended to show the translational relationships of the structure, not
to delimit some particular volume.

These simplifications are primarily intended to cut down on plotting time; they may be
removed in the future as processors become faster.

3D Modes. The 3D Drawing Modes use a completely different drawing method. Fully
three-dimensional objects are drawn in any order, but the height (x-coordinate in the
system used by ATOMYS) of each pixel is compared with the value in a depth buffer and
the color which isalready in that pixel is replaced by the color belonging to the new
object only if the new object is closer to the eye at that point (i.e. if the new object
overlies al other objects at that point). In this drawing mode there is absolutely no
restriction on interpenetration relations - they are drawn correctly as a matter of course.
Thus unit cells are drawn in correct 3-dimensional position, not in front of the structure.
Crystal edges are also always drawn in correct position, and interpenetrations are exact.

Crystal and unit-cell faces, that is actual surfaces, may also be drawn in 3D modes.
Usually thisis most useful if the faces are transparent or translucent. However, full
transparency may not be supported by the system software and/or hardware. Absolutely
correct transparency would require drawing from back to front, and would again
encounter some of the problems discussed above for 2D drawing modes.
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412 ELEMENTS Files

Thesefiles provide atable of standard or default parameters for input atoms, namely

atomic display radii, type numbers and colors. The key to the elementsin thetableis
through the two-character symbol, normally the standard elemental symbol, which is

matched to the first two or one charactersin the label for the input atom.

The radii may be used when reading in atom parameters from an ASCI| filein the

Input Atoms dialog (see also Atom Parameter Files), or when importing adatafile
(Import Files popup of the File menu(Startup) or File menu(Graphics)). Note that when
generating bonds automatically (Generate Bonds dialog), by default a different table of
radii isused (from the RADII file), athough the atom display radii can optionally be
used.

Thesingle ELEMENTS.DAT in early versions of ATOMS has been superceded by the
ionic and covalent equivalents, ELEMENTS.ION and ELEMENTS.COV. One or the
other of these is used, depending on the setting in the Preferences dialog in the Settings
menu, or in the dialogs for import files. The default versions of these files now contain
full ionic and covalent radii, and when importing afile or reading atomic coordinates the
radii values are multiplied by the Factor in the Preferences dialog in the Settings menu.

Thefirst field in each line is the atomic number or other designated type number. The
second field, or SYM field, consisting of two characters in single quotes, is usually the
normal elemental symbol. The remaining fields give the default values for the rim color
and thefill color (RGB components 0-255, three numbers for each color), the rim and fill
b/w shades (one integer for each, 0-15 for white-black) and pen number. These fields
arethe same asthe RMC, FLC, RMP, FLP and PEN parameters as described in

Atom Parameter Files. All thesefieldsarerequired, in the given order. Thereisalimit
of 150 entries (lines) in the ELEMENTSfiles.

Modifyingthe ELEMENTSfiles. The ELEMENTS files may be modified with aword
processor to assign any desired default valuesto the parameters. It may also be necessary
to do some editing to avoid problemsin interpreting the LAB field in terms of elemental
symbols, or to change the elemental symbols from English to other language versions.
Atomic numbers or types may be duplicated; for example you can have aline with
number 53 and symbol | and also one with symbol J.

ATOMSfirst attempts to match the first two charactersin the LAB field with two-
character SYMBOLsin the ELEMENTSfile. If no match isfound, then it tries one-
character symbols. For example, it will test the first two charactersin the LAB against
CA, CD, CL, etc., and only then will it test the first character against C (or C). Thusa
carbon atom designated CALPHA would be read as calcium unless the CA lineis
removed from the ELEMENTSfile. The label "C-ALPH" would avoid this problem.
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If you only work with alimited number of atom types, it would be best to prepare a
shortened version of the ELEMENTSfile, to avoid possible conflicts and to shorten
search times.

If no match isfound in the ELEMENTSfile for the first two characters of aLAB field,
the values from the first entry in the file are used. Thusif you want to assign the same
default valuesto al atoms, regardless of the LAB field, you can put these valuesin a
single line and remove al others.

Y ou can use appropriate values for the radius to set up for polyhedral or wire frame
models. For example, if all Si and O atomsin asilicate are part of silicate tetrahedra, the
radii for Si and O could be set to 0.0, which insures that the atoms which are not part of
complete polyhedra are not plotted. Likewise for wire-frame models the radii can be set
to -1.0, so that only bonds are plotted.

The Factor edit field in the Atomic Radii group in the Preferences dialog (Settings
menu) multiplies the radii. For ball-and-stick models a factor of about 0.5 is appropriate,
and for interpenetration (space-filling) models afactor considerably larger than one may
berequired.. Also, you can multiply all radii by a given factor with the Atoms - Global
dialog in the I nput1 menu.

Blanksinthe SYMBOL field in the ELEMENTSfile are ignored.

ELEMENTS.ION usesionic radius values for the most common ionization state (rare
gases use Van der Waals radii, and minimum values of 0.05 are used for atoms which
are central atoms of radicals). The radii are mostly from the tabulation of Shannon and
Prewitt. Note that V4.0 and later of ATOMS uses full ionic radii, while previous
versions had values of 50% for the radii. ELEMENTS.COV has full values of covalent
radii, mostly from Pauling.

4.13 File Types

ATOMS uses several different types of auxiliary files, with different extensions.
Structure data files (.str). These hold the information on individual structures. The
Open, Save and Save As commands in the File menu of the Graphics window pertain to
these files.

Internal files. These arefor ATOMS interna use and should not normally be modified
by the user (but see Direct Modification of Files). SCRPTR isthe main start-up file
which saves current settings. DEFAULTS saves default display variables for use with
the New command. These two files have been replaced for most users by the user- and
platform-specific setup or Preferencesfile. PPLOT contains data on pen plotters.
CPATOMS.HLP [Windows] or ATOMS HELP [Macintosh] isthe help file, which isin
condensed format and not modifiable by the user. CIFDIC.SHT isthe (shortened)
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dictionary file used when importing CIF files.
Space-group file. Thefile HALL.DAT contains space-group information.

Scattering factor file. Thefile SCATFAC.DAT contains the X-ray scattering factor data
for neutral atomsin the exponential form as given in the International Tables, Vol. 4, for
use in the Powder and Precession diffraction options (Display menu). Thisfile may be
modified to use other scattering factors (e.g. for ionized atoms). The scattering factors
are keyed by sequence number as read from thisfile to the atom type. Thereisa
maximum of 100 scattering factors.

Cartesian symmetry files (.sym). These contain Cartesian point-symmetry matrices
generated by the auxiliary program SY MGRP.

Palette files (.pal). These contain RGB values for two 16-color palettes which (a) form
the basis for 8-bit (256-color) palettes; and (b) are used to convert PC-DOS color
numbersto RGB values. They can be modified, read and written with the Pal ettes
commands in the Settings menu.

Atom parameter input files (.inp). These arefiles supplied by the user, containing at
least the atom labels and coordinates, and optionally other parameters. They areread in
through the [nput Atoms dialog in the I nput1 menu, not the Open command in the
File menu (Startup) or File menu (Graphics).

Atom parameter default file (ELEMENTS.ION or ELEMENTS.COV). Thiscontains
default atom types, radii and colors for use when reading in atom parameters from.inp
files. It can be modified by the user to give the desired parameters. By default,
ELEMENTS.ION contains standard ionic radii and ELEMENTS.COV contains standard
covalent radii.

Radius values for bonds. The RADII file supplies values for generating input bonds. It
also has index values for each element, which optionally may be used avoid superfluous
or impossible bonds. The values currently used are 1 for cations, -1 for anions, O for
"non-metals’, and 3 for inert (rare gases). At the time of generating input bonds, the
values for the two candidates (input atoms) are added together, and pairs with absolute
values greater than 1 are rejected.

Imported data files. These include the following. These files types are sometimes given
arbitrary extensions, but any filename can be opened. (1) CCDC EDAT files (.fdt). (2)
SHELX refinement input files (.ins). (3) CIE - Crystallographic Information Files (.cif).
(4) DBWS/LHPM Rietveld refinement files (.dbw and.lhp). (5)

Inorganic Crystal Structure Database (ICSD) files (.ret and.cry). (6) ORTEP datafiles
(cort). (7) XTLVIEW structure display files (.xtl). (8) VIBRAT motion files (.mot). (9)
Protein Data Bank files (.pdb). (10) RIETAN Rietveld files (.xyz). (11) GSAS Los
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Alamos program system files (.exp). (12) American Mineralogist structure database files
(.amc). (13) FEULLPROF refinement files (.pcr). (13) Free-form (.inp) files.

Text output files (.atd). These contain the input to and/or results of the ATOMS
calculations. Thefileinfile ATD contains output of the atom-locating calculation on the
structure file infile.STR, such as atom locations, atoms in bonds and polyhedra, bond
length and angles. INPUT.ATD liststhe input data. GENATOMS.ATD liststhe
Cartesian coordinates of all the generated atomsin their current orientations.
FACES.ATD lists attributes of the current boundary and/or display crystal faces.
TOTALS.ATD givestotals of various types and the current maxima for these values.
BONDS.ATD gives bonds and angles around each or al input atoms. These files may
all appear in a Text window, and are saved independently of the ATOMS structure data
files.

Graphics output files. ATOMS can write graphics output files of various types:
encapsulated PostScript files (.eps); HPGL vector files (.pgl), 3D VRML filesand

---- Windows only ----

raster files (.bmp,.pcx,.tif,.png); and Windows metafiles (.wmf or.emf).

---- Linux only ----

raster files (.bomp,.pcx,.tif,.png).

---- Macintosh only ----

PICT files (.pic) in either Picture (metafile) or bitmap format and.png raster files.
---- End Windows/Mac/Linux only ----

File Locations

ATOMS expectsto find certain filesin the "home" directory, which isthe directory
containing the ATOMS program file (CPATOMS.EXE for Windows). These files are
SCRPTR, DEFAULTS, PPLOT, SPCGRP.DAT, CPATOMS.HLP, ELEMENTS,
HALL.DAT, CIFDIC.SHT, RADII, SCATFAC.DAT and palette (.PAL) files.

The information in the SCRPTR and DEFAUL TSfiles istransferred to a user- and

platform-specific setup or Preferencesfile, which is used after the first startup of
ATOMS.

If you are using Cartesian symmetry files (.sym), they should be in the same directory
("data" directory) asthe structure file. The data directory is reset whenever you read or
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write astructure file (.str). Most output files, including EPS, raster, HPGL, metafiles and
calculation output files (infile.atd), will be written to the data directory. However, the
datafiles (.atd) from the List... optionsin the File menu are written to the home
directory, to avoid cluttering the disks. To save these files permanently, use Save A< to
give them new names in the directory of your choice.

When reading files, the extensions are not mandatory, and you can always use a different
extension when saving afile, or specify "al files" when browsing or searching for afile.

---- Macintosh only ----
File and Creator Types

Most output and data text files have file creator 'ATOM' and file type TEXT'. The
main ATOMS datafiles (.STR) havefiletype'ATDT', to prevent accidental damage by
editing with aword processor. However, you can can change thefile typeto TEXT
with autility program if necessary. Only fileswith creator 'ATOM' and extension.STR
will be opened as data files by ATOMS when they are double-clicked.

Filesfrom previous versions of ATOMS may have different creator and file types.
---- End Macintosh only ----

4.14 Frames

With printed and pen-plot output, you have a choice of using the full page, or confining
the output to aframe. For Raster Files and Metafiles or PICT files (File menu) output
always goesto aframe.

If you are using the Univer sal or Maximize Each View scale modes (Scaling dialogin
the I nput2 menu), theimage is scaled to fit in the frame. If you are using the Fixed
scale mode, the image is clipped to the frame.

In printed and pen-plot output, the frame can be positioned on the page; the offset gives
the displacement of the upper left corner of the frame from the upper left corner of the

page.

In some cases, you can choose the units for the size and offset of the window; either
inches, centimeters or dots (pixels), and you may also be able to specify the nominal dots
per inch or centimeter. The units setting is independent of the overall choice of inches or
centimetersin the Preferences dialog in the Settings menu.

© 2011 Shape Software



216 ATOMS Help

4.15 Lighting Equation

In the 3D drawing mode the material properties of objects determine the way the objects
interact with the light sources. The color observed at a given point is aresultant of the
light source(s) (3D Lighting) and the Material properties; that is, the RGB coefficients
of the Ambient, Diffuse and Specular components of the light source(s) are multiplied
by the specified colors of the objects, and by the material coefficientsin this dialog, then
the results are limited to the range 0.0-1.0.

Itotd = KeC ;emissive
+laKaC ;ambient
+Sum(i) [ (NdotVi) li KdC] ;diffuse
+ Sum(i) [ ( NdotSi )*ns i Ks] ;specular
Where
Itotal isthetotal intensity as an RGB triplet at any point on an object;
laistheintensity (RGB triplet) of the ambient light source (3D Lighting dialog);

li istheincident intensity (RGB triplet) at the object of directional or positiona light
sourcei (3D Lighting dialog);

C isthe assigned color (RGB triplet) of the object (Input Atoms, Bonds, Polyhedra
diaogs);

K e isthe emissive material coefficient of the object (3D Material Properties dialog);
K a isthe ambient material coefficient of the object (3D Material Properties dialog);
Ksisthe specular material coefficient of the object (3D Material Properties dialog);

ns is the specular exponent or shininess coefficient of the object (3D Material Properties
dialog);

N (avector) isthe normal to the surface at the point in question;
Vi (avector) isthe direction of the incident directiona or positional light i at the point;

S (avector) isthe bisector of the angle between the light-surface vector (or Vi) and the
eye-surface vector;

"dot" signifies the vector dot product.
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The incident intensity from alight source isitself subject to attenuation (3D Lighting
dialog);

li =1i(0)/ (Kc+ Kl d + Kqd~2)

Where d is the distance of the point in question from the (positional) light and Kc, K

and Kq are the constant, linear and quadr atic attenuation coefficents respectively.
Constant attenuation is essentially a brightness coefficient. Valueslarger than 1.0 simply
darken the scene. Values smaller than 1.0 may add a white component and/or increase
the specular contribution. Linear and quadr atic attenuation apply only to Positional
lights.

Ambient light has no direction or origin and is considered to bathe all objects uniformly.
Having a significant ambient component causes non-illuminated parts of objects to be
other than black. It thus "softens" the illumination in a somewhat similar way to the
Darkest Shade and Dar kness Angle parameters (Shading dialog) in the 2D Drawing
modes.

Diffuse color isusually the main component of the appearance of objects. The intensity
of the color is dependent on the angle between the light ray and the normal to the surface
in question.

Specular reflection only occurs when the normal to the surface in question is close to
bisecting the angle between the incident light and the vector from the point on the
surface to the eye. It produces bright highlights on a curved surface. The larger the
Specular material coefficient, the smaller will be the bright specular highlight on a
curved surface. The shininess coefficient has a maximum of 128 because of
computational restrictions, but values on the order of 5-30 are usually realistic. In
ATOMS, specular reflection is always white, that is it does not depend on the color of
the object, only the color of the light source(s). For directional lights, specular reflection
may not work well for polyhedra because faces at certain angles will give asolid white
appearance.

Emission is similar to ambient, except that there is no dependence on the color of any
light source. A high value of emission makes an object look likeisis glowing.

This equation ignores translucency, which causes colors of objectslying at different
depthsto be blended.

4.16 Settings, Preferences or Configuration Files

ATOMS hasin the past saved various settingsin two files, SCRPTR and DEFAULTS,
both of which are in the same folder or directory as the wxAtoms program or executable
file. SCRPTR saves genera settings which may be used for all data, such as frame sizes
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for printing and graphics file output and is always saved before exiting the program.
DEFAULTS saves settings which are more particular for each data set - these may be
used asthe initial or default values for anew data set. The DEFAULTSfile could be
read or written through options in the Settings Menu, and at other times when starting a
new data set or importing afile.

Starting with V6.3, thisinformation is saved in a standard type of file which is specific
to the platform (Windows, Mac or Linux), and thisfileisin alocation specific to each
user. Thus each user will have his or her settings preserved, even if only one copy of the
ATOMS folder/directory and executable file is present. Further, these settings will be
carried on as new versions of ATOMS areinstalled.

Specifically the new settings files will bein the following locations:
Windows: \Documents and Settings\username\ATOMS.ini

Macintosh: :Users.username:Library:Preferences: ATOMSPreferences
Linux: /home/username/. ATOMS (note the period - thisisahidden file)
where username is the name of the current user logged in.

The..ini, Preferences or config file has separate sections containing the SCRPTR
information and the DEFAULTS information.

The SCRPTR and DEFAULTSfiles still exist. On startup, ATOMS looks first for the
user-specific file, and if thisis not present it reads the values from the SCRPTR and
DEFAULTSfilesin thefolder or directory containing the ATOMS executablefile.
Thereafter the user-specific file iswritten and used.

The Windows and Linux versions have separate Help server programs, and these write
their own user-specific preferencesfiles. Thesefileswill be in the above locations, and
the program nameis "wxHTMLHelpController" instead of "ATOMS". Inthe
Macintosh version, there is no separate Help server program and the datafor the Help
windows (window sizes and location and fonts) isin the ATOMS Preferencesfile.

In the Settings menu, there are now options to read and write the "archive" SCRPTR and
DEFAULTSfiles - thiswrites the values currently used by ATOMS. [f there are
multiple users of ATOMS, these files should probably be written only by the the system
administrator. All users may read the files to get the "standard" or archive values.
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4.17 Shortcut Keys

Since several viewing or drawing modes have been added for V6.4, and since stereo
images may require full-screen viewing in which menus are not available, the keyboard
shortcuts for modifying or animating the images have been revised and extended.

In the full-screen modes accessed with the Fullscreen button in the Dialog Bar - Left or
the menu option, the left mouse button always performs the identification function,
identifying either atoms or crystal faces, and the right button performs the rotation
function. Clicking outside the crystal faces or structure (not on an atom) brings up a
dialog giving most of the options, which can be selected with buttons. If the structureis
in motion, clicking with either mouse button will stop it. Exit from Fullscreen mode
either with this dialog, or with the Esc(ape) key.

The displacement function with the right mouse button which was available in earlier
fullscreen viewing has been discontinued.

In the Direct3D fullscreen mode, the mouse buttons only cause rotation (click and drag),
not crystal-face or atom identification, and no dialog is called up by clicking. When the
structure is in automatic motion, rotating or vibrating, clicking anywhere will stop the
motion. The same keyboard shortcuts are available, and exit from fullscreen is with the

Esc(ape) key.
The shortcut key combinations:

SHIFT-X Rotate on the x axis (horizontal in screen). Stop rotation on x, y or z with a
mouse click or SHIFT-Q, and change the speed with the SHIFT-F (faster) and SHIFT-G
(slower) keys.

SHIFT-Y Rotateonthey axis (up in screen)
SHIFT-Z Rotate on the z axis (out of screen)

SHIFT-V This starts vibrational motion according to the mode currently selected in the
Vibrational Modes dialog (Inputl menu). A file with vibrational mode information
written by VIBRATZ isrequired. Stop vibration with amouse click, and change the
speed with the SHIFT-F or SHIFT-G keys.

SHIFT-T This starts thermal motion, with parameters selected in the Thermal Motion
dialog (Inputl menu). A file with vibrational mode information written by VIBRATZ i<
required. Stop vibration with amouse click, and change the speed with the SHIFT-F or -
G keys.

SHIFT-O Thisrestoresthe original or standard orientation.
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SHIFT-l Thisrestorestheinitia orientation
SHIFT-P This decreases the perspective distance, increasing the 3-D effect.

SHIFT-[ Thisincreases the perspective distance (the [ key isthe one to the right of the
P key on U.S. keyboards, but it may be elsewhere on other keyboards).

SHIFT-plus Thiswill change the rescale factor upwards.This factor can be set in the
Scaling dialog (Input2 menu). The plus and minus keys are those in the regular
aphanumeric part of the keyboard, not the number pad.

SHIFT-minus Thiswill change the rescale factor downwards.

SHIFT-A Increase the stereo rotation angle between the two images, or increase the
effective interocular distance. This does not apply to the Direct3D stereo mode - for that
mode, the rotation or "depth" setting is controlled by the video card, usually with a
separate set of keys. Thisrotation does apply to the quad-buffered OpenGL stereo mode
aswell asthe stereopair modes.

SHIFT-S Decrease the stereo rotation angle between the two images.

SHIFT-F Speed up motion. The SHIFT-F and SHIFT-G keys only apply when thereis
rotation or vibration going on. They permanently affect the angular rotation increment in
the Continuous Rotation dialog (Rotation menu), or for vibrational motion, the
frames/cycle parameter in the Vibrational Modes dialog (Inputl menu), or for thermal
motion, the frames/cycle (highest frequency) in the Thermal Motion dialog (Inputl
menu).

SHIFT-G Slow down motion.

4.18 Space- and Point-Group Orientation

Proper generation of atoms by symmetry requires that atom coordinates be consi stent
with the orientation of symmetry elements. That is, the people who publish or otherwise
report atom coordinates have to assume a particular geometric relationship between the
symmetry elements and the coordinate axes in terms of which the atomic positions are
given. In some point and space groups there is only one reasonable choice for the mutual
orientation of coordinate axes and symmetry, but in some groups there may be two or
more possibilities and ambiguity may arise.

Crystals. The preferred symmetry option for crystalsis normally Space-group, which
reads the symmetry operations from a selection of those in the Tables. The main part of
the Tables themselves (section 4.3 of Volume |, pre-1983 or Chapter 6 of Volume A,

© 2011 Shape Software



Reference 221

post-1983) lists only some of the possible orientations of space-group symmetry for
monoclinic and orthorhombic crystals, but the alternate orientations can be generated by
ATOMS, as described in the detailed instructions for the Space-group option. The
aternate settings are listed in Table 6.2.1 of Volume 1 or Table 4.3.1 of Volume A of the
Tables.

A consistent orientation of symmetry elements with respect to axesis not always used
for space groups in the International Tables for X-ray Crystallography. As an example
of alternate orientations, consider the point group C3y. The two simplest orientations for
the vertical mirror planes are either parallel to the a1 and a2 axes, or in between, rotated
30 degrees. These two orientations are embodied in the two space groups P31m-C3y4
(no. 157) and P3m-C3y! (no. 156). If the same orientation were used for both, one of
them would have a C-centered Bravais | attice, the avoidance of which the compilers of
the Tables apparently considered more important than consistent axial orientation.

It isimportant to realize that these different possibilities exist, especially when using face
or form indices from textbooks or the literature; it may be necessary to transform the
indices to conform with the orientation used in the structure description.

Molecules. Using the Point Group symmetry option, which derives the symmetry
operations from space-group listings in the Tables, unavoidably makes certain
assumptions about orientation. In monoclinic symmetry (point groups 2-C2, m-Cs, and
2/m-C2n) the unique axisis taken to be parallel to c or z, rather thanb or y (asin
crystals). In the orthorhombic point group mm2-C2y, the two-fold axisis assumed to be
parallel to c. If the atomic coordinates for the molecule are given in terms of a non-
standard setting, an alternate to manual rotation of the coordinates before input is to use
the Space-group option, specifying a space group in the point group of interest which has
the aternate orientation. Some examples of aternate settings related by 30 and 45 degree
rotations on the c axis are given in the section on the Space-group option.

4.18.1 Special Considerations for Molecules and Polymers

While ATOMS can deal equally as well with molecules as crystals, the input contains
some options which are extraneous for molecules. The following sections give some
guidelines for dealing with molecules and polymers. Thisisintended only for molecules
which are input as single entities with absolute coordinates, not for molecules which are
part of acrystal structure, which can be isolated with the L ocate Groups command
(Transform menu), the Find button in the Generated Atom Data dialog, or the special
boundary options for moleculesin crystals..

1. Coordinate Axesfor Molecules.
The type of axia system specified in the Title/Axes dialog (I nputl menu) may depend
on the symmetry of the molecule. Except for cases in which one 3-fold or 6-fold axisis
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present, i.e. trigonal or hexagonal symmetry, there is no reason not to use Cartesian
reference axes. The symmetry may then be specified using the Point-group symmetry
option if the moleculeisin a standard orientation, or the Space-group or Custom options
if itisnot. All these options use symmetry operations which are of the type used for
crystals.

However, if amolecule has either a 3-fold or a 6-fold axis the full symmetry can be
specified by means of crystallographic symmetry operations only if hexagonal structure
axes are used. Both trigonal and hexagonal crystal systems by default use "hexagonal
axes', that isa1 and a2 axes at right angles to the ¢ axis, and 120 degrees from one
another. Trigonal crystals may aso use rhombohedral axes, which are not applicableto
molecules. Cartesian coordinates may be transformed to hexagonal coordinates, and
vice-versa, with the following sets of equations (anglesin degrees).

xh = (1/a) xc sin120 + (1/a) yc cos120
yh = (1/a) xc cos120 + (1/a) yc

Xc = (@) xh sin120

Yc = (@) Xh €os120 + (a) yh

where aisthe length of the hexagonal a axes (or ratio of lengths hexagonal over
Cartesian if the Cartesian axes are not of length one). These equations assume that the
two c or z axes are parallel and that thea2, b or y axes are parallel.

Trigonal and hexagonal point groups. If unit Cartesian axes are used and atrigonal or
hexagonal point group is selected in the Point Group symmetry option, the standard
matrices for this group (derived from the first space group in the point group in the
International Tables) are converted from abasis of hexagonal axesto Cartesian axes.
Thisimplies a certain orientation of the symmetry elements. If adifferent orientation is
desired, there are two options; you can use a space group with a different orientation, or
you can select the Cartesian symmetry option. The Cartesian option requires the
preexistence of afile containing the symmetry matrices, which may be generated with
the auxiliary program SY MGRP available from Shape software. With this option the
symmetry elements may have any desired orientation with respect to the coordinate axes.

2. Boundary Optionsfor M olecules and Polymers.

For an isolated molecule, the boundary option will normally be No boundaries — this
simply accepts all atomsin the original input and those generated by point-group
symmetry — no tranglations (lattice vectors) are applied. Again, if you want to locate a
molecule in acrystal structure, see the Locate Groups command in the Transform
menu, the Find button in the Generated Atom Data dialog, or the special boundary
options for moleculesin crystals.

For a polymer, there are two possible choices. The simplest isto use the Trandation
Limits option. Thistakes all the atomsin the central cell and those generated by
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trandation within the given limitsin the directions of the selected |attice vectors (axes).
For aone-dimensional (chain) polymer, two of the trandlations should be disabled and
for atwo-dimensional (sheet) polymer, three should be disabled. Thisis certainly the
best choice for aone-dimensiona polymer.

The other choice isto use the Enter Forms option, and manually disable one or two
lattice trandlations. This allows for showing different parts of two-dimensional polymers.
For example, consider atrigonal or hexagonal sheet; the Translation Limits option
allows for showing only arhombic slice of the sheet. Suppose that the polymer extends
inthea and b (x and y) directions; then it can be limited by vertical faces such as (100),
(010), etc. to give aslice with hexagonal or trigonal symmetry. Trandlation in the ¢ (2)
axis direction should be disabled.

The above choices again assume that the input is actually for amolecule, and not a
crystal. For viewing moleculesin crystals, the procedure is different. First, you can
import several types of crystallographic files for structures containing molecules using
the Isolate Moleculesin Crystal boundary option (Inputl menu). The Free-

Form (.inp) import option can be used to read in almost any type of atomic-coordinate
information. Y ou can aso use the Locate Groups option in the Transform menu to
isolate individual molecules or polymers.

3. Symmetry for M oleculesand Polymers.

Symmetry of moleculesis normally described in terms of point groups. The point group
symmetry can be provided as crystallographic symmetry operations, or in the form of
Cartesian symmetry matrices.

3.1. Crystallographic symmetry operations.

ATOMS can automatically provide the symmetry for the 32 point groups which are also
crystal classes, i.e. contain no non-crystallographic symmetry elements such as 5-fold
axes. Provided that the orientation of the symmetry elements with respect to the
coordinate axesis standard, it is only necessary to give the Schoenflies or International
(Hermann-Maughin) symbol for the point group in the Point-group symmetry option.
Certain alternate orientations, related to the "standard" ones by arotation of 45 or 30
degreeson the c or z axis, can be attained by using the Space-group symmetry option. If
the orientation is not attainable by either of these methods, appropriate symmetry
operations can be entered with the Custom symmetry option.

Thereisno provisionin ATOMS for strictly one-dimensional, two-dimensional or spiral
symmetry elements, such as might occur in polymers. Nevertheless, most if not all of the
symmetry in polymers may be included with judicious use of space groups, combined
with disabling of repetition by tranglation in one or two dimensions. The space groups
which are applicable are those which have no screw axes or glide planes with tranglation
in anon-polymer direction. For example, an ideal silicate chain polymer is completely
described by space group no. 28 Pma2-C2y4, with the chain running in the a ()
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direction and the translations in the b and ¢ directions disabled.

3.2 Cartesian Symmetry Matrices.

This symmetry option is necessary for non-crystallographic point symmetry, that is
symmetry groups containing n-fold axes with n equal to 5 or higher than 6. It can also be
used for trigonal and hexagonal symmetry if you want to use Cartesian atomic
coordinates. Some symmetry files are provided, namely for the two icosahedral groups
and the pentagonal groups; in other cases the Cartesian matrices must be generated
before running ATOMS, by using the program SY MGRP, which generates self-
consistent point symmetry groupsin any orientation.

4.19 Standard PostScript Typefaces
Standard PostScript Typefaces (Font Families)

The names of the fonts should be entered exactly as given, with no embedded spaces. |If
your printer does not recognize afont string, it will probably default to Courier.

Times Roman Family

Standard: Times-Roman
Slanted: Times-Italic
Bold: Times-Bold

Bold Slanted: Times-Bolditalic

Helvetica (Swiss) Family

Standard: Helvetica
Slanted: Helvetica-Oblique
Bold: Helvetica-Bold

Bold Slanted: Helvetica-BoldOblique

Courier Family

Standard: Courier
Slanted: Courier-Oblique
Bold: Courier-Bold

Bold Slanted: Courier-BoldOblique

4.20 Starting ATOMS - Command-Line Processing

Starting ATOMS from DOS or Linux command linewith data file or import file

---- Windows and Linux only ----
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ATOMS for Windows can be started from the DOS or linux command line, or other
situations where command lines are used. If the name of an ATOMS datafile
(extension.STR) or an import file is also given, thisfile will beread in. For example

wxAtoms MYFILE.STR

will start ATOMS and open the ATOMS datafile MY FILE.STR.
wxAtoms MYFILE.INS

will import the SHEL X input file MY FILE.INS.

Linux is case sensitive and the capitalization must be exact for the executable
(wxAtoms) and file name.

ATOMS distinguishes among the different kinds of files by using the file extension (the
last three charactersin the name, following the dot). It testsfirst for the ATOMS data
file extension.STR, then tests for the extensions for the import file types in the order in
which the file types are listed in the File/lmport menu (with one exception). The default
extensions are as follows:

INP  Free-form Input

FDT CCDC FDAT file

INS  SHELX input file

.CIF CIE Crystallograpic Information File
.DBW DBWS Rietveld file

LHP  LHPM Rietveldfile

RET ICSD RETRIEVE file

.CRY ICSD CAN/SND file

.CRY ICSD Original CRY STIN file (must be changed; see below)
XTL Xtlview file

.PDB Protein Data Base file

XYZ  RIETAN Rietveldfile

EXP  GSAS (LosAlamos) Rietveld file

AMC  American Mineralogist structure database
.PCR FULLPROF refinement file

MOT  VIBRATZ atomic motion file

In order to read Origina CRY STIN ICSD files with the command line, the. CRY
extension (or that of CAN/SND files) must be changed within ATOMS, as both file
types normally use the same extension.

The extensions, which should always be three characters, can be changed in the dialogs
for the individual file types, accessed through the Import item in the File menu (Startup)
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or File menu (Graphics). The options for importing are also set in these dialogs. Thus to
set the file extension and other options, start up ATOMS in Windows and select
File/lmport and the file type of interest. The extension and options will be saved if you
click OK inthese diadlogs—it is not necessary to actually read afile (that is, you can click
Cancel in the File Open dialog).

Note that you must give sufficient information about the PATH so that the ATOMS
program file (WXATOMS.EXE) and the datafile to be read can be located. If this
information in not in the current DOS PATH, and the files are not both in the current
directory, path information must be given in the names. For example:

C\ATOMS60\WXATOMS.EXE C\ATOMS60\SAMPLES\DDRANE.STR

In Linux, base directory names will be different and the forward slash "/" is used instead
of the backslash "\"

4.21 Stereoscopic Display Modes

Improved technology has made stereoscopic viewing, that is viewing still images and
movies with separate left- and right-eye images to give apparent depth, better quality and
and more common on computers and televisions. Asfar asATOMS is concerned, there
are two separate kinds of stereo-enabled video cards of the most recent types. At
present, most software stereoscopic drivers for these cards appear to be available only for
Windows.

The 3D Quad Stereo Drawing Mode is available only for graphics cards supporting
OpenGL quad-buffered stereo. It is potentially supported for Macintosh and Linux as
well as Windows, though driver software does not seem to be available yet for them. The
Quadro series of cards from nVidia actually supports either Direct3D or quad-buffered
OpenGL stereo.

Direct3D sterea in Windows (only) is supported by the nVidia GeForce series of
graphics cards,with their 3D Vision package, and perhaps some others. The GeForce
series only supports stereo using Direct3D i(not any kind of OpenGL).

With either type of video card there are basically two types of viewing hardware.

1) Shutter glasses. Theimages are drawn independently and flashed alternately on the
screen at a high rate - 120 times per second in the latest computer implementations, for
exampl e those supported by both the nVidia Quadro and GeForce series of display cards.
A 120 Hz monitor isrequired, and it must be viewed with special shutter glasses which
blank out the left and right eyes alternately in synch with the images on the screen.
Projectors and projection TVs are also available.
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2) Polarizing monitorsor projectors. The monitor or projector simultaneously or
aternately (very rapidly) generates two images which are viewed with glasses with the
two lenses polarized at 90 degrees to each other, or with different circular polarizations.
Movie theater 3D (stereo) systems use a more elaborate variant of this method. It does
not require expensive shutter glasses, only relatively inexpensive polarizing glasses for
each viewer.

These types of hardware stereo viewing are full-color and should not be confused with
the old two-color (red-green) anaglyph technology which really only shows monochrome
or bi-chromeimages. ATOMS has always supported stereo viewing using two spatially
separated images combined with the naked eye or an optical viewer - this type of
technology goes back to the 19th century.

The terminology for stereo viewing can be somewhat confusing. 1n movie theaters and
television, the term 3D means stereoscopic viewing, that is separate images for left and
right eyes. In computer and video-game graphics, the term 3D has been applied to
several kinds of software techniques, at present primarily OpenGL and Direct3D, which
keep track, pixel-by-pixel, of the third dimension in drawings and thus typically produce
more realistic images than 2D line and space-fill drawings, though they are not
necessarily stereoscopic (no separate images for left and right eyes). Thisisthe way the
term 3D isused in al ATOMS literature. OpenGL and Direct3D may be used in
ATOMS for single non-stereo images as well as stereo (2D images may also be shown as
stereopairs with ATOMS, athough thisis usually inferior to using a 3D method).

ATOMS in the past has used only OpenGL, which is available for Windows, Macintosh
and Linux. ATOMS now supports stereo viewing using the quad-buffered OpenGL
method, which is currently available on the Quadro series of video cards from nVidia
and some other video cards.

A Direct3D drawing mode has been added to ATOMS for Windows to support stereo
viewing with GeForce cards and any others which require Direct3D. Thisisselected in
the Display menu, or with the Drawing Mode drop-down the Dialog Bar - Left.

Older Shutter-Glasses Systems

Older stereo display drivers from nVidia, which worked only on Cathode-Ray-Tube
monitors, - not flat-screen LCD monitors, supported Direct3D and OpenGL without
quad-buffering. This system works with inexpensive shutter glasses, but if the refresh
rate of the monitor isless than 100 Hz or so the flicker tends to be excessive. Such
systems are basically outmoded and may not be supported by manufacturers.

Changesin operation of ATOMS

In order to keep the total number of options to a minimum, what were formerly Display
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Modes have now been separated into Model Modes and Drawing Modes. The Model

M ode specifies the type of model which represents the structure, and includes Standard,
Ellipsoid, Cavities and Protein. The Drawing Mode specifies which computer technique
and viewing mode is used, and includes 2D single, 2D stereopair, OpenGL single,
OpenGL stereopair, OpenGL quad stereo and Direct3D. The 2D modes use essentially
line and fill drawing, which is suitable for schematic drawings for publication, for
example, though shading isavailablein ATOMS. The 3D modes - OpenGL and
Direct3D - use generally more realistic lighting and superior interpenetration relations,
and usually look better on screen or in full-color high-resolution printed images. The
OpenGL 3D system software is available on Windows, Macintosh and Linux, but
Direct3D isavailable only on windows.

An additional 3D mode, Direct3D, which is available only on Windows, has been added.
Thisisthe Drawing Mode which isrequired for stereo viewing with nVidia GeForce
display cards or any others which support Direct3D only. It may be either full-screen or
windowed, with the latest nVidiadrivers.

Selection of Stereo Viewing Methods

Smple stereopair methods. These allow stereo viewing using no aids or inexpensive
glasses or optical viewers. The stereopair modes alow stereo viewing with or without
optical aids, but these modes have limitations; the stereopair modes halve the size of the
image and the other image is aways visible, giving three images (unless some special
type of viewer isused).

Hardware stereo methods. In these methods a single image drawn by ATOMS is split
into left- and right-eye images by the display hardware, or actually its resident software.
Then the two images are displayed on screen, either aternating rapidly in synchrony with
shutter glass, or astwo differently polarized images. Any of several ATOMS Drawing
Modes may need to be used, depending on your video card and monitor.

1) Cards or driver software which support OpenGL quad-buffering, such asthe nVidia
Quadro series: Select the 3D quad stereo option in the Drawing Mode drop-down box in
the Dialog Bar - Left or in the Display menu. Stereo can be shown either in awindow or
full-screen. The program itself sends the two completed images or objectsto two
separate buffers, so both the perspective distance and the stereo rotation angle ( = depth
or stereo separation) are controlled by ATOMS; perspective distance is changed
onscreen with the SHIFT-P and SHIFT-[ keys and the rotation angle with the SHIFT-A
and SHIFT-Skeys.

Setting up nVidia 3D Vision for quad-buffered OpenGL. Inthe nVidiacontrol panel,
select Manage 3D Settingsin 3D Settings. In the Global Settings tabe, the Global
presets option should be set to "3D OpenGL Stereo”. It may then be necessary to select
the particular setting Stereo - Display Mode and set it to "Generic active stereo (with
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NVIDIA 3D Vision)".

2) nVidia GeForce cards which support their 3D Vision system, and any other display
cards which support only Microsoft Direct3D (DirectX). Click on the Direct3D button in
the Dialog Bar - Left or the Direct3D option in the Display menu. These cards will also
display in anaglyph (red-green glasses) mode without shutter glasses or a special
monitor. In this stereo mode, or any other except quad-buffered OpenGL, the program
sends only asingle drawing (or really, a 3D object) to the video card, which then rotates
the image one way for the |eft-eye image and the other way for the right-eye image.

For full-color operation these options will also require either the nVidia 3D Vision
shutter-glass kit and a compatible 120 Hz monitor or a compatible projector, or a stereo
polarizing monitor and polarizing glasses. Other hardware and software driver
combinations may also be available.

3) Older nVidia cards or some other card with stereo driver software, a CRT monitor
and shutter glasses. These may work with the Direct3D option asin 1) and/or with the
3D single option in the Drawing Mode drop-down box in the Dialog Bar - Left or the
Display menu. Thiswill only work in full-screen. Like Direct3D in 1) above, ATOMS
sets the perspective distance but the stereo rotation is controlled by the video driver.

Shortcut keys for controlling ATOMS images. Since stereo images may require full-
screen viewing in which menus are not available, the keyboard shortcuts for modifying
or animating the images have been revised and extended.

Additional Details

In ATOM S the perception of depth in stereoscopic viewing is affected by two
parameters, the Stereopair Rotation Angle, and the Perspective Distance; both are set in
dialogsin the Input2 Menu, or in the DialogBar - Right. A value of about 100
Angstroms for perspective distance and about 1-3 degrees for rotation angle are good
starting points.

In viewing real life objects setting the perspective distance would fix the stereopair
rotation angle because the human eyes are afixed distance apart. However in viewing
objects on an Angstrom scale the interocular distance is arbitrary, and thus it is possible
to set both parameters - in effect the stereopair rotation angle fixes the interocular
distance or the scale of the atomic structure relative to the viewer.

The nVidia settings depth and convergence are not available to the user in ATOMS,
because they are controlled by the two ATOM S settings stereopair rotation angle and
per spective distance. Convergence affects the apparent overall distance of the object -
whether it appearsto bein front of or behind the screen. However, excessive
displacement in either direction can cause difficult in the ability of the eyes to merge the
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two images (they may become excessively separated on the screen), and aso increased
prominence of "ghosts" or residual weak imagesin thewrong eye. Therefore ATOMS
always sets the convergence distance equal to the perspective distance so that the center
of the structure isin the plane of the screen, not in front of or behind it. The stereopair
rotation angle then fixes the nVidia depth parameter, which isreally the interocular
distance (the term "depth” does not refer to the position of the object front-back, but to
the apparent distance between the nearest and the furthest parts of the object).

The nVidiaKeyboard Shortcuts or hot keys for changing depth and convergence have no
effect in ATOMS, although using the depth keys will bring up a scale showing the
relative degree of stereo effect.

The control of depth and convergence by the ATOMS parameters applies only to the
nVidia3D Vision system. If other video cards or software drivers are used, the controls
supplied may have different names; depth, separation and/or convergence and the action
of each may involve both translation of the image on screen and rotation. Considerable
adjustment of these controls may be required to get the desired stereo effect and an
acceptable level of comfort. In particular, it isusualy best to adjust the two images
without wearing any glasses so that their physical separation isleast at the center of the
object. InnVidia3D vision, thiswould be done by adjusting convergence (but is
actually done automaticaly by ATOMS).

If the perspective distance issmall in ATOMS, the projection of spherical atoms will be
elliptical on the screen, and while this may actually be what the eye would see at a short
distance, such a projected image is usually unsatisfactory in practice. Thusthe
perspective distance should usually not be decreased beyond the point at which atoms
begin to look non-spherical.

There is no stereo rotation or stereo effect at all in Direct3D if the projection is
orthographic rather than perspective - that isif Perspective is not selected in the Input 2
menu. Therefore, ATOMS always uses perspective projection in the Direct3D mode,
with the perspective distance entered in the Perspective dialog (Input2 menu). If that
distance is zero, a plausible value is entered based on the dimensions of the structure.

In real life when attention is directed to anear object, not only is each eye directed
towards that object, but the focus is adjusted; viewing a near object causes distant objects
to go out of focus or become blurred and vice versa. This enhances perception of depth.
On a computer or movie screen the focus cannot be changed, and this may interfere with
depth perception for some people. Of course everything drawn by ATOMS isawaysin
focus, unlike a non-animated movie which is recorded by cameras which change focus
liketheeye. InATOMS, you may select fog, which only fades out the colors from front
to back and does not change the focus.
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5 Tutorials

In addition to the examples selected for tutorials, the subfolder SAMPLES contains some other
examples. All example files have the suffix.STR; check the file EXAMPLES.DOC for
comments on the examples, including the tutorials.

To start any of the tutorials elect the New command from the File menu. Thiswill step through
most of the dialogs in the Input1 menu and also the I nput2 menu if desired. Input for each of
these dialogs is discussed below. After each of these main dialogs has been completed by
clicking on the OK button, the Enter New Data Set dialog comes up. This givesyou the
choice to Continue, Abort or Revise the last category of input. This dialog will not be
mentioned again, but keep in mind that it comes up after each of the main dialogs described
below.

In the input for atoms, polyhedra, bonds etc., there are edit boxes for the pen number. Pen
numbers will not be discussed, since for multi-pen plotters the color depends on which pens are
placed in each position in the holder.

Note that when you are editing individual entriesin the Input Atoms, Polyhedra or Bonds
dialog, you can continue to edit itemsin the list with the Revise button; input of these listsis
finished when you click on OK. When in the Atom Data, Polyhedron Data or Bond Data
dialogs which are called up by the Revise or Add buttons, you can step through the list forwards
or backwards with the Next and L ast buttons. When you are editing the last item in each list,
the Next button becomes the New button. The same things hold true for editing boundary or
display forms.

Y ou can get Help for any dialog with the Help button.

5.1 Tutorial 1 - Glutaric Acid

Thisillustrates basic atom and bond input and interpenetrating atoms (space-filling
representation). The coordinates and radii were improvised from an illustration in a magazine
ad, and are not absolutely redlistic.

Dialog - Title/Structure Axes. IntheTitle field, enter "Glutaric Acid". In the Structure axes
combo box, select "unit Cartesian”.

Dialog - Symmetry Option. Select Point group from Table.
Sub-Diaog - Symmetry - Point Group from Table. Select the group mm2 - C2v.

Dialog - Boundary Option. Select No Boundaries (molecule). This brings up adialog which
simply confirms the choice

Dialog - Crystal Formsfor Display. Inthe Display forms group of radio buttons, select None.

Dialog - Input Atoms. Click on the Add Atoms button.
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Sub-Dialog - Revise Atom. We will first enter three carbon atoms. For all these atoms, the
Type will be 6 (the atomic number) and the Radius will 0.75. The colors can be selected as
desired; however black (RGB components 0, O, 0) is recommended for rims, and dark gray (85,
85, 85) for fills. These colors can be selected by filling in the RBG fields directly, or by
clicking on the Select...Color buttons, and choosing from the 16 colors presented there. For
Black-and-white pattern numbers, 15 is recommended for rimsand 2 for fills. All these
fields can be entered once, and they will be copied to the next atom.

The fields which will change between atoms are the L abel, and the coordinates (x, y and z). For
thefirst atom, fill in the fields from the values given for atom number 1 below. Then, if you
have filled in the remainder of the fields as described in the previous paragraph, click on the
New button. For the second atom, al the fields will be the same; replace the values for L abel,
X, y and z for atom 2) below. In like manner continue on to the third carbon atom. Note that
these are absolute coordinates, in Angstroms.

Carbon atoms:

1) C1 0.0 0.0 0.0
2) c2 0.0 0.943 0.333
3) C3 0.0 1.886 0.0

Next come three hydrogen atoms. Click on New after the last carbon atom. Set the Typeto 1,
and the Radiusto 0.4. The rim color and patterns can be left as black, but the fill color and
pattern should be changed, for example to green (0, 255, 0) and 8. Again, for each new atom
you can change only the L abel and coordinates x, y and z to the values given below.

Hydrogen atoms:

4) H1 052 0.0 -0.233
5) H2 052 0943 0.566
6) H3 0.0 24 -11

Next come two oxygen atoms. Set the Type to 8, and the Radius to.75. Thefill color and
pattern can be changed to red (255, 0, 0) and 5.

Oxygen atoms:

7) o1 0.0 2.794 0.419

8) 02 0.0 1.794 -0.996
When finished with atom 8), click on OK.

Back in the Input Atoms dialog, check thelist. If there are any mistakes, you can correct them
by selecting the atom and clicking on the Revise button.

Dialog - Polyhedra. No polyhedrawill be used, so just click on OK.
Dialog - Bonds. Click on the Add Bonds button.

Sub-Dialog - Bond Data. We will add four bonds. Since the atoms will be interpenetrating, the
bond radius, colors and patterns will not be used, and there is no need to set thesefields. The
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Min distance field can be set to 0.4 or any small number, and the M ax. distance field can be set
to 1.2. Set thefieldslisted below, clicking on New to go from bond 1) to 2) and so on.

Atomtypel Atomtype?2

) 6 6 (C-C)
2 6 8 (C-0)
3 6 1 (C-H)
4 8 1 (O-H)

Back in the Bonds dialog, correct any mistaken entries. Click on OK when done.

Dialog - End of Mandatory Input. At this point you have the choice of continuing with the
dialogs in the I nput2 menu, or accepting default values for the parametersin those dialogs. If a
structure file was in memory when you started the New input, you can also accept the
parameters used in that structure (the current values). Let us continue, to insure that the result is
the same as the sample file GLUT.STR.

Dialog - Crystal Edges. A crystal shapeisinappropriate for this molecule, so select Atoms
only from the Display group.

Dialog - Per spective Viewing. Do not check the box; perspective viewing adds little to this
molecule.

Dialog - Stereopairs. You can check the Stereopairs on box if you like, although you may
need a special viewer to see the screen image in 3D.

Dialog - Rims. Check all the boxes. Unshaded color drawings and all black-and-white
drawings look best with rims, and shaded drawingsin color usually look better without rims.

Dialog - Line Widths. Click on the Set All to O button - thiswill result in widths of one dot in
screen display and raster output. Be sure that the Use Individual check boxes are off.

Dialog - Shading. Uncheck the boxes Shading for atoms, Shading for bonds and Shading
for polyhedra. You can switch later to shading.

Dialog - Background Color. A light or medium gray, such as (170, 170, 170) usually works
best on the screen.

Dialog - AxesdUnit Cell. Inthe Display group, select Neither.
Dialog - Thermal Ellipsoid Parameters. Click on Cancel to skip thisdialog.

Dialog - Initial Orientation. Set theInitial Cartesian rotations (X, y and z) all to zero. Check
the Clinographic viewing box.

Dialog - Scaling. Set the Scale mode to Maximize size for each view.

Dialog - Centering/Displacement. Select Automatic Centering.
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Dialog - Calculation Output. Inthe combo box Output, select "No Output".

After the last dialog has been completed, you are asked if you want to save thefile. Thena
message box appears saying "New input completed - calculate now?'. Click on Yes, and the
drawing should appear quickly.

Y ou can compare the results of thisinput process with the file GLUT.STR in the SAMPLES
subfolder. If there are differences, you can print out the input parametersin either or both files
with the List Input command in the File menu (Listings sub-menu).
Y ou can experiment with shading, using the Shading dialog in the Input2 menu. The shaded
drawing will look better if atom rims are turned off in the Rims dialog in the Input2 menu.
Note, however, that if you are using a 256-color display adapter, and if you use 32 shading
zones, the carbon atoms become solid black. As explained in section 1V-2, the second 8 colors
in the 16-color palette are not valid for 32 shading zones. Y ou can use the Atoms -

Global diaog in the Inputl menu to change thefill color for al type 6 atomsto one of the
colors in the upper half of the Choose Color dialog.

5.2 Tutorial 2 - Diopside

Thisisatypical silicate crystal. Unlessthe unit cell isvery small, ball-and-stick display istoo
complicated for most silicates, and showing the SiO4 groups as polyhedrais usually more
satisfactory. The atomic radii used for Mg and Ca are approximately half the ionic radii, which
works fairly well as ageneral practice.

Select the New command from the File menu. See the start of the Tutorials section for general
comments.

Dialog - Title/Structure Axes. Inthe Title field, enter "Diopside”. Inthe Structur e axes
combo box, select "monoclinic”. For the a, b and ¢ axes, enter 9.746, 8.899 and 5.251, and for
beta enter 105.63.

Dialog - Symmetry Option. Select Space group from Table.

Sub-Diaog - Symmetry - Space Group from Table. Enter "C2/c" inthe H-M Symboal field,
and make sure that the radio button for this option is checked. Or, you can select this space
group in the list box, clicking on the Select button, and it makes no difference which option (H-
M, Hall or Number) is selected.

Dialog - Boundary Option. Select Enter Forms.
Sub-Diaog - Boundary - Enter Forms. Set the Symmetry for boundary forms to Center
only. At the bottom of the dialog, Use individual atom distances should be unchecked and all

the L attice trandation boxes should be checked. Now click on the Add For ms button.

Sub-Sub-Dialog - Add/Revise Form. For each form, enter the indices shown below inthe h, k
and | edit boxes, and the distance in the Central distance box. When finished with each, click
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on the New Form button to go to the next. When done, click on OK.

h k [ distance
1) 1 0 0 4.0
2) 0 1 0 7.0
3) 0 0 1 11.0

Back in the Boundary - Enter Formsdialog, check the list and correct the entries if necessary
with the Revise button. When done, click on OK .

Dialog - Crystal Formsfor Display. Inthe Display forms group of radio buttons, select Same
asboundary.

Dialog - Input Atoms. Click on the Add Atoms button.
Sub-Dialog - Revise Atom.

Atom 1) issilicon. The Label should be Si, the Type should be 14 (the atomic number) and the
Radius 0.15 - silicon atoms will not appear by themselves unless skeletal or transparent
polyhedra are selected for 3D Drawing modes. The colors and pattern numbers can be ignored
for thisreason. The x, y and z coordinates are 0.2862, 0.0933, and 0.2293. When done, click on
the New button.

Atom 2) is magnesium - Mg and Ca atoms will be shown as spheres. The L abel should be Mg,
the Type should be 12 (the atomic number) and the Radius 0.36. The x, y and z coordinates are
0.0, 0.9082 and 0.25. The colors can be selected as desired; however black (RGB components
0, 0, 0) isrecommended for rims, and red (255, 0, 0) for thefill. For Black-and-white pattern
numbers, 15 isrecommended for rims and 6 for fills. When done, click on the New button.

Atom 3) iscalcium. The Label should be Ca, the Type should be 20 (the atomic number) and
the Radius 0.56. Thex, y and z coordinates are 0.0, 0.3015 and 0.25. The colors can be
selected as desired; however black (RGB components O, O, 0) is recommended for rims, and
blue (0, 0, 255) for thefill. For Black-and-white pattern numbers, 15 is recommended for
rimsand 4 for fills. When done, click on the New button.

Now enter three oxygen atoms. For al these atoms, the Type will be 8 (the atomic number) and
the Radius will be 0.0 - oxygen atoms only appear as corners of polyhedra, and if they areto be
shown as spheres they can be given auniform radius. The rim color can be black and the fill
color cyan (0, 255, 255). For Black-and-white pattern numbers, 15 is recommended for rims
and 1 for fills.

The fields which will change between atoms are the L abel, and the coordinates (x, y and z). For
thefirst atom, fill in the fields from the values given for atom number 1 below. Then, if you
have filled in the remainder of the fields as described in the previous paragraph, click on the
New button. For the second atom, al the fields will be the same; replace the values for L abel,
X, y and z for atom 2) below. In like manner continue on to the third carbon atom.

Oxygen atoms:
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4) o1 0.1156 0.0873 0.1422
5) o2 0.3611 0.25 0.3180
6) o3 0.3503 0.0176 -0.0047

When finished with atom 6), click on OK.

Back in the Input Atoms dialog, check thelist. If there are any mistakes, you can correct them
by selecting the atom and clicking on the Revise button.

Dialog - Polyhedra. Click on Add Polyhedra.

Dialog - Polyhedron Data. The only polyhedron will be the silicate tetrahedron, although isis
also possible to do Mg octahedra. The Coor dination number isfour, the Maximum bond
distance can be 1.8, the Central type (S)) is 14 and thereis only one Ligand type, 8 for
oxygen; put the number eight in the first Ligand type box and be sure the other 6 boxes are
empty. The rim color should be black, and the fill color can be yellow (255, 255, 0). Rim
pattern should be 15 (black) and fill pattern can be 2. Click on OK when finished.

Back in the Polyhedra dialog, in the Show ligands as spher es group, select the Use single
radius radio button, with radius 0.2.

Click on OK if the single polyhedron entry is correct.
Dialog - Bonds. Click on the Add Bonds button.

Sub-Dialog - Bond Data. We will add two bonds. The Atom types, Max. distance and rim
color are given below. The Radius should be set to 0.0 for single-line bonds, which will use the
rim color and pattern number - the fill color and pattern are ignored. Rim pattern number should
be 15. The Min distance field can be set to 0.4 or any small number.

For bond 1), Mg-0, the two types are 12 and 8; the maximum distance is 2.3; and rim color can
be blue (0, 0, 255). After entering the values for bond 1), click on New to go to 2). For bond 2),
Ca-0, the two types are 20 and 8; the maximum distance is 3.0; and rim color can be magenta
(255, 0, 255). Click on OK when finished with bond 2)

Back in the Bonds dialog, correct any mistaken entries. Click on OK when done.

Dialog - End of Mandatory Input. At this point you have the choice of continuing with the
dialogs in the I nput2 menu, or accepting default values for the parametersin those dialogs. If a
structure file was in memory when you started the New input, you can also accept the
parameters used in that structure (the current values). Let us continue, to insure that the result is
the same as the sample file DIOPSIDE.STR.

Dialog - Crystal Edges. You can select either Both or Atoms only from the Display group.
Set the dash length to 0.2 and the dash ratio to 0.45. colors can be yellow (255,255,0) for front
edges and blue (0,0,255) for back edges. Pattern numbers for both front and back edges should
be 15.

Dialog - Per spective Viewing. Check the box and set the Per spective distance to 50.0.

© 2011 Shape Software



Tutorials 237

Dialog - Stereopairs. You can check the box if you like, although you may need a special
viewer to see the screen image in 3D.

Dialog - Rims. Check all the boxes. Unshaded drawings look best with rims, and shaded
drawingsin color usualy look better without rims.

Dialog - Line Widths. Click on the Set All to O button - thiswill result in widths of one dot in
screen display and raster output. Be sure that the Use Individual check boxes are off.

Dialog - Shading. Uncheck the boxes Shading for atoms, Shading for bonds and Shading
for polyhedra. You can switch later to shading.

Dialog - Background Color. A light or medium gray, such as (170, 170, 170) usually works
best on the screen.

Dialog - AxedUnit Céll. Inthe Display group, select Neither.
Dialog - Thermal Ellipsoid Parameters. Click on Cancel to skip thisdialog.

Dialog - Initial Orientation. We want to look almost directly down the ¢ axis, so set the Initial
Cartesian rotations (x, y and z) to 0.0, 92.5 and 0.0. Uncheck the Clinographic viewing box.

Dialog - Scaling. Set the Scale mode to Maximize size for each view.
Dialog - Centering/Displacement. Select Automatic Centering.
Dialog - Calculation Output. Inthe Output combo box, select "No Output".

After the last dialog has been completed, a message box appears saying "New input completed -
calculate now?'. Click on Y es, and the drawing should appear quickly.

Y ou can compare the results of thisinput process with the file DIOPSIDE.STR in the
\SAMPLES subdirectory. If there are differences, you can print out the input parametersin
either or both fileswith the List Input command in the File menu (L istings sub-menu).

5.3 Tutorial 3 - Dodecahedrane

Thisisahypothetical cyclic saturated hydrocarbon molecule with carbon atoms at the 20
corners of a pentagona dodecahedron (Icosahedral symmetry, group |), and one hydrogen
bonded to each carbon. It illustrates the input of non-crystallographic symmetry using.SYM
files, and the use of stick bonds. This drawing will also be done with shading and perspective
viewing. See SYMGRP for the generation of the |.SYM file, which in this case is present in
both the SAMPLES and the SY MGRP subfolders. Since the Cartesian symmetry file must bein
the same directory as the data file, be sure you are in one of these two directories, or move the
I.SYM file to the directory you arein. Y ou can switch ATOMS to the SAMPLES subfolder by
reading in afile from there. Y ou can aso go through the New input until you reach the message
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box "New input completed - calculate now?"'. If you click on No, you can use Save As in the
File menu to save the current file to the SAMPLES subfolder. Then select Calculate from the
File menu.

Select the New command from the File menu. See the start of the Tutorials section for general
comments.

Dialog - Title/Structure Axes. IntheTitle field, enter "Dodecahedrane”. In the Structure
axes combo box, select "unit Cartesian”.

Dialog - Symmetry Option. Select Cartesian Matrices.
Sub-Dialog - Symmetry - Cartesian Matrices. Inthe File name box, enter |.SYM.

Dialog - Boundary Option. Select No Boundaries (molecule). This brings up adialog which
simply confirms the choice

Dialog - Crystal Formsfor Display. Inthe Display group of radio buttons, select None.
Dialog - Input Atoms. Click on the Add Atoms button.

Sub-Dialog - Revise Atom. We will enter only one carbon atom. The Type should be 6 (the
atomic number) and the Radius 0.35. Thex, y and z coordinates are 0.0, 0.0 and 1.4. The colors
can be selected as desired; however black (0, 0, 0) is recommended for rims, and magenta (255,
0, 255) for fills. For Black-and-white pattern numbers, 15 is recommended for rimsand 2 for
fills. The Pen number can be 1, or if you will not be using a pen plotter, just ignore thisfield.

Click on the New button to enter the hydrogen atom. Set the Type to 1, and the Radius to 0.2.
Thex, y and z coordinates are 0.0, 0.0 and 2.2. The rim color and patterns can be left as black,
but the fill color and pattern should be changed, for example to cyan (0, 255, 255) and 4. The
L abel should be "H" and the x, y and z coordinates 0.0, 0.0 and 2.2.

Back in the Input Atoms dialog, check thelist. If there are any mistakes, you can correct them
by selecting the atom and clicking on the Revise button.

Dialog - Polyhedra. No polyhedrawill be used, so just click on OK.
Dialog - Bonds. Click on the Add Bonds button.

Sub-Diaog - Bond Data. We will add 2 bonds. For C-C bonds, both Atom type 1 and Atom
type2 are6. The Min. distance field can be set to 0.4 or any small number, and the M ax.
distance field can be set to 1.4. Set the Radius to 0.1. Therim color should be black and the
rim pattern number 15. Fill color and pattern can be selected to taste, for example red (255, O,
0) and 6.

For C-H bonds, Atom type 1is6 and Atom type2is1. TheMin. Distance field can be set to
0.4 or any small number, and the M ax. Distance field can be set to 1.0. Set the Radius to 0.06.
The rim color should be black and the rim pattern number 15. File color and pattern can be
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selected to taste, for example blue (O, 0, 255) and 6.

Back in the Bonds dialog, correct any mistaken entries. Click on OK when done.

Dialog - End of Mandatory Input. At this point you have the choice of continuing with the
dialogs in the I nput2 menu, or accepting default values for the parametersin those dialogs. If a
structure file was in memory when you started the New input, you can also accept the
parameters used in that structure (the current values). Let us continue, to insure that the result is
the same as the sample file DDRANE.STR.

Dialog - Crystal Edges. Select Atoms only from the Display group.

Dialog - Per spective Viewing. Check the box; and set the perspective distanceto 7.5.

Dialog - Stereopairs. You can check the box if you like, although you may need a special
viewer to see the screen image in 3D.

Dialog - Rims. Uncheck all the boxes. Shaded drawingsin color usually look better without
rms.

Dialog - Line Widths. Click on the Set All to O button, although rims will not be used. Be sure
that the Use Individual check boxes are off.

Dialog - Shading. Check the boxes Shading for atoms and Shading for bonds. Set the
Number of zones to 32. The Illumination vector can be 3.0, -1.0, 1.0 (this vector will be
normalized to length one after leaving the dialog). Set the Darkest shade to 0.0 and the
Darknessangleto 110. Y ou can check Front-back fading if desired, and set the Fading
factor to 0.15. Thisfactor should be smaller than the Factor for complete fading shown at the
bottom of the dialog; however, this factor is not computed until the structure is calculated.

Dialog - Background Color. A light or medium gray, such as (170, 170, 170) usually works
best on the screen.

Dialog - AxedUnit Céll. Inthe Display group, select Neither.
Dialog - Thermal Ellipsoid Parameters. Click on Cancel to skip thisdialog.

Dialog - Initial Orientation. Set theInitial Cartesian rotations (X, y and z) all to zero. Check
the Clinographic viewing box.

Dialog - Scaling. Set the Scale mode to Maximize size for each view.
Dialog - Centering/Displacement. Select Automatic Centering.
Dialog - Calculation Output. Inthe combo box Output, select "No Output".

After the last dialog has been completed, a message box appears saying "New input completed -
calculate now?'. Click on Y es, and the drawing should appear quickly.
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Y ou can compare the results of thisinput process with the file DDRANE.STR in the SAMPLES
subfolder. If there are differences, you can print out the input parametersin either or both files
with the List Input command in the File menu (Listings sub-menu).
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bond distances 98 Close Command (Graphics) 54
Bond Labels 154 Close command (Text) 180
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GraphicsWindow MenuBar 51
grid- scale 157

groups - locating or isolating 172
groupsincrystals 204

Groups Located 173

GSAS (.EXP) files 38
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HPGL files 61

Hydrogen Bond Specifications 108
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illumination vector 119

import ADFfile 42

Import File Button 159
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mouse mode 151
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NDOT 123

New Command 26, 53
NLINE 123
NPLANE 123
nVidia 160
nVidiastereo 146

-0 -

offset - dlice 88, 95
Opencommand 53

orientation - initial 133

orientation - space/point-group 220
ORTEPfile 36

ORTEP model mode 139

ORTEP parameters 123

output - calculation 134

_P-

Page Setup 59

Page Setup dialog box 43, 181
Palette 49

palettes 195

Pastecommand 182

patterns 199

PDB attributes 189

PDB Files 37

pen numbers 199

PenPlot 61
Pen Plotter Settings 47

Pen-Plotter Commands and Parameters
48

Perspective 117

picking atoms 183, 184

PICT files 65

planes- general 157

plot codes 184

plot states - atomsand bonds 137
point-group orientation 220
Point-Group Symmetry 80
Polyhedra 101
polyhedraproperties- 3D 131
Polyhedron Data 103

polymers- isolating 172
polymers - special considerations 221
PostScript files 60

Postscript printing 60

PostScript Settings 45

PostScript Transfer Function 47
PostScript typefaces - standard 224
POV-Ray File Output 69

Powder Diffraction 163

Powder Diffractogram Window 23
Precession Pattern 164
Precession Pattern Window 24
Preferences- Constants Tab 46
Preferences - Operation Tab 43
Preferencesfiles 217

Print command (Text) 181

Print GraphicsImage 55

Protein Attributes of Atom 189
Protein Data Bank (PDB) files 37
proteindisplay 132

protein model mode 142

© 2011 Shape Software




246 ATOMS Help
Save command (Text) 180
- Q - Save Defaults Command 50
. Save GraphicsWindow 67
t 7
Quit command 70 SCAL? 123
“R- Scale Grid 157
Scaling 133

Raster (Bitmap) Files 62

Ravel ATOMSfileimport 40

Read Defaults Command 50

Read Structure Fragment from File 175
Reference 189

Remove Crystal Symmetry 177
Remove Rotations 168

Replot Command 151

Reset Rotation Center of Fragment
reset scaling and centering 136
residues (protein) 132

Revise Atom - BasicTab 96

Revise Atom - Central Distances Tab
95

Revise Atom - Slice Offset Tab 95
Revise Atom - Vector Tab 95
Revise Structure Fragment 175
Rims 118

Rotate on Cartesian Axes 166
Rotate on Structure Vector 166
Rotate Structure Fragment 176
rotation - continuous 169
rotation - initial 133

rotation - stereopair 167
Rotation Menu (Graphics Window)
Rotation Movie 169

rotations - removing 168

177

165

-S -
Save As command (Graphics) 54
Save Ascommand (Text) 180

Save command (Graphics) 53

screen preview - PostScript 45
screenshot 67

SCRPTR 217

SCRPTRfile 50

Select Color 189

Settingsfiles 217
SettingsMenu 43

Settings Menu (Graphics Window)
shades- input 199

Shading 119

SHELX .INSFiles 32
Shubnikov settings 75

shutter glasses 160

slice boundary option 88

dice offset - individual atom 95
Space-group orientation 220
Space-Group Symmetry - Basic Tab 72

Space-Group Symmetry - Shubnikov Tab
75

special characters 194

special considerations for molecules and
polymers 221

sphere boundary option 90
Standard Model Mode 139
Standard PostScript Typefaces 224
Starting ATOMS - Command-Line
Processing 224
startingup 14
Startup Menu Bar 25
Startup Window 22
stereo 146

guad-buffered OpenGL 146
stereographic viewing with glasses 149

178
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stereopair 144
2D Drawing modes 144
3D Drawing modes 144
Stereopair Rotation 167
Stereopairs 118
stereoscopic viewing 160
structureaxes 71

structure fragment - resent center 177

structure fragment - revision 175
structure fragment - rotate 176
structure fragment - trandlate 177
structure fragments - multiple 174
subscripts 194

superscripts 152, 194

Symmetry 72

Symmetry - Cartesian 80
Symmetry - Custom 81
Symmetry - Point Group 80
Symmetry - removal 177
Symmetry - Space Group 72
symmetry numbers 152
systematic absences 88

“T-

TAPER 123

Temperature Factor Tab 94
Text Window 24

Text Window Menu Bar 179
text windows - font 179
Thermal Ellipsoid model Mode 139
Thermal motion 112

thermal motion movie 169
thickness - dlice 88

Title/Axes 71

transfer function - PostScript 47

Transform Menu (Graphics Window)
170

Trandate Structure Fragment 177

trandation limits boundary option 90
truestereo 146

Tutorials 231

Types of Windows 20

U -

Undo command 182

unit-cell - drawing 209
unit-cell boundary option 84
Unit-Cell Displacements 123
unit-cell display 122

_V -

vector - dignon 167

vector - illumination 119

vectors - Individual atoms 95
VIBRAT (.MOT or .VBR) files 39
vibration - animation 160
Vibration Movie 169

Vibrational Modes 111
VIBRATZ program 203

video - rotation 169

VRML Files 68

W -

Wien2k fileimport 41
Window menu 179, 182
windows - types 20
Windows metafiles 65

_X -
XTLVIEW file 37
_7 -

zeolitefileimport 41
z-matrix 99
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zones- shading 119
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